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Section I
Overview and Operations

This section includes a total of three chapters. The first two are 
intended to provide an overview of the components that control 
access to Spartan Student’s graphical user interface (GUI). The 
third (Walking Through Spartan Student) provides a “guided 
tour” of the interface, with examples provided (from pre-calculated 
molecules) demonstrating many rudimentary operations and emphasis 
on commonly used features. Description of the full range of Spartan 
Student’s capabilities (and detailed tour through all menu items and 
interface options) is deferred to Section 3 (User’s Guide), which is 
intended to serve as a reference to the current version 9 feature set.
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Chapter 1
Spartan Student

This chapter describes the architecture of Spartan Student, focusing 
on the connectivity of computational, graphical and database 
components to the user interface. Available molecular mechanics 
and quantum chemical methods are enumerated and their utility and 
applicability assessed.

Spartan Student comprises a series of independent molecular 
mechanics and quantum chemical calculation modules tightly 
connected via a graphical user interface that is highly functional, 
yet simple and uncluttered. It has been designed not only to greatly 
reduce the number of steps and possibility for human error associated 
with the preparation of input for calculations, but also to guide the 
interpretation of output from calculations. The interface may be 
viewed as an interactive and intuitive analytical device accessing 
molecular mechanics and quantum chemical techniques. 

Included in the interface are 3D builders for organic, inorganic and 
organometallic molecules, polypeptides and polynucleotides, and 
a procedure for building transition states. 2D sketch capability for 
organic and organometallic molecules has been refined with this 
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version of Spartan Student. Additionally, use of ChemDraw1 is 
enabled without having to exit the interface. A ≈6,000 molecule subset 
of the Spartan Spectra and Properties Database (SSPD) contains 
structures, infrared and NMR spectra as well as a wide variety 
of molecular properties obtained from the EDF2/6-31G* density 
functional model. The wavefunction is included, allowing quick 
access to a variety of graphical surfaces and property maps. On-line 
access to the Protein Data Bank (PDB)2, a collection of >190,000 
biological macromolecular structures, is available. Experimental 
infrared spectra for ≈2,000 molecules are available from the NIST 
website3 and experimental NMR spectra for >44,000 molecules are 
available from NMRShiftDB website.4

Spartan Student’s interface provides the gateway to a range of modern 
computational methods5. The simplest of these is the MMFF molecular 
mechanics model, available to determine equilibrium geometries and 
equilibrium conformers of molecules comprising upwards of several 
thousand atoms.

Quantum chemical models are required to account for the geometries 
of transition states as well as for reaction and activation energies.7 
The simplest of these are semi-empirical molecular orbital models. 
The PM3 model, supported in Spartan Student, has proven successful 
for determining equilibrium geometries including the geometries of 
transition-metal compounds, but it is not reliable for the calculation 
of the reaction or activation energies.

Hartree-Fock molecular orbital models are a mainstay of quantum 
chemical techniques, in particular, for determining equilibrium and 
transition-state geometries and reaction energies, and are supported in 
Spartan Student with the STO-3G, 3-21G, 6-31G* and 6-311+G** 
basis sets. Hartree-Fock models generally provide suitable descriptions 
of many types of reactions, but are not adequate for thermochemical 
comparisons where bonds are broken or formed. In addition, they 
do not provide a proper account of the geometries of molecules 
incorporating transition metals. Supported in Spartan Student are the 
B3LYP, EDF2, and wB97X-D density functional models (DFT) and 
the MP2 Møller-Plesset model. All properly account for the energies 
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of reactions that involve bond making and breaking and both density 
functional models (but not the MP2 model) properly account for the 
geometries of molecules incorporating transition metals. DFT and 
MP2 models are supported with the 6-31G* and 6-311+G** basis 
sets. The T16 thermochemical recipe, providing high accuracy heats 
of formation for uncharged, closed-shell systems containing H, C, 
N, O, F, Si, P, S, Cl and Br, is also provided. 

Spartan Student provides access to infrared spectra (MMFF, PM3, 
Hartree-Fock, B3LYP, EDF2, wB97X-D and MP2 models) and NMR 
spectra7 (Hartree-Fock, B3LYP, EDF2, wB97X-D models only). These 
are available both as numerical data (vibrational frequencies, chemical 
shifts) as well as spectral plots. Spartan Student provides internet 
access to experimental IR and NMR databases3,4, allowing direct 
comparison with calculated spectra. Infrared spectra from density 
functional models has been corrected using both a multiplicative scale 
of calculated frequencies and peak width at half height as parameters. 
Proton and 13C chemical shifts obtained from B3LYP/6-31G* and 
wB97X-D/6-31G* as well as proton, 13C and 19F chemical shifts 
obtained from the EDF2/6-31G* density functional model have been 
empirically corrected to account for local environment.

Also available are energy, equilibrium and transition state geometry, 
and frequency calculations using the C-PCM solvation model in 
conjunction with Hartree-Fock and density functional models only. 
The model depends only on the dielectric constant of the solvent and 
preset values are available for typical non-polar and polar solvents 
as well as water.

New in Spartan Student 9 is calculation of UV/vis spectra (density 
functional only) based on ground state geometry, with excited state 
calculation from TDDFT. In general, calculated UV/vis spectra results 
are not sufficient to identify or confirm color, but are sufficient to 
indicate if substitutions will shift color toward red or blue.

Spartan Student provides a variety of graphical tools to assist in 
interpreting the results of calculations. These include molecular 
orbitals, electron and spin densities, local ionization potentials and 
electrostatic potentials that can be displayed as surfaces, slices and 
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1.  ChemDraw is not included with Spartan Student, but may be obtained from PerkinElmer  
(www.perkinelmerinformatics.com). Seamless access to ChemDraw is not available in 
the Macintosh version although both Windows and Macintosh versions are able to read 
ChemDraw files.

2. PDB web reference: https://www.rcsb.org.
3. NIST web reference: https://book.nist.gov.
4. NMRShiftDB web reference: https://nmrshiftdb.nmr.uni-koeln.de
5. Full discussion and assessment of the specific molecular mechanics and quantum chemical 

models available in Spartan Student is provided in: W.J. Hehre, A Guide to Molecular 
Mechanics and Quantum Chemical Calculations, Wavefunction, Irvine, 2003. This is 
available as a PDF on Wavefunction’s website (www.wavefun.com). See also: W.J. Hehre, 
L. Radom, P.v.R. Schleyer and J.A. Pople, Ab Initio Molecular Orbital Theory, Wiley, New 
York, 1986; Y. Shao, Z. Gan, E. Epifanovsky, A. T. B. Gilbert, M. Wormit, J. Kussmann, A. 
W. Lange, A. Behn, J. Deng, X. Feng, D. Ghosh, M. Goldey P. R. Horn, L. D. Jacobson, I. 
Kaliman, R. Z. Khaliullin, T. Kús, A. Landau, J. Liu, E. I. Proynov, Y. M. Rhee, R. M. Richard, 
M. A. Rohrdanz, R. P. Steele, E. J. Sundstrom, H. L. Woodcock III, P. M. Zimmerman, D. 
Zuev, B. Albrecht, E. Alguire, B. Austin, G. J. O. Beran, Y. A. Bernard, E. Berquist, K. 
Brandhorst, K. B. Bravaya, S. T. Brown, D. Casanova, C.-M. Chang, Y. Chen, S. H. Chien, 
K. D. Closser, D. L. Crittenden, M. Diedenhofen, R. A. DiStasio Jr., H. Dop, A. D. Dutoi, R. 
G. Edgar, S. Fatehi, L. Fusti-Molnar, A. Ghysels, A. Golubeva-Zadorozhnaya, J. Gomes, M. 
W. D. Hanson-Heine, P. H. P. Harbach, A. W. Hauser, E. G. Hohenstein, Z. C. Holden, T.-C. 
Jagau, H. Ji, B. Kaduk, K. Khistyaev, J. Kim, J. Kim, R. A. King, P. Klunzinger, D. Kosenkov, 
T. Kowalczyk, C. M. Krauter, K. U. Lao, A. Laurent, K. V. Lawler, S. V. Levchenko, C. Y. 
Lin, F. Liu, E. Livshits, R. C. Lochan, A. Luenser, P. Manohar, S. F. Manzer, S.-P. Mao, N. 
Mardirossian, A. V. Marenich, S. A. Maurer, N. J. Mayhall, C. M. Oana, R. Olivares-Amaya, 
D. P. O’Neill, J. A. Parkhill, T. M. Perrine, R. Peverati, P. A. Pieniazek, A. Prociuk, D. R. 
Rehn, E. Rosta, N. J. Russ, N. Sergueev, S. M. Sharada, S. Sharmaa, D. W. Small, A. Sodt, 
T. Stein, D. Stück, Y.-C. Su, A. J. W. Thom, T. Tsuchimochi, L. Vogt, O. Vydrov, T. Wang, 
M. A. Watson, J. Wenzel, A. White, C. F. Williams, V. Vanovschi, S. Yeganeh, S. R. Yost, 
Z.-Q. You, I. Y. Zhang, X. Zhang, Y. Zhou, B. R. Brooks, G. K. L. Chan, D. M. Chipman, C. 
J. Cramer, W. A. Goddard III, M. S. Gordon, W. J. Hehre, A. Klamt, H. F. Schaefer III, M. 
W. Schmidt, C. D. Sherrill, D. G. Truhlar, A. Warshel, X. Xua, A. Aspuru-Guzik, R. Baer, 
A. T. Bell, N. A. Besley, J.-D. Chai, A. Dreuw, B. D. Dunietz, T. R. Furlani, S. R. Gwaltney, 
C.-P. Hsu, Y. Jung, J. Kong, D. S. Lambrecht, W. Liang, C. Ochsenfeld, V. A. Rassolov, L. 
V. Slipchenko, J. E. Subotnik, T. Van Voorhis, J. M. Herbert, A. I. Krylov, P. M. W. Gill, 
and M. Head-Gordon. Advances in molecular quantum chemistry contained in the Q-Chem 
4 program package. [Mol. Phys. 113, 184–215 (2015)].

6. W.S. Ohlinger, P.E. Klunzinger, B.J. Deppmeier, W.J. Hehre, J. Phys.Chem. A, 103, 10, 2165 (2009).
7. Chemical shifts only. HH coupling constants and splitting patterns are evaluated empirically.

property maps. Spartan Student provides the ability to distinguish 
accessible and inaccessible regions on a density surface and on 
property maps based on this surface. Animations can be created and  
used to depict conformational changes or the progress of chemical 
reactions.
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Chapter 2
Operating Spartan Student

This chapter describes the general operating features of Spartan 
Student.

Opening and Exiting/Quitting Spartan Student

To open from Windows, click the Search field next to the Windows 
icon and type: Spartan Student. Click on the Spartan Student v.9 
app to open (or double click on the Spartan Student shortcut icon on 
your desktop). To open from Macintosh, double click on the Spartan 
Student icon in the Applications Folder. To exit, select Exit from the 
File menu (select Quit Spartan Student from the Spartan Student 
menu for Mac), or click the Close button ( ) at the top right (  top 
left for Mac) of the Spartan Student interface.

Menus and Icons

Program functions may be accessed either from the menu bar or from 
icons in the toolbar which is directly underneath  the menu bar. The 
menu bar may either be accessed as pull-down menus (Drop Down), 
for example, the Setup menu:

or under Windows (only) from a list of icons presented in a palette 
(Button Pad), for example, the Display menu:
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Selection is made in the Settings Preferences dialog (Preferences... 
under the Options menu; Chapter 10).

Icons for all menu functions (as shown alongside text in both Drop 
Down and Button Pad styles) are available. Display choice (beyond 
the default initially supplied with Spartan Student) is made in the 
Icons tab (Preferences... under the Options menu; Chapter 10). 
Icon size is selected from the Settings tab (Preferences... under the 
Options menu; Chapter 10).

File

Allows you to build or sketch a new molecule or read in a molecule that 
you have previously saved, to retrieve the structure, properties and IR 
and NMR spectra from a molecule in Spartan Student’s database from 



12	 Chapter 2

its name, to retrieve a protein structure from the Protein Data Bank, to 
print what is on screen or save it as an image file, and to make QuickTime 
movies (Macintosh only). Open, Close, and program Exit functions are 
also accessible.

Edit

Allows you to transfer information to and from the clipboard, to undo 
operations, to find text strings and molecule fragments, to center molecules 
on screen, and to clear the active molecule by deleting it.

Model

Allows you to control the style of your model, to display hydrogen bonds 
and to couple or decouple molecules in a multi-molecule document. 
Enables display of a Ramachandran plot for a protein structure brought 
in from PDB, toggles on/off display of hydrogen bonds and labels R/S 
chiral centers.
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Geometry

Allows you to measure and constrain bond lengths, angles and dihedrals, 
define points and planes, specify atoms to be “frozen”, elaborate isomers 
and align molecules.

Build

Allows you to build or sketch and edit molecules, and to build/estimate 
a transition state geometry based on a library of reactions (using arrow 
pushing markers).

Setup

Allows you to specify the task to be performed and the theoretical model 
to be employed for this task, and specify graphical surfaces and property 
maps and to submit jobs for calculation.*

*	 If a quantum chemical calculation has previously been performed, or if the molecule 
has been retrieved from the SSPD, surfaces are generated “on-the-fly” from the Spartan 
Student graphical interface, and do not require submission to generate graphical models.
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Display

Allows you to display text output, molecular and atomic properties, 
orbital energy diagrams, surfaces and property maps and infrared and 
NMR spectra, as well as to access experimental IR and NMR over the 
internet. Allows you to present data in a spreadsheet and make plots 
from and perform regression analysis on these data, and to compute 
reaction energies based either on user data or from entries in the database 
associated with Spartan Student.

Options

Allows you to set display standards, specify the location of the database, 
monitor executing jobs and customize colors, icons and other aspects of 
the graphical user interface.

Activities

Allows you to display tutorials, topics, and lab 
activities inside of Spartan Student and to search 
Wikipedia.
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Help

Provides access to information on Spartan 
Student’s general operation and a number of 
computational FAQ’s, the Spartan Student 
Manual, and license information. Allows users 
to check for version updates.

A complete listing of menu functions is 
provided in Appendix B.

Additional Icons

A variety of other icons appear in Spartan Student, both in individual 
dialogs and in the information bar at the bottom of the screen.

	 Post to Spreadsheet	 	 Search Transition State

/ 	 Lock/Unlock Constraints /  Move Up/Down Dialog

 Play	  Pause /  Step

 Extend to Fullscreen	  Revert to Actual Size  Stop

 Look Up in Wikipedia  Look Up in ChemSpider

Tabs

Spartan Student assigns a tab to each open document. When more 
than a single document is open, these appear in a single row along 
the bottom of the screen in the order that the documents were created 
or read. Backward and forward step keys (  and ) at the far right 
provide access to tabs outside of those displayed. Documents are 
selected for display by clicking on its tab. To the left of each tab 
is a check box, if checked, this indicates that the document will 
be displayed on screen even if it is not the selected document. By 
default, tabs are not checked. Selecting Pin New Documents from 
the Settings tab (Preferences... under the Options menu; Chapter 
10) changes the behavior and checks all tabs.
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Mouse/Keyboard Operations

The following functions are associated with a standard mouse and 
keyboard. Note: the the zoom function (translation in the z plane) is 
managed by the center mouse wheel (or moving the finger over the 
center of the mouse for the standard Macintosh mouse)

	 Keyboard	 Left	 Right

	 –	 X/Y rotation, atom/fragment	 X/Y translation 
		  substitutiona, insertiona	

	 Shift	 Range selection, Z rotate	 Zoom (Z translate)
	 Ctrl (view mode)	 multiple rotation, X/Y rotation	 X/Y translation for all 
		  for all visible molecules	 visible molecules
 	 Ctrl (build mode)	 selected fragment,  	 selected fragment,
		  X/Y rotation	 X/Y translation
	 Ctrl (build) Windows	 chiral center inversiona	 	

	 Command (build) Macintosh	 chiral center inversiona	
	 Ctrl + Shift (view)	 Z rotation for all visible molecules
	 Ctrl + Shift (build) Windows 	 selected fragment Z rotate, 
		  absolute chirality inversiona

	 Command + Shift	 selected fragment Z rotate, 
	 (build mode) Macintosh	 absolute chirality inversiona

	 Alt Windows (view)	 group selectionb	
	 Option Mac (view)	 group selectionb	

	 Alt Windows (build)	 bond rotation	 bond stretching	
	 Option Mac (build)	 bond rotation	 bond stretching

a)	 Build mode only, requires double clicking.
b)	 With no keys pressed, holding down the center mouse wheel (or both left and right 

mouse buttons), dragging enables a selection box for group selection.

These broadly fall into two categories: selection (picking) and 
manipulation (translation/rotation/zooming).

Selection. Clicking (left button) selects objects on screen and/or 
menu items. Left and right buttons together are used to define a 
selection box for copying to the clipboard, as well as for multiple 
model selection. Together with the Shift key, the left button allows 
for selection over a range. Together with the Ctrl (Control) key, the 
left button allows for multiple selection. Both range and multiple 
selection apply not only to text items in lists, but to atoms and bonds 
in molecules as well. Together with the Alt key (Option key for 
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Mac), the left button allows for selection of an entire group (detached 
molecular fragment). 

In Edit Build mode (only), double clicking (left button) on an atom 
exchanges it with the atom or atomic fragment selected in the model 
kit. Double clicking on an atom while holding down the Ctrl key 
leads to inversion in chirality of the atom and double clicking on a 
molecule while holding down both the Ctrl and Shift keys inverts 
the absolute configuration of the molecule. These operations are not 
available in the 2D sketcher (Edit Sketch mode). Once an initial 
fragment, group or ring has been specified, double clicking on the 
background will insert it alongside (but not bonded to) whatever 
currently exists on screen.

Manipulation. The left button is used for rotation and the right 
button is used for translation and scaling of objects on screen. With 
no keys depressed, moving the mouse while holding down the left 
button gives rise to rotation about the X and y (screen) axes, while 
moving the mouse while holding down the right button gives rise 
to translation in the x and y (screen) directions. Together with the 
Shift key, moving the mouse while holding down the left button 
gives rise to rotation about the z direction, while moving the mouse 
while holding down the right button gives rise to scaling. The center 
(scroll) wheel on the mouse may also be used for scaling.

The Ctrl key in conjunction with the left or right mouse buttons and 
(optionally) the Shift key, signifies a change in focus away from 
the default for the purpose of rotations and translations. Outside 
of Edit Build/Edit Sketch mode, the default is focus on a single 
molecule (the selected molecule). Use of the Ctrl key changes focus 
to the entire set of molecules on screen, meaning that rotations and 
translations are carried out globally. In Edit Build mode (only), the 
default is focus on the full set of fragments that make up the molecule 
being constructed, and rotations and translations refer to this set of 
fragments as a whole. Use of the Ctrl key changes focus to a single 
fragment (the selected fragment), and rotations and translations now 
refer only to this fragment (does not apply to Edit Sketch mode).
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In Edit Build mode (only), moving the mouse while holding down 
the Alt key (Option key for Mac) together with the left mouse button 
rotates about the selected bond. With the right mouse button, this 
changes the length of the selected bond. Bond rotation (only) may 
also be accomplished by moving the mouse up and down inside the 
demarked area at the left of the screen while holding down the left 
mouse button (does not apply to Edit Sketch mode).

Additional keys control various Spartan Student functions.

Page Up, Page Down Moves up (Page Up), down (Page Down), to the 
Home, End top (Home) and to the bottom (End) of the set of 

open molecules. Also, moves up and down pages 
in the Output dialog.

Insert In Edit Build/Edit Sketch fragment mode only,
(Option for Mac) inserts a new fragment on screen. This is
 accomplished by selecting the fragment from the 

model kit, holding down the Insert key and clicking 
on screen. Insertion may also be accomplished 
by double clicking on the background following 
selection of a fragment.

Delete Deletes a fragment, free valence, reaction arrow or 
the contents of a selection box. This is accomplished 
by holding down the Delete key and clicking on 
the fragment, etc.

Enter Required following text or data entry into
(Return for Mac) spreadsheet or dialogs.

Touch-Screen Operations

Tapping is equivalent to clicking and double tapping is equivalent 
to double clicking. Touch commands for range and multiple 
selection have not been implemented. One finger motions on screen 
are equivalent to left button motions (object and bond rotation). 
Two finger motions are equivalent to right button motions (object 
translation). Two finger pinching is equivalent to scroll wheel 
operations (zooming).
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Selecting Molecules

While two or more molecules may be simultaneously displayed in 
Spartan Student’s window (see Tabs earlier in this chapter), only 
one molecule may be selected. Only the selected molecule has 
access to all capabilities. Molecule selection occurs by clicking on 
its structure model or on any of its associated graphical surfaces. 
The previously selected molecule is deselected. 

Where the molecule belongs to a document with more than a single 
molecule, selection from among the different molecules may be made 
using either the  and  buttons or the scroll bar at the bottom left 
of the screen. Clicking on  at the bottom left of the screen animates 
the display of molecules in the document, that is, steps through them 
sequentially. Animation speed is controlled from the Settings tab 
(Preferences... under the Options menu; Chapter 10). Clicking on 

 (that replaces ) stops the animation. If the spreadsheet associated 
with the document is open (Spreadsheet under the Display menu; 
Chapter 9), selection can also be made by clicking on the molecule 
label at the left of the spreadsheet. 

Two or more molecules from the same document may be displayed at 
once (although only one may be selected). Molecules are marked for 
display by checking the box immediately to the left of the molecule 
label in the spreadsheet.

Database

Included with Spartan Student is a ≈6,000 molecule subset of the 
Spartan Spectra and Properties Database (SSPD).** This provides 
infrared and NMR spectra in addition to a variety of molecular 
properties obtained from the EDF2/6-31G* or wB97X-D/6-31G* 
density functional model. The database may be accessed either by 
molecule name (see Chapter 3) or by molecule structure (see below). 

The existence of the selected molecule in the database is signaled by 
its name being displayed at the bottom of the screen.

**	 The SSPD is a growing collection of >300,000 organic molecules along with associated 
properties and IR and NMR spectra data. Contact sales@wavefun.com for licensing options.
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Details are provided by clicking on  to the immediate left of the 
molecule name (it then changes to ). This brings up a dialog 
that allows a 3D model of the entry in the database to be rotated, 
translated and scaled using the usual mouse/keyboard commands 
(you need to position the cursor inside the viewing area). Model 
style may not be changed.

The selected (on-screen) molecule may be replaced by the selected 
database entry by clicking on Replace at the bottom of the dialog. 
(Replacement can be undone by selecting Undo from the Edit 
menu; Chapter 4). If Update molecule names when replaced is 
checked, the name of the molecule in the database will replace the 
name previously associated with the molecule.

In the event that the selected (on-screen) molecule belongs to a 
multi-molecule document, it is possible to replace all molecules in 
the document for which database entries are available. In this case, 
clicking on Replace will give rise to a second dialog. Clicking on 
All will replace all the molecules in the document, while clicking on 
Current will replace only the selected molecule.

Stereo Displays
Spartan Student supports red-cyan stereo. Red/blue glasses must 
be worn. To enter stereo-mode, select Stereo ON, under the Stereo 
preference (Options menu, Preferences, Settings tab).
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Changing Colors and Setting Preferences

Colors and Preferences... under the Options menu (Chapter 10) 
allow for changing default background and graphical object colors, 
and for setting (and resetting) program defaults, respectively.

Monitoring and Terminating Jobs

Monitor under the Options menu (Chapter 10) allows for monitoring 
of executing jobs as well as for terminating jobs.
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Tutorial 1
Walking Through  
Spartan Student

This tutorial introduces a number of basic operations in Spartan 
Student required for molecule manipulation, property query and 
spectra and graphics display. Specifically it shows how to: i) open 
molecules, ii) view different models and manipulate molecules on 
screen, iii) measure bond distances, angles and dihedral angles, 
iv) display energies, dipole moments, atomic charges and infrared, 
NMR, and UV/vis spectra, and v) display graphical surfaces and 
property maps. Spreadsheet operations are not illustrated, molecules 
are not sketched or built and no calculations are performed.

1.	 Start Spartan Student. Click (left mouse button) on File from 
the menu bar that appears at the top of Spartan Student’s main 
window. Click on Open... from the File menu that appears. 
Alternatively, click on the  icon that appears at the top of the 
screen. A file browser appears.

Tap on  at the top of the screen. If the icon is not available, 
tap on File in the menu bar to bring up a palette of icons and 

then tap on .

	 Move to the Tutorials directory*, click on Walking Through 
Spartan Student and click on Open. 

Tap on Walking Through Spartan Student and tap on Open. 
Note that click (left mouse button) and tap (one finger) are 

equivalent as are double click and double tap. We shall only 
indicate click/double click throughout the text that follows.

*	 For Windows, the Tutorials directory is found in Program Files/Wavefunction/Spartan 
Student. It needs to be copied and saved to another location to access. For Macintosh, the 
Tutorials directory is on the Spartan Student disc image. It needs to be copied to another 
location available to the user (we recommend Documents or Desktop).
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	 A single document containing ethane, acetic acid dimer, 
propene, ammonia, hydrogen peroxide, acetic acid, water, 
cyclohexanone, camphor, 3-aminobenzophenone, ethylene, 
benzene, aniline and cyclohexenone will be opened. A ball-and-
spoke model for the first molecule (ethane) will be displayed; 
its name will appear at the bottom right of the screen. The 
appearance of the name means that the molecule is included 
in the ≈6,000 molecule subset of the Spartan Spectra and 
Properties Database (SSPD) installed with Spartan Student.

2.	 Practice rotating (move the mouse while holding down the left 
button), rotating in the plane of the screen (move the mouse 
while holding down both the left button and the Shift key), 
and translating (move the mouse while holding down the right 
button). Use the scroll wheel to zoom in and out, or alternately 
move the mouse up or down while holding down both the right 
mouse button and the Shift key.

To rotate, move one finger across the screen. To rotate in the 
plane of the screen, twist two fingers. To translate, move two 

fingers across the screen. To zoom in, pinch two fingers together. 
To zoom out, move two fingers apart.

	 Click on Model from the menu bar.
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		  Wire	 Ball-and-Wire	 Tube	 Ball-and-Spoke

	 One after another, select Wire, Ball and Wire, Tube and finally 
Ball and Spoke from the palette of icons that results from 
selection of the Model menu. All four models for ethane show 
roughly the same information. The wire model looks the most 
like a conventional line formula. It uses color to distinguish 
different atoms, and one, two and three lines between atoms to 
indicate single, double and triple bonds, respectively.

	 The ball-and-wire model is identical to the wire model, except 
that atom positions are represented by small colored spheres, 
making it easy to identify atom locations. The tube model is 
identical to the wire model, except that bonds are represented by 
solid cylinders. The tube model is better than the wire model in 
conveying three-dimensional shape. The ball-and-spoke model 
is a variation on the tube model; atom positions are represented 
by colored spheres, making it easy to see atom locations.

	 Select Space Filling from the palette of icons that results from 
the selection of Model menu.

	
	 Space-Filling

	 The space-filling model is different from the others in that bonds 
are not shown. Rather, each atom is displayed as a colored 
sphere that represents its approximate size. Thus, the space-
filling model provides a measure of molecular size. While 
lines between atoms are not drawn, the existence (or absence) 
of bonds can be inferred from the extent to which spheres on 
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neighboring atoms overlap. If two spheres substantially overlap, 
then the atoms are almost certainly bonded, and conversely, 
if two spheres barely overlap, then the atoms are not bonded. 
Intermediate overlaps suggest weak bonding, for example, 
hydrogen bonding.

3.	 Click once on the right arrow key  at the bottom left of the 
interface. This will move to the next molecule in the document, 
acetic acid dimer. Its name will appear at the bottom of the 
screen. If you make a mistake, use the backward  or forward 

 step keys to access acetic acid dimer in the document. Switch 
to a space-filling model and look for overlap between the (OH) 
hydrogen on one acetic acid molecule and the (carbonyl) oxygen 
on the other. Return to a ball-and-spoke model. Click on the 
Model menu and select Hydrogen Bonds.

	
	 Ball-and-Spoke model for acetic acid dimer  

with hydrogen bonds displayed

	 The two hydrogen bonds responsible for holding the acetic acid 
molecules together will be drawn.

4.	 Distances, angles, and dihedral angles can easily be measured 
with Spartan Student using Measure Distance, Measure 
Angle, and Measure Dihedral (respectively), from the 
Geometry menu.
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a)	 Measure Distance: This measures the distance between 
two atoms. Click once on  to move to the next molecule, 
propene. Click on the Geometry menu and select Measure 
Distance (or click on the  icon if it appears at the top of 
the screen). Click on a bond or on two atoms (the atoms do 
not need to be bonded). The distance (in Ångstroms) will 
be displayed at the bottom right of the screen. Repeat the 
process for different bonds or pairs of atoms. When you 
are finished, select View from the Build menu (or click on 
the  icon at the top of the screen).

  
b)	 Measure Angle: This measures the angle around a central 

atom. Click once on  to move to the next molecule, 
ammonia. Click on the Geometry menu and select Measure 
Angle (or click on the  icon if it appears at the top of the 
screen). Click first on H, then on N, then on another H. 
Alternatively, click on two NH bonds. The HNH angle (in 
degrees) will be displayed at the bottom right of the screen. 
Click on  when you are finished.

c)	 Measure Dihedral: This measures the angle formed by 
two intersecting planes, one containing the first three 
atoms selected and the other containing the last three atoms 
selected. Click once on  to move to the next molecule, 
hydrogen peroxide. Click on the Geometry menu and 
select Measure Dihedral (or click on the  icon if it 
appears at the top of the screen) and then click in turn on 
the four atoms (HOOH) that make up hydrogen peroxide. 
The HOOH dihedral angle will be displayed at the bottom 
right of the screen. Click on  when you are finished.
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5.	 Energies, dipole moments, atomic charges, thermodynamic and 
QSAR properties (among other calculated data) are available 
from Properties under the Display menu.

	

Molecule Properties:

a)	 Molecule: Click once on  to move to the next molecule,  
acetic acid. Click on the Display menu and select Properties 
(or click on  icon if it appears at the top of the screen). 
The Molecule Properties dialog appears. It provides the 
energy and a host of other information relating to the isolated 
molecule. 

	
	 The energy for acetic acid is given in atomic units (Energy in 

au). The magnitude of the dipole moment (Dipole Moment 
in debye) is also provided in the Molecule tab. A large 
dipole moment indicates large separation of charge. You can 
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display the dipole moment vector,  where the + side 
refers to the positive end of the dipole, to the model on the 
screen, by checking the box to the left of Display Dipole 
Vector near the bottom of the dialog.

The vector will not be displayed if the dipole moment is zero. 
The dipole moment will not be reported if the molecule is charged 
because in this case it depends on the location and orientation of 
the molecule in space. 

b)	 QSAR: Quantitative structure - activity relationship  
properties including area, volume and polar surface area 
(and many others) may be accessed from the QSAR tab.

c)	 Thermodynamics: Thermodynamic properties including 
zero-point energy, entropy, enthalpy, Gibbs free energy, and 
heat capacity are available from the Thermodynamics tab.

d)	 2-D Drawing: Spartan Student Edition will generate a 
2-D drawing for anything constructed in 2D or 3D (with a 
maximum limit of 100 atoms).

e)	 Utilities: Access to a number of convenient options related 
to a molecule’s display, color, bonding and absolute 
configuration are available.	

f)	 Atomic Charges: To display the charge on an atom, click on it 
when the Molecule Properties dialog is on screen. The Atom 
Properties dialog replaces the Molecule Properties dialog.
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	 Atomic charges based on the electrostatic potential are 

given in units of electrons. A positive charge indicates a 
deficiency of electrons and a negative charge indicates an 
excess of electrons. Repeat for other atoms. Confirm that 
the positively-charged atom(s) lie at the positive end of the 
dipole moment vector. When you are finished, close the 
dialog by clicking on  at the top.

g)	 Infrared Spectra: Molecules vibrate (stretch, bend, twist) 
even at absolute zero. The infrared spectrum of a molecule 
arises due to transitions between ground and excited-state 
vibrational energy levels, that is, correspondence of the 
frequency of the light and the energy of vibrational excitation.  
Infrared spectroscopy is important for identifying molecules 
as different functional groups vibrate at noticeably different 
and characteristic frequencies. 

	 Click once on  to move to the next molecule in the 
document, water. To animate a vibration, select Spectra 
from the Display menu (or click on  if it appears at the 
top of the screen). This leads to an empty spectra pane at the 
bottom of the screen.
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	 Click on  at the top left of the pane and select  
from the available spectra.

  
	 The calculated IR spectrum of water from 4000 - 500 cm-1 

appears in the pane.

	
	 There are three lines, one of moderate intensity around 3728 

cm-1, one very weak around 3608 cm-1 and one very strong 
around 1623 cm-1. In turn, move the cursor on the spectrum 
(move the mouse while holding down the left mouse button 
over each of these lines). In response, the molecular model 
will vibrate. The line of moderate intensity corresponds to 
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an asymmetric OH stretching motion, the very weak line 
corresponds to a symmetric OH stretching motion and the 
strong line corresponds to the HOH bend.

	 To translate the plot inside the pane, position the cursor over 
the spectrum and move the mouse left or right while holding 
down the right button. To expand or contract the scale of 
the IR plot from its default range, position the cursor over 
the spectrum and use the scroll wheel on your mouse (or 
alternatively move the mouse while holding down both 
the right button and Shift key). To reset the spectra plot to 
the original values, click on  in the bar at the top of the 
spectra pane.

	 To see a complete listing of frequencies and intensities, click 
on  at the left of the spectra pane.

	

	 Click on each entry in the table to highlight the frequency in 
the spectrum and animate the vibration. Click on  again to 
dismiss the table and click on  to remove the spectrum.

Changing the size of the spectra pane as well as translating 
and rescaling a spectrum is quite simple with touch screen 

operations. To resize the spectrum, position one finger inside the 
menu bar at the top of the spectra pane and move up or down. To 
translate the spectrum, move two fingers over the spectrum. To 
alter the scale, pinch two fingers over the spectrum.

	 Click once on  to move to cyclohexanone, the next 
molecule in the list. The spectra pane is still on screen but 
should be empty. (If it is not on screen, select Spectra from 
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the Display menu or click on  if it appears at the top of 
the screen to restore.) Click on  in the bar at the top of the 
spectra pane and select . The calculated infrared 
spectrum of cyclohexanone appears.

	
	 The spectrum obtained from quantum chemical calculations 

has been broadened (to account for finite temperature) and 
scaled (to account for the fact that the underlying energy 
function is assumed to be quadratic). The same broadening 
and scaling parameters are used for all molecules. The 
strongest line appears at 1759 cm-1 and corresponds to a CO 
stretch. The fact that the line is both intense and isolated 
from other features in the spectrum makes it a very useful 
indicator of carbonyl functionality. Move the cursor over this 
line and examine the “vibrating” model for cyclohexanone 
on screen above the spectrum.

	 Click again on  and this time select . The 
experimental IR spectrum (from the public NIST database) 
is superimposed on top of the calculated spectrum.

	
	 Note that the two spectra are quite similar. This would have 

not been the case with the raw calculated data, however, 
calculated frequencies and intensities have been empirically 
corrected to account for finite temperature and for systematic 
errors in the theory.
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	 When you are done, select  from the bar at the top of the 
spectra pane.

e)	 NMR Spectra: Along with mass spectrometry, NMR 
spectroscopy is the most powerful tool available with which 
to assign molecular structure. Among the nuclei that exhibit 
NMR spectra, proton and 13C are by far the most important.

	 Click once on  to move to the next molecule in the 
document, camphor. With the spectra pane on screen, click 
on  in the bar at the top of the spectra pane and select 

. The calculated 13C NMR spectrum appears.

	

	 This comprises nine lines, in the range of 150 to 0 ppm 
(there is a tenth line corresponding to the carbonyl carbon 
at 217 ppm). You can zoom out to see this line by using the 
scroll wheel on your mouse. More instructive is to zoom 
in on the range from 60 to 0 ppm to get a better look at the 
other lines.

	 Move the mouse while holding down the left button over the 
spectrum. When you come to a line, the chemical shift will 
appear at the top of the spectrum and the atom (or atoms) 
responsible for this line will be highlighted on the model 
displayed above the spectrum.
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	 Again, click on  in the bar at the top of the spectra pane 
and select . The experimental  13C spectrum obtained 
from a public database will be superimposed on top of the 
calculated spectrum.

	

	 You will see that the overall agreement between calculated 
and experimental 13C spectra is quite good. As with infrared 
spectra (see preceding discussion of cyclohexanone), the data 
resulting from the quantum chemical calculations have been 
empirically corrected (for density functional calculations 
only).

	 Click again on  and select . An “idealized” 
proton spectrum where three-bond HH coupling constants 
are set to zero appears.
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	 The manipulations are as before and the hydrogens 
responsible for selected lines are highlighted in the model. 
No experimental spectrum is available, but the quality of 
the match would be expected to be similar to that previously 
observed with comparison of 13C spectra.

	 Click again on  and select  from the palette. 
The resulting spectrum which takes account of three-bond 
HH coupling is more complicated and much closer to what 
would be observed experimentally. Coupling constants and 
splitting patterns have not actually been calculated from 
quantum mechanics, but rather have been estimated based 
on local environment.

	
	 Zoom in on specific lines (scroll wheel) to see the detailed 

splitting patterns. For example, the two protons at C3 are 
both split by the proton at C4. The doublet at 2.23 ppm 
shows a much larger splitting than the doublet at 1.99 ppm 
(you need to zoom way in to see that this is a doublet). This 
reflects the fact that the proton responsible for the line at 
2.23 ppm makes a dihedral angle of 43° with the proton at 
C4, whereas the proton responsible for the line at 1.99 ppm 
makes a dihedral angle of 80°.

	 Finally, note that you can switch among the three calculated 
NMR spectra (as well as the experimental 13C spectrum) 
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for camphor by clicking on the associated button in the bar 
above the spectra pane. When you are done, remove all three 
spectra by clicking  three times in succession.

f)	 UV/visible Spectra: Absorption of light in the visible or 
ultraviolet range of the electromagnetic spectrum leads to 
electronic excitation from the ground-state to excited-states 
and (in the case of absorption in the visible), is responsible for 
a molecule’s color. UV/visible spectroscopy not only offers 
a “fingerprint” but is also an important screen to identify 
molecules that may be damaged by exposure to light.

		  Click once on  to move to the next molecule, 
3-aminobenzophenone. The spectra pane should still be 
on screen. Click on  and select . No empirical 
corrections have been applied to the calculated spectrum 
that appears.

		
		  Click again on  and select . The experimental UV/

visible spectrum from the freely available NIST database 
will be drawn on top of the calculated spectrum.

		
		  The two spectra are visually similar at least qualitatively. 

However, calculated and experimental UV/visible spectra 
are likely to be sufficiently different that the theory will not 
often be able to account for the “color” of the molecule. 
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Where the theory is likely to be more successful is in 
anticipating changes in color resulting from subtle changes 
in structure. Click on  when you are done. Also, remove 
the spectra pane either by clicking on  at the top right or 
by selecting Spectra from the Display menu or by clicking 
on  if it appears at the top of the screen. 

6.	 Spartan Student permits display, manipulation and query 
of a number of important graphical quantities resulting from 
quantum chemical calculations. Most important are the electron 
density (that reveals how much space a molecule actually takes 
up), the bond density (that reveals chemical bonds), and key 
molecular orbitals (that provide insight into both bonding and 
chemical reactivity). In addition, the electrostatic potential 
map, an overlay of the electrostatic potential (the attraction or 
repulsion of a positive charge for a molecule) on the electron 
density, is valuable for describing overall molecular charge 
distribution as well as anticipating sites of electrophilic addition. 
Another indicator of electrophilic addition is provided by the 
local ionization potential map, an overlay of the energy of 
electron removal (ionization) on the electron density. Finally, 
an indicator of nucleophilic addition is provided by the |LUMO| 
map, an overlay of the absolute value of the lowest-unoccupied 
molecular orbital (the LUMO) on the electron density.

	 Click once on  to move to the next molecule in the list, 
ethylene. Click on the Display menu and select Orbital 
Energies (or click  if it appears at the top of the screen). An 
orbital energy diagram for ethylene will appear at the left of the 
screen. This provides the energies of all six occupied valence 
molecular orbitals and two unoccupied molecular orbitals.
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	 Click on the energy level in the diagram labeled HOMO. In a 
second, the familiar π bond in ethylene will appear. Note that 
the graphic has “blue” and “red” regions. These correspond to 
positive and negative values of the orbital (the absolute sign 
is arbitrary). Examine the other occupied orbitals (by clicking 
on their respective energy levels in the diagram) as well as the 
lowest-unoccupied molecular orbital (the LUMO). Note that 
you can move from one level to the next by moving the mouse up 
or down while holding down and then releasing the left button.

“Swipe” one finger up or down over the orbital energy 
diagram to move to the next higher or lower energy level.

	 Click once on  to move to the next molecule in the list, 
benzene. Click on the Display menu and select Surfaces from 
the palette (or click on  if it appears at the top of the screen). 
The Surfaces dialog appears.
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 	 Select electrostatic potential map inside the Surfaces dialog 
(click inside the box to the left of the name). An electrostatic 
potential map for benzene will appear. Click on the map. The 
Style menu will appear at the bottom right of the screen. Select 
Transparent from this menu. This makes the map transparent 
and allows you to see the molecular skeleton underneath. Go 
back to a Solid display (Style menu) in order to clearly see 
color differences. The surface is colored red in the π system 
(by convention, indicating negative potential and the fact that 
this region is attracted to a positive charge), and blue in the 
σ system (by convention, indicating positive potential and the 
fact that this region is repelled by a positive charge). Click 
on the Display menu and select Properties (or click on  
if it appears at the top of the screen) and click on the surface. 
Remove the checkmark from the box to the left of Bands in the 
Surface Properties dialog to replace the series of color bands 
(discrete display) by a continuous display.*

*	 Discrete displays are the default. You can change the default to continuous displays from 
the Molecule Preferences dialog (Preferences... under the Options menu; Chapter 10, 
Spartan Student Manual).
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	 Click once on  to move to the next molecule in the list, aniline, 
and select local ionization potential map inside the Surfaces 
dialog. By convention, red regions on a local ionization potential 
map indicate areas from which electron removal (ionization) is 
relatively easy, meaning that they are subject to electrophilic 
attack. These are easily distinguished from regions where 
ionization is relatively difficult (by convention, colored blue). 
Note that the ortho and para ring carbons are more red than the 
meta carbons, consistent with the known directing ability of the 
amino substituent.

	 Click once on  to move to the last molecule in the list, 
cyclohexenone, and select LUMO inside the Surfaces dialog. 
The resulting graphic portrays the lowest-energy empty 
molecular orbital (the LUMO) of cyclohexenone. This orbital 
is delocalized onto several atoms and it is difficult to tell 
where exactly a pair of electrons (a nucleophile) will attack the 
molecule.

	 A clearer portrayal is provided by a LUMO map, that displays 
the (absolute) value of the LUMO on the electron density 
surface. First, remove the LUMO from your structure (select 
LUMO in the Surfaces dialog) and then turn on the LUMO 
map (select |LUMO| map in the dialog). By convention, the 
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color blue is used to represent maximum value of the LUMO 
and the color red, minimum value. Note that there are two blue 
regions, one directly over the carbonyl carbon and the other over 
the β carbon. This is entirely consistent with known chemistry. 
Enones may either undergo carbonyl addition or conjugate 
(Michael) addition.

	

HO CH3

CH3

OO

CH3Li
carbonyl addition

(CH3)2CuLi
Michael addition

7.	 When you are finished, close the document by selecting Close 
from the File menu or alternatively by clicking on the  icon 
if it appears at the top of the screen.
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Section II
Tutorials

This section includes a brief description (Getting Started) of a 
collection of tutorials organized of 10 Chapters covering a good 
portion of available features in the Spartan Student’s graphical 
user interface (GUI). Where appropriate estimates are given for the 
approximate amount of computational time (these are based on a 
modestly configures (quad core) laptop.

Completing the full set of tutorials in this section will take a few 
hours of your time. This will not make you an “expert”, but will leave 
you comfortable enough to navigate throughout Spartan Student. 
Later tutorials build upon  skills introduced in earlier tutorials and 
will expose you to a wider range of the program’s features and 
capabilities.

Finally, a selection of 42 Labs, organized into the following broad 
categories:

General Chemistry, Organic Chemistry, Physical Chemistry, 
Organometallic Chemistry, and Biochemistry are available from 
within the program, accessible from the Activities menu.

.
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Getting Started
The tutorials that follow provide an introduction to both the user 
interface and the calculation capabilities of Spartan Student. The 
intent is to provide hands-on experience with the user interface and 
in doing so, illustrate the setup, submission, and interpretation of 
molecular mechanics and quantum chemical calculations. Tutorials 
are not intended to illustrate the full range of capabilities available 
in Spartan Student, but focus on building and sketching a variety 
of molecules and on use of the program to calculate equilibrium and 
transition-state geometries, to search conformation space, to align 
molecules, to evaluate reaction thermochemistry and activation 
energetics and to obtain NMR, infrared spectra and UV/vis spectra.

Sketching Organic Molecules (Tutorial 2) and Building Organic 
Molecules (Tutorial 3) present alternative ways to specify molecular 
structure, the first step in performing a molecular mechanics or 
quantum chemical calculation. The advantage of 2D sketching over 
3D building becomes more and more evident as molecular size and 
complexity increase, and with the rapidly growing popularity of 
touch-screen tablets and Windows PC’s. The 3D building paradigm 
is quite general and Spartan Student provides tools not only for 
building organic molecules (described in Tutorial 3) but also for 
inorganic and organometallic molecules and for polypeptides and 
polynucleotides. The tutorials in these chapters are limited to building/
sketching and do not involve either calculations or examining the 
results of calculations.

The tutorials in Spectra, Properties, and Graphical Models of Organic 
Molecules from the Database (Tutorial 4) and Spectra, Properties 
and Graphical Models from Quantum Chemical Calculations 
(Tutorial 5) make use of the same molecules sketched or built in the 
previous chapters, but with focus on obtaining and interpreting the 
results of calculations.

The tutorials in Groups of Organic Molecules (Tutorial 6) introduce 
multi-molecule documents and associated spreadsheet, plotting and 
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analysis tools available in Spartan Student. In order to save time, 
no quantum chemical calculations are required with all results being 
drawn from the database (Spartan Spectra Properties Database).

The tutorials in Spectra of Organic Molecules (Tutorial 7) further 
illustrate the use of Spartan Student to interpret infrared spectra, to 
assist in the assignment of NMR spectra, and to introduce the UV/
visible spectra calculation.

All of the molecules considered up to this point have either been 
rigid or have been assumed to exist in a single conformer. In reality, 
most molecules can adopt more than one conformation. The tutorials 
in Flexible Molecules (Tutorial 8) illustrate how to examine the 
conformational profile of a molecule with only a single rotatable 
bond, how to assign the lowest-energy conformer of a molecule with 
multiple degrees of freedom and how to interpret the NMR spectrum 
of a flexible molecule. 

Organic Reactions (Tutorial 9) illustrates two approaches available 
in Spartan Student for finding the transition state for an organic 
reaction. The first starts from a guess based on the structure of the 
reactant together with a set of “reaction arrows”, while the second 
moves a geometric variable through the transition state.

Applications to proteins and nucleotides are provided in Biomolecules 
(Tutorial 10). Access to the PDB is illustrated.

Finally, Inorganic and Organometallic Molecules (Tutorial 11) 
illustrates the inorganic model kit available in Spartan Student. An 
example of a transition state for an organometallic reaction is also 
provided.
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Tutorial 2
Sketching Organic Molecules 

The tutorials in this section introduce and illustrate tools to sketch 
organic molecules in 2D and convert them into realistic 3D structures.

Not only are 2D sketches (or “drawings”) more familiar to most 
chemists (and chemistry students) than 3D structures, they are 
often easier to produce especially for complex molecules that may 
incorporate fused rings or require stereochemistry to be defined. The 
advent of touch-screen computers makes the argument for sketching 
as an alternative to building even more compelling. Molecules that 
require several minutes to build in 3D can be sketched in seconds. 
The key is automatic and reliable conversion from 2D drawings to 
3D structures.

Sketch Palette

The sketch palette contains tools for making and manipulating 2D 
drawings, including tools for adding cues to designate stereochemistry.

These include atoms that are most commonly found in organic 
molecules (H, B, C, N, O, F, Si, P, S, Cl, Br and I), the phenyl, 
cyclohexyl and cyclopentyl rings and the carbonyl, acid/ester and 
amide functional groups. A More icon (immediately below H and 
B icons) allows for entering additional elements, functional groups 
and ligands. The palette also contains stereochemical markers and 
charge/radical markers.



46	 Tutorial 2

Sketching a Molecule

To start a sketch, first select (click on) an atom, group, ring or wildcard 
icon in the palette and then double click in the white portion of the 
screen (the drawing area). To draw a bond, first click on an atom, 
group, or ring icon in the palette to designate what is at the end of 
the bond, then position the cursor over the atom in the drawing area 
where you want the bond to start, move the cursor while holding 
down the left button (“drag” the cursor) to the place in the drawing 
area where you want the bond to end and release the button. Multiple 
bonds are made by dragging over existing bonds.

1. position

2. drag

3. release
gives

1. position

2. drag

3. release
gives

4. position 5. drag

1. position 2. drag 3. release
gives

5. drag 4. position6. release

6. release

To make a bond touch the screen where you want it to start, move 
one finger to where you want it to end and lift. Replace position by 

touch, drag by move and release by lift in the diagram above.

Manipulating a Sketch

To translate the sketch, move the mouse over the screen while holding 
down the right button. To rotate the sketch (in the plane of the screen), 
move the mouse up and down while holding down both the left button 
and Shift key. Use the scroll wheel to resize the sketch.

To translate the sketch, move two fingers over the screen. To rotate 
the sketch in the plane of the screen, “twist” two fingers on the 

screen. To resize the sketch, pinch (or spread) two fingers on the screen.
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N,N-Dimethylaniline

N

1. Select New Sketch from the File menu (or click on  if it 
appears at the top of the screen) to bring up the sketch pad. Click 
on  in the palette and double click on screen.

2. Click on  in the palette. Position the cursor over the “top” 
carbon on the benzene ring, drag it up and release. You have 
drawn aniline.

3. Click on  in the palette. Position the cursor over the nitrogen, 
drag it up and to the left and release.  is still selected. Again 
position the cursor over the nitrogen, drag it up and to the right 
and release.

4. Click on  in the palette to clean up your drawing and click on 
 to produce a 3D structure. The name N,N-dimethylaniline 

will appear at the bottom of the screen as the molecule is in the 
database.

5. Close N,N-dimethylaniline.

trans-Stilbene

1. Select New Sketch from the File menu ( ) to bring up the 
sketch pad. Click on  in the palette. Position the cursor on 
the screen, drag it to the right and release. Position the cursor 
on one end of the line (CC bond) that you have just drawn, drag 
it to the other end and release. You have drawn ethylene.
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2. Click on . Position the cursor over the left end of the double 
bond, drag it down and to the left and release. You have drawn 
styrene.

 
3.  is still selected. Position the cursor over the right end of the 

double bond, drag it up and to the right and release.

4. Click on  to clean up your drawing. Click on  to convert 
it to a 3D structure. The name trans-stilbene will appear at the 
bottom of the screen as the molecule is in the database.

5. Close trans-stilbene.

Indigo

N

N

O

H

H

O

7
7a6

5

4
3a 3

2 2'

1'

3a'

7a'

3' 4'
5'

6'

7'

1

1. Select New Sketch from the File menu ( ). Click on  and 
double click on screen. 

2.  is still selected. Position the cursor over C2 (see numbering 
in diagram above), drag it to the right and release. Your sketch 
should appear as below.

 

3. Select  from the palette. Position the cursor above C3, drag it 
away from the ring and release. Again position the cursor above 
C3, drag it along the CO bond to the oxygen and release. Repeat 
for C3'. You are left with a drawing.
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O

O

4. Select  from the palette and one after another double click 
on C1 and C1'.

 

N

N

O

H

H

O

5. Select  from the palette. Position the cursor above C2, drag 
it to C2' and release.

 

N

N

O

H

H

O

6. Select  from the palette and double click on the bond 
connecting C3a and C7a. Repeat for C3a' and C7a'.

7. Click on  to clean up your drawing and click on  to turn it 
into a 3D structure. The name indigo will appear at the bottom 
of the screen as the molecule is in the database.

8. Close indigo.

3-Cyano-4-methylcyclohexenyl Radical

3
2

6
5 4

1
CN•

1. Select New Sketch from the File menu ( ). Click on  in 
the palette and double click on screen. 

2. Click on  in the palette. Position the cursor over C4 (see 
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diagram above for numbering), drag it away from the ring and 
release. You have drawn methylcyclohexane.

3.  is still selected. Position the cursor over C1, drag to C2 and 
release. You have drawn 4-methylcyclohexene.

4. Double-click on the More icon that is located immediately below 
H and B in the palette, and then click on the Groups tab. Click on 
–CN in the upper right corner. CN now appears as the selected 
icon. Position the cursor over C3, and drag it away from the ring 
and release. You have drawn 3-cyano-4-methylcyclohexene.

5. One of these icons ( , , ) will appear in the palette directly 
below . If it is not , click on the icon until the icon is . 
Double click on C3. A “dot” (radical marker) will appear next to 
C3.

6. Click on  to clean up your drawing and click on  to make 
a 3D structure. The name will not appear at the bottom of the 
screen as this radical is not in the database.

7. Close 3-cyano-4-methylcyclohexenyl radical.

Androsterone
H3C

H

HH

H
HO

H3C

O
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1. Select New Sketch from the File menu ( ) to bring up the 
sketch pad. Click on  and double click on screen. Cyclohexane 
is still selected. Double click on the 5-10 bond (see diagram 
above).
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2. Cyclohexane is still selected. Double click on the 8-9 bond.

 
3. Click on  and double click on the 13-14 bond. You have now 

drawn the complete steroid skeleton.

4. Click on , position the cursor over C10, drag up and release. 
Repeat for C13.

5. Click on . Position the cursor over C3, drag down and to the 
left and release. Position the cursor over C17, drag up and to 
the right and release. Convert the single (CO) bond at C17 to a 
double bond. Double click on the C-OH bond to convert this to 
a carbonyl bond.

6. It is necessary to explicitly specify hydrogens at C5, C8, C9 and 
C14 in order to incorporate the necessary stereochemical cues (up 
and down “wedges”) in your drawing. Click on , position the 
cursor over C5, drag away from the ring and release. Repeat for 
C8, C9 and C14.

7*. Click on . Position the cursor over C10, drag along the bond 
to the methyl group that you drew in step 4 and release. Repeat 
for C13. Position the cursor over C8, drag along the CH bond 
that you drew in step 6 and release. Up wedges will appear for 
all three centers.

8*. Click on . Position the cursor over C3, drag along the CO 
bond that you made in step 5 and release. Position the cursor 
over C5, drag along the CH bond that you made in step 6 and 
release. Repeat for the CH bonds at C9 and C14. Down wedges 
will appear for all four centers.

9. Click on  to clean up your drawing. Click on . The name 
androsterone should appear at the bottom right of the screen as 

*	 Beginning in Spartan Student v.9, you can sketch with stereochemical markers. This 
removes the need to first create a bond and then modify its stereochemistry.
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the molecule is in the database. If it does not, you have made 
an error somewhere. Select Edit Sketch from the Build menu 
or click on  if it appears at the top of the screen to return to 
the sketch pad.

10. Androsterone incorporates seven chiral centers. To assign them 
as R or S, select R/S Chirality from the Model menu or click on 

 if it appears at the top of the screen. R/S labels will appear 
next to each of the chiral centers.

11. Close androsterone.



Tutorial 3	 53

Tutorial 3
Building Organic Molecules 

The tutorials in this section introduce and illustrate tools to build 3D 
molecular structures. These include atomic fragments, functional 
groups and rings contained in the organic model kit together with tools 
for making and breaking bonds, deleting atoms and refining structure.

Organic Model Kit

The organic model kit contains a selection of atomic fragments 
corresponding to elements commonly found in organic molecules. 

Different hybridization states are included for some elements (C, N, 
O, and S) from top to bottom.
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 C(sp3) N(sp3) P(sp3) H
 C(sp2) N(sp2) O(sp3) F
 C(sp) N(sp) O(sp2) Cl
 C(aromatic) N(aromatic) S(sp3) Br
 Si(sp3) N(planar) S(sp2) I

A fragment is chosen by clicking on its icon, which is then displayed 
in a box at the top of the model kit. Once selected, the fragment may 
be used to initiate building, to add alongside of an existing structure or 
appended onto an existing structure. To initiate building, double click 
anywhere on screen. To add alongside of an existing structure, double 
click in a blank area on screen. To bond to an existing structure, click 
on a free valence (not an atom). Free valences are colored yellow 
on the selected molecule. Bond type in the case of atomic fragments 
with multiple bond types, for example, sp2 carbon, depends on the 
nature of the free valence selected.

Clicking on the Groups button near the bottom of the model kit 
changes the focus from fragments to groups, one of which will be 
shown in the box at the top of the model kit and named directly 
underneath. Clicking on the name brings up a menu of available groups.

Once selected from the menu, a group may be used to initiate building, 
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to add alongside of an existing structure on screen, or to add to an 
existing structure. 

Clicking on the Rings button near the bottom of the model kit changes 
the focus to rings, one of which will be shown in the box at the top 
of the model kit and named immediately underneath. Clicking on the 
name brings up a menu of available rings.

Once selected from the menu, a ring may be used to initiate building, 
to add alongside of an existing structure on screen, or to add to an 
existing structure.

Note that only hydrocarbon rings* are available. Heteroatoms may be 
substituted for carbons, for example, substituting an oxygen for one 
of the carbons in cyclohexane leading to tetrahydropyran. Note also, 
that the amide and carboxylic acid/ester groups and the cyclohexane, 
cycloheptane, naphthalene, phenanthrene, indene and fluorene rings 
have more than one different free valence. The free valence that is 
to be used is marked with a gold • (in the icon shown in the box at 
the top of the model kit). The marked position circulates among the 
possible positions with repeated clicking on the icon. Selection of an 
axial or equatorial free valence in cyclohexane and cycloheptane is 
indicated by the label ax or eq appearing alongside the icon.

*	 Additional heterocycles are available from the  button, which accesses a library 
of additional molecules including nitrogen, oxygen, and sulfur heterocycles.
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Acrylonitrile

C C
H

H H

C
N

1. Click (left button) on the File menu and select (click on) New 
Build. Alternatively, click on  at the top of the screen. The 
organic model kit appears. Click on trigonal planar sp2 hybridized 
carbon  from the fragment library. A model of the fragment 
appears at the top of the model kit. Bring the cursor anywhere on 
screen and double click (left button). To maintain compatibility 
with the sketch builder (see next tutorial), a double click is used 
to add the first fragment. This can be changed to single click (as 
in previous versions of Spartan Student) from the Settings tab in 
the Preferences dialog (Preferences under the Options menu). 
Rotate the carbon fragment (drag the mouse while holding down 
the left button) so that you can clearly see the double free valence 
(=) and the two single free valences (–).

2.	 sp2 carbon is still selected. Click on the double free valence. The 
two fragments are connected by a double bond, leaving you with 
ethylene. The name ethylene will appear at the bottom right of 
the screen. If you make a mistake and click instead on the single 
free valence, select Undo from the Edit menu (or click on  at 
the top of the screen). You can also start over by selecting Clear 
from the Edit menu (or click on  from the Edit menu).

3.	 Click on the Groups button at the bottom of the model kit, click 
on the name of whatever group is shown in the text box at the 
top of the model kit, and select Cyano from the groups available 
from the menu. Click on any of the four single free valences 
on ethylene (they are equivalent). This bonds the cyano group 
to ethylene, leaving you with acrylonitrile. Its name will now 
appear at the bottom right of the screen.

4.	 Click on  at the bottom of the model kit. (You can also select 
Minimize from the Build menu or click on  if the icon appears 
at the top of the screen.) The molecular mechanics energy (36.2 
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kJ/mol) and symmetry point group (Cs) are provided at the 
bottom right of the screen.

5.	 Select View from the Build menu (or click on the  icon at the 
top of the screen). The model kit disappears, leaving only a ball-
and-spoke model of acrylonitrile on screen. As noted, the name 
appears at the bottom of the screen, indicating as acrylonitrile 
is in the database.

	
ball-and-spoke model

	 This model can be rotated, translated and zoomed by using the 
mouse in conjunction with keyboard functions. To rotate the 
model, drag the mouse while holding down the left button; to 
rotate in the plane of the screen also hold down the Shift key. 
To translate the model, drag the mouse with the right button 
depressed. To zoom the model (translation perpendicular to the 
screen), use the center mouse wheel (scroll wheel) if available, 
or hold down the Shift key in addition to the right button while 
dragging the mouse up (zoom in) or down (zoom out).* 

Rotate the molecule by moving one finger over the screen. 
Rotate in the plane of the screen by twisting two fingers. 

Translate by moving two fingers. Zoom by pinching two fingers.

6.	 Select Close from the File menu or click on  at the top of the 
screen.

*	 Described is standard 3-button (center wheel) mouse behavior, both Windows and 
Macintosh allow for user customization of mouse behavior.
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Cyclohexanone
O

1.	 Click on the File menu and select New Build from the palette or 
click on  at the top of the screen. Click on the Rings button 
near the bottom of the model kit, click on the name of whatever 
ring is shown in the selection bar and select Cyclohexane from 
the list of rings. Double click anywhere on screen.

2.	 Select sp2 carbon  from the model kit. Double click on 
any carbon (not a free valence). The sp3 hybridized carbon will 
be replaced by an sp2 hybridized carbon.

In the Organic Model Kit, fragment replacement is subject both to 
the usual valence rules and to the availability of free valences. For 
example, replacement of an sp3 carbon by an sp2 carbon requires 
that at least two free valences are available.

3.	 Select sp2 oxygen  from the model kit. Click on the double 
free valence on the sp2 carbon. You have made cyclohexanone. 
Click on  at the bottom of the model kit to produce a structure 
with Cs symmetry. Click on  to remove the model kit. The 
name cyclohexanone appears at the bottom of the screen as the 
molecule is in the database.

4.	 Close cyclohexanone.

Limonene

1

2 3 4

56

1.	 Select New Build from the File menu (or click on the  icon 
at the top of the screen) to bring up the organic model kit. Click 
on the Rings button near the bottom of the model kit, click on 
the name of whatever ring is shown and select Cyclohexane 
from the list of rings. Double click anywhere on screen.
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2.	 Click on the Groups button near the bottom of the model 
kit, click on the name of whatever group is shown and select 
Alkenyl. Click on the equatorial free valence on C4 (see figure 
above for numbering). You have made vinylcyclohexane.

3.	 Click on the Make Bond icon ( ) at the bottom of the model 
kit. One after another click on the axial free valence on C1 and 
then the axial free valence on C2. You have made 4-vinyl-1-
cyclohexene.

4.	 Select sp3 carbon  from the model kit and one after another 
click on the free valence on C1 and on the free valence of the 
vinylic carbon attached to the ring. You have made limonene. 
Click on  at the bottom of the model kit to give a refined 
geometry and finally click on ( ) to remove the model kit. 
The name will appear at the bottom of the screen as limonene 
is in the database.

5.	 Close limonene.

Nicotine

N

N

Me

1.	 Select New Build from the File menu ( ). Click on the Rings 
button in the model kit. Click on the name of whatever ring 
is shown in the window at the top of the model kit and select 
Benzene. Double click anywhere on screen.

2.	 Click on the name Benzene (the currently selected ring) in the 
model kit and select Cyclopentane from the list of rings. Click 
on one of the free valences on benzene on screen. You have 
made phenylcyclopentane (the name will appear at the bottom 
of the screen).

3.	 Click on sp2 nitrogen in the model kit ( ) and double 
click on the appropriate (meta) carbon (not a free valence) in 
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the benzene ring for the structure on screen. You have made 
3-cyclopentylpyridine.

4.	 Click on sp3 nitrogen in the model kit ( ) and double 
click on the appropriate carbon in the cyclopentyl ring for the 
structure on screen. You have made nornicotine. Note, if you 
have built the R enantiomer, Spartan will name this 3-[(2R)-
1-methylpyrrolidin-2-yl]pyridine. Click on  to access the 
Molecule Properties dialog, click on the Utilities tab. Finally, 
click on the Change Absolute Configuration button. The name 
(r,s)-nornicotine will appear at the bottom of the interface.

5.	 Click on sp3 carbon in the model kit ( ) and click on the 
free valence on the nitrogen in the pyrrolidine ring. Click on 

 at the bottom of the model kit to clean up your structure. 
The name nicotine will appear at the bottom of the screen as 
the molecule is in the database.

6.	 Click on the bond connecting the pyridine and pyrrolidine rings. 
A red arrow will encircle the bond and will also appear at the top 
of a narrow shaded band at the left of the screen. While holding 
down the left mouse button, move the cursor up or down inside 
this band to rotate about the bond.*

Move one finger up and down on the bond to rotate about the 
bond.

7.	 Select R/S Chirality from the Model menu ( ). The R/S 
chirality will be displayed. The S isomer is the naturally 
occurring isomer of nicotine.

8.	 Close nicotine.

*	 Bond rotation may also be accomplished by left clicking to select the bond, then holding 
down the Alt (Windows) or Option (Macintosh) key and with the left mouse button 
depressed, moving the mouse up or down.
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Tutorial 4
Spectra, Properties and 

Graphical Models of Organic 
Molecules from the Database

The tutorials in this and the section that follows will utilize the 
molecules that you built and sketched in the preceding two tutorials. 
The emphasis shifts from providing input, to analyzing the results 
of quantum chemical calculations (this tutorial) and to submitting 
calculations (the following tutorial).

The database supplied with Spartan Student provides atomic and 
molecular properties as well as IR and NMR spectra that have 
previously been calculated using the wB97X-D/6-31G* density 
functional model. The wave functions are available, allowing 
graphical models to be generated and displayed “on-the-fly”.

Limonene

1.	 Build limonene ( ), minimize ( ) and exit the builder ( ). 
Alternatively, sketch limonene ( ) and exit the sketcher ( ).

2.	 Click on the name limonene at the bottom of the screen and click 
on Replace in the dialog that results. Properties and spectra for 
limonene are now available.

3. Select Spectra from the Display menu, or click on  if it 
appears at the top of the screen. Click on  at the top of the 
spectra pane that results to show available calculated spectra (in 
red) and (possibly) available experimental spectra (in blue).
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 Select . The calculated 13C NMR spectrum appears in 

the spectra pane. Move the cursor horizontally over the spectrum. 
You will see that when you intersect a line, it will be highlighted 
in the spectrum and the value of the chemical shift indicated. 
Also, the carbon (or carbons) in the structure responsible for 
this line will be highlighted in the structure model (in the top 
part of the screen). You will see that there are ten lines in the 
calculated 13C spectrum, corresponding to the ten unique carbons 
in limonene.

4. Again, click on  at the top of the spectra pane, but this time, 
select . The experimental 13C spectrum of limonene 
will be superimposed on top of the calculated spectrum. Visual 
comparison will give you an idea of what you can expect from 
13C shift calculations. To get an even better idea, alter the 
range of the scale (initially from 150 to 0 ppm), by moving 
the cursor over the spectrum while holding down the right 
button. You can also change the scale (initially from 150 ppm), 
that is, zoom-in or zoom-out, using the scroll wheel on your 
mouse. You can return to the original setting by clicking on  

 in the bar at the top of the spectra pane.

Move one finger over the spectrum to select a line. Move 
two fingers over the spectrum to shift the range of the scale 

and pinch two fingers to zoom in and out.

5. Close limonene.
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Indigo
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1. Build indigo ( ), minimize ( ) and exit the builder ( ). 
Alternatively, sketch indigo ( ) and exit the sketcher ( ).

2.	 Click on the name indigo at the bottom of the screen and make 
sure wB97X-D/6-31G* is selected and click on Replace in the 
dialog that results. Properties and spectra for indigo are now 
available. If the name does not appear, then you have made an 
error. In this case, re-enter either the builder by selecting Edit 
Build from the Build menu ( ), or the sketch pad by selecting 
Edit Sketch from the Build menu ( ) and correct your model.

3.	 The calculated proton NMR spectrum of indigo can be displayed 
in two ways. The simpler “idealized” presentation assumes that 
three-bond HH coupling constants are zero. Select Spectra 
from the Display menu ( ) to bring up the spectra pane. Click 
on  in the bar at the top to show available calculated spectra 
(in red) and possibly available experimental spectra (in blue). 
Select  from the palette. The spectrum that results 
shows only lines corresponding to the four unique hydrogens. 
To see the more familiar (and more complex) proton spectrum, 
click again on , but this time select . The same four 
lines appear, but all are split (as in a real proton spectrum). The 
lines at ≈ 6.72 and 7.88 ppm are doublets due to C7 and C4, 
respectively (and split by C6 and C5, respectively). The lines 
centering at ≈ 6.9 and 7.48 are quartets (doublet of doublets), 
due to C5 and C6, respectively (and split by C4 and C6 and C5 
and C7, respectively).

4.	 The experimental proton NMR for indigo is not available from 
the on-line database. However, the experimental 13C spectrum is 
available. You can if you wish compare it to the corresponding 
calculated spectrum. Either is accessed by clicking on  at the 



64	 Tutorial 4

top of the spectra pane followed by selecting the appropriate 
entry from the resulting palette.

5.	 Close indigo.

trans-Stilbene

1. Build trans-stilbene ( ), minimize ( ) and exit the builder 
( ). Alternatively, sketch trans-stilbene ( ) and exit the 
sketcher ( ).

2. Click on the name trans-stilbene at the bottom of the screen, 
make sure wB97X-D/6-31G* is selected and then click on 
Replace in the dialog that results. Data are now available.

3. Select Spectra from the Display menu ( ). Click on  in 
the bar at the top of the spectra pane and select . The 
calculated IR spectrum of trans-stilbene appears in the spectra 
pane. You may find it valuable to increase the size of the spectrum. 
Position the cursor inside the bar at the top of the spectra pane 
and drag it up.

4. Move the cursor horizontally over the spectrum. You will see 
that as you intersect a line in the spectrum, it will turn green 
and the value of the frequency will appear at the bottom. In 
addition, the molecular model “vibrates” to reflect the motion 
that the molecule undergoes. Examine the motions of one or 
more of the lines of moderate intensity in the vicinity of 1500 
cm-1 (at 1446, 1494 and 1609 cm-1). You might find it useful to 
expand the scale (use the scroll wheel) or to shift it (move the 
mouse horizontally over the spectrum while holding down the 
right button). You can return to the original settings by clicking 
on ( ) in the bar at the top of the spectra pane.
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Move one finger over the spectrum to select a line. Move 
two fingers over the spectrum to shift the range of the scale 

and pinch two fingers to zoom in and out.

5. Click on  from the bar at the top of the spectra pane and 
select . The experimental IR spectrum of trans-stilbene 
obtained from the public NIST database will be superimposed 
onto the calculated spectrum. Note that the two spectra are similar 
although the experimental spectrum exhibits a number of (small) 
lines not found in the calculated spectrum.

6. Close trans-stilbene.

Nicotine

N

N

1. Build nicotine ( ), minimize ( ) and exit the builder ( ). 
Alternatively, sketch nicotine ( ) and exit the sketcher ( ).

2. Click on the name nicotine at the bottom of the screen, and 
click on Replace in the dialog that results. Your structure will 
be replaced by that in the database making the wave function 
available.

3. Select Surfaces from either the Setup or Display menu or click 
on ( ) if it appears at the top of the screen. Click on Add 
(at the bottom of the Surfaces dialog that results) and select 
electrostatic potential map from the menu. This requests an 
electrostatic potential map (an electron density surface onto 
which the value of the electrostatic potential is mapped). A line 
electrostatic potential map appears at the top of the dialog.

 The graphics calculation will run automatically following your 
request. When it completes in a few seconds, check the box to 
the left of electrostatic potential map in the Surfaces dialog. 
The surface itself corresponds to the electron density, and 



66	 Tutorial 4

provides a measure of the overall size and shape of nicotine. 
The colors indicate values of the electrostatic potential on 
this surface. By convention, colors toward red correspond to 
negative potential (stabilizing interaction between the molecule 
and a positive charge), while colors toward blue correspond 
to positive potential. The two nitrogen atoms show the largest 
negative potential (orange to red). Which is the more negative, 
the nitrogen in the pyridine ring or that in the pyrrolidine ring?

4. Quantify your observation. Select Properties from the Display 
menu or click on ( ) if it appears at the top of the screen and 
click anywhere on the electrostatic potential map. This will bring 
up the Surface Properties dialog.

 
 Check the box to the left of Legend to display the property range 

on screen. (Uncheck the box to remove the legend.) To translate 
the legend, click on the legend to select, then hold down the 
right mouse button and move the mouse. The legend is useful 
when making qualitative comparisons of property values. Turn 
the map such that you can clearly see the pyridine nitrogen and 
click on the area that is “most red”. An arrow marks the point on 
the surface and the value of the potential is shown to the right 
of the legend. Do the same for the pyrrolidine nitrogen.
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Tap on the legend to select. Move two fingers to move it 
around the screen. Pinch two fingers to make the legend 

smaller or larger.

5. Nicotine is relatively small and it is easy to associate regions 
on the map with the underlying molecular skeleton. This 
becomes more difficult with increasing molecular size. Change 
the presentation, from the Style menu located both inside the 
Surface Properties dialog and at the bottom right of the screen. 
Select Transparent or Mesh from this menu. You now can see 
through the map to the underlying molecular structure.

6. Close nicotine and any open dialogs.

N,N-Dimethylaniline

N

1. Build N,N-dimethylaniline ( ), minimize ( ) and exit the 
builder ( ). Alternatively, sketch N,N-dimethylaniline ( ) 
and exit the sketcher ( ).

2. Click on N,N-dimethylaniline at the bottom of the screen and 
click on Replace in the dialog that results. Your structure will 
be replaced by that in the database.

3. Select Surfaces from either the Setup or Display menu ( ). 
Click on Add at the bottom of the Surfaces dialog that results 
and select local ionization potential map from the menu. 
This requests a map showing the energy required to remove an 
electron (the ionization potential) as a function of its location on 
the electron density surface. Calculation is automatic and will 
only take a few seconds. When completed, check the box to the 
left of local ionization potential map in the Surfaces dialog. 
Select Properties from the Display menu or click on ( ). 
Click on the local ionization potential map surface. Click on the 
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Reset M/M button. This puts the property range on an absolute 
scale which is useful when examining individual molecules. The 
color convention is the same as for the electrostatic potential 
map, although the scale is completely different. Local ionization 
potentials are always positive. Colors toward red correspond 
to small ionization potentials (greatest electrophilic reactivity, 
easiest atoms to remove an electron from) and colors toward 
blue correspond to large ionization potentials. Note that the red 
regions on the map are over the ortho and para ring positions. 
This is exactly what is experimentally observed.

4. Close N,N-dimethylaniline and any open dialogs.

Androsterone

H3C

H

HH

H
HO

H3C

O

1. Build androsterone ( ), minimize ( ) and exit the builder  
( ). It is much easier to sketch the molecule ( ) and exit the 
sketcher ( ).

2. Click on the name androsterone at the bottom right of the screen 
and click on Replace in the dialog that results. Your structure will 
be replaced by that in the database. If the (correct) name is not 
provided, then you have made a mistake. In this case, re-enter 
the builder by selecting Edit Sketch from the Build menu ( ).

3. Select Orbital Energies from the Display menu or click on  
 if it appears at the top of the screen. An orbital energy diagram 

will appear at the left of the screen. To examine the molecular 
orbital corresponding to a line in the diagram, click on the line. You 
will see that the LUMO is a π* orbital localized on the carbonyl 
group. It is clearly more concentrated on  carbon than on oxygen, 
but you cannot easily tell which side of the steroid skeleton 
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(toward or away from the two methyl groups) it is concentrated. 
For this, a LUMO map is a much better graphical model.

4. Select Surfaces from the Display menu ( ). Click on Add and 
select |LUMO| map from the menu. The graphics calculation 
will run automatically and will only require a few seconds. When 
completed, check the box to the left of |LUMO| map inside the 
Surfaces dialog. The largest (absolute) values of the LUMO 
are colored blue. Note that by visualizing the |LUMO| map 
and rotating the molecule, you can easily see that the LUMO is 
more concentrated on the face away from the methyl groups.

5. Close androsterone and any open dialogs.
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Tutorial 5
Spectra, Properties and 

Graphical Models of Organic 
Molecules from Quantum 

Chemical Calculations
The tutorials in this section provide the earliest, and some of the 
simplest examples, of specifying and performing quantum chemical 
calculations. As in the previous tutorial, they refer back to Tutorials 
2 and 3. 

2 min

Acrylonitrile

C C
H

H H

C
N

1. Build acrylonitrile ( ), minimize ( ) and exit the builder 
( ). Alternatively, sketch acrylonitrile ( ) and exit the 
sketcher ( ).

2. Select Calculations... from the Setup menu or click on  and 
perform the following operations in the Calculations dialog 
which appears.



Tutorial 5	 71

 

a. Select Equilibrium Geometry from the leftmost menu to the 
right of Calculate. This specifies optimization of equilibrium 
geometry.

b. Select wB97X-D and 6-31G* from the middle and rightmost 
menus to the right of Calculate. This requests that the 
wB97X-D/6-31G* density functional model is to be used 
for this calculation (the same model as that in the database).

c. Click on Submit at the bottom of the dialog. A file browser 
appears.

 
 Because the model is in the database (even though we will not use 

the data), the name acrylonitrile will be presented to you in the 
box to the right of File name:. Either use it or type in whatever 
name you like and then click on Save. You will be notified that 
the calculation has been submitted.
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 The message will close automatically (after ≈5 seconds); you 

can also click on OK to remove the message from the screen.

After a molecule has been submitted, and until the calculation has 
completed, you are not permitted to modify any dialogs or other 
information associated with it.

3. You will be notified when the calculation has completed (less 
than a minute).

 
	 Click on OK to remove the message from the screen. Select 

Output from the Display menu or click on  if it appears at 
the top of the screen. A window containing a summary of the 
calculation appears.

	
	 Depending on calculation details, a number of data tables are 

available (explore by clicking on the  indicator to the left of 
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the title). Additional data is accessed by clicking on the Output 
tab. You can scan this by using the scroll bar at the right of 
the window or by clicking (left button) on or inside the output 
window and using the scroll wheel on your mouse. Additional 
information includes the task, basis set, number of electrons, 
number of unpaired electrons and the charge, as well as further 
details of the calculation including the number of threads used 
during the calculation. Below this is the symmetry point group 
of the molecule that was maintained during the optimization.

	 The lines under the heading Optimization tell the history of the 
optimization. If the geometry was not optimized satisfactorily 
an error message, such as: Optimization has exceeded N steps 
– Stop, will be displayed following the last optimization step 
and you would be notified that the job had failed.

	 Near the end of the output is the final total energy (≈ -170.764625 
atomic units for acrylonitrile with the wB97X-D/6-31G* 
model), and the computation time. Click on  at the top of the 
output dialog to close it.

	 You may examine the total energy and dipole moment among 
other calculated properties without having to go through the 
output. Select Properties from the Display menu to bring up 
the Molecule Properties dialog.
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	 To see the dipole moment vector (indicating the sign and 
direction of the dipole moment), check the box to the right of 
Display Dipole Vector. Wire, ball-and-wire or tube models are 
best for this display.

	
	 Uncheck the box to remove the dipole moment vector.

	 Click on an atom. The (Molecule Properties) dialog will be 
replaced by the Atom Properties dialog.

	
	 Among other things, this provides atomic charges based on the 

electrostatic potential. To obtain the charge on another atom, 
simply click on it. Inspect all the atomic charges on acrylonitrile 
(by clicking on the appropriate atoms). When you are finished, 
click on  at the top of the Atom Properties dialog to close it.

4.	 Select Surfaces from either the Setup or Display menu ( ). 
Click on Add at the bottom of the Surfaces dialog that results, 
and select electrostatic potential map from the menu. This 
requests an electrostatic potential map (an electron density 
surface onto which the value of the electrostatic potential is 
mapped). The graphics calculation will run automatically 
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(without needing to resubmit the job) following your request. 
When it completes in a few seconds, check the box to the left of 
electrostatic potential map in the Surfaces dialog. The surface 
itself corresponds to the electron density and provides a measure 
of the overall size and shape of acrylonitrile. The colors indicate 
values of the electrostatic potential on this surface; by convention, 
colors toward red correspond to negative potential (stabilizing 
interaction between the molecule and a positive charge), while 
colors toward blue correspond to positive potential. The nitrogen 
(the most electronegative atom) is red and the hydrogens (the 
most electropositive atoms) are blue.

5.	 Close acrylonitrile and any open dialogs.

2 min

Cyclohexanone
O

1. Build cyclohexanone ( ), minimize ( ) and exit the builder 
( ). Alternatively, sketch cyclohexanone ( ) and exit the 
sketcher ( ).

2. Select Calculations... from the Setup menu or click on . 
Specify Equilibrium Geometry, wB97X-D and 6-31G* from 
the three menus to the right of Calculate. Click on Submit 
and accept the name cyclohexanone. Wait until the calculation 
completes (2-3 minutes) before proceeding to the next step.

3.	 Cyclohexanone undergoes nucleophilic attack at the carbonyl 
carbon, and it is reasonable to expect that the molecule’s lowest-
unoccupied molecular orbital (the LUMO) will be localized 
here. To visualize the LUMO, bring up the Surfaces dialog 
(Surfaces from the Setup or Display menu or click on ). 
Click on Add and select LUMO from the menu. Also request 
an electron density surface onto which the (absolute) value of 
the LUMO has been mapped in color (a so-called LUMO map). 
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Click on Add and select |LUMO| map from the menu. The two 
graphics calculations will run automatically and will require 
only a few seconds.

4.	 Check the box to the left of LUMO in the Surfaces dialog. 
You will see that the resulting graphic is a π* orbital primarily 
localized on the carbonyl group, consistent with the fact that 
nucleophiles (electron pairs) add to the carbonyl carbon. See if 
you can tell on which face of the carbonyl carbon is the LUMO 
more concentrated.

5.	 Uncheck the box to the left of LUMO in the Surfaces dialog (to 
turn off the display of the LUMO, it operates in toggle mode). 
Then check the box to the left of |LUMO| map to display the 
electron density surface onto which the (absolute) value of 
the LUMO has been mapped. By convention, colors toward 
red indicate small (absolute) values of the LUMO (near zero), 
while colors toward blue indicate large (absolute) values of the 
LUMO. We are looking for a “blue spot”. Note that it is directly 
over the carbonyl carbon. This corresponds to the maximum 
value of the LUMO and is where nucleophilic attack will occur.

6.	 You will see that the blue spot over the axial face of the carbonyl 
carbon is “more blue” than that over the equatorial face. This 
indicates preferential attack by nucleophiles onto the axial face. 
Quantify the difference by measuring the (absolute) value of the 
LUMO on these two faces. Select Properties from the Display 
menu or click on  and click anywhere on the graphic to bring 
up the Surface Properties dialog.
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	 Check the box to the left of Legend to display the property range 
on screen. (Remove the checkmark to remove the legend.) To 
translate the legend, click on the legend to select, then hold 
down the right mouse button and move the mouse. The legend 
is useful when making qualitative comparisons of property 
values. Turn the map such that you can clearly see the axial 
face of the carbonyl carbon, and click on the area of maximum 
blue. The (absolute) value of the LUMO at the surface point 
you have selected is provided in the dialog to the right of Val. 
Note the value, and then turn the map over such that you can 
now see the equatorial face of the carbonyl carbon, and click 
on the region of maximum blue on this face. Do these values 
support your qualitative conclusions from viewing the image?

7.	 Close cyclohexanone and any open dialogs.
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8 mins

3-Cyano-4-methylcyclohexenyl Radical
CH3

CN•

1.	 Build 3-cyano-4-methylcyclohexenyl radical ( ), minimize  
( ) and exit the builder ( ). Alternatively, sketch the radical 
( ) and exit the sketcher ( ).

2. Select Calculations... from the Setup menu ( ). Specify 
Equilibrium Geometry, Density Functional-Fock, wB97X-D,  
and 6-31G* from the menus to the right of Calculate. This 
molecule has one unpaired electron. If you sketched it (which 
requires that you explicitly specify the radical center) the number 
of unpaired electrons will be correct. However, if you built the 
molecule, you will need to change Unpaired Electrons from 0 
to 1. Click on Submit at the bottom of the Calculations dialog. 
Name it 3-cyano-4-methylcyclohexenyl radical. (A name will 
not be provided as the radical is not in the database.) Wait for 
the calculations to complete before proceeding.

3.	 Select Surfaces from the Setup or Display menu or click on 
. Click on Add and select spin density from the menu. Click 

on Add and select spin density map from the menu. You have 
requested two different representations of spin distribution. The 
first presents spin density as a surface of constant value, while 
the second uses color to map the value of the spin density onto 
an electron density surface. Finally, request the singly-occupied 
molecular orbital. Click on Add one more time and select 
aHOMO (the highest-occupied molecular orbital of a spin that 
is, the orbital that contains the unpaired electron) from the menu.

4.	 The three graphics you requested will run automatically and 
will require only a few seconds to complete. When they are 
done, check the box to the left of spin density in the Surfaces 
dialog to display the spin density surface. Note that the spin 
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density is delocalized over two of the ring carbons and onto the 
cyano group.

	
5.	 Remove the spin density surface (uncheck the box to the left 

of spin density in the Surfaces dialog) and then check the box 
to the left of spin density map to display a surface on which 
the spin density is mapped onto the electron density. Note that 
the areas of maximum spin (colored blue) closely match those 
where the surface is large in the previous image.

6.	 Remove the spin density map (uncheck the box to the left of 
spin density map), and then check the box to the left of aHOMO 
(the molecular orbital which holds the unpaired electron). Aside 
from the colors (different signs of the orbital), note that this 
graphic is nearly identical to the previously-displayed image of 
the spin.

7.	 Uncheck the box to the left of aHOMO. Click on More 
Surfaces... at the bottom of the (Surfaces) dialog, and select 
Slice from the Surface menu and spin density from the 
Property menu. Click on OK. A new line Slice, spin appears 
in the window at the top of the dialog.* Select it by checking 
the box at the left. A plane (a slice of spin density) surrounded 
by a frame appears in the middle of the model on screen. Click 
inside the frame to select. The frame will turn gold. Position 
the cursor outside the frame, then press both the Shift key and 
right button and move the mouse up and down (or use the scroll 
wheel). This will zoom the plane. You can also translate and 
rotate the plane independently of the molecule using the usual 

*	 You can change the display style from Contours to Solid or Transparent using the Style 
menu at the bottom right of the screen. This will appear only when the slice is selected.
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mouse operations. Alternatively, you can move the molecule and 
plane together by first clicking on the molecule (the frame will 
now turn white) and then using the mouse. For all operations, 
be certain to keep the cursor positioned outside of the frame. 
Size and orient the slice as you wish.

	

Tap on the graphic to select the graphic and on the frame to 
select the frame. Use one finger to rotate and two fingers to 

translate the graphic or frame. Pinch two fingers to zoom the graphic 
or frame.

8.	 Remove 3-cyano-4-methylcyclohexenyl radical and any open 
dialogs.
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Tutorial 6
Groups of Organic Molecules

The tutorials in this section introduce and illustrate a number of 
basic operations involved in processing groups of molecules, as well 
as the associated spreadsheet for organizing and fitting data and 
facilities for making plots.

Computational investigations typically involve series of related 
molecules. Here, it may be of interest to compare geometries, energies 
or other calculated properties, or to compare trends in calculated 
and measured properties. Spartan Student allows molecules to be 
grouped into a single document, either manually, or automatically 
as a result of following a particular vibrational motion, or from a 
scan of a dihedral angle. Once grouped, molecules may be aligned. 
Calculations may be performed either on individual molecules or on 
the complete group of molecules, and the results may be analyzed 
individually or altogether to seek out trends.

Associated with a multi-molecule document is a spreadsheet. This 
allows convenient access to virtually any calculated quantity that can 
be given a value. Additionally, data may be entered manually into 
the spreadsheet or pasted from other applications such as Excel. Data 
in the spreadsheet may be manipulated, linear regression analyses 
performed and plots displayed. Alternately, the data in a Spartan 
Student spreadsheet may be pasted into Excel (or other applications) 
for further analysis.

The tutorials in this section introduce and illustrate a number of 
basic group operations available in Spartan Student, building and 
manipulating multi-molecule documents, and fitting an experimental 
observable to one or more calculated properties by way of linear 
regression. The use of the Reactions dialog is illustrated. None of 
the examples in this tutorial actually require performing quantum 
chemical calculation as all molecules involved are available from 
the included database.
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Dienophiles in Diels-Alder Cycloadditions

The most common Diels-Alder reactions involve electron-rich dienes 
and electron-deficient dienophiles.

X

Y

X = R, OR

Y = CN, CHO, CO2H
X

Y

+

The rate of these reactions generally increases with increasing  
π-donor ability of the diene substituent, and with increasing  
π−acceptor ability of the dienophile substituent. This can be 
rationalized by noting that donor groups raise the energy of the 
highest-occupied molecular orbital (the HOMO) on the diene, while 
acceptor groups lower the energy of the lowest-unoccupied molecular 
orbital (the LUMO) on the dienophile. Thus, the HOMO-LUMO gap 
is reduced, leading to enhanced stabilization.

HOMO

LUMO

Orbital 
Energy

diene dienophile

better acceptor groups

better donor groups

The objective of this tutorial is to correlate experimental relative 
rates of Diels-Alder cycloadditions involving cyclopentadiene and a 
variety of cyanoethylenes with dienophile LUMO energies.

1.	 Build ( ) and minimize ( ) acrylonitrile, H2C=C(H)CN. 
Select View from the Build menu ( ). Copy the structure to 
the clipboard. Either right click on the background and choose 
Copy from the resulting contextual menu, or select Copy from 
the Edit menu ( ).

2.	 Select Build New Molecule (not New Build) from the File 
menu ( ). This specifies that a new molecule is appended 
to the end of the current document. The screen will be 
cleared. Click on Clipboard at the bottom of the model 
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kit and double click on screen. Acrylonitrile will appear. 
Click on Groups in the model kit, select Cyano and add 
to the appropriate free valence on acrylonitrile to make  
1,1-dicyanoethylene. Click on .

3.	 Repeat this procedure (Build New Molecule, followed by 
Clipboard, followed by Groups, followed by ) four more 
times to build cis and trans-1,2-dicyanoethylene, tricyanoethylene 
and tetracyanoethylene. When you are all done (six molecules in 
total in a single document), click on  to remove the model kit.

4.	 Click on the name of whatever molecule from the document 
appears at the bottom of the screen make sure that wB97X-D/ 
6-31G* is selected and click on Replace in the dialog that results, 
and then click on All. Your structures will be replaced by those 
from the database (all six are available).

5.	 Select Spreadsheet from the Display menu ( ).

	
	 You can move among the six molecules either by clicking inside 

the “Label” cells at the far left of the spreadsheet, or by using 
the  and  (step) keys at the bottom left of the screen.

6.	 Enter experimental relative rates into the spreadsheet.	
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 dienophile log10 (relative rate)	
 acrylonitrile 0	
 1,1-dicyanoethylene 4.64
 cis-1,2-dicyanoethylene 1.94
 trans-1,2-dicyanoethylene 1.89	
 tricyanoethylene 5.66
 tetracyanoethylene 7.61
 Experimental data from: J. Sauer, H. Weist and A. Mielert, Chem. Ber., 97, 3183 (1964).

	 Double click inside the header cell for a blank column in the 
spreadsheet, type Log(rate)= and press the Enter key (return 
key on Mac). You need to press the Enter key (return key on 
Mac) following each entry (or use the  key). Sort by relative 
rate. Click on the column header Log(rate), and then click on 
Sort at the bottom of the spreadsheet.

7.	 Click inside a header cell for a blank column and click on Add... 
at the bottom of the spreadsheet. Alternatively, right click inside 
the header cell for a blank column in the spreadsheet, and select 
Add... from the contextual menu that results. Select E LUMO 
(eV) from the list in the dialog that results.

	
	 The spreadsheet, which now contains both the calculated LUMO 

energies and experimental relative rates, has served its purpose. 
Remove it from the screen by clicking on  at the top.
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8.	 Select Plots... from the Display menu or click on  if it appears 
at the top of the screen. This leads to an empty plot pane at the 
right of the screen. Click on  in the bar at the top of the pane.

	 Select Log(rate) from the list of items in the X Axis menu and 
E LUMO(eV) from the Y Axes list, and click on Create.

	
	 Click on the Edit icon ( ), and then click to choose Least 

Squares Fit. Click Done when finished. A least-squares line 
will be drawn through the six data points.

9.	 Close the document and any open dialogs.
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Addition vs. Substitution

Alkenes normally undergo addition reactions whereas aromatic 
compounds normally undergo substitution reactions. For example, 
bromine reacts with cyclohexane to give trans-1,2-dibromocyclohexane 
(the addition product) not 1-bromocyclohexene, whereas it reacts with 
benzene to give bromobenzene (the substitution product) not trans-
5,6-dibromo-1,3-cyclohexadiene.

The objective of this tutorial is to establish the preferred product for 
each reaction.

1.	 One after another, build or sketch cyclohexene, trans-1,2-
dibromocyclohexane, 1-bromocyclohexene, benzene, trans-
5,6-dibromo-1,3-cyclohexadiene, bromobenzene, bromine 
(Br2) and hydrogen bromide (eight molecules in total). Put 
all in the same document. Use New Build ( ) or New 
Sketch ( ) for the first molecule and Build New Molecule  
( ) or Sketch New Molecule ( ) for each successive molecule.

2.	 Click on the name of whatever molecule from the document 
appears at the bottom of the screen, confirm wB97X-D/6-31G* 
is selected and click on Replace in the dialog that results and 
then click on All. Your structures will be replaced by those from 
the database (all eight are available).

3.	 Select Reactions from the Display menu or click on  if it 
appears at the top of the screen.
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	 Compute the energy for Br2 addition to cyclohexene: select 
bromine and cyclohexene as Reactants and trans-1,2-
dibromocyclohexane (and <none>) as Products. Note the 
reaction energy. Repeat for the corresponding substitution 
energy (same reactants but the products are 1-bromocyclohexene 
and hydrogen bromide) and for both addition and substitution 
reactions of benzene (reactants are benzene and bromine and 
products are trans-5,6-dibromomo-1-3-cyclohexadiene and 
<none> for addition and bromobenzene and hydrogen bromide 
for substitution).

	 Are all reactions thermodynamically favorable (exothermic)? If 
any of the reactions are not exothermic, provide a rationale as 
to why they are not. Why is there a change in preferred reaction 
in moving from the alkene to the arene?

4.	 Close the document and any open dialogs.	
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Acidities of Carboxylic Acids

Acid strength is among the most important molecular properties. 
It is readily available from calculation, either in terms of absolute 
deprotonation energy,

AH A–  +  H+

or, more commonly, as the deprotonation energy relative to that of a 
standard acid (A°H).

AH  +  A°– A–  +  A°H

Electrostatic potential maps may offer an alternative to energy 
calculations for the description of relative acidities. In particular, 
the value of the electrostatic potential in the vicinity of the acidic 
hydrogen in the neutral acid might be expected to reveal gross trends 
in acidity. For example, the acidic hydrogen in a strong acid, such as 
nitric acid, is more positive than that in a weak acid, such as acetic 
acid, which in turn is more positive than that in a very weak acid, 
such as ethanol.

 nitric acid acetic acid ethanol

The objective of this tutorial is to use electrostatic potential maps 
to quantify changes in acid strength due to subtle variations in 
structure.

1.	 One after the other, build or sketch trichloroacetic, dichloroacetic, 
chloroacetic, formic, benzoic, acetic and pivalic acids. Put all 
molecules into the same document. Use New Build ( ) or New 
Sketch ( ) both from the File menu for the first molecule and 
use Build New Molecule ( ) or Sketch New Molecule ( ) 
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both from the File menu for each successive molecule. Click on 
 when you are done.

2.	 All of the molecules that you have built are available in the 
database. Click on the name of whichever molecule is selected at 
the bottom of the screen, click on Replace in the dialog that results 
and finally on All. The wave function is also provided as part of the 
database entry allowing electrostatic potential maps to be made.

3.	 Select Spreadsheet from the Display menu or click on . 
Expand it so that you can see all seven molecules, and that two 
data columns are available. Double click inside the header cell 
of the next available data column, type pKa and press the Enter 
key (return key on Mac). Enter the experimental pKa’s (given 
on the next page) into the appropriate cells under this column. 
You need to press the Enter (return) key following each entry. 
Alternatively, use the  key to move to the next cell.

	 acid pKa

	 trichloroacetic (Cl3CCO2H) 0.7
	 dichloroacetic (Cl2CHCO2H) 1.48
	 chloroacetic (ClCH2CO2H) 2.85
	 formic (HCO2H) 3.75
	 benzoic (C6H5CO2H) 4.19	
	 acetic (CH3CO2H) 4.75
	 pivalic ((CH3)3CCO2H) 5.03	

 Experimental data from: E.P. Sargeant and B. Dempsey, Ionization Constants of Organic 
Acids in Aqueous Solution, IUPAC no. 23, Permagon Press, 1979.

4.	 Arrange the seven molecules on screen such that you can clearly 
see the acidic hydrogen on each. To display all molecules at once, 
check the box to the left of the molecule name (Label column) 
in the spreadsheet for each entry. To manipulate the molecules 
independently of one another, click to deselect Coupled from the 
Model menu or click on  if it appears at the top of the screen.

5.	 Select Surfaces from either the Setup or Display menus or click 
on  and then select electrostatic potential map. When the 
electrostatic potential map calculations complete (they will be 
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marked “completed”), check the box at the left of electrostatic 
potential map in the Surfaces dialog. Select Properties from 
the Display menu or click on  and click on the electrostatic 
potential map to display the Surface Properties dialog. Click 
on  to the left of Max inside the Surface Properties dialog. 
The maximum value of the electrostatic potential (corresponding 
to the acidic proton) will be pasted to the spreadsheet. Leave the 
dialog on screen.

6.	 Plot experimental pKa vs. maximum in the electrostatic potential. 
Select Plots from the Display menu or click on  and then 
select pKa under the X Axis menu and Property Max (Surface) 
from the Y Axes list. Click on Create. Click on Edit ( ). 
Choose Least Squares Fit and click on Done. Does there appear 
to be a correlation between pKa and the maximum value of the 
electrostatic potential?

7.	 Close the document and any remaining dialogs from the screen. 
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Tutorial 7
Spectra of Organic Molecules

This collection illustrates applications involving the calculation of 
IR, proton and 13C NMR spectra, and UV/vis spectra.

In addition to equilibrium geometries, reaction energies and diverse 
molecular properties, calculations are able to account for molecular 
spectra. The infrared spectrum arises from the transitions between 
ground and excited vibrational states, while the NMR spectrum arises 
from transitions between nuclear spin states. While experimental 
spectra are used to provide clues to the structure of an unknown 
molecule, that is, features in the spectrum are taken as evidence for 
features in the molecular structure, a calculated spectrum starts with a 
known structure. A high degree of similarity with a measured spectrum 
may be taken as evidence that the calculated molecule is the same or 
at least very similar to that for which a spectrum was measured. Lack 
of similarity suggests that the two molecules are not the same.

The first tutorial in this section deals with the infrared spectrum of 
methyl formate. It details the steps needed to calculate a spectrum 
and to relate the spectrum to the underlying molecular structure. 
The next three tutorials deal with NMR spectroscopy: detailing the 
steps involved in calculating and displaying the proton spectrum for 
1-methylindole and the 13C spectrum of cytisine, and examining the 
dependence of carbon chemical shifts on stereochemistry. The final 
tutorial presents the new procedure for calculating and plotting a 
UV/visible spectra, specifically the organic dye indigo is utilized to 
demonstrate both steps and performance of the underlying approach.



	 Tutorial 7

6 mins

Infrared Spectrum of Methyl Formate

In the harmonic approximation, the frequency at which a diatomic 
molecule vibrates is proportional to the square root of the ratio of 
the force constant (the second derivative of the energy with respect 
to change in bond length) and the reduced mass (the product of the 
masses of the two atoms divided by their sum). Frequency increases 
with increasing force constant or stiffness of the bond and decreases 
with increasing masses of the atoms involved in the bond.

frequency α force constant
reduced mass

The same expression applies for each of the 3N-6 vibrations of 
a polyatomic molecule with N atoms. Cartesian (or internal) 
coordinates need to be transformed to normal coordinates, a system 
that leads to a diagonal matrix of second energy derivatives. For a 
polyatomic molecule, these will typically involve the motions of 
several (and perhaps all) of the atoms.

The intensity of absorption for a diatomic molecule is proportional 
to the change in the dipole moment with change in bond length. The 
fact that there is no change in the dipole moment of a homonuclear 
diatomic molecule with change in bond length, means that molecules 
such as N2 and O2, which make up the bulk of the earth’s atmosphere,  
are transparent in the infrared. The intensity of each of the individual 
lines in an infrared spectrum of a polyatomic molecule follows 
from the change in dipole moment along the associated normal 
coordinate. Note that some of the normal coordinates in a polyatomic 
molecule may not lead to a change in dipole moment, for example, 
the symmetric stretch in carbon dioxide where both CO bonds are 
simultaneously moved. 

This tutorial illustrates the steps required to calculate and display an 
infrared spectrum and to compare it with an experimental spectrum. 
It illustrates how the ease or difficulty of molecular motion and 
atomic masses impact frequency.
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1.	 Build methyl formate and click on . Select Calculations... 
from the Setup menu ( ), and request an equilibrium geometry 
using the EDF2/6-31G* density functional model. Check IR and 
click on Submit.

2.	 After the calculation has completed (several minutes), select 
Spectra from the Display menu ( ). Click on the  in the 
bar at the top of the spectra pane and select  from the 
palette of icons. Click on the  again and select  from 
the icon palette. Calculated (in red) and experimental (in blue) 
infrared spectra are now superimposed.

	
3.	 Move the mouse while holding down the right button to shift the 

cursor across the spectrum. Position it over the intense line in 
the (calculated) spectrum at 1817 cm-1. Note that the molecular 
model (on screen above the spectra pane) vibrates. Describe the 
motion. Position it over the intense line at 1211 cm-1 and describe 
its motion.

4.	 Select Save As from the File menu ( ) to make a copy of 
methyl formate; name it methyl formate d3. Select Properties 
from the Display menu or click on  and click on one of the 
three hydrogen atoms on the methyl group to bring up the Atom 
Properties dialog. Change Mass Number from Standard to 2 
Deuterium. Repeat for the other two methyl group hydrogen 
atoms. Resubmit the calculation (it will require only a few 
seconds) by selecting Submit ( ) from the Setup menu. 
Compare the frequencies of the undeuterated and deuterated 
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forms of methyl formate, and identify which change the most 
and which change the least. Explain your results.

5.	 Close all molecules and dialogs that are open on screen.

 6 mins

Proton NMR Spectrum of 1-Methylindole

Proton NMR spectroscopy was the first tool available to chemists that 
allowed definitive assignment of the molecular structures of complex 
organic molecules. By the 1970’s, it had largely replaced infrared 
spectroscopy and to a large extent chemical proofs of structure. 13C 
NMR is now more dominant, but proton NMR remains an essential 
tool in the chemist’s arsenal.

NMR is based on the fact that nuclei possess spins that can either 
align parallel or antiparallel to an applied magnetic field, giving rise 
to different nuclear spin states. The Δ Energy of these states (ΔE) 
depends on the nucleus and on the strength of the applied magnetic 
field, by way of a simple relationship.

∆E = γℏB0

γ is the gyromagnetic ratio (a constant for a given type of nucleus), 
ℏ is Planck’s constant divided by 2π and B0 is the strength of the 
magnetic field at the nucleus. While the two nuclear spin states are 
normally in equilibrium, this equilibrium can be upset by applying a 
second magnetic field. The absorption of energy as a function of field 
strength (a resonance) between the states can then be detected. 
The key to the utility of the magnetic resonance experiment is that 
the energy at which a nucleus resonates depends on its location in the 
molecule, and is different for each (chemically) distinct nucleus. The 
reason  is that the applied magnetic field is weakened by electrons 
around the nucleus. Nuclei that are well shielded by the electron 
cloud will feel a lesser magnetic field than those that are poorly 
shielded, and will show a smaller energy splitting. The difference, 
given relative to a standard, is termed a chemical shift. By convention, 
both proton and 13C chemical shifts (treated later in this tutorial) 
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are reported relative to tetramethylsilane (TMS) as a standard.

While each unique proton in a molecule gives rise to a single line 
(resonance) in the spectrum, the spins on nearby nuclei add and 
subtract to the external magnetic field. This leads to a splitting of 
lines, the splitting pattern depending on the number of neighboring 
protons and their geometry. Discounting splitting, the intensity of 
the lines is approximately proportional to the number of equivalent 
protons that contribute. For example, the proton NMR spectrum of 
1-methylindole would be expected to show seven lines, six with unit 
intensity corresponding to the protons on the indole ring and one line 
with three times the intensity corresponding to the three equivalent 
methyl group protons.

The objective of this tutorial is to calculate the proton NMR spectrum 
of 1-methylindole and compare it with the experimental proton 
spectrum in the absence of three-bond HH coupling. 

1.	 Build or sketch 1-methylindole. If you build, click on  and 
then on . If you sketch, click on . Select Calculations... 
from the Setup menu or click on . Specify calculation of 
equilibrium geometry using the wB97X-D/6-31G* density 
functional model. Check NMR and click on Submit. Accept the 
name 1-methylindole. The calculation will require a few minutes.*

2.	 When the calculation has completed (or after you have retrieved 
results from the database), select Spectra from the Display menu  
or click on . Click on  in the bar at the top of the spectra 
pane and select  (proton NMR spectrum in which there 
is no HH coupling).

* 1-methylindole is in the database and you can, if you like, avoid doing any calculations and 
simply retrieve it. In this case, click on the name at the bottom of the screen and then click 
on Replace in the dialog that results.



96 Tutorial 7

	

	 Move the mouse while holding down the left button over the 
spectrum. When you intersect a line, a numerical value for the 
proton shift appears at the top of the spectrum.

3.	 Click again on  and this time select  (experimental 
proton NMR spectrum with HH coupling constants set to 0). The 
experimental spectrum will be retrieved from the public NMR 
database and displayed on top of the calculated spectrum. Proton-
proton coupling has been eliminated (all coupling constants are 
assumed to be 0).

	

	 The comparison gives you an idea of the level of agreement that 
can be expected between calculated and experimental proton 
spectra. 

4.	 Click again on   and select  (calculated proton NMR 
spectrum). The calculated proton spectrum that now appears 
accounts for three-bond HH coupling. Note that coupling 
constants not calculated but rather evaluated empirically based 
on the three-dimensional geometry of the molecule.
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	 You can focus in on details by a combination of zooming the 
spectrum (scroll wheel) and shifting the displayed range (move 
the mouse while holding down both the right button and Shift 
key). You will see that lines due to protons at C2, C3, C4 and C7 
are doublets, while those due to protons at C5 and C6 are quartets 
(doublet of doublets).

5.	 Close 1-methylindole and any remaining dialogs.

 20 mins

13C Spectrum of Cytisine

There are several reasons why NMR spectroscopy, in particular, 13C 
NMR, is one of the most important routine analytical techniques 
available for characterizing organic molecules. The experiment, 
which is straightforward and can be carried out rapidly, requires 
relatively small samples and is non-destructive. The resulting (proton 
decoupled) spectrum is quite simple, comprising but a single line for 
each and every unique carbon. However, assigning 13C spectra is by 
no means trivial, even for molecules that might appear to be quite 
simple. The problem is that the positions of the lines in the spectrum 
(the chemical shifts) are very sensitive to the  environment in which 
the carbons find themselves. Where two or more carbons in a molecule 
reside in what appears to be similar environments, it may be very 
difficult to distinguish them. 

This tutorial uses the alkaloid cytisine to illustrate the use of 
calculated 13C spectra to assist in assigning the measured spectrum 
of the molecule.
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1.	 Either build and minimize or sketch cytisine and click on 
. Select Calculations... from the Setup menu or click on  
 and specify calculation of equilibrium geometry with the 

wB97X-D/6-31G* density functional model. Check NMR, click 
on Submit and accept the name cytisine. The job will require 
upwards of 15 minutes to complete*.

2.	 When the calculation is done (or after you have accessed 
information from the database), select Spectra from the Display 
menu or click on . Click on  in the bar at the top of the 
spectra pane and select  (experimental 13C spectrum). 
The experimental 13C spectrum is drawn.

	
3.	 Use the calculated spectrum to associate the individual lines 

in the experimental 13C spectrum with specific carbons in the 
structure of cytisine. Click on  and this time select  
(calculated 13C spectrum). The calculated spectrum (in red) will 
be superimposed on top of the experimental spectrum (in blue). 
This gives an impression of the performance of the quantum 
chemical calculations. It also allows you to assign the lines in 
the (calculated) spectrum to individual carbons and by inference 
to assign the lines in the experimental spectrum. Move the 
mouse while holding down the left button over the spectrum. 

* Cytisine is available in the database. If you decide to use this instead of doing the 
calculations, click on the name at the bottom of the screen and click on Replace at the 
bottom of the dialog that results. 



Tutorial 7	 99

When the cursor overlaps a line in the spectrum, the value of the 
chemical shift will be shown, and the carbons responsible will 
be highlighted in the structure model.

4.	 Close cytisine and any open dialogs.

no calculations

Stereochemical Assignments from 13C Spectra

NMR spectroscopy, in particular 13C spectroscopy, is without doubt 
the method of choice to establish the three-dimensional structure of 
organic molecules. Only X-ray diffraction provides more definitive 
results, although the requirement of a crystalline sample severely limits 
its application. The availability of a “virtual NMR spectrometer” offers 
organic chemists an entirely new paradigm for structure determination, 
that is direct comparison of a measured spectrum with calculated 
spectra for one or more chemically reasonable candidates.

The objective of this tutorial is to compare calculated 13C chemical 
shifts for endo and exo stereoisomers of 2-methylnorbornane with 
the corresponding experimental shifts. The question to be answered 
is whether or not the calculations are able to reproduce differences 
in chemical shifts as a function of stereochemistry.

1.	 Build or sketch endo and exo stereoisomers of 2-methylnorbornane.

	
	 Place both in the same document. Use Build New Molecule  

( ) or Sketch New Molecule ( ) from the File menu (instead 
of New Build or New Sketch) for the second stereoisomer.

2.	 Both stereoisomers are available in the database so there is no 
need to perform any calculations. Click on the name of whichever 
molecule is selected at the bottom of the screen. Confirm that 
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CH3

4

1 2

35

6

7

wB97X-D/6-31G* is selected and click on Replace in the dialog 
that results and then on All.

3.	 Select Spectra from the Display menu or click on , click on 
 in the bar at the top of the spectra pane and select . 

You can switch between the two stereoisomers using the  and 
 keys at the bottom of the screen. Compare the 13C chemical 

shifts with experimental values, paying particular attention to 
differences between endo and exo stereoisomers.

		  Experimental 13C NMR Data	  endo exo ∆
		  C1 43.5 42.2 -1.3
		  C2 36.8 34.6 -2.2
		  C3 40.2 40.7 0.5
		  C4 37.3 38.2 0.9
		  C5 30.3 30.6 0.3
		  C6 29.0 22.4 -6.6
		  C7 35.0 38.9 3.9
		  CH3 22.3 17.4 -4.9

	 Can the calculations be used to distinguish between the two 
isomers? Are the differences due to stereochemisty in the 
experimental shifts reproducible in the calculated shifts?

4.	 Close the document and any open dialogs.
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30 mins

UV/visible Spectrum of Indigo

Absorption of light in the ultraviolet (UV) or visible (vis) range of the 
electromagnetic spectrum leads to electronic excitation (from ground 
state to excited states). In the case of absorption in the visible range, 
this determines a molecule’s color.

Note the visible band is tiny (≈ 400 – 700 nm).

UV/visible spectroscopy provides a molecular “fingerprint”, that can 
be used in identification/detection. This technology is also utilized 
in concentration measurement and, in general, supports production 
of materials and products that protect from damage caused from 
exposure to light. 			 

The common presentation is a plot of intensity vs. energy, the latter 
ranging from the far UV (< 200 nm), through the near UV (200-400 
nm) into the visible (400-800 nm). A shorthand is simply to identify 
the maximum absorption, commonly referred to as λmax. Absorption 
(in particular maximum absorption) dictates “color” in the sense 
that it removes a component of the visible spectrum, and what is not 
removed (absorbed) determines the color that is reflected (seen).
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The color wheel (below) affords a convenient way of assessing 
color. If one “walks across” the color wheel below, and looks at 
the complementary color convenient . A molecule that absorbs in 
the green appears red, while one that absorbs in the yellow appears 
violet. 

New in Spartan Student Edition v.9,is the ability calculate and display 
a UV/visible spectrum, and optionally a corresponding experimental 
UV/visible spectrum (if available) from NIST (National Institutes 
of Standards and Technology, https://webbook.nist.gov/chemistry). 
The student edition can also read in (import) an experimental UV/
visible spectrum in the JCAMP (.dx) file format.

Dyes are molecules that absorb in the visible range, and commonly 
include a network of alternating single and double bonds. Indigo 
(dye), above, is a dye with a known λmax (maximum absorption) of  
≈ 612 nm. Can quantum models be called upon to calculate or 
confirm color?

H
N

N
H

O

O

1.	 Build or sketch indigo, explicit instructions for sketching indigo 
in 2D are provided in the Sketching Organic Molecules in 2D 
section. Indigo is also available from the subset of the SSPD 
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and can be accessed via the File menu via the Access Database 
by Name. . . entry. Once you have built, sketched, or retrieved 
indigo from the database, click on .

2.	 Select Calculations… from the Setup menu ( ), and request 
an equilibrium geometry using the B3LYP/6-31G* density 
functional model. Check the UV/vis button, click on the Submit 
button. Accept the provided name. Following the geometry 
optimization, a ground state and a set of excited state energy 
calculations will be performed, with resulting data used to 
generate a calculated UV/vis spectrum.

When performing UV/vis calculations, Spartan Student obtains the 
ground state geometry using the specified DFT model, a subsequent 
energy calculation for the ground state and the first twenty (20) 
excited states using the time-dependent density functional theory 
(TD-DFT) are performed. While additional options exist in the 
research version, the UV/vis recipe is fixed in the Spartan Student 
version, and uses B3LYP/6-31+G* model. For each excited state, 
Spartan Student returns a wavelength and intensity (also called 
the oscillator strength or “strength” in the Verbose Output). 
Wavelength and intensity are used to display the UV/vis spectra 
plot, where the X axis is the wavelength and the Y axis is the 
intensity. A fit of the calculated data (wavelength and intensity) to 
a Gaussian function in which peak width and half height is treated 
as a parameter (one value for all 20 peaks) which accounts for the 
line broadening. Additionally, the Y axis uses a logarithmic scale 
(1.0e-06 to 1.0).

3.	 Select ( ) from the Display menu, and click on ( ) and 
then click inside the checkbox for ( ). Approximate λmax 

(maximum absorption) for the calculated spectrum.  Note that 
indigo absorbs both in the visible but also in the near UV range 
(200 to 400 nm). Use the peak on the right-hand side of the plot 
to estimate λmax:
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	 With a known experimental λmax of 612 nm, does the calculation 

provide sufficient results such that they could be used to estimate 
color based on calculated UV/visible spectra?

While calculated λmax are almost always off by more wavenumbers 
than allowable to be useful in a computationally predicting color, 
there are a number of observations that point towards the potential 
of improved results (and perhaps a new correction scheme). Firstly, 
including solvent in the calculation has been shown to improve 
results. Adding to the number of excited states (the procedure in 
Spartan Student calculates the first twenty) also improves results. In 
most cases, calculated λmax is lower than experiment (and might be 
improved by a simple scaling factor).

As is often the case, asking the question in a relative way, is a good 
strategy for benefiting from cancelation of errors. The UV/visible data 
does quite well in anticipating the results of a structural substitution 
(does a change at position X shift). 

4.	 Close indigo and any open dialogs.
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Tutorial 8
Flexible Molecules

This collection demonstrates procedures associated with calculations 
on flexible molecules.  

The three tutorials in this section illustrate applications involving 
molecules with more than one stable conformer, that is, molecules that 
incorporate rotatable single bonds or flexible rings. The first tutorial 
deals with a molecule with only one degree of (conformational) freedom. 
The goal here is not only to identify the “best” conformer, but also to 
rationalize why it is the best. The second tutorial deals with a molecule 
with multiple degrees of freedom and multiple conformers. The goal 
here is to identify the best (lowest energy) conformer. The final tutorial 
involves a molecule with several degrees of conformational freedom. 
Its goal is to obtain the lowest energy conformers that contribute to 
the molecule’s Boltzmann distribution (with molecular mechanics), 
and then to calculate the NMR spectrum for these conformers and 
compare the calculated 13C NMR to a known experimental NMR. 

8 mins

Internal Rotation in Dimethylperoxide

OO
CH3

CH3

Any function chosen to represent the energy of rotation about a single 
bond needs to repeat itself in 360°. The most common choice is a 
truncated Fourier series.

Etorsion (ω)  =  ktorsion1 (1 - cos(ω - ωeq))  + ktorsion2 (1 - cos2(ω - ωeq))
+  ktorsion3 (1 - cos3(ω - ωeq))

Here, ω­eq is the ideal dihedral angle and ktorsion1, ktorsion2 and ktorsion3 are 
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parameters. The three terms are independent and may be independently 
interpreted. The first (one-fold) term accounts for the difference in 
energy between syn and anti conformers, the second (two-fold) 
term for the difference in energy between planar and perpendicular 
conformers, and the third (three-fold) term for the difference in energy 
between eclipsed and staggered conformers. 

The objective of this tutorial is to interpret the potential energy function 
for rotation about the oxygen-oxygen bond in dimethylperoxide.

1.	 Build dimethylperoxide. If the molecule is not already in an anti 
conformation, select Measure Dihedral from the Geometry 
menu ( ) and set the COOC dihedral angle to 180 (180°) by 
typing 180 in the box at the lower right of the screen and pressing 
the Enter key (return key on Mac). Do not minimize.

2.	 Select Constrain Dihedral from the Geometry menu ( ). 
Select the COOC torsion, and then click on  at the bottom 
right of the screen. The icon will change to  indicating that a 
dihedral constraint is to be applied. 

	 Check the box to the left of Profile at the bottom right of the 
screen. This will result in two additional text boxes.

	
	 Leave 180 (180°) in the original (leftmost) box alone, but change 

the contents of the box to the right of to to 0 (0°). You need to 
press the Enter (return) key after you type in the value. Steps 
should be 10. If it is not, type 10 and press the Enter (return) 
key. What you have specified is that the dihedral angle will be 
constrained first to 180°, then to 160°, then to 140°, etc. and 
finally to 0°*. Click on . 

4.	 Select Calculations... from the Setup menu ( ) and specify 
Energy Profile, Hartree-Fock and 6-31G* from the menus to 
the right of Calculate. Click on Submit and accept the name 
dimethyl peroxide.

* The difference between constraint values is given by: (final-initial)/(steps-1).
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5.	 When the calculations complete, the results are written to a new 
document named dimethyl peroxide.Prof.spartan. Click on Yes 
following the prompt that will ask you if you want to open this 
file. Align the conformers. Select Align from the Geometry 
menu ( ), one after the other, click on both oxygens and on one 
of the carbons, and finally click on the Align button at the bottom 
right of the screen. Select Spreadsheet from the Display menu  
( ), and enter both the energies relative to the 180° conformer, 
and the COOC dihedral angles. First click on the label (M0001) 
for the top entry in the spreadsheet (the 180° conformer), then 
click on the header cell for the leftmost blank column, and finally, 
click on Add at the bottom of the spreadsheet. Select Δ Energy 
from the quantities under the Molecule List tab, kJ/mol from the 
Δ Energy Units menu. To enter the dihedral angle constraints, 
select Constrain Dihedral from the Geometry menu ( ), click 
on the constraint marker attached to dimethylperoxide and click 
on  at the bottom of the screen (to the right of the value of 
the dihedral angle). Click on .

6.	 Select Plots from the Display menu ( ). Click on  
at the top of the (empty) plot pane and select  Constraint(Con1) 
from the X Axis menu and Δ Energy (kJ/mol) from the Y Axes 
list; click on the Create button.

	

	 By default, the data points are not connected. To fit the points to 
a Fourier series, click on  at the top of the plot pane and select 
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Fourier to the right of Curve in the resulting dialog. Check the 
box to the left of Curve and click the Done button.

	

7.	 Use energies from wB97X-D/6-31G* density functional 
calculations, together with the Hartree-Fock geometries  
to provide a better fitting function. First, make a copy  
of dimethyl peroxide.Prof.spartan. Name it dimethyl peroxide 
density functional. Select Calculations... from the Setup menu 
( ) and select Energy, wB97X-D and 6-31G* from the three 
menus to the right of Calculate. Make certain that Global 
Calculations (at the bottom of the dialog) is checked to signify 
that energy calculations are to be performed on all conformers. 
Click on Submit.

8.	 Energy calculations for all ten conformers will require a few 
minutes to complete. When they are done, examine the plot and 
compare it to the energy plot produced earlier.

9.	 Remove all molecules and dialogs from the screen. 
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15 mins

Ethinamate

O
O

NH2

Ethinamate, a prescription drug previously used for the treatment 
of insomnia, provides a very simple example of a molecule with 
multiple conformers. These arise from rotation about the CO single 
bond connecting the carbamate group and the cyclohexane ring and 
the “flipping” of the ring. Rotation about the other CO single bond 
can be ignored as the “cis” conformer drawn above is much lower in 
energy than the “trans” alternative.  

1.	 Build or sketch ethinamate. Click on . Select Calculations... 
from the Setup menu ( ) and specify Conformer Distribution 
from the menu to the right of Calculate. MMFF molecular 
mechanics is the only model available in Spartan Student. Click 
on Submit, and accept the name ethinamate.

2.	 When the job completes (a few seconds), all low-energy 
conformers will be placed in a new document ethinamate.Conf.
spartan. Click on OK to the request to open this document. 
Select Spreadsheet from the Display menu ( ), and size 
the spreadsheet such that all rows (corresponding to different 
conformers) are visible. Click on the top row of the spreadsheet 
(corresponding to the lowest-energy conformer according to the 
MMFF model). Click on Add at the bottom of the spreadsheet. 
Select Δ Energy, Boltzmann Weights and DEnergy from the 
Molecule List tab. Describe the lowest-energy conformer. Does 
the carbamate group prefer to be equatorial or axial? Does one 
conformer dominate the Boltzmann distribution or are two or 
more conformers needed to account for 90%? Have you found the 
expected number of conformers? If not, describe any “missing” 
conformers and suggest why they are missing.
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3.	 See if the results of the molecular mechanics calculations (identity 
of the lowest-energy conformer and makeup of the Boltzmann 
distribution) maintain if you utilize a better theoretical model.

	 Make a copy of ethinamate.Conf.spartan (Save As from the 
File menu or click on ). Name it ethinamate conformers 
density functional. Select Calculations... from the Setup menu 
( ) with this copy and specify calculation of Equilibrium 
Geometry using the B3LYP/6-31G* density functional model. 
Make certain that Global Calculations at the bottom of the 
dialog is checked. (This applies the calculation model to all the 
molecules in the document and not just the selected molecule.) 
Click on Submit.

4.	 The calculations will require several minutes (perhaps 10-20 
depending on your computer). When completed, bring up the 
spreadsheet and identify the best conformer. Is it the same as that 
assigned from the MMFF calculations? If not, is the equatorial 
or axial preference for the carbamate group the same? Is the 
Boltzmann distribution similar in the sense that one conformer 
dominates, or do two or more conformers contribute significantly?

5.	 Close any open documents and dialogs.

15 mins

13C Chemical Shifts Depend on Conformation

At normal temperatures, the time for nuclear spin relaxation is very 
long relative to the time required for equilibration among conformers. 
This means that for each of the carbon chemical shifts in the NMR 
spectrum of a flexible molecule, 13C, will be a weighted  average of 
the shifts NMR of the individual conformers,13Ci.

13C = Σi ωi
13Ci

The weight, ωi, is given by the Boltzmann equation, and depends on 
its energy, εi (relative to that of the lowest-energy conformer, ε0) and 
on temperature, T. Summation is over all conformers (including the 
lowest-energy conformer), gi is the number of times that conformer i 
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appears in the overall distribution and k is the Boltzmann constant.
ωi = gi exp - [εi - ε0/kT]/Σj {exp - [εj - ε0/kT]}

In practice, conformers that are 10 kJ/mol or more above the lowest-
energy conformer make a negligible contribution to the total (at 
room temperature). However, molecular mechanics is not capable 
of providing conformer energies within such a tight threshold and 
looser limits (involving more conformers) are needed for preliminary 
steps in a calculation of Boltzmann weights.

In this tutorial, you will see how well the 13C spectrum of the “best” 
(lowest-energy) conformer of limonene reproduces the experimental 
room temperature NMR. More generally, you will assess the sensitivity 
of 13C chemical shifts to change in conformation.

1.	 Build or sketch limonene. Click on .

	
2.	 Select Calculations... from the Setup menu ( ) and request a 

Conformer Distribution using the MMFF molecular mechanics 
model. Click on Submit and accept the name limonene.

3.	 The job will complete in a few seconds and you will be asked 
whether or not you wish to open limonene.Conf.M0001, the 
document containing the full list of conformers. Click on 
YES. Select Spreadsheet from the Display menu ( ). Click 
on the top row of the spreadsheet to select the lowest energy 
conformer. Click on Add at the bottom of the spreadsheet, click 
on the Molecule List tab, select both Δ Energy and Boltzmann 
Weights and click anywhere on screen to dismiss the dialog.

4.	 Delete any conformers that are more than 40 kJ/mol higher 
in energy than the best conformer, as they will not contribute 
significantly to the Boltzmann distribution.

5.	 Select Calculations... from the Setup menu and specify an 
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Energy calculation and Density Functional and wB97X-D with 
the 6-31G* basis set. We are simplifying the calculations by 
using MMFF geometries, but several conformers are involved 
and it will require several minutes. Check NMR to the right of 
Calculate and click on Submit.

6.	 When the calculation completes, select Spectra from Display 
menu ( ), click on  in the bar at the top of the spectra pane 
and select . Click again on  and this time select the 
experimental 13C spectrum  for each of the low-energy 
conformers. You can move from one conformer to another using 
the “step keys” (  and ) at the bottom left of the screen. While 
the calculated spectrum changes from one conformer to another, 
there is only one experimental spectrum. Is there significant 
variation as you move from one conformer to another? Does 
the spectrum from the lowest-energy conformer adequately 
reproduce the experimental spectrum? 

4.	 Close any open documents and dialogs.
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Tutorial 9
Organic Reactions

This section outlines and illustrates strategies for locating and 
verifying transition states for organic reactions.

While unique valence structures may generally be written for most 
molecules and, based on these structures, reasonable guesses at bond 
lengths and angles may be made, it is often difficult to designate 
appropriate valence structures for transition states (let alone 
specify detailed geometries). The reason is the complete absence of 
experimental data for the structures of transition states. However, 
calculated transition-state geometries are now commonplace, and 
Spartan Student provides both a library of calculated transition-state 
geometries and a facility for automatically matching an entry in this 
library with the reaction at hand.*

Spartan Student also provides a procedure for driving user-defined 
coordinates. Aside from conformational analysis (see discussion in 
Tutorial 8), another application of coordinate driving is to force 
reactions, thereby permitting identification of transition states.

The first tutorial in this section illustrates Spartan Student’s automatic 
procedure for guessing transition-state geometries. The use of 
vibrational analysis to verify that a particular structure corresponds 
to a transition state and to show the motion connecting it to reactants 
and products is also presented. The second tutorial illustrates how a 
reaction may be driven through a transition state.

An example of a transition state calculation for an organometallic 
reaction is provided in Tutorial 11 Inorganic and Organometallic 
Molecules.

*	 Where a reaction is unknown to Spartan Student’s transition state library, a fallback 
technique which averages reactant and product geometries (based on the so-called linear 
synchronous transit method) is invoked.
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10 mins

Ene Reaction of 1-Pentene

C

C
C

C

C C

C
H

H
C

C
HHH

H

1-pentene ethylene propene

H

C

H

H

+

H H

H H
H

H

H

HHH H

The proposed mechanism of the ene reaction involves simultaneous 
transfer of a hydrogen atom and CC bond cleavage. The objective 
of this tutorial is to establish the transition state for the ene reaction 
of 1-pentene and to examine the reaction coordinate for evidence of 
concerted motion.

1.	 Build 1-pentene in a conformation in which one of the terminal 
hydrogens on the ethyl group is poised to transfer to the terminal 
methylene group. To rotate about a (single) bond, first click 
on it to select (it will be marked by a red arrow), and drag the 
mouse up or down in the area below  at the left of the screen. 
Alternatively, hold down the left button and Alt key (option key 
on Mac) and move the mouse up and down. Minimize and click 
on .

2.	 Select Transition State from the Build menu or click on  if 
it appears at the top of the screen. Click on bond a in the figure 
on the following page and then click on bond b. A curved arrow 
from double bond a to single bond b will be drawn.

	

C

C
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C
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e

	 Next, click on bond c and then on bond d. A second curved arrow 
from bonds c to d will be drawn. Finally, click on bond e and 
then, click on the (methyl) hydrogen to be transferred and next 
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on the terminal (methylene) carbon to receive this hydrogen. A 
third curved arrow from bond e to the center of a dotted line that 
has been drawn between the hydrogen and oxygen, will appear.

	 If you make a mistake, you can remove an arrow by selecting 
Delete from the Build menu ( ) and then clicking on the arrow. 
(You will need to select  to continue.) Alternatively, hold down 
the Delete key as you click on an arrow. With all three arrows in 
place, click on  (Search Transition State) at the bottom right 
of the screen. Your structure will be replaced by a guess at the 
ene transition state. If the resulting structure is unreasonable, 
then you have probably made an error in the placement of the 
arrows. In this case, select Undo from the Edit menu ( ) to 
return to the model with the arrows and modify accordingly.

3.	 Select Calculations... from the Setup menu ( ), and specify 
calculation of transition-state geometry using the 3-21G Hartree-
Fock model. Select Transition State Geometry, Hartree-Fock and  
3-21G from the three menus to the right of Calculate. Check IR. 
This will allow you to confirm that you have found a transition 
state, and that it smoothly connects reactant and product. Click 
on Submit and name it ene reaction 1-pentene.

4.	 When the job completes, animate the motion of atoms along the 
reaction coordinate. Select Spectra from the Display menu ( ), 
click on  in the bar at the top of the spectra pane and click 
on  in the palette that results. Click on  (Tables) at the left 
of the spectra pane to bring up a list of frequencies and intensities. 

	

	 Click the top entry in the list. It corresponds to an imaginary 
frequency, and will be designated with an i in front of the number. 
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As detailed in Tutorial 7 of the Spartan Student Manual, vibrational 
frequency is proportional to the square root of the ratio of the force 
constant (reflecting the curvature of the potential surface along a 
particular coordinate) divided by a combination of the masses of 
atoms involved in motion along that coordinate. At a transition 
state (a maximum in the reaction coordinate), the curvature is 
negative. Since the mass term is positive, the quantity inside the 
square root is negative and the frequency is an imaginary number.

	 Is the vibrational motion consistent with an ene reaction of 
interest and not with some other process? 

5.	 Click on  (Make List) at the left of the spectra pane. Controls 
in the dialog that result allow for changing both the amplitude of 
vibration (Amp) and the number of steps that make up the motion 
(Steps). Leave the number of steps (11) alone but change the 
amplitude to 0.3. Type 0.3 in the box to the right of Amplitude: 
and press the Enter key (return key on Mac). Next, click on 
Make List at the bottom of the dialog. This will give rise to a 
new document containing 11 structures that follow the reaction 
coordinate down from the transition state both toward reactant and 
product. You are done with ene reaction 1-pentene, so close it.

6.	 With focus on the new document, select Calculations... from the 
Setup menu ( ) and specify Energy, Hartree-Fock and 3-21G 
from the three menus to the right of Calculate (the same as 
used to obtain the transition state and calculate the frequencies). 
Make certain that Global Calculations is checked and click OK. 
Select Surfaces from either the Setup or Display menu ( ) 
and specify evaluation of two surfaces: a bond density surface 
and a bond density surface onto which the electrostatic potential 
has been mapped. Before you do so, make certain that Global 
Surfaces is checked. Click on More Surfaces...*, select density 
(bond) for Surface and none for Property and click on Apply. 
Select density (bond) for surface and potential for Property 
and click on OK.

* You need to use More Surfaces rather than Add as the electrostatic potential is mapped on 
the bond density surface.
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7.	 Submit for calculation*. Name it ene reaction 1-pentene  
sequence. Once the job has completed, enter the Surfaces 
dialog and examine the surfaces that you have calculated. For 
each, step through the sequence of structures (  and ) keys at 
the bottom of the screen) or animate the reaction ( ). Note, in 
particular, the changes in bonding revealed by the bond density 
surface. Also pay attention to the value of the potential on the 
migrating atom. This reflects its charge. Is it best described as a 
proton (blue), hydrogen atom (green) or hydride anion (red)? 

8.	 Close all open documents and dialogs.

10 mins

SN2 Reaction of Bromide and Methyl Chloride

Br–  + C Cl

H

H

H
+  Cl–CBr

H

H

H
C

H

H H

ClBr

1.	 The SN2 reaction passes through a transition state in which 
carbon is in a trigonal bipyramid geometry and the entering and 
leaving groups are collinear. To build it, first construct methyl 
chloride. Then select bromine from the palette of icons in the 
model kit. Hold down the Insert key (option key on Mac) and 
click on screen opposite chlorine. Alternatively, double click on 
screen. Two detached fragments, methyl chloride and hydrogen 
bromide, appear on screen. Click on  or hold down the Delete 
key and then click on the free valence on bromine. You are left 
with methyl chloride and bromine atom (bromide). Manipulate 
the two such that bromide is poised to attack methyl chloride 
from the backside (as in the transition state above). (Translations 
and rotations normally apply to all fragments, but can be made 
to apply to a single fragment by first clicking on the fragment 
and then holding down on the Ctrl key while carrying out the 
manipulations.) Do not minimize. Click on .

*	 In this example, you have requested graphical surfaces prior to submitting the calculation. 
You could also have requested them to be done “on-the-fly” following the calculation.
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2.	 Select Transition State from the Build menu ( ). Click on 
bromide and then click first on carbon and then on bromide again. 
A dotted line will be drawn from bromine to carbon, together with 
an arrow from bromine to the center of this line. Next, click on 
the CCl bond and then click on the chlorine, and click a second 
time on chlorine. A second arrow from the carbon-chlorine bond 
to the chlorine will be drawn.

	
Br C Cl

	 Click on  (Search Transition State) at the bottom right of the 
screen. Your structure will be replaced by a guess at the transition 
state.

3.	 Select  Measure Distance from the Geometry menu. Click 
on the CBr bond. Replace the current CBr distance in the box at 
the bottom right of the screen by 3.8 (3.8Å) and press the Enter 
button. You have made a complex representing the reactant.

4.	 Select Constrain Distance from the Geometry menu or click on 
 if it appears at the top of the screen. Click on the CBr bond, 

and then click on  at the bottom right of the screen. The icon 
will change to  indicating a constraint is to be applied to this 
distance. Check the box to the left of Profile at the bottom of right 
of the screen. This will result in two additional text boxes.

	
	 Leave the value 3.8 (3.8Å) in the leftmost box alone, but change 

the number in the box to the right of to to 1.9 (1.9Å) and press 
the Enter button. Change the number in the box to the right 
of Steps from 10 (the default) to 20. 20 Calculations with CBr 
bond lengths constrained from 3.8Å (the starting point) to 1.9Å 
(the ending point) will be performed. The transition state should 
have a CBr distance in between these values. Click on .

5.	 Select Calculations... from the Setup menu ( ), and select 
Energy Profile in Water and Hartree-Fock 3-21G from the 
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menus to the right of Calculate. You also need to change Total 
Charge to Anion.

6.	 Submit the job. Name it bromide+methyl chloride. When 
completed, it will give rise to a sequence of calculations placed 
in a new document with the name bromide+methyl chloride.
Prof.spartan. Accept the prompt to open this file. Close the first 
document bromide+methyl chloride to reduce clutter.

7.	 Select Spreadsheet from the Display menu ( ). Click on the 
Add button at the bottom of the spreadsheet. Select DEnergy 
from the Energy From Molecule options under the Molecules 
List tab. Next, enter the (constrained) CBr distances and bromine 
charges in the spreadsheet. Select Constrain Distance from 
the Geometry menu ( ), click on the constraint marker in the 
model and click on  at the bottom right of the screen. 

	

	 Click on . Select Properties from the Display menu ( ) 
to bring up a Properties dialog. Click on bromine and click on 

 to the left of Electrostatic Charges in the Atom Properties 
dialog. Close the spreadsheet and select Plots from the Display 
menu ( ) to bring up the Plots dialog. Click on  in the 
bar at the top of the dialog and select Constraint (Con1) (the 
distance at which the CBr bond has been constrained) from the 
X Axis menu, and both Δ Energy (kJ/mol) and Electrostatic 
(Br1) from the Y Axes list in the dialog that results. Click on 
Create. By default, the data points are not connected. Click on 

 in the bar at the top of the plots plane, select Point-to-Point 
for both  Δ Energy (kJ/mol) and Electrostatic(Br1). Also set 
the X Axis Range from 4 to 1.8. and click on Done.

	 One plot gives the energy as the reaction proceeds and the other 
gives charge on bromine. Are the two related? Explain.
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8.	 SN2 reactions involving charged species normally need to be 
carried out in highly-polar media, for example, water. The 
C-PCM solvent model available with Spartan Student allows 
the effect of solvent to be estimated.

9.	 Select Surfaces from either the Setup or Display menu ( ). 
Click on More Surfaces.... * Select density (bond) from the 
Surface menu and none from the Property menu and click on 
Apply. Select density (bond) from the Surface menu, but this 
time potential from the Property menu. Click on OK. Do not 
close the Surfaces dialog. The Spartan Student interface will 
perform these graphics calculations on-the-fly, however, it will 
take 30 seconds to a minute to complete the two surfaces for all 
20 molecules on the list.

10.	 When completed, check the box to the left of the bond density 
surface inside the Surfaces dialog (the first one you specified) to 
turn it on. Click on  at the bottom left of the screen to animate 
the display. Note, that bonds are smoothly broken and formed 
during the course of reaction. Click on  at the bottom of the 
screen when you are done.

11.	 Turn display of the bond density off (uncheck the box) inside 
the Surfaces dialog, and then turn display of the electrostatic 
potential mapped onto the bond density on. Click on . Relate 

* You need to use More Surfaces rather than Add as the electrostatic potential is mapped on 
the bond density surface.
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the migration of negative charge during reaction as indicated by 
colors in the electrostatic potential map to the plot you constructed 
in step 8. Recall, that colors near red indicate maximum negative 
potential.

12.	 Remove all molecules and any remaining dialogs from the 
screen.
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Tutorial 10
Biomolecules

The two tutorials in this chapter illustrate models appropriate to 
large biomolecules (proteins and polynucleotides), in particular, 
ribbon displays of secondary structure and display of hydrogen 
bonds. No calculations are performed.

Treatment of very large molecules, proteins and polynucleotides 
(biopolymers) most important among them, requires models which 
are simpler than those appropriate for small organic and inorganic 
molecules. This refers both to structural models for display and 
manipulation (where a simplified ribbon display of the biomolecule’s 
backbone is used) and to theoretical models used for calculation of 
structure and properties (where molecular mechanics replaces quantum 
chemical models).

Structural Motifs in Proteins

Two main themes dominate the 
3-dimensional structures of essentially 
all proteins, the a helix and the b 
sheet.

a Helix

1.	 Select New Build from the File 
menu ( ) and click on the 
Peptide builder from the Model 
Kit. This contains a library of 
the 20 natural amino acids, each 
identified by a 3-letter code.

2.	 Click on gly- (glycine). As you 
toggle the checkbox to the left of 
Sequence on and off, the display 
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window at the top of the model kit will shift between a text field 
showing gly (Sequence box checked) and a 2D rendering of 
non-terminated glycine (Sequence box un-checked).

3.	 Make sure the Sequence box is checked, and randomly select 
an additional 9 amino acid residues. Below the pallet of amino 
acids are a series of buttons: a Helix, b Sheet and Other. These 
allow specification of the secondary structure of constructed 
polypeptide sequences.  Select a Helix and double click on 
screen.

4.	 A ball-and-spoke model of a 10-residue polypeptide is displayed. 
There are two open valences (indicated by their yellow color) 
at either end of this non-terminated polypeptide molecule.  
From the lower right side of the Peptide builder, click on the 
Terminate button. The dialog that results lets you terminate the 
polypeptide either as an uncharged form (CO2H and NH2) or as 
a zwitterionic form (CO2

–  and NH3
+).

	
	 Choose CO2H  and NH2 (the uncharged form) and click on the 

OK button to terminate.

5.	 To simplify the model, display the polypeptide as a Tube 
model and deselect Hydrogens from the Model menu. Select 
Hydrogen Bonds from the Model menu. Dotted lines depicting 
hydrogen bonds will appear on screen between the oxygens 
of carbonyl groups and the nitrogens of amine groups (recall 
that display of hydrogens has been turned off). In the a helix 
structure, hydrogen bonds are formed between the C=O of one 
amino acid and NH group of another amino acid, separated by 
a space of 4 residues. It is this network of internal hydrogen 
bonding that holds together the a helix.	
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6.	 To better see the a helix, select Ribbons from the Model menu. 
You may also, if you choose, turn off the molecular structure 
display of the peptide all together, by selecting Hide from the 
Model menu. Rotate the model on screen to get an idea of its 3D 
structure. Note that the hydrogen bonds are still visible. Close 
the document when you finish examining the a helix structure.

b Pleated Sheet

7.	 Select New Build from the File menu ( ) and click on the 
Peptide builder from the Model Kit. The ten-residue sequence 
you previously constructed will remain in the viewer window 
at the top of the builder (if not, make sure the Sequence box is 
checked and randomly choose another 9 amino acids). Select b 
Sheet and double click on screen.

8.	 Again, a model of a 10-residue polypeptide is displayed. This 
time, the secondary structure is in the b sheet configuration. 
Terminate the structure in either the uncharged or zwitterionic 
form.

9.	 Click on  to remove the model kit. Note that the same 
10-residue sequence is significantly longer in the b sheet 
arrangement. As you did for the a helix, switch to a tube model, 
and turn on display of hydrogen bonds. The extended b sheet 
does not contain internal hydrogen bonding so no hydrogen 
bonds appear. Close the document when you finish examining 
the b-sheet structure.

10.	 Hydrogen bonds play a role in connecting b strands to make a 
b sheet. Select Access PDB Online... from the File menu.
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	 Type 1JIC* into the dialog that results and click on Open. Turn 

on hydrogen bonds (Hydrogen Bonds from the Model menu). 
Hydrogen bonds appear between different b strands. Note that 
hydrogen bonds may also exist between residues on the same 
strand, in this example they form a hairpin turn resulting in 
the same b sheet running adjacent to itself but in the opposite 
(or anti-parallel) direction. Close 1JIC when you have finished 
examining the b-sheet structure.

11.	 Select Access PDB Online... from the File menu ( ), type 
1A3F** into the resulting dialog and click on Open. Note that a 
simple ribbon display, showing the protein backbone (secondary 
structure) has replaced the usual structural models (ball-and-

spoke, tube, etc.). To see why this 
is preferable, turn on (select) one 
of these models from the Model 
menu. The model styles that 
provide detail of the enzyme’s 
primary structure completely 
obscure a significant structural 
detail (namely that this enzyme 
is comprised of three identical 
sub-units). Note, however, that 

a space-filling model (Space-Filling from the Model menu) 
remians useful in providing indication of the overall size and 
shape of the enzyme.

*	 PDB designation 1JIC. Torres, A.M., Kini, R.M., Selvanayagam, N., Kuchel, P.W.; J. 
Biochem. 360: 539-548 (2001).

**	 PDB designation 1A3F. Segelke, B.W., Nguyen, D., Chee, R., Xuong, N.H., Dennis, 
E.A.; J.Mol. Bio., 279, 223-232 (1998).
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12.	 To better visualize the three sub-units, turn the selected model 
style off (choose Hide from the Model menu) and select 
Configure from the Model menu, click on the Ribbons tab, 
select By Strand for Coloring and Extended Ribbons for 
Style and click Apply. Note that each oligomer is colored 
differently. Explore the remaining options for coloring 
(click Apply after each selection). Monochrome provides a 
single colored model useful for tracing the backbone of the 
biomolecule. By Secondary Structure gives information about 
how the backbone is organized (alpha-helices are colored red, 
beta-sheets are colored blue, while any remaining segments are 
colored green). By Residue provides a multi-colored display 
where each unique color represents a specific amino acid residue 
type.  To further explore, click on the OK button to dismiss the 
Configure dialogue, and then click on the individual colored 
segments of the ribbon. The specific peptide or amino acid 
residue (in the case of peptide chains, proteins, or enzymes) 
or nucleotide base (in the case of nucleotide chains, DNA, or 
RNA) will be specified in the lower right of the workspace.

13.	 Select Ramachandran Plot from the Model menu.

	
	 Each point gives the dihedral angles between a pair of amino 

acids (the so-called f and y angles). Note that many points fall 
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into two clusters, one corresponding to helices and the other to 
b sheets.

14.	 Close 1A3F. 

Structure of DNA

Only a single motif, a helix, defines the elegant structure of DNA.

1.	 Select New Build from the File menu ( ) and click on the 
Nucleotide model kit.

	

	 This model kit includes options for building a variety of nucleic 
acid sequences (based on nucleotide residues) including both 
single and double stranded DNA and RNA, as well as hybrid 
DNA-RNA sequences. Choose DNA from the menu in the 
middle of the Nucleotide model kit.
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2.	 Just below the viewer window (inside the model kit) are four 
buttons designating the nucleotide bases. Click on A (adenine). 
Toggle the check-box to the left of Sequence on and off. The 
display window at the top of the model kit will shift between a 
text field showing A- (with the Sequence box checked) and a 
2D rendering of adenine (with the Sequence box un-checked). 
Note that even though the 2D rendering displays only the 
nucleotide base, when building, the entire nucleotide, including 
the organic base (purine or pyrimidine), sugar (ribose), and 
phosphate group, will be inserted on screen. In the case of double-
stranded sequences, the complementary base is also inserted.

3.	 Double click on screen to insert an adenosine nucleotide, and 
its complementary base thymine nucleotide. Select Hydrogen 
Bonds from the Model menu to display hydrogen bonding 
between the AT base pair. Note that adenosine-thymine pairings 
in double stranded DNA will always form two hydrogen bonds, 
whereas guanine-cytosine pairings result in the formation of 
three hydrogen bonds. When you are finished examining the 
A-T base pair, select Clear from the Edit menu.

4.	 Make sure the Sequence box is checked, and randomly select 
an additional 15-20 nucleotide bases. Below the pallet of 
nucleotide bases  is a series of buttons (marked A, B, and Other) 
that provide for specification of the nucleotide sequence Helix. 
Select B for the helix type and double click on screen. (DNA 
exists in three forms, A, B, and Z. Almost all DNA in living 
organisms is in the B-DNA configuration.)

5.	 Select Tube and Ribbon from the Model menu. Display of 
hydrogen bonds has already been specified. If you turned this 
off, hydrogen bonds can be accessed from the Model menu. 
Also select Configure from the Model menu and click on the 
Ribbons tab. Select By Strand from the Coloring options and 
click OK. The ribbon tracing the backbone of the sequence you 
constructed from the builder is colored red; the complementary 
sequence is colored blue.
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6.	 Because the glycosidic bonds of the base pairs (bonds connecting 
the base pairs to their sugar molecules) are not exactly opposite 
one another, B-DNA has two clearly visible grooves (called the 
major groove and the minor groove). The major groove is ≈ 12 
Å wide and the minor groove is roughly half that size.  Select 
Space-Filling from the Model menu and locate the major and 
minor grooves in your B-DNA sequence.

7.	 Close all open documents.
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Tutorial 11
Inorganic and  

Organometallic Molecules
This chapter shows how to construct inorganic and organometallic 
molecules using Spartan Student’s inorganic model kit.

Many molecules are made up of a relatively few elements and obey 
conventional valence rules. They may be easily built using the organic 
model kit. However, others cannot be assembled with this model kit 
either because they incorporate other elements, or do not conform 
to normal valence rules or involve ligands. Important among these 
are inorganic and organometallic compounds involving transition 
metals.

1 min

Sulfur Tetrafluoride

S
F

F

F

F

Sulfur tetrafluoride cannot be constructed using Spartan Student’s 
organic model kit. This is because sulfur is not in its normal bent 
dicoordinate geometry, but rather in a trigonal bipyramid geometry 
with one of the equatorial positions vacant. However, the molecule 
can easily be made using the inorganic model kit.

1.	 Select New Build from the File menu ( ) and then select 
Inorganic from the menu at the top of the model kit.
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	 The inorganic model kit comprises a selection bar (initially, 

clicking on the selection bar brings up the Periodic Table) 
followed by a selection of atomic hybrids. Buttons access menus 
of groups, rings and ligands, additional libraries (More) and the 
clipboard. Finally, a selection of bond types is provided at the 
bottom of the model kit.

2.	 Click on the selection bar to bring up the Periodic Table.

	
	 Select (click on) S in the Periodic Table and the five coordinate 

trigonal bipyramid structure  from the list of atomic hybrids. 
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Double click on screen. A trigonal bipyramid sulfur will appear 
at the top of the model kit.

3.	 Again, click on the atom bar, select F in the Periodic Table and 
the one-coordinate entry  from the list of atomic hybrids. 
One after the other, click on both axial free valences of sulfur, 
and two of the three equatorial free valences.

4.	 It is necessary to delete the remaining free valence (on an equatorial 
position); otherwise it will become a hydrogen. Click on  and 
then click on the remaining equatorial free valence.

5.	 Click on . Click on  to remove the model kit.

6.	 Select Calculations... from the Setup menu ( ). Select  
Equilibrium Geometry*, Density Functional, wB97X-D, and 
6-31G* from the menus to the right of Calculate and click on 
Submit. Accept the name sulfur tetrafluoride.

7.	 When the job completes, select Properties from the Display 
menu ( ) and click on an atom, for example, sulfur. The 
atomic charge based on the electrostatic potential will appear in 
the (Atom Properties) dialog. Are the charges consistent with 
covalent or ionic bonding?

8.	 Select Surfaces from the Display menu, click on Add and select 
HOMO from the menu that results. The graphics calculation is 
automatic and will take only a second or two. When completed, 
check the box to the left of HOMO inside the Surfaces dialog. 
Is the highest-occupied molecular orbital in sulfur tetrafluoride 
consistent with the notion that sulfur is surrounded by six electron 
pairs? Elaborate.

9.	 Close sulfur tetrafluoride and any open dialogs.

* It should be noted that were an incorrect geometry specified at the outset, optimization 
would lead to the correct structure, as long as the starting geometry possessed no symmetry 
(C1 point group). Thus, square planar SF4 in D4h symmetry would remain square planar, 
while an almost square planar structure (distorted only slightly from D4h symmetry to C1 
symmetry) would collapse to the proper structure.
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 10 mins

Benzene Chromium Tricarbonyl

Cr
OC CO

CO

benzene chromium tricarbonyl

Does a chromium tricarbonyl group donate or withdraw electrons 
from an aromatic ring to which it is coordinated? The objective of 
this tutorial is to find out by comparing electrostatic potential maps 
for benzene chromium tricarbonyl and free benzene.

1.	 Select New Build from the File menu ( ) and then Inorganic 
from the menu at the top of the model kit. Click on the selection 
bar and select Cr from the Periodic Table. Select the four-
coordinate tetrahedral structure  from the list of atomic 
hybrids. Double click anywhere on screen.

2.	 Click on Ligands in the model kit, select Benzene from the 
menu of available ligands.

	
	 Click on one of the free valences on the four-coordinate chromium 

center. 
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3.	 Select Carbon Monoxide from the Ligands menu, and click on 
the remaining (three) free valences on chromium. Click on  
to produce a refined structure.

4.	 Select Build New Molecule from the File menu ( ). Click on 
Rings, select Benzene and double click on the screen. Click on 

 and then on . The document now contains both benzene 
chromium tricarbonyl and benzene.

5.	 Select Calculations... from the Setup menu ( ). Specify 
calculation of Equilibrium Geometry and PM3 from the menus 
to the right of Calculate. Make certain that Global Calculations 
(at the bottom of the dialog) is checked. Click on OK.

6.	 Select Surfaces from either the Setup or Display menu ( ). 
Click on Add and choose electrostatic potential map from the 
menu. Make certain that Global Surfaces is checked. Do not 
close the Surfaces dialog.

7.	 Submit the job (Submit from the Setup menu). Name it benzene 
chromium tricarbonyl. When completed select Spreadsheet 
from the Display menu ( ), and check the box to the left of 
the label for both entries. This allows the two molecules to be 
displayed simultaneously on screen. By default, Coupled (Model 
menu) is checked. Remove the checkmark by selecting it. The 
two molecules may now be moved independently. Orient each 
molecule so that you can clearly see the benzene face (exposed 
face in the case of the organometallic).

8. 	 Check electrostatic potential map in the Surfaces dialog. Compare 
electrostatic potential maps for both free and complexed benzene, 
with attention to the exposed benzene face.* Does the Cr(CO)3 
group donate or withdraw electrons from the ring? Would you 
expect the aromatic ring in benzene chromium tricarbonyl to be 
more or less susceptible to electrophilic attack than free benzene? 
More or less susceptible to nucleophilic attack?

9.	 Close the documents and any open dialogs.

* Electrostatic potential maps (as well as other maps) for molecules in a group will be put onto 
the same (color) scale. This allows comparisons to be made among different members.
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5 mins

Ziegler-Natta Polymerization of Ethylene

Ziegler-Natta polymerization involves a metallocene. This complexes 
an olefin, which then inserts into the metal-alkyl bond.

Cp2Zr+R Cp2Zr+R
H2C CH2 Cp2Zr+CH2CH2R

H2C CH2 H2C CH2

RCp2Zr+

The object of this tutorial is to obtain a transition state for insertion 
of ethylene into Cp2ZrCH3

+.

1.	 Select New Build from the File menu ( ) and then Inorganic 
from the menu at the top of the model kit. Click on the selection 
bar and select Zr from the Periodic Table. Select  from the list 
of hybrids and double click on screen. Select Cyclopentadienyl 
from the Ligands menu and click on two of the free valences on 
zirconium. 

2.	 Select Organic from the menu at the top of the model kit to move  
to the organic model kit. Select sp3 carbon  and click on 
the remaining free valence on zirconium. Select Alkenyl from the 
Groups menu, hold down the Insert key (option key on Mac) and 
click anywhere on screen or double click in a blank area on screen.

3.	 Orient the two fragments (Cp2ZrCH3 and ethylene) as shown 
below:

	
Zr CH3

Cp

Cp

H2C CH2

	 (To move the fragments independently, hold down the Ctrl key.)

4.	 Select Guess Transition State from the Build menu ( ). Click 
on the ZrC (methyl) bond, and then one after another, click on 
the methyl carbon and on one of the ethylene carbons. Next, 
click on the ethylene double bond and then, one after another, 
click on the other ethylene carbon and on zirconium. Click on 

 (Search Transition State) at the bottom right of the screen. 
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In a few seconds, a guess at the transition state appears.

5.	 Select Calculations... from the Setup menu ( ). Specify 
Transition State Geometry and PM3 from the menus to the 
right of Calculate. Change Total Charge to Cation and check 
IR. Click on Submit and name the job Cp2ZrMe cation + 
ethylene.

6.	 When the job has completed, select Spectra from the Display 
menu ( ). Click on the  in the bar at the top of the spectra 
pane and select  (calculated IR Spectrum). The infrared 
spectrum calculated for the transition state appears. Click on 

 (Tables) at the far left of the spectra pane. This brings up a 
list of calculated frequencies and infrared intensities. Note that 
the frequency value at the top of the list is preceded by an “i”. 
This designates it as imaginary. Click on this frequency and 
examine the vibrational motion. Would you describe the process 
as concerted or occurring in discrete steps?

7.	 Close Cp2ZrMe cation + ethylene and any open documents and 
dialogs.
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Section III
User’s Guide

This section describes the functions available under the menus 
incorporated into Spartan Student, and is intended to serve as a 
general reference to the program. The coverage follows the order 
of the menus presented in the user interface: File, Edit, Model, 
Geometry, Build, Setup, Display, Options, Activities and Help. 
The functions and usage of each of the menu entries is described. 
Entries under the File, Model, Geometry and Build menus deal 
primarily with the input and construction of both 2D drawings and 
3D structures and with their display and query. Entries under the 
Setup menu specify molecular mechanics or quantum chemical 
models, and designate what properties and spectra are to be obtained, 
and request one or more graphical models and include the submit 
function for jobs passed on to computational programs (submitted in 
the background). Entries under the Display menu access calculated 
quantities including calculated spectra. Entries under the Options 
menu set program defaults and user preferences, designate paths to 
databases of calculated and experimental information.

The chapters in this section provide only limited commentary about 
the performance and requirements of different computational methods 
and the utility of different graphical models. Additional information 
is provided under Topics accessed from the Activities menu, which 
also accesses PDF files comprising the Tutorials and Labs. The Help 
menu provides additional technical help under Spartan Student 
v9 Help, Includes the full program, manual as s PDF file, accesses 
details About the program and contains the License Utility (allowing 
for upgrading the licensing, renewing maintenance, configuring the 
license type, etc.). New in this release, the Check for Updates… entry 
compares the user’s version with the latest available for download, 
and alerts the user to newer versions. Note, the software will not 
automatically update, this tool only alerts users to the availability of 
newer versions.
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Chapter 3
The File Menu*

The File menu accesses a 2D sketch pad, model kits to build, edit and 
substitute molecules in 3D, the file system to read and write both native 
and non-native files, print text and on-screen graphics, save on-screen 
graphics as image files, the database of quantum chemical results by 
name, the online PDB database of protein and nucleotide structures.

New Build ( )

Brings up a model kit and clears the screen. Model kits are discussed 
in Chapter 7.

New Sketch ( )

Brings up the 2D sketch pane and clears the screen. The 2D sketch 
pane is discussed in Chapter 7.

* The File menu previously contained Screen Recording tools. These are now accessible 
through the operating system: Win+Alt+R for Windows, Command+Shift+5 for Macintosh.
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Build New Molecule ( )

Brings up a model kit and clears the screen. Build New Molecule 
differs from New Build, in that the resulting molecule is appended 
to the end of the document associated with the molecule (or sketch) 
that is presently selected.

Sketch New Molecule ( )

Brings up the 2D sketch pane and clears the screen. The menu bar is still 
accessible, but only the View ( ) and Sketch New Molecule ( ) 
icons are available. Sketch New Molecule differs from New Sketch 
in that the resulting sketch is appended to the end of the document 
associated with the molecule (or sketch) that is presently selected.

Delete Molecule ( )

Deletes the selected molecule(s) from a document. Deleting the last 
molecule leads to an empty document.

Append Molecule(s)... ( )

Appends molecules from one or more documents onto the end of 
the current document. Append Molecule(s)... leads to a file browser 
from which one or more documents may be selected.*

Open... ( )

Opens a file that contains all information associated with a particular 

* Alternatively, molecules may be appended onto an existing document either by copy/paste 
operations using the clipboard or by dragging from an external window. Both require that 
the spreadsheet associated with the destination document be open on screen.

	 To copy a molecule open on screen onto the clipboard, first select (click on) it, and then 
select Copy from the Edit menu. Alternatively, click on its label in its spreadsheet (in the 
leftmost column), and then select Copy from the Edit menu. The latter permits several 
molecules to be selected (and copied) at once using the Shift and Ctrl keys in the usual 
manner. Once on the clipboard, the molecule or molecules may be moved to the destination 
list by clicking on an empty row header in the spreadsheet (for the destination document), 
and then selecting Paste from the Edit menu.

	 To copy a document from an external window, drag it onto the open spreadsheet (associated 
with the destination document) inside of Spartan Student. Several documents can be 
dragged at once using the Shift and Ctrl keys in the usual manner.
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molecule (or list of molecules). In addition to native (.spartan) files 
(documents) including 2D sketch files, supported are files containing 
2D drawings, 3D structures and 1D strings. Also supported are file 
formats for experimental IR and NMR spectra. Non-native files are 
normally hidden from view, but may be seen by selecting All Files 
from the Files of type menu at the bottom of the dialog.

Open Recent Documents ( )

Brings up a list of (at most) ten recent documents. Clicking on one 
opens the document.

Save ( )
Save As... ( )
Save Image As... ( )

Saves the document containing the selected molecule exactly as it 
appears on screen. Opening the document will bring it on screen 
exactly as it was last saved. If the document has not previously been 
named, Save behaves as Save As.... Documents may be either be 
saved in native format or in one of the formats listed under Save As.... 
In addition, Bitmap (.bmp), JPEG (.jpg) and PNG (.png) graphics 
file formats are supported. Selection is made under the Save as type 
menu in the Save As dialog. Save Image As... allows for saving 
molecules as high resolution PNG files.
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Print ( )

Selection leads to a dialog in order to designate a printer, specify 
print layout and number of copies. It also allows printing to a file.

The contents of the spreadsheet (Spreadsheet under the Display 
menu; Chapter 9) may be printed using Print from the contextual 
menu. The results of a reaction energy calculation (Reactions... 
under the Display menu; Chapter 9), may be printed using Print 
from the contextual menu.

Access Database By Name... ( )

Included with Spartan Student is a ≈6,000 molecule subset of the 
Spartan Spectra and Properties Database (SSPD). The individual 
entries correspond to calculations from the wB97X-D/6-31G* 
density functional model and each includes the structure, energy, 
infrared and NMR spectra, as well as a variety of molecular and 
atomic properties. The wave function is available allowing graphical 
surfaces and property maps to be computed on-the-fly. Selection 
brings up a dialog:
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A name search is initiated by entering a name (or partial name) 
in the box to the right of By Name: at the bottom of the Access 
Database by Name dialog. The search will return all entries that 
include whatever text string is entered into this box. For example, 
searching xanthine will not only result in xanthine, but also any 
related molecules.

Following the search, one or more hits may be retrieved by selecting 
them from the hit list and then clicking on Retrieve. Shift and Ctrl 
keys are used in the usual way to select multiple entries from the hit list.

Access PDB Online... ( )

Provides access to the online Protein Data Bank (PDB)* comprising 
more than 190,000 protein and nucleotide structures. Selection 
results in a dialog. 

To access a PDB structure, enter the four character identification 
code in the box to the right of PDB ID and click on Open. If the PDB 
entry contains more than one structure and/or the PDB ID yields more 
than one entry, all structures will be returned in a single document.

* The web address is https://www.rcsb.org.
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PDB access will typically require a few seconds. The PDB ID will 
appear at the right and a ribbon model of the protein or nucleotide 
will appear on screen. A Ramachandran plot associated with a protein 
structure may either be drawn upon initial retrieval of the PDB file 
by checking the box to the left of Draw Ramachandran Plot or 
later from Ramachandran Plot under the Model menu (Chapter 5).

Screen Recording

For Windows (10 or higher) use the Win+Alt+R keys to start 
screen recording of the focused window. A menu is presented 
allowing the “Stop” recording feature. Similarly, for Macintosh use 
the Command+Shift+5 keys to access the screenshot toolbar for 
MacOS Mojave or higher.

Close ( )

Closes the document containing the selected molecule, as well as any 
document specific dialogs. If the document has not previously been 
saved, a name is requested. If a previously-saved document has been 
altered, verification that the changes are to be saved is requested.

Exit ( )

Exits Spartan Student, that is, clears the screen and closes all open 
documents. A prompt for a name is provided for each document that 
has not previously been saved.
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Chapter 4
The Edit Menu

Operations under the Edit menu provide for undoing commands, 
copying items to and from the clipboard, finding text and graphics, 
centering molecules on screen and clearing the selected molecule.

Undo ( )

Undoes the last operation from the Build and Edit menus. Undoes 
transition-state formation (see Transition State in Chapter 7).

Cut ( ), Copy ( ), Paste ( )

Cut moves the selected item to the clipboard and removes it from 
the document. Copy copies the item to the clipboard. The item 
is unaffected. Paste transfers the contents of the clipboard to the 
selected location. The contents of the clipboard are unaffected. 
Among the important uses of the clipboard are:

(i)	 Transferring on-screen graphics into other applications such 
as Microsoft Word® and PowerPoint®.

(ii)	 Temporary storage of a 3D molecular structure for use in 
molecule building. Temporary storage of a 2D sketch is 
accomplished using Copy/Paste under a contextual menu 
(see Chapter 7).

(iii)	 Transferring data between Spartan Student spreadsheets 
and between a Spartan Student spreadsheet and other 
applications such as Microsoft Excel®.
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(iv)	 Making multi-molecule documents and/or transferring 
molecules between documents.

Copy operations for (i) and (ii) also refer to the contents of a 
selection box if one has been drawn, but to the selected molecule 
if a box has not been drawn. Copy operations from a spreadsheet 
refer to all spreadsheet information associated with a document if 
selection is made on the header cell of the leftmost column, but 
only to the selected (text) information if selection is made on any 
other column. Further discussion relating to use of the clipboard in 
molecule building is provided in Chapter 7 and for moving data in 
and out of the spreadsheet in Chapter 9. 

Select All ( )

Selects all atoms in the selected molecule.

Find...( ), Find Next ( )

Find locates a text string defined in the Find dialog if an output 
window or a spreadsheet is selected, or a structure sequence defined 
on the clipboard if an on-screen model is selected. Find Next locates 
the next occurrence of a text string or a structure sequence.

Center ( )

Centers on screen all molecules in the document for which the selected 
molecule is a member (only the selected molecule is displayed).

Clear ( )

Clears (deletes) the structure and other information for the selected 
molecule, and brings up a model kit. Information is not removed 
from the file system until the document is saved.
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Chapter 5
The Model Menu

Structure models available under the Model menu include wire, ball-
and-wire, tube, ball-and-spoke and space-filling (CPK) models, with 
or without hydrogens, with or without hydrogen bonds indicated, with 
or without atom labels, and with or without R/S chirality labels, as 
well as ribbon displays for polypeptides and polynucleotides, with 
or without labels and with or without hydrogen bonds indicated. 
It allows drawing a Ramachandran plot for a protein structure 
retrieved from the Protein Data Bank (PDB). The menu also provides 
for configuring atom labels to display element name, mass number, 
charge or chemical shift, and for specifying color coding and display 
style for ribbon labels, as well as turning a variety of other labels on 
and off. Finally, it allows model style to be applied globally (to all 
molecules in a document) and models to be manipulated in concert.

Only one model style Wire, Ball and Wire, Tube, Ball and Spoke, 
Space Filling or Hide) may be selected. The selected model is 
designated by a check mark  in front of its entry in the drop down 
menu or by a highlighted button in the case of the button pad menu 
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display. Global Model, Coupled, Hydrogens, Labels, Chirality, 
Hydrogen Bonds, Ribbons and Ramachandran Plot operate as 
toggle switches. A  in front of the entry in the menu indicates that 
it is selected.

All structure models and graphics may be displayed either in orthogonal or 
perspective projections. The latter may be valuable in helping to visualize 
large molecules. Selection is done in the Settings tab (Preferences... 
under the Options menu; Chapter 10). Both structure models and 
graphics may be presented in 3D stereo. This is also controlled from the 
Settings tab. Stereographic displays require perspective projections. 

Wire ( )

This represents the molecule as a wire model where the vertices 
represent the atoms.

Bonds are drawn in two colors, one for each of the atoms making up 
the bond. Default atom colors are given in Figure 5-1.	

Atom colors apply globally (to all atoms of given type), and may 
be changed using the Set Colors dialog (Colors under the Options 
menu; Chapter 10). All models use the same color scheme for atoms, 
and provide for the same mechanism of changing colors globally or 
individually. Note: Individual atoms may be custom colored, or may 
be displayed in a custom model style from the Atom Style panel, 
accessible from the drop down triangle in the lower right of the Atom 
Properties dialog (Properties under the Display menu, Chapter 9).

Ball and Wire( )

This represents atoms by small balls and bonds by wires.

Wire Model



148	 Chapter 5

Figure 5-1: Default Atom Colors
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Ball-and-Spoke Model

The balls are color coded according to atom type, and the wires 
representing bonds are drawn in two colors (as in wire models).

Tube ( )

This is similar to the wire model, except that tubes instead of wires 
are used to represent bonds.

Tubes may either be solid cylinders or be split to represent multiple 
bonds. As with wire models, bonds are drawn in two colors.

Ball and Spoke ( )

This represents atoms by balls (the color of which depends on atom 
type), and bonds by spokes.

Spokes are either cylinders or are split to represent multiple bonds. 
Bond (spoke) color is gray by default but it may be changed using 
the Color dialog (Colors under the Options menu; Chapter 10). 

Tube Model

Ball-and-Wire Model
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Space Filling ( )

This represents the molecule as a composite of spheres, the radii 
of which have been chosen to approximate van der Waals contact 
distances.* Also known as CPK models, space-filling models are 
intended to portray overall molecular size and shape.

Volume, surface area and polar surface area (PSA)** are displayed in 
the Molecule Properties dialog (Properties under the Display menu; 
Chapter 9) and correspond to a space-filling model.

Hide ( )

This removes the structure model from the screen. This may be 
desirable where its display leads to unnecessary crowding, for 
example, in proteins where ribbon displays are more appropriate. A 
structure model may be restored by selecting it from the Model menu.

Global Model ( )

If checked (turned on), this signifies that all molecules in a document 
will share attributes. These include presentation of hydrogens, atom 
and other labels, hydrogen bonds and ribbon displays. Default model 
style is controlled from the Molecule tab (Preferences... under the 
Options menu; Chapter 10). Global Model acts in a toggle manner, 
switching between global and individual display. Global Model is 
normally on.

*	 Default values for van der Waals radii may be changed from the VDW Radii tab accessible 
from Preferences under the Options menu (Chapter 10). Settings apply to all atoms of 
given atomic number.

**	 Polar surface area is defined as the area due to nitrogen and oxygen and any hydrogens 
attached to nitrogen and oxygen.

Space-Filling Model
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Coupled ( )

If checked (turned on), this signifies that all molecules in a document 
will be moved together. Coupled is turned on following molecule 
alignment (see Align under the Geometry menu; Chapter 6). 
Coupled acts in a toggle manner, that is, repeated selection couples 
and decouples the molecules.

Hydrogens ( )

If checked (turned on), this signifies that hydrogens are to be included 
in the model display. Hydrogens acts in a toggle manner, that is, 
repeated selection turns the display of hydrogens on and off.

Labels ( )

If checked (turned on), this signifies that labels associated with 
atoms, ribbons and bonds as well as with other attributes specified in 
Configure... (see discussion later in this chapter) are to be displayed 
in conjunction with model display. Labels acts in a toggle manner, 
that is, repeated selection turns display of labels on and off. Labels 
is automatically turned on following selection of Apply or OK in the 
Configure dialog (if any changes are made).

R/S Chirality ( )

If selected, this adds R/S chirality labels to the model. R/S Chirality 
acts in a toggle manner, that is, repeated selection turns R/S labels 
on and off.

Hydrogen Bonds ( )

If checked, this signifies that hydrogen bonds are to be drawn as part 
of the model. Hydrogen Bonds  acts in a toggle manner, that is, 
repeated selection turns display of hydrogen bonds on and off.

Ribbons ( )

If checked, this signifies that ribbons are to be displayed along with 
the selected model. (If only ribbons are desired, select Hide for the 
model.) Ribbons acts in a toggle manner, that is, repeated selection 
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turns display of ribbons on and off.

Ramachandran Plot ( )

If checked, this draws a Ramachandran plot for a protein input from 
the Protein Data Bank (see Access PDB Online under the File menu; 
Chapter 3). Ramachandran Plot acts in a toggle manner, that is, 
repeated selection turns the plot on and off. Note that coloring of 
the points on the plot (red for a-helices, blue for b-sheets, green 
for “other”) is not based on the actual 3D geometry but rather on 
assignments in the PDB file.

Configure... ( )

This selects the types of labels attached to atoms and ribbons, as well 
as display of other objects such as points, planes, and user annotations.

	 Configure Labels

Atom labels may be selected from among the following: Labels, 
a unique element/number combination that may be changed 
from the Atom Properties dialog (accessible from Properties 
under the Display menu; Chapter 9), Element, Mass Number, 
Electrostatic Charge, Strand: Residue\Label (polypeptides 
and polynucleotides), and Exposed Area (of an atom in a space-
filling model) and Chem Shift (Calculated, Experimental, and 
Calculated-Experimental). In addition, Bond Labels, Point 
Labels, Plane Labels, Constraint Labels, Residue Labels and/
or Reaction (Arrow) Labels may be provided. Default settings 
(for a new molecule) are made in the Molecule Preferences dialog 
(Preferences under the Options menu; Chapter 10).
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	 Configure Objects

Clicking on the Objects tab leads to the Configure Objects dialog.

If checked, Constraint and Frozen markers, Points and Planes 
and Reaction arrows attach to the model. If not checked, these are 
shown only in the respective modes, for example, Frozen markers 
are shown only if Freeze Center is selected.

	 Configure Ribbons

Clicking on the Ribbons tab leads to the Configure Ribbons dialog.

Ribbon coloring may be selected from among the following: 
Monochrome, By Secondary Structure, By Strand or By 
Residue. Ribbon style may be selected from among the following: 
Ribbons, Extended Ribbons, Beads, or Lines.

The Configure dialog is removed from the screen with all 
selections maintained by clicking on OK. Clicking on Cancel 
or on  removes the dialog but selections are lost. Clicking on 
Apply maintains the selections but leaves the Configure dialog on 
screen. Note, that Labels (from the Model menu) will be turned 
on following either clicking on OK or on Apply. 
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Chapter 6
The Geometry Menu

Functions available under the Geometry menu allow querying, 
changing and constraining bond lengths, angles and dihedral angles, 
defining points, ligand points and planes, freezing atomic centers and 
aligning molecules in a document.

Measure Distance ( )
Measure Angle ( )	  
Measure Dihedral ( )

Measure Distance displays the distance (in Ångstroms) between two 
atoms, whether or not they are bonded. Selection results in a message 
at the bottom left of the screen.

Clicking on two atoms displays the distance at the bottom right of 
the screen.

Alternatively, clicking on a bond displays its length.

Measure Distance may also be used to alter the distance between 
atoms (as long as both are not incorporated into the same ring), by 
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altering the contents of the box to the right of Distance (A,B) = or 
Length (A)=, and then pressing the Enter key (return key on Mac). 
The distance (length) may be entered into the spreadsheet by clicking 
on  to the right of its display (see Spreadsheet under the Display 
menu; Chapter 9). Alternatively, the label “Distance (A,B)=” or 
“Length (A)=” may be dragged into the spreadsheet.

Angle and dihedral angle queries are handled in a similar manner. 
Angles require that three atoms or two bonds be identified (in the 
proper order) while dihedral angles require that four atoms or three 
bonds be identified (in the proper order).

Freeze Center ( )

This forces atoms to be held in place during minimization (in the 
3D builder) or during equilibrium or transition-state geometry 
optimization, conformational searching, or energy profile generation 
using methods specified in the Calculations dialog (Calculations... 
from the Setup menu; Chapter 8).

Atom freezing may be useful in a number of situations, among them 
guessing a transition-state geometry for a reaction that is closely 
related to one for which a transition state is available. For example, a 
good guess at the transition state for pyrolysis of cyclohexyl formate 
will be obtained by modifying the transition state for pyrolysis of 
ethyl formate, freezing all but the modified sections (designated in 
bold in the figure below) and then minimizing.

H2C CH2

H

OC

O

HC CH

H

OC

O

H2C

H2C CH2

CH2

HC CH

H

OC

O

H2C

H2C CH2

CH2

H H H

modify
structure

freeze minimize

transition-state structure 
for ethyl formate
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structure for 
cyclohexyl formate

Selection of Freeze Center leads to a message at the bottom left of 
the screen, and Freeze All, Freeze Heavy, and Thaw All options at 
the bottom right of the screen.



156	 Chapter 6

Clicking on an atom or free valence*, freezes it; clicking again thaws 
it. Buttons at the bottom right of the screen allow for freezing all 
atoms (Freeze All), freezing all heavy (non-hydrogen) atoms (Freeze 
Heavy) and for thawing all atoms (Thaw All).

Frozen atoms are indicated by magenta colored markers ( ). 
Whether or not these are included with the model (outside of freeze 
center mode) is controlled from the Molecule Preferences dialog 
under Preferences... in the Options menu (Chapter 10).

Constrain Distance ( )
Constrain Angle ( )
Constrain Dihedral ( )

These introduce one or more geometrical constraints during structure 
minimization (in build mode), and during equilibrium or transition-
state geometry optimization or conformational searching using 
methods specified in the Calculations dialog (Calculations... from 
the Setup menu; Chapter 8). They also allow for setting a range of 
constraints needed for generation of energy profiles. Constraints may 
be useful in a number of situations, among them:

(i) constructing conformational energy profiles where one or 
more dihedral angles need to be fixed while other geometrical 
variables are optimized,

(ii) optimizing molecular structures where the values of certain key 
parameters are known, for example, optimizing the geometry of 
a molecule with an intramolecular hydrogen bond or a disulfide 
linkage, and 

(iii) building molecules with unusual geometries, for example, 
molecules with very long bonds, as might be required in the 
construction of transition states and intermolecular complexes.

Selecting Constrain Distance results in a message at the bottom left 
of the screen.

*	 The bond distance in this case is that appropriate for hydrogen being added to the free valence.
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Clicking on two atoms, or a bond results in a message at the bottom 
right of the screen.

Clicking on  changes it to  and shows the current distance.

This (constraint) distance can now be changed by altering the contents 
of the box and then pressing the Enter key (return key on Mac). 
Alternatively, the existing distance may be used as the constraint 
distance. If the selected distance had previously been constrained, the 
icon  would have been initially displayed. In this case, clicking on 

 turns the constraint off and returns the icon to . Finally, the 
value of the constraint (that may be different from the value of the 
current distance*) may be entered into the spreadsheet by clicking 
on  to its right. Alternatively, the label Constraint (A,B)= may be 
dragged into the spreadsheet.

This sequence of operations (bond identification followed by turning 
the constraint on and off) may be repeated as many times as necessary. 
Any bonds or non-bonded distances on which constraints are to be 
imposed are indicated by magenta colored markers. Any constraints 
introduced are automatically enforced. 

Angle and dihedral angle constraints are handled in a similar manner. 
Note that points and planes may not be used to define constraints.

Checking the  leads to additional options at the bottom right of 
the screen. This allows a sequence of constraints to be defined (from 
some initial value to some final value in a given number of steps) for 
the purpose of constructing an energy profile along a predefined set of 
coordinates (see Calculations... under the Setup menu; Chapter 8).

The leftmost box sets the initial value of the constraint, the middle 

*	 Note, however, that you should not start a constrained geometry optimization from a structure 
that is very different from that satisfying one or more constraints.
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box to the right of to sets the final value, and the rightmost box to 
the right of Steps: sets the number of steps. For example, were the 
initial value set to 0°, the final value to 180° and the number of steps 
to 10, then a series of ten constraints (0°, 20°, 40°, ... 180°) would 
be specified. This can also be accomplished using the Constraint 
Properties dialog, (see Properties under the Display menu; Chapter 
9) and the value of the constraint posted to the spreadsheet.

Whether or not constraint markers are included as part of the 
model (outside of constrain distance, constrain angle or constrain 
dihedral mode) is controlled from the Molecule Preferences dialog 
(Preferences... under the Options menu; Chapter 10).

Define Point ( )

This defines a point as the geometric (unweighted) center of selected 
atoms (or points) previously defined. Selection results in display of 
a message at the bottom left of the screen.

Clicking on atoms (or points) in any order, and clicking a second 
time on any one of the atoms (or points) defines a point (depicted as 
a small sphere). As many points as desired can be defined and these 
are treated in the same way as an atom in defining distances, angles, 
etc. Points move with the molecule as its geometry is altered.

Whether or not points and ligand points are shown as part of the model 
is controlled from the Molecule Preferences dialog (Preferences... 
under the Options menu; Chapter 10).

Define Ligand Point ( )

This defines a point of attachment directed perpendicular to the 
geometric center of the plane defined by three atoms (or best plane 
in the case of four or more atoms). Clicking on atoms (or points) in 
any order, and clicking a second time on any one of the atoms (or 
points) defines a ligand point (depicted as a small sphere). As many 
ligand points as desired can be defined. A ligand point shares all the 
characteristics of a normal point, but may also be used to bond to 
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atomic fragments, functional groups, etc. See Make Bond under the 
Build menu (Chapter 7) for a discussion. Ligand points move with 
the molecule as geometry is altered.

Delete from the Build menu ( ) or the Delete key may be used to 
remove a point or ligand point.

Whether or not points and ligand points are shown as part of the model 
is controlled from the Molecule Preferences dialog (Preferences... 
under the Options menu; Chapter 10).

Define Plane ( )

This defines and displays a reference plane. Selection results in 
display of a message at the bottom left of the screen.

Clicking on three atoms or points defines a plane. As many planes 
as desired may be defined, and these may be used in defining 
distances, angles, etc. Planes move with the molecule as its geometry 
changes.

Delete from the Build menu ( ) or the Delete key may be used to 
remove a plane.

Whether or not planes are included as part of the model is controlled 
from the Molecule Preferences dialog (Preferences... under the 
Options menu; Chapter 10).

Align ( )

This aligns all other molecules to the selected molecule in the same 
document. Note: the Align icon or menu entry will only be available 
if you access it with focus on a multi-molecule document. If your 
document has a single molecule the icon is grayed out. Selection of 
Align from the Geometry menu results in a message at the bottom 
left of the screen.
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Clicking on an atom designates it as an alignment center, and marks it 
with a red circle. Clicking on the circle removes the designation (and 
the circle). Following selection of alignment centers, clicking on the 
Align button at the bottom right of the screen aligns the molecules. 
If no atoms are selected prior to clicking on Align, then alignment is 
based on all (non-hydrogen) atoms.

Following alignment, two or more molecules may be displayed 
at once using spreadsheet functions (see Spreadsheet under the 
Display menu; Chapter 9). Their motions (coordinates) will be 
coupled following alignment, but may be uncoupled allowing the 
aligned molecules to move independently (see Coupled under the 
Model menu; Chapter 5). Note that alignment center selections are 
kept and molecules can be realigned by again selecting Align from 
the Geometry menu (or clicking on ) followed by clicking on the 
Align button.

The alignment score from 0 to 1 (where 1 designates perfect 
alignment), is available in the spreadsheet. This is accessed by clicking 
on the Add button at the bottom of the spreadsheet, and selecting 
Alignment Score from the Molecule List tab (see Spreadsheet under 
the Display menu; Chapter 9). A score of 0 is assigned to molecules 
that cannot be aligned to the selected molecule.
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Chapter 7
The Build Menu

The Build menu provides a sketch palette for drawing molecules in 
2D, model kits and associated tools for building and editing organic, 
inorganic and organometallic molecules as well as polypeptides 
and polynucleotides in 3D, 2D to 3D conversion and 3D structure 
refinement using molecular mechanics. 

Spartan Student provides a variety of tools for specification of 3D 
molecular structure, a necessary first step to any molecular mechanics 
or quantum chemical calculation. Molecules can either be rendered 
as 2D sketches and later brought into 3D*, or directly constructed 
from 3D fragments. Polypeptide and polynucleotide construction is 
availale from 3D (only). 

2D Sketch Palette

The 2D sketch palette contains tools for making and manipulating 
drawings. There are also tools for specifying charges and radical sites 
and for designating stereochemistry.

Atom Icons. H, B, C, N, O, F, Si, P, Cl, Br and I only.

*	 The Windows version of Spartan Student also allows seamless access to ChemDraw 
installed and licensed on the same computer. 2D drawings are automatically brought into 
3D. Both Windows and Mac versions of Spartan Student are able to read ChemDraw files. 
Information is provided in Appendix E.
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Periodic Table, Groups, Ligands. A More icon which appears 
below the H and B icons, allows any atom as well as a variety of 
common functional groups and a selection of common ligands to 
be specified.

Common Rings. Three icons facilitate the rapid addition of 
benzene ( ), cyclohexane ( ) and cyclopropane ( ), 
cyclobutane ( ), cyclopentane ( ) and cycloheptane ( ).

Common Carbonyl Groups. Three icons facilitate the rapid 
addition of carbonyl ( ), carboxylic acid/ester ( ) and amide 
( ) groups to drawings.

Stereochemical Markers. Wedges and dashes, represented by  
and , can be used to designate in-out stereochemistry. Once a 
stereochemical marker has been added to a drawing, it is possible 
to designate the orientation of hydrogen atoms and/or substituents 
bonded to six-member rings as ax(ial) or eq(uatorial) (ax and eq 
labels appear only on the drawing, not in the palette).

Charge/Radical Markers. Conventional bonding rules (neutral C 
makes 4 bonds, neutral N makes 3 bonds, and so on) are enforced 
when 2D perspective drawings are converted into 3D models. This 
is accomplished by adding hydrogen atoms to the drawing. For 
example, a single carbon on screen will give methane, a single line, 
ethane, and a double line, ethylene. (Hydrogen atoms are added 
to nitrogen, oxygen, phosphorous and sulfur in the 2D drawings.) 
When another outcome is desired, for example, for an ion or free 
radical, charge or radical markers must be added to the drawing.

Two icons,  and , are used to label atoms that bear formal 
charges.   is used to label atoms that are neutral, open-shell 
radicals. Each of these markers affects the number of electrons 
and the number of hydrogen atoms added to the 3D model. For 
example, O will produce a 3D model of water, H2O. However, 
adding the appropriate marker will result in 3D models of H3O+  
( ), HO– ( ), or HO radical ( ), respectively. Only one 
charge/radical marker can be assigned to an atom.
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Only one charge/radical marker is displayed on the palette, but 
clicking on the icon will cause each marker to appear in turn.

Reaction Arrows.  designates one ore more curved arrows 
allowing access to Spartan’s automated search transition state 
procedure. The tail of the arrow corresponds to the source of the 
electron pair. If the source is a lone pair, then select the atom that 
holds the lone pair. If the source is a bond, then select the bond. 
Clicking on an atom or bond highlights (colors gold) the atom or 
bond. Clicking again on the same atom (or same bond) removes the 
highlighting. The head of the arrow corresponds to the destination 
of the electron pair. If the destination is an atom (leading to a lone 
pair), then select the atom that will hold the lone pair by clicking 
on it two times. If the destination is an existing bond (leading to an 
increase in bond order from single → double or double → triple), 
then select (click on) the bond. If no bond presently exists, select 
(click on) the two atoms that will become bonded upon reaction. 
These operations result in a curved arrow being drawn on the 
reactant structure. This extends from an atom, or the center of a 
bond to an atom, or the center of a bond, or the center of a dotted 
line that has been drawn between atoms that are to be bonded.

Note that the head and tail do not need to reside on atoms or bonds 
on the same fragment. Also the tail may involve atoms of two 
detached fragments.

The process (tail selection followed by head selection) is repeated  
as necessary to fully define the reaction. Incorrect reaction arrows 
may be removed by clicking on  from the palette and clicking 
on the arrow. You then need to select  to continue arrow 
specification.

Once defined, reaction queries can be used to provide a guess at 
a transition state based on its similarity to an entry in an internal 
database* of transition states for a variety of common reactions.

Drawing Tools.  Undoes the most recent drawing operation(s). 
 Removes or modifies parts of a drawing.  Deletes an entire 

*	 This collection presently consists of more than 2000 named reactions.



164	 Chapter 7

drawing (a warning is provided).  Improve the readability of a 
drawing by applying various “clean up” procedures.

Making a Sketch

To start a sketch, first select (click on) an atom, group, ring or the 
More icon in the sketch palette and then double click in the white 
portion of the screen (the drawing area). To draw a bond, first click on 
an atom, group, ring or More icon in the sketch palette to designate 
what is at the end of the bond, then position the cursor over the atom 
in the drawing area where you want the bond to start, move the cursor 
while holding down the left button (drag the cursor) to the place in the 
drawing area where you want the bond to end and release the button. 
Multiple bonds are made by dragging over existing bonds.

1. position

2. drag

3. release
gives

1. position

2. drag

3. release

gives4. position
5. drag

6. release
1. position 2. drag 3. release

gives
5. drag 4. position6. release

To make a bond touch the screen where you want it to start, move 
one finger to where you want it to end and lift. Replace position by 

touch, drag by move and release by lift in the diagram above.

Manipulating a Sketch

To translate the sketch, move the mouse over the screen while holding 
down the right button. To rotate the sketch (in the plane of the screen), 
move the mouse up and down while holding down both the left button 
and Shift key. Use the scroll wheel to resize the sketch.

To translate the sketch, move two fingers over the screen. To rotate 
the sketch in the plane of the screen, twist two fingers on the screen. 

To resize the sketch, pinch (or spread) two fingers on the screen.
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Sketch Operations

Add an Atom, Ring, or Carbonyl Group. To add an atom, 
click on that atom’s icon. Position the cursor over the atom in 
the drawing that will connect to the new atom, drag it away and 
release the button. To add a common ring or carbonyl group, click 
on that ring’s (group’s) icon, position the cursor over the atom in 
the drawing that will connect to the new ring (group) and drag 
it away and release the button. The carboxylic acid/ester  and 
amide  icons contain an arrow that shows which atom in these 
groups will be connected to the existing drawing. To change the 
location of this connection point (arrow), click on the group’s icon 
until the arrow reaches the desired location.

Add Multiple Bonds. To add a multiple bond, first draw a single 
bond at the location where the multiple bond is needed, then either 
double click to increase the bond order, or redraw the bond once 
to make a double bond, and redraw it again to make a triple bond 
(in other words, position the cursor over one end of the bond, drag 
to the other end, and release the button).

Fuse Rings. Click on an icon for the first ring and double click 
on the screen. Next, click on the icon for the second ring and 
double click the bond that the rings will share. This will create a 
drawing with a fused bicyclic ring system. Note that the (cis or 
trans) stereochemistry of the ring juncture is ill-defined. This will 
be addressed later (Add Stereochemical Markers).

This technique can also be used to add rings to an existing bond in 
any drawing. Click on the icon for the ring to be added and double 
click on the bond that will become part of the ring.

Replace an Atom with Another. If a drawing contains atom A 
where atom B is needed, click on the icon for B, then double click 
on A in the drawing. This allows the drawing of heterocycles. 
First, draw an all-carbon ring and then replace specific carbons 
with heteroatoms.

Access an Element, Functional Group, or Ligand. Click on 
the icon underneath H and B (this icon will initially be labeled 
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with the name of the group that was previously selected (or with 
More if no previous selection was made) and will change each 
time you select a new moiety. A tabbed dialog initially displaying 
a Periodic Table results.

If instead of an element, a functional group is desired, click on the 
Groups tab, and then on a group from the dialog that results.

Finally, if a ligand is desired, click on the Ligands tab, and then 
a ligand from the dialog that results.
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An element, group or ligand defined in this way can be added to a 
drawing, replaced, or removed using the same drawing techniques 
used for standard atoms.

Add a Stereochemical Marker (Dash or Wedge). 3D information 
can be added to a drawing by replacing single bonds with 
stereochemical markers: dashes or wedges.

To use a marker, click either  or , then draw or (re-draw) the 
single bond. To reverse the orientation of the marker, re-draw the 
bond or marker in the opposite direction. One type of marker can 
be replaced directly by the other. Click on the desired marker and 
then re-draw the existing marker. Markers can also be converted 
back into single bonds. Click on , then double click on the 
marker.

For best results during 2D-to-3D conversion, all substituent bonds 
to rings should be drawn with stereochemical markers.

Add an Axial or Equatorial Marker (6-member rings only). 
The orientation of a hydrogen/substituent on a 6-member ring 
can be specified by marking one ring substituent as either 
ax(ial) or eq(uatorial). If the molecule contains multiple rings, 
the conformation of each ring can be specified by marking one 
substituent per ring. Axial or equatorial markers can only be added 
to stereochemical markers (dashes, wedge) so the bond connecting 
the substituent to the ring must be drawn with a stereochemical 
marker first.

To add an axial or equatorial marker to a stereochemical marker, 
click on either  or , then double click on the stereochemical 
marker. ax will appear on top of the stereochemical marker. To 
replace ax with eq, double click on the stereochemical marker 
again. To remove the marker, double click on the marker again.

Although it is possible to produce a drawing in which several 
bonds are marked as axial or equatorial, only one marker is used 
when converting a 2D ring drawing into a 3D model. 
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Assign Charges and Radical Sites. Formal charges and unpaired 
electrons can be assigned to individual atoms* using charge/
unpaired electron markers. To assign a positive formal charge to 
an atom, click on  and double click on the atom in the drawing. 
To assign a negative formal charge or unpaired electron, click on 
the charge/unpaired electron marker until the desired icon appears 
(tapping the marker rotates it through three possibilities: , , 
and ) and double tap the atom in the drawing.

To replace a charge/unpaired electron marker on an atom with a 
different marker, click on the desired charge/unpaired electron icon 
and double click the marked atom. To remove a marker, click on 

 and double click on the marker.

Charge/unpaired electron markers play an important role during 
the conversion of 2D drawings into 3D models in that they 
determine the number of hydrogens that need to be added to the 
model (it is usually unnecessary to draw hydrogens unless they 
are needed to mark stereochemistry).

Hydrogens are not shown in 2D perspective drawings unless they 
have been drawn explicitly (exceptions: hydrogens attached to 
neutral N, O, P, and S are shown). When a drawing is converted 
into a 3D model, hydrogens are added to the model according to 
conventional bonding rules. A neutral carbon atom is assumed to 
form four bonds, nitrogen three bonds, oxygen two bonds, and so 
on. Analogous logic is used for atoms that carry a formal charge 
or unpaired electron marker.

Charge and unpaired electron markers are carried over into 
specification of quantum chemical calculations (Calculations... 
from the Setup menu; Chapter 8). The total charge is set equal to 
the sum of the formal charges in the 2D drawing. A model with one 
unpaired electron is treated as a free radical (drawings that contain 
more than one unpaired electron may give unanticipated results).

*	 While convenient when sketching in 2D, the radical or charge is not actually located on 
an atom, rather the quantum chemical calculation will convey delocalization, this is best 
explored with graphical models. See Surfaces in the Display menu, Chapter 9.
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Undo the Last Action. Click on  to return to the drawing as it 
existed before the last action.

Clean Up a Drawing. Click on  to clean up a drawing, that is, 
to equalize bond lengths, bond angles, and so on. Clean up can 
improve the appearance of a 2D drawing, but not every clean up 
will produce a desirable result. To undo an unsatisfactory clean 
up operation, click on .

Remove an Atom or Bond. Click on  and then double click on 
the atom or bond. If you click an atom, all bonds to that atom will 
also be removed. Removing a bond, either by clicking on an atom 
or by clicking on the bond itself, will also remove terminal atoms, 
that is, atoms not connected to any other atoms in the drawing will 
be removed along with the bond.

Remove a Multiple Bond. To remove a multiple bond, click on 
 then double click on the multiple bond. This reduces the bond 

order by one. Repeated double clicks on a triple bond will reduce 
the bond order: triple → double → single → no bond.

Remove a Reaction Arrow. To remove a reaction arrow, click on 
 and double click on the reaction arrow.

Remove a Stereochemical Marker. Click on , then double 
click the marker. This replaces the marker with a single bond.

Change or Remove an Axial or Equatorial Label from a 
Stereochemical Marker. Tap either  or , then double click 
on the stereochemical marker where an axial or equatorial label 
appears. This cycles the label (in order) among ax (axial), eq 
(equatorial) and nothing. The stereochemical marker itself will 
not be affected.

Remove a Charge or Radical Marker. Click  on  and double 
click on the marker.

Clear the Screen. Click on . A warning message will ask you 
to confirm this operation.

A 3D structure is obtained from the 2D sketch by clicking on .
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3D Model Kits

Spartan Student provides four different model kits for assembling a 
variety of molecular systems: an organic model kit for most organic 
molecules, an inorganic model kit for organic molecules not well 
represented in terms of an uncharged (non-zwitterionic) valence 
structure, as well as inorganic and organometallic molecules, and 
model kits for polypeptides and polynucleotides. The organic and 
inorganic model kits utilize atomic fragments, functional groups 
and rings (and ligands in the inorganic model kit), while the peptide 
model kit uses the set of natural amino acids as building blocks, and 
the nucleotide model kit the set of nucleotide bases.

3D molecule construction in Spartan Student proceeds much in the 
same manner as a chemist would assemble a structure from a plastic 
model kit, that is, pieces are taken from the kit one at a time and added 
sequentially to the molecule under construction.

Organic Model Kit

The organic model kit contains a suite of molecule building/editing 
tools specifically designed to construct organic molecules.
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In the center of the model kit are a selection of atomic fragments, 
which from left to right and then top to bottom, correspond to:

 C(sp3) N(sp3) P(sp3) H
 C(sp2) N(sp2) O(sp3) F
 C(sp) N(sp) O(sp2) Cl
 C(aromatic) N(aromatic) S(sp3) Br
 Si(sp3) N(planar) S(sp2) I

A fragment is chosen by clicking on its icon, which is then 
displayed at the top of the model kit. Once selected, the fragment 
may be used to initiate building, to add alongside of an existing 
structure or appended onto an existing structure. To initiate 
building, double-click anywhere on screen. To add alongside of an 
existing structure, hold down the Insert key (option key on Mac), 
and then click anywhere on screen, or double click in a blank area 
on screen (no Insert or option key modifier required). To bond 
to an existing structure, click on a free valence (not an atom). 
(Free valences are colored yellow on the selected molecule.) 
Bond type in the case of atomic fragments with multiple bond 
types, for example, sp2 carbon, depends on the nature of the free 
valence selected.

While only H, C, N, O, F, Si, P, S, Cl, Br and I are available from 
the organic model kit, other elements may be substituted using atom 
replacement feature available in the inorganic model kit (see General 
Molecule Building Functionality later in this chapter). Similarly, bond 
types may be altered in the inorganic model kit.

Menus inside the model kit provide access to a number of pre-
built fragments corresponding to functional groups (Groups) and 
rings (Rings), and to additional libraries of rings (as well as any 
user-defined structures) stored in Spartan’s file system (More). 
The model kit also accesses the clipboard (Clipboard).
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	 Groups 

	 Clicking on Groups brings up a menu 
of groups, and displays an icon of one 
group in a box at the top of the model kit.

	 Once selected from the menu, a group 
may be used to initiate building, to 
add alongside of an existing structure 
on screen, or to add to an existing 
structure. 

	 The amide and carboxylic acid/ester 
groups have more than one different 
free valence. The free valence that is to 
be used is marked with a gold • (in the 
icon at the top of the model kit). The 

marked position circulates among the possible positions with 
repeated clicking on the icon.

	 Rings

	 Clicking on Rings brings up a menu 
of hydrocarbon rings, and displays an 
icon of one ring in a box at the top of 
the model kit.

	 Once selected from the menu, a ring 
may be used to initiate building, to 
add alongside of an existing structure 
on screen, or to add to an existing 
structure. A ring may be “fused” 
by double clicking on a bond in an 
existing ring. Note that the (cis or 

trans) stereochemistry of the ring juncture may need to be 
adjusted by inverting chirality (see discussion later in the 
chapter).

	 Cyclohexane, cycloheptane, naphthalene, anthracene, 
phenanthrene, indene and fluorene have more than one different 
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free valence. The one that is to be used is marked with a 
gold • (in the icon). The marked position circulates among 
the available positions with repeated clicking on the icon. 
Selection of an axial or equatorial free valence in cyclohexane 
and cycloheptane is indicated by the label ax or eq appearing 
alongside the icon. All rings in this menu are hydrocarbons, 
but heteroatoms may be substituted (see General Molecule 
Building Functionality later in this chapter).

	 More

	 This provides access to a broader selection of rings as well as to 
access user-defined entities (rings, groups, ligands, etc.). Upon 
initial entry, the menu to the right of More will be empty. It 
can be populated, by clicking on  to the far right. This brings 
up a file browser that has been set to point toward a Library 
directory containing documents of common rings.

		  nitrogen heterocycles	 saturated nitrogen rings
		  oxygen heterocycles	 saturated oxygen rings
		  sulfur heterocycles	 saturated sulfur rings
		  mixed heterocycles	 saturated mixed rings

 	 Clicking on a document followed by clicking on Open or 
double clicking on a document populates the menu to just 
under the 3D space at the top of the Model Kit. Menu entries 
are selected in the usual way. In response, a ball-and-wire 
model of the selected ring will appear in a box at the top of 
the model kit. This may be manipulated (rotated, translated, 
zoomed) using the usual mouse/keyboard commands (you need 
to position the cursor inside the box) or with the usual one and 
two-finger touch commands. The ring may be used to initiate 
building, to add alongside of an existing structure, or to add 
to an existing structure. In the latter case, the attachment point 
(on the ring in the window) needs to be identified by clicking 
on the appropriate free valence. 

	 Documents containing ligands, chelates and high-coordination 
fragments intended for use with the inorganic model kit 
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(discussed in the next section) are also available. In addition, 
any Spartan Student document may also be accessed.

	 Clipboard

	 Clicking on Clipboard accesses the clipboard. A ball-and-
wire model of whatever is on the clipboard is displayed in 
a box at the top of the model kit. This may be manipulated 
using the usual mouse/keyboard commands (you need to 
position the cursor inside the box or with the usual one and 
two-finger touch commands). Once selected, the contents 
of the clipboard may be used to initiate building, to add 
alongside of an existing structure, or to add to an existing 
structure. In the latter case, the attachment point needs to 
be identified by clicking on the appropriate free valence.

	 An empty clipboard will be signaled by:

	

Inorganic Model Kit

Spartan Student’s inorganic model kit allows construction 
of a much wider class of molecules (including inorganic and 
organometallic species) than possible from the organic model 
kit. Structures that violate conventional bonding rules may be 
constructed, as this model kit purposefully provides no bonding 
rule enforcement. The inorganic model kit is reached by selecting 
Inorganic from among the tabs at the top of the model kit.*

*	 Tabs may require too much vertical space on computers or tablets with very small screens. 
Alternative Builder Selection Methods are available in the Miscellaneous tab (Preferences 
from the Options menu; Chapter 10).
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Atoms may be selected by clicking on the selection bar near the 
center of the model kit. This brings up a full Periodic Table. 
Main-group elements are colored red, transition metals are colored 
green and lanthanides and actinides are colored blue. The Model 
menu inside the Periodic Table highlights elements for which the 
selected model is available.

Selecting an entry from this menu leads to recoloring of the 
Periodic Table. A light green color is used to indicate elements 
for which the selected model may be used. Immediately below is 
a selection of atomic hybrids.

Selection of atom type is accomplished by clicking on the 
appropriate element in the Periodic Table. The entry will be 
highlighted. Selection of an atomic hybrid follows by clicking 
on the appropriate icon which will then be highlighted.* This 

*	 Hybrids for a number of high-coordination centers are available as a library reachable from 
More (see discussion under Organic Model Kit).
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combination (atom type + atomic hybrid) may be used to initiate 
building, to add alongside of an existing structure or to append 
onto an existing molecular fragment. To initiate building, double 
click anywhere on screen. To add alongside of an existing structure, 
hold down the Insert key (option key on Mac) and click anywhere 
on screen, or double click in a blank area on screen. To bond to an 
existing fragment, click on the appropriate free valence.

Two of the hybrids (trigonal bipyramidal and square-based 
pyramidal) may bond either axially or equatorially. Selection 
of the appropriate bonding point, marked by a •, is effected by 
repeatedly clicking on the icon; the bonding point alternates 
between the two sites.

Atoms are connected with whatever bond type (partial single, 
single, aromatic, double, triple or quadruple) is selected from a 
menu near the bottom of the model kit. A bond type may be changed 
by first selecting a type and then double clicking on the bond. Bond 
types have no impact on quantum chemical calculations, but do 
affect molecular mechanics calculations which reference a Lewis 
structure (including minimization in the builder; see discussion 
later in this chapter).

No valence checking is performed in the inorganic model kit, and 
the user is free to construct any arrangement of atoms.

Menus under Groups, Rings and More are the same as those 
described for the organic model kit as is Clipboard. One additional 
fragment collection is provided:

	 Ligands
	 This provides access to a number of pre-built ligands, useful 

in the construction of inorganic and organometallic molecules. 
Its operation is analogous to that of the Groups and Rings 
menus. Clicking on Ligands brings up a menu of available 
ligands, and results in an icon of one ligand from this menu 
being displayed in a box at the top of the model kit.
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	 A ligand may be used to initiate building or to add alongside 
or to an existing structure. Additional ligands are accessible 
from More (see previous discussion). Ligands may also be 
built with the aid of ligand points (Define Ligand Point in the 
Geometry menu; Chapter 6).

To toggle the selection bar back to atom selection from the Periodic 
Table, click on one of the atomic hybrid icons.  

Peptide Model Kit

The peptide model kit available in Spartan Student is not intended 
to be used for constructing proteins (although this is actually 
possible). Rather, it is primarily intended to build idealized helix 
and sheet structures. Protein structures are best entered from the 
Protein Data Bank (see Access PDB Online... under the File 
menu; Chapter 3). A model kit for construction of polypeptides 
is accessed by selecting Peptide from among the tabs at the top 
of the model kit.
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At the middle of the peptide model kit are icons designating the 
amino acids (specified by their three-letter codes). An amino acid 
is selected by clicking on its three-letter code, the icon of the 
amino acid is displayed in the box at the top of the model kit. If 
the Sequence check box is selected, the three-letter code for the 
amino acid is appended to the sequence of codes in the box at the 
top of the model kit. Amino acids replace atoms, functional groups, 
rings and ligands as the building blocks in the peptide model kit. 
Because these other building blocks are missing, modifications 
of  peptides, aside from modifications in sequence and in overall 
conformation, need to be carried out using the organic or inorganic 
model kits.

There are two different modes of operation: single amino acid mode 
and polypeptide mode. The former is used to initiate building with a 
single amino acid, to add a single amino acid alongside of an existing 
structure or to add a single amino acid to an existing structure, while 
the latter is used to construct amino acid sequences (polypeptides).  
Sequence off (unchecked) corresponds to single amino acid 
mode, and on (checked) corresponds to polypeptide mode.

Peptide construction (Sequence on) is accomplished in three steps:
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	 Specify Amino Acid Sequence

	 This is accomplished by clicking in the desired order on the 
amino acid codes. Building occurs from the N end to the C 
end of the peptide. In response to each selection, the three-
letter code is appended to the sequence of codes in the box 
at the top of the model kit. The stereochemical configuration 
of the amino acid is by default the l configuration; this may 
be changed to the d configuration prior to selection of the 
amino acid, by checking d to the right of stereoisomer in 
the model kit. (It may be changed back to l by checking l). d 
amino acids are indicated by .d following the code in the box.

	 The sequence may be altered by changing the text in the box. 
Existing amino acid codes may be deleted or changed or new codes 
can be added. The entire sequence may be specified in this way 
if desired. Specification of a non-existent code will result in an 
error message. The sequence can be cleared by clicking on Clear.

	 Specify Macroscopic Structure

	 Once sequencing is complete, macroscopic structure (ψ and 
φ angles), is specified by clicking on one of α Helix, β Sheet 
or Other. In the case of the first two, preset angle values are 
displayed on the right. In the case of specification of Other, 
boxes appear, into which the desired dihedral angles need to 
be entered.

	 Terminate

	 The peptide is not yet terminated, and the two ends are still set 
up for addition of further amino acids.

	

O
C

*
C end

N
H

*
N end

	 where the * indicates a free valence. Clicking on Terminate 
at the bottom of the model kit leads to the Terminate dialog.
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	 C and N terminating groups may be selected by repeated 

clicking on the C and N icons, respectively. Selection will 
rotate among the available terminating groups. Clicking on OK 
removes the dialog and terminates the polypeptide. Clicking 
on Cancel or  removes the dialog but does not terminate 
the polypeptide.

The peptide (or single amino acid) may now be used either to 
initiate building, by double-clicking anywhere on screen or added 
alongside of an existing structure, by holding down the Insert 
key (option key on Mac) and clicking anywhere on screen, or 
by double clicking in a blank area on screen. If unterminated, it 
may also be joined onto an existing structure by clicking on a free 
valence. In the latter case, attachment is made from the N end, 
unless the free valence corresponds to an unterminated peptide 
fragment, in which case the appropriate end required to make an 
amide bond is used.

Nucleotide Model Kit

Finally, Spartan Student provides a model kit for construction of 
polynucleotides. It is reached by selecting Nucleotide from among 
the tabs at the top of the model kit.



Chapter 7	 181

At the middle of the model kit is a menu designating the type of 
polynucleotide.
   		  DNA
   		  DNA (single strand)
   		  RNA
   		  RNA (double strand)
   		  DNA-RNA
   		  RNA-DNA

Immediately above this menu are icons, designating the nucleotide 
bases. Selection of DNA, DNA (single strand) or DNA-RNA from 
the menu leads to one set of icons.

Selection of RNA, RNA (double strand) or RNA-DNA leads 
to a second set, the only difference is that uracil (U) has been 
substituted for thymine (T).

A nucleotide base is selected by clicking on its letter, following 
which either an icon of the base is displayed in the box at the top of 
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the model kit, or the letter for the base is appended to the sequence 
of letters in the box. Nucleotide bases replace atomic fragments, 
functional groups, rings and ligands as the building blocks in the 
nucleotide model kit. Because these other building blocks are 
missing, modifications of nucleotides, aside from modifications in 
sequence and helical structure, need to be carried out using either 
the organic or inorganic model kits.

There are two different modes of operation: single base mode and 
polynucleotide mode. The former is used to place a single base or 
base pair on screen, to add a single base or base pair alongside of an 
existing structure, or to add a single base or base pair to an existing 
structure, while the latter is used to construct strands of DNA or 
RNA (or mixed strands). Sequence off (unchecked) corresponds 
to single base (base pair) mode and on (checked) corresponds to 
polynucleotide mode.

Polynucleotide construction (Sequence on) is accomplished in 
two steps:

	 Specify Base Sequence 

	 This is accomplished by clicking in order on the base codes. In 
response to each selection, the letter code is appended to the 
sequence of codes in the box at the top of the model kit. The 
sequence may be altered by editing the contents of the box. 
Existing base codes may be deleted or changed or new codes 
added. The entire sequence can be specified in this way if 
desired. The sequence may be cleared by clicking on Clear.

	 Specify Helical Structure 

	 Once sequencing is complete, a helical structure may be 
specified by clicking on A or B. These correspond to A and B 
helices, respectively. Selecting Other allows user modification 
of  the rise (in Å) per base (Rise/Base) and twist (in degrees) 
per base (Twist/Base).

	 Note that the polynucleotide is not yet terminated, and the two 
ends are still set up for addition of further bases or base pairs.
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O

O

CH2OPO2

*

Base *

	 * indicates a free valence. Hydrogens occupy all free valences 
(except the *’ed positions at the two ends of the chain). 

	 The polynucleotide (or single base pair) may now be used to 
either initiate building, by double-clicking anywhere on screen, 
Add alongside an existing structure, by first holding down the 
Insert key (option key on Mac) and clicking anywhere on 
screen, or double clicking on a blank area on screen. Join onto 
an existing structure by clicking on a free valence. In the latter 
case, attachment is made from the phosphate end.

General Molecule Building Functionality

Additional capabilities are available with Edit Build selected:

Multiple Fragments

Multiple fragments may result either from bond breakage (see 
Break Bond later in this chapter) or from use of the Insert key 
(option key on Mac), or double clicking in a blank area on screen. 
A fragment is selected by clicking on it, following which the 
associated free valences are colored yellow (free valences for any 
non-selected fragments are colored white). Rotation and translation 
apply to the entire set of fragments, but may be made to apply to 
the selected fragment (only) by holding down the Ctrl key while 
carrying out these operations.

Fragments may be attached using Make Bond (see discussion 
later in this chapter).

Rotate/Stretch Bonds

In addition to molecule rotation, translation and scaling, the mouse 
is used to rotate about and stretch bonds not incorporated into rings. 
This is accomplished via the following sequence of operations:
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(i)	 Clicking on the bond, which is then marked by a red cylindrical 
arrow. (The bond connecting the last atom, group, ring or 
substituent added to the molecule is automatically selected.)

(ii)	 Bond rotation (only) follows from moving the cursor up and 
down inside the demarked area at the left of the screen while 
holding down the left button. Alternately, simultaneously 
holding down the Alt key (option key on Mac) and the left 
mouse button while dragging the mouse up and down, for 
bond rotation, or the Alt (option) key and the right mouse 
button for bond stretching. 

Replace Atom/Fragment

Another function of the mouse is atom replacement. This 
behaves differently in the organic and inorganic model kits. 
Double clicking on an atom (not a free valence) while an atomic 
fragment in the organic model is highlighted, replaces the atom by 
selected fragment. Free valences are adjusted to accommodate the 
replacement, for example, replacement of sp3 carbon by sp3 oxygen 
results in two free valences being removed. Atom replacements 
that violate valence rules or that would disrupt substituents are not 
permitted. Double clicking on an atom (not a free valence) while 
an element in the Periodic Table from the inorganic model kit is 
selected, replaces the atom by the selected element, that is, changes 
the atomic number. No changes in the number or arrangement of 
free valences is made, and no checking is done. Atom replacement 
is not applicable to the peptide or nucleotide model kits.

Invert Chirality

In the Edit Build mode, double clicking on a  chiral atom with the 
Ctrl key (Command key on Mac) depressed inverts the chirality 
of the atom (R→S or S→R). Double clicking on any atom with 
both Ctrl (Command key on Mac) and Shift keys depressed 
inverts the absolute configuration of the molecule.
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Replace click with tap and double click with double tap for multiple 
fragment, fragment replacement and chirality inversion. One finger 

movement up and down the shaded area at the left of the screen results 
in rotation about the marked bond.

Building/Editing Menu Functions

Molecule building/editing functions are found under the Build menu. 

Icons for Delete, Make Bond, Break Bond and Minimize are also 
found at the bottom of the model kit. They may also be included in 
the icon toolbar at the top of the screen.

View ( )

This exits build mode, and removes the model kit from the screen 
and also adds hydrogens to any open valences (one does not need 
to explicitly add hydrogens).

Initial entry into the 3D builder is by way of New Build or Build 
New Molecule under the File menu (Chapter 3). Edit Build, Delete, 
Make Bond, Break Bond and Minimize are for modifying existing 
structures.

Edit Build ( )

In addition to the capabilities discussed under General Molecule 
Building Functionality, this allows access to the libraries of 
atomic fragments, groups, rings, ligands and substituents, as well 
as the file system and the clipboard. Clicking on any buttons or 
menus in the organic, inorganic, peptide, nucleotide or substituent 
model kits, leads to Edit Build. (If a model kit is not already 
on screen, selection brings up the last-accessed model kit.) A 
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fragment may be used to initiate building by double-clicking 
anywhere on screen, to add alongside an existing structure on 
screen by holding down  the Insert key (option key on Mac) and 
by clicking anywhere on screen, or by double clicking in a blank 
area on screen, or be added to an existing structure by clicking on 
the appropriate free valence. Fragment addition can be terminated 
by selection of any other function.

Edit Sketch ( )

This allows a 2D sketch to be modified in the 2D sketcher after it 
has been converted to a 3D structure. Edit Sketch is unavailable 
when the existing 3D molecule contains more than 250 atoms.

Delete ( )
This allows atom and free valence removal from a structure. 
Selection leads to a message at the bottom left of the screen.

Subsequent clicking on an atom or free valence results in its deletion. 
Deletion of an atom results in deletion of all of its associated free 
valences. Free valences for any atoms to which the deleted atom 
was previously connected are restored. Note that atom deletion 
may result in one or more detached fragments. Selection of Delete 
does not bring up a model kit nor does it remove a model kit that 
is present on screen. Delete is (by default) a one-time operation. 
Double-clicking on the Delete icon will hold the delete mode open 
until the user selects another mode (for example  to View, or 

 to return to Edit Build).

Delete is also used to delete points and planes.

Deletion may also be accomplished by holding down on the Delete 
key (on the keyboard) while clicking on the item to be deleted. 
This mode (also) allows multiple deletions.
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Make Bond ( )
This allows bonds to be drawn between free valences and/or atoms. 
Selection leads to a message at the bottom left of the screen.

Clicking on two free valences (on different atoms) will cause 
these atoms to be linked by a single bond. Alternatively, double 
clicking on each of two atoms will bond them, and clicking on a 
free valence on one atom and double clicking on a different atom 
will bond the two atoms. Note that available free valences are 
consumed as a result of bond formation, irrespective of whether 
free valences or atoms are selected.* If the selected atoms are 
already bonded, this will result in the bond order being increased 
by one, that is, single → double, double → triple. Selection of 
Make Bond does not bring up a model kit nor does it remove a 
model kit that is already present on screen. Make Bond may be 
terminated by selection of any other function.

Break Bond ( )
This allows breaking an existing bond resulting in free valences. 
Selection leads to a message at the bottom left of the screen.

Clicking on a bond breaks it and restores free valences. Note that 
bond breaking may result in detached fragments. Selection of 
Break Bond does not bring up a model kit nor does it remove a 
model kit that is present on screen. Break Bond may be terminated 
by selection of any other function. 

Replace click with tap and double click with double tap for delete, 
make bond and break bond operations.

*	 Free valences can be protected without altering the molecule by adding hydrogens to them 
(  from the organic model kit).
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Minimize ( )

This uses molecular mechanics to refine the geometry. Selection 
leads to a message at the bottom left of the screen.

The molecular mechanics energy* in kJ/mol, displayed at the 
bottom right of the screen, is continually updated during the 
minimization process. Minimization may be stopped at any time 
by clicking on the  icon at the bottom right of the screen. Any 
geometrical constraints imposed on the structure (see Constrain 
Distance, Constrain Angle, Constrain Dihedral under the 
Geometry menu; Chapter 6) are enforced during minimization. 
Also, any frozen atoms in the structure (see Freeze Center under 
the Geometry menu; Chapter 6) remain frozen. 

Guess Transition State ( )

Spartan Student provides a facility for automatically guessing 
the geometries of transition states based on the similarity of the 
reaction of interest with one or more entries in Spartan Student’s 
reaction database. Where an exact match is not available, Spartan 
Student will attempt to provide as close a match as possible. This 
will generally involve a less substituted system or one in which 
substituents differ. Here, the procedure is to use those parts of the 
structure of the transition state in the database that are common, and 
to optimize the remaining parts (using molecular mechanics).

It may be essential for the reactants to be properly oriented to reflect the 
desired stereochemical outcome of the reaction.

Where a reaction is completely unknown to the database, a fallback 
technique (the linear synchronous transit method) is automatically 
invoked.

*	 The mechanics energy is a combination of the strain energy which is either zero or positive and 
the non-bonded or intramolecular interaction energy which can be either positive or negative. 
It will most commonly be a positive quantity, although it can be slightly negative.
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Input to Spartan Student’s transition-state guessing procedure will 
be familiar to organic chemistry students (and organic chemists), in 
that it is based on reaction arrows. The reaction is specified using 
curved arrows, where each arrow identifies the movement of one 
electron pair. The direction of electron flow follows customary 
practice:

source of 
electron pair

destination of
electron pair

There are two possible sources of an electron pair and three possible 
destinations, leading to six combinations:
lone pair → lone pair	 move lone pair
lone pair → bond	 use lone pair to increase bond order
lone pair → space between atoms	 use lone pair to make a new (single) 

bond
bond → lone pair	 decrease bond order to make lone 

pair
bond → bond	 decrease bond order of one bond to 

increase bond order of another bond
bond → space between atoms	 decrease bond order to make a new 

(single) bond
The first of these is a null operation, and its inclusion has no effect.

Selecting Guess Transition State results in a message at the bottom 
left of the screen.

The tail of the arrow corresponds to the source of the electron pair. 
If the source is a lone pair, then select (click on) the atom that holds 
the lone pair. If the source is a bond, then select (click on) the bond. 
Clicking on an atom or bond highlights (colors gold) the atom or bond 
and leads to a new message at the bottom left of the screen. Clicking 
again on the same atom or bond deselects (de-highlights) it and leads 
back to the first message.
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The head of the arrow corresponds to the destination of the electron 
pair. If the destination is an atom (leading to a lone pair), then select 
(click on) the atom that will hold the lone pair two times. If the 
destination is an existing bond (leading to an increase in bond order 
from single → double → or double → triple), then select (click on) 
the bond. If no bond presently exists, then select (click on) the two 
atoms that will become bonded upon reaction. These operations result 
in a curved arrow being drawn on the reactant structure. This extends 
from an atom, or the center of a bond to an atom, or the center of a 
bond, or the center of a dotted line that has been drawn between atoms 
that are to be bonded. The original message returns to the bottom left 
of the screen.

The process (tail selection followed by head selection) is repeated  
as necessary to fully define the reaction. Incorrect reaction arrows may 
be removed by selecting Delete from the Build menu ( ) followed 
by clicking on the arrow to be deleted. You can also use the Undo 
feature ( ). Alternatively, click on the arrow(s) to be deleted while 
holding down the Delete key on your keyboard.

After all reaction arrows have been properly designated, click on the 
Search Transition State icon ( ) at the bottom right of the screen 
to replace the reactant with a guess at the transition state. In the event 
that the guess is unreasonable, this operation may be undone with 
the Undo feature ( ). This allows you to review your assignment 
of arrows and make changes as needed.

Examples

Diels-Alder reaction of 1,3-butadiene and ethylene

c

a

b

a, b. double bond to empty space leading to a single bond and to 
a new single bond
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c. double bond to single bond leading to a single bond and a 
double bond

SN2 reaction of chloride and methyl iodide
a b

C I Cl C l–Cl–

a.	 atom to empty space leading to a new single bond 
b.	 single bond to an atom leading to the loss of the single bond

Ene reaction of 1-pentene
a
H H

+
cb

a.	 single bond to empty space leading to loss of the single bond 
and to a new single bond

b.	 double bond to single bond leading to a single bond and a 
double bond

c.	 single bond to single bond leading to loss of the single bond 
and to a double bond

Ring closure of 1-hexenyl radical to methylcyclopentyl radical
b

a
•

•

a.	 atom to empty space leading to a new single bond
b.	 double bond to an atom leading to a single bond
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Chapter 8
The Setup Menu

This chapter describes functions available under the Setup menu. 
Calculations... is used to specify MMFF molecular mechanics 
calculations, PM3 semi-empirical molecular orbital calculations, 
Hartree-Fock molecular orbital calculations, B3LYP, EDF2, and 
wB97X-D density functional calculations, MP2 and T1 thermochemical 
recipe calculations. Tasks include calculating energy, equilibrium 
geometry, equilibrium conformation, conformer distribution, and 
transition-state geometry, enumerating accessible conformers and 
constructing energy profiles. STO-3G, 3-21G, 6-31G* and 6-311+G** 
basis sets are provided for Hartree-Fock calculations and 6-31G* 
and 6-311+G** basis sets for B3LYP, EDF2, wB97X-D and MP2 
calculations. Hartree-Fock and density functional calculations may 
be carried out in solvent as well as in the gas. Not all methods are 
applicable to all tasks. Calculations... also optionally requests IR 
and NMR spectra, QSAR properties.

Surfaces is used to designate graphical surfaces, including electron 
and spin densities, electrostatic potentials, local ionization potentials 
and molecular orbitals, for later display as surfaces, property maps 
and contour plots. Inaccessible regions on electron density surfaces 
and property maps based on these surfaces may be demarked.

Submit is used to initiate calculation.

Calculations... ( )

The MMFF molecular mechanics model, the PM3 semi-empirical 
molecular orbital model, Hartree-Fock molecular orbital models, 
B3LYP. EDF2 and wB97X-D density functional models and MP2 
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Møller-Plesset models are available to calculate energy, equilibrium 
geometry and make energy profiles. All models except MMFF are 
available for calculating transition state geometry. The MMFF 
molecular mechanics model is also available to calculate equilibrium 
conformation or conformer distribution. STO-3G, 3-21G, 6-31G* and 
6-311+G** basis sets are available for Hartree-Fock calculations and 
6-31G* and 6-311+G** basis sets for B3LYP, EDF2, wB97X-D and 
MP2 calculations. The T1 recipe (although including an equilibrium 
geometry task) is only available when the task specified is an energy 
calculation.

Hartree-Fock and density functional calculations, aside from NMR 
calculations, may be carried out in solvent according to the C-PCM 
model.

Quantum chemical calculations also provide atomic charges, IR and 
NMR spectra. IR spectra are available for all models but NMR spectra 
are only available for Hartree-Fock or density functional models.

Selection of Calculations... results in the Calculations dialog.

This contains pull-down menus, buttons and check boxes:

Calculate

This section is used to specify the task to be accomplished, 
theoretical model to be employed and spectra to be supplied.

Specification of a task is by way of a pull-down menu:
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Energy specifies calculation of energy (and in the case of quantum 
chemical methods, a wave function) at a single geometry. 

Spartan Student reports energies from molecular mechanics calculations 
in kJ/mol, from semi-empirical calculations as heats of formation in 
kJ/mol, and from Hartree-Fock, B3LYP, EDF2, wB97X-D and MP2 
calculations as total energies in atomic units (hartrees).

The molecular mechanics energy comprises two parts: the strain energy 
and the non-bonded energy. The strain energy is the difference in energy 
between a molecule and its “strain free” analog. It is nearly always positive 
and less than a few hundred kJ/mols in magnitude. The non-bonded energy 
accounts for attraction or repulsion between atomic centers that are not 
connected due to van der Waals and Coulombic interactions. Because the 
strain energy of every molecule relates to a different standard, molecular 
mechanics energies cannot be used to obtain reaction energies (unless 
there are no changes in bonding between reactants and products).

The heat of formation is to the enthalpy at 298K of a balanced chemical 
reaction in which a molecule is converted to a set of standard products. 
For example, the heat of formation of ethylene is given by reaction,

C2H4 + → 2C (graphite) + 2H2 (gas)
where graphite and hydrogen molecule are the carbon and hydrogen 
standards, respectively. In practice, the actual measurement is typically 
carried out for a combustion reaction, for example, for ethylene:

C2H4 + 3O2 → 2CO2 + 2H2O
Heats of formation may be either positive or negative quantities and 
generally span a range of only a few hundred kJ/mol.

Heats of formation are not suitable for presenting energy data from 
quantum chemical calculations, simply because the standards for several 
important elements (most notably, carbon) are not well-defined isolated 
species. In its place is the energy of a reaction that splits a molecule into 
isolated nuclei and electrons, for example, for ethylene:

C2H4 → 2C+6 + 4H+ + 16e–

Total energies, as the energies of such reactions are termed, are always 
negative and may be very large (tens of thousands of kJ/mol). They are 
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most commonly given in atomic units (hartrees).

1 atomic unit = 2625 kJ/mol

It is possible to relate total energies to heats of formation by incorporating 
data on atomic species. Heats of formation reported from T1 calculations 
(part of the information provided in Spartan Student’s database) relate 
directly to experimental heats and are given in kJ/mol.

To summarize, the heat of formation differs from the total energy both with 
regard to the standard reaction and with regard to units. Either provides 
a suitable basis for thermochemical calculations.

Equilibrium Geometry specifies that the nearest energy minimum 
will be located, Equilibrium Conformer specifies that the lowest 
energy conformer will be located and Transition State Geometry 
specifies that the nearest transition state (energy maximum in one 
dimension and energy minima in all other dimensions) will be 
located. Energy Profile steps along user-defined coordinates.

Except for Equilibrium Conformer and Conformer Distribution, 
a theoretical model needs to be specified by way of pull-down 
menus. (Equilibrium Conformer and Conformer Distribution 
are limited to MMFF Molecular Mechanics.) The first provides a 
choice among different classes of models.

Selection of Molecular Mechanics leads to a single method, 
MMFF. Selection of Semi-Empirical leads to a single method, 
PM3. Selection of Hartree-Fock leads to a second menu of 
available basis sets.

Selection of either B3LYP, EDF2, wB97X-D or MP2 leads to an 
abbreviated menu of available basis sets.
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Transition State Geometry is not available for Molecular 
Mechanics. Use of solvent is available for Hartree-Fock and 
Density Functional models.

Spectra

If checked, Infrared Spectra calculates vibrational frequencies 
and intensities together with the corresponding vibrational 
modes. These are available in the output (Output under the 
Display menu; Chapter 9) along with zero-point energies and 
thermodynamic properties (enthalpies, entropies, heat capacities 
and Gibbs energies). Vibrational motions (normal modes) may 
be animated and an IR spectrum displayed from the IR dialog 
accessible from Spectra under the Display menu (Chapter 9). 
Frequency calculations involving MP2 models are very costly in 
terms of computation and are not recommended.

Infrared frequencies from B3LYP/6-31G*, EDF2/6-31G*, and 
wB97X-D/6-31G* calculations have been uniformly scaled to 
account for known systematic errors. Calculated frequencies from 
all other models have not been scaled. The lines in the calculated 
infrared spectrum obtained from all models have been broadened 
to account for the fact that the calculations correspond to 0K, 
whereas experimental measurements are carried out at finite 
temperature.

If checked, NMR Spectra specifies that NMR chemical shifts 
will be calculated. These are then available in the output (Output 
under the Display menu; Chapter 9) as well as from the Atom 
Properties dialog (Display menu) and as atom labels (Configure... 
under the Model menu; Chapter 5). 13C (proton decoupled) and 1H 
spectra may be displayed from the NMR Spectra pane accessible 
from Spectra under the Display menu (Chapter 9)*. For density 
functional calculations with the 6-31G* basis set, 13C, chemical 

*	 Chemical shifts for other nuclei are available in the Output dialog (Output under the 
Display menu) and may also be attached as labels (Configure... under the Model menu; 
Chapter 5).



Chapter 8	 197

shifts have been empirically corrected for local environment. 
Line intensities are assumed to be proportional to the number 
of equivalent carbons or hydrogens. Three-bond HH coupling 
constants for 1H spectra are estimated empirically and these have 
been used to simulate splitting patterns.

If checked, UV/vis specifies that a UV/vis spectrum will be 
calculated based on the following procedure: energy calculations 
at the ground state and the first twenty (20) excited states are 
performed using time dependent density functional theory, 
specifically B3LYP/6-31+G*. Corresponding wavelength and 
intensity data are used to generate a calculated UV/visible spectrum.

QSAR

If checked, calculates a number of wave function-based properties 
accessible from the QSAR tab in the Molecular Properties dialog 
(Chapter 9).

Total Charge

Total charge. The default setting (Neutral) may be changed either 
by clicking on , and selecting Anion, Dianion, -3, etc. from the 
menu, or by typing a number in the. Total Charge is ignored for 
molecular mechanics calculations.

Unpaired Electrons

The number of unpaired electrons. The default setting (0) may 
be changed either by clicking on , and selecting 1 or 2 from the 
menu, or by typing in the menu. Unpaired Electrons is ignored 
for molecular mechanics calculations.

Global Calculations

If checked, signifies that settings in the Calculations dialog are 
to be applied to all molecules in the document.

The Calculations dialog may be exited by clicking on Submit, 
Cancel or OK at the bottom right of the dialog, or on  at 
the top. (Submit and OK are not available if the job is already 
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executing.) Clicking on OK or on Submit overwrites any previous 
information. Additionally, Submit enters the job in the execution 
queue (see discussion later this chapter). Clicking on Cancel or on 

 exits the Calculations dialog without saving any changes.

Calibrate/Est. Time

The Calibrate feature runs a single back-end calculation that 
should take no more than 30 seconds. This is compared against 
a reference calculation and is used to provide an estimate of how 
long a specified calculation will take. Once calibrated, all future 
specified calculations will include an Est. Time.

Surfaces ( )

Spartan Student allows graphical display of the HOMO and LUMO 
among other molecular orbitals, the electron density, the spin density 
for molecules with unpaired electrons, the electrostatic potential and 
the local ionization potential.

The electron density is the number of electrons found at a point in space. 
It is the quantity measured in an X-ray diffraction experiment that is 
then used to locate atomic positions, that is, most electrons are closely 
associated with atoms. While the electron density is non-zero everywhere, 
it is possible to define surfaces of constant density. The most important 
of these contains most of a molecule’s electrons and that roughly 
corresponds to a space-filling model, that is, a van der Waals surface. 
We will refer to this as the electron density. It is interesting because it 
reveals overall molecular size and shape and demarks the steric barrier 
seen by encroaching molecules. Another important surface, that we will 
refer to as the bond density, contains fewer electrons in total and demarks 
atomic connectivity.

The spin density is the difference in the number of electrons of α and β 
spin at a point in space. It indicates the location of the unpaired electron 
in a radical or unpaired electrons in a triplet. 

The electrostatic potential is the energy of interaction of a positive 
charge with a molecule. This assumes a fixed electron distribution for the 
molecule. It represents a balance between repulsive interactions involving 
the positively-charged nuclei and attractive interactions involving the 
negatively-charged electrons. Regions where the balance tips toward 



Chapter 8	 199

attraction are said to be electron rich (basic) and subject to attack by 
electrophiles, while regions where the balance tips toward repulsion are 
said to be electron poor (acidic) and subject to attack by nucleophiles. 
Electron-rich regions such as lone pairs are typically located outside 
the van der Waals surface. As such, they may be easily identified by 
constructing a surface of negative (attractive) electrostatic potential. 
While interesting electron-poor areas such as acidic hydrogens also 
lie outside the van der Waals surface, the electrostatic potential is also 
positive (repulsive) throughout the region inside this surface.

The local ionization potential indicates the ease or difficulty of electron 
removal (ionization). Like the negative regions of the electrostatic 
potential, regions of low local ionization potential are likely to be subject 
to attack by electrophiles.

Note that neither electrostatic potential nor the local ionization potential 
are experimental observables, although they relate to quantities that can 
be given clear chemical interpretation.

Additionally, any one of the quantities listed above (except the electron 
density) may be mapped onto any surface (except a molecular orbital 
surface). In practice, the only maps to have received widespread 
attention are those based on the electron density surface (depicting 
overall molecular size and shape). Most common are the electrostatic 
potential map, the local ionization potential map and the LUMO map. 
Some regions of an electron density surface are inaccessible and are not 
available for interaction with their environment (or with an incoming 
reagent). Spartan Student allows these regions to be identified.*

The electrostatic potential map paints the value of the electrostatic 
potential onto an electron density surface. By convention, colors 
toward red depict negative potential, while colors toward blue depict 
positive potential, and colors in between (orange, yellow, green) depict 
intermediate values of the potential. Thus, an electrostatic potential map for  
p-tert-butylphenol will show oxygen to be red, its attached (acidic) 
hydrogen to be blue, the π faces of benzene to be orange or yellow and 
the tert-butyl group to be green. 

*	 A region on a density surface is designated as inaccessible if a sphere of radius 1.0 Å 
centered on a line normal to the surface and touching a point in the middle of the region, 
impinges on any other regions of the density surface. The sphere radius may be changed in 
the Settings tab (Preferences under the Options menu; Chapter 10).
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The main advantages of this presentation relative to separate electron 
density and electrostatic potential surfaces are its clarity and its 
compactness. A disadvantage is that it provides information only about 
the contact surface and does not reveal how far electron-rich and electron-
poor areas extend beyond the surface.

An alternative to an electrostatic potential map, referred to as an exposed 
electrostatic potential surface, is a composite of three different surfaces: 
an electron density surface depicting overall molecular size and shape, a 
negative electrostatic potential surface identifying electron-rich regions 
and a positive electrostatic potential surface identifying electron-
poor regions. These surfaces need to be generated and then displayed 
simultaneously. The electron density may either be displayed as an opaque 
solid or as a transparent solid (in order that the molecular skeleton may be 
seen inside). The two potential surfaces are best represented as transparent 
solids, the negative surface colored red and the positive surface colored 
blue. The exposed electrostatic potential surface for p-tert-butyl phenol 
is shown below.

Note that the exposed electrostatic potential surface provides the same 
information as the electrostatic potential map. Red areas in the map 
correspond to regions when the negative electrostatic potential surface is 
likely to protrude from the electron density while blue areas correspond 
to regions where the positive electrostatic potential surface is likely to 
stick out. 

The local ionization potential map paints the value of the local ionization 
potential onto an electron density surface. By convention, colors toward 
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red indicate low ionization potential, while colors toward blue indicate 
high ionization potential. Thus, the local ionization potential map for 
aniline shows that the ortho and para ring positions have a lower ionization 
potential than the meta positions, consistent with the known directing 
ability of an amino group in electrophilic aromatic substitution.

The |LUMO| map paints the absolute value of the lowest-unoccupied 
molecular orbital (the LUMO) onto an electron density surface. By 
convention, colors near blue indicate high concentration of the LUMO, 
while colors near red indicate low concentration. Given that the LUMO 
designates space available for a pair of electrons, a |LUMO| map indicates 
where nucleophilic attack would likely occur. For example, a |LUMO| 
map for cyclohexenone shows concentration in two regions, one over 
the carbonyl carbon and the other over the β carbon, consistent with both 
carbonyl addition and Michael (conjugate) addition.

The spin density map paints the value of the spin density onto an electron 
density surface. By convention, colors near blue indicate high concentration 
of spin density, while colors near red indicate low concentration. For 
example, a spin density map for the radical resulting from loss of 
hydrogen from 3,5-di-tert-butylhydroxytoluene (BHT) shows that the 
spin has delocalized from oxygen onto the ortho and para ring positions.
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This radical would be expected to be particularly stable, which explains 
why BHT acts as an antioxidant (scavenging less favorable localized 
radicals).

Surfaces (including those underlying maps) connect points of equal 
value (they are isosurfaces), and may be displayed as an arrangement 
of dots, a mesh, or an opaque or translucent solid. Examples of 
graphical output in orthogonal projection are provided in Figure 
8-1. Surfaces (and maps) may also be rendered in perspective (see 
Chapter 5) and in stereo (see Chapter 2).

Calculated quantities may also be displayed as two dimensional 
contour plots (slices). Unlike surfaces and maps, these can be 
translated, rotated and zoomed independently of the molecular 
skeleton. An example of a slice display is provided in Figure 8-1.

Several different surfaces, maps and slices may be simultaneously 
displayed. In addition, any of the usual structure models may be 
displayed along with the graphic. The total display can become very 
complex, and selective use of meshes and/or translucent solids (as 
opposed to opaque solids) may facilitate improved visualization.

Selection of Surfaces leads to the Surfaces dialog.
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showing bonding in the transition state.

showing hydrogen bonding.

showing interaction of the HOMO of 
1,3-butadiene and the LUMO of ethylene. 

showing overall molecular size and shape.

Frontier orbitals for a symmetry-allowed 
Diels-Alder reaction,

Space-filling model and electron density 
surface of cyclohexanone,

Electron density surface (0.08 electrons/
au3) of transition structure for pyrolysis 
of ethyl formate,

Electrostatic potential surfaces (-40 kJ/
mol) of trimethylamine (left) and dimethyl 
ether (right),

Electron density slice for acetic acid 
dimer,

Figure 8-1: Examples of Graphical Displays Available in Spartan Student

showing accessibility for nucleophilic at-
tack.

Simultaneous display of the LUMO 
and the electron density surfaces of 
cyclohexanone,

showing the lone pairs on nitrogen 
and oxygen, respectively.
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This contains a box at the top for listing requested surfaces and 
property maps. 

Common Surfaces and Property Maps

Add at the bottom of the dialog is used to specify a number of 
commonly-used graphical surfaces and property maps*. Clicking 
on it leads to a menu.

 
 Selection of all but the last entry in the menu leads to a request 

for the analogous surface or map. A surface and property map 
specified from this menu will be calculated at medium resolution 
and will assume a fixed isovalue unless a different resolution has 
been selected and/or an adjustable isovalue has been requested. 

More Surfaces
 Additional surfaces and maps or the same surfaces or maps 

at different resolution and with adjustable isosurfaces may be 
requested by selecting More Surfaces... from the menu (or by 
clicking on More Surfaces... at the bottom of the Surfaces dialog). 
This leads to the Add Surfaces dialog that contains three menus 
and a check box:

* Additional selections are provided if the molecule has unpaired electrons.
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Surface  

Available surface types appear under the Surface menu.

 Density is the total electron density which may be used to reveal 
bonding as well as overall molecular size and shape, HOMO{-}, 
HOMO, LUMO, LUMO{+}, SOMO* are molecular orbitals, 
potential is the electrostatic potential, ionization is the local 
ionization potential and spin density* is the spin density.

 Selection of HOMO{-} and LUMO{+} results in display of a box 
to decrement the HOMO and increment the LUMO. This allows 
any molecular orbital to be specified..

 

 Slice designates that a plane will cut through the graphic defined 
by Property.

 Property  

 Properties for maps appear in the Property menu.

*	 These menu entries appear only for molecules with one or more unpaired electrons.
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 Available properties are the molecular orbitals (HOMO{-}, 

HOMO, LUMO, LUMO{+}, SOMO*), the electrostatic potential 
(potential), the local ionization potential (ionization) and the spin 
density (spin density)*. none indicates that no property is to be 
mapped onto the surface). As with Surface above, selection of 
HOMO{-} and LUMO{+} leads to a decrement (increment) box.

 A Spin button will be displayed if Unpaired Electrons (in the 
Calculations dialog) is set to a value other than 0, and if HOMO{-}, 
HOMO, LUMO or LUMO{+} has been selected for Surface or 
for Property. Clicking on Spin toggles it between Alpha and Beta. 
Alpha designates that the molecular orbital either to be displayed 
as a surface or mapped as a property corresponds to α spin; 
Beta designates that the molecular orbital corresponds to β spin.

 Resolution 

 Selection of surface resolution is from the Resolution menu.

 	
High resolution is desirable for surfaces based on percentage 
enclosure. Both calculation time and disk storage increase 
significantly in moving from medium to high resolution.

 Isovalue 

 Checking the box to the left of Fixed specifies calculation of a 
surface with fixed isovalue. In the case of a density surface, the 
default value of 0.002 electrons/bohr3 corresponds roughly to 
enclosure of 99% of the total number of electrons and closely 
resembles a space-filling model. Fixed surfaces take less time to 
compute and require less storage.
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Following Surface, Property, Resolution, Isovalue and (optionally) 
spin selection, clicking on OK adds the requested surface to the list 
and removes the (Add Surfaces) dialog. Clicking on Apply adds the 
requested graphic to the list but leaves the dialog on screen. Clicking 
on Cancel does not add a graphic to the list but removes the (Add 
Surfaces) dialog.

The process (clicking on Add..., followed by selection from the menu 
or clicking on More Surfaces... followed by selection of surface, 
property, resolution and isovalue and clicking on OK or Apply) may 
be repeated as required.

An existing surface may be deleted from the list by first highlighting 
(clicking on) it and then clicking on Delete.

Global Surfaces

If checked, signifies that the requested surfaces will be calculated for 
all members of the list.

Only one copy of the Surfaces dialog may appear on screen, and any 
actions relate to the currently selected molecule. The dialog may be 
removed by clicking on .

Submit ( )

Following setup of a molecular mechanics or quantum chemical 
calculation, including any requests for spectra and/or graphical 
displays, the required calculations will begin when Submit is selected. 
If the job has not previously been saved or submitted, selection of 
Submit triggers a request for a name. If the document contains only 
a single molecule and that molecule exists in the Spartan Spectra 
and Properties Database, the name in the database will be presented 
as a default name. Otherwise, the default name presented will be 
spartan for the first job and spartanx (where x is an integer starting 
with 1) for all successive jobs. After a name has been provided (or 
the document is saved) a dialog appears indicating that the job has 
actually been submitted.*

*	 The job is submitted to a job queue and will begin when released from this queue. See 
Monitor under the Options menu (Chapter 10) for discussion.
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The message will close after 5 seconds, or you may click on OK 
to remove it. After a job has started, and until it has completed, all 
associated files will be designated read only.

Another dialog appears following completion of a calculation.

Click on OK to remove it.

Upon completion, an energy profile calculation leads to an additional 
document being created for each molecule in the original document. 
These new documents are named document.Prof.spartan where 
document is the name given to the original document . A query dialog 
is provided asking whether the resulting document is to be opened. 
Similarly, upon completion of a conformer distribution calculation, 
a new document named document.Conf.spartan is created, and a 
prompt to open is provided.
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Chapter 9
The Display Menu

Functions available under the Display menu provide for text, dialog, 
spreadsheet and graphical displays. Functions are also available to 
query a variety of on-screen objects, display both calculated and (if 
available) experimental IR and NMR spectra, animate vibrational 
motions, prepare plots from spreadsheet data and calculate reaction 
energies.

Output ( )

Selection of Output opens a window:

Tabs at the top left of the window select the type of output.



210	 Chapter 9

Summary provides a brief summary of the calculated data, in 
particular, the energy and any spectral quantities. Output provides 
standard text output. Verbose Output contains more detailed output, 
but is eliminated upon normal completion unless Keep Verbose is 
checked in the Settings tab (Preferences under the Options menu; 
Chapter 10). Molecule Reference provides the literature reference 
for data retrieved from the PDB. Job Log contains diagnostic 
information.
The contents of the output window may be scrolled and may be paged 
up or down by clicking above or below the scroll bar. The contents 
may be printed or copied by right clicking inside the Output window 
and selecting Print or Copy from the menu that results. Similarly, 
copying is accomplished by selecting Copy from the Edit menu when 
an output is selected. Find... and Find Next functions from the Edit 
menu are also available.

Only one output window is associated with each document, and 
changes focus as different molecules from the document are selected. 
Output windows for different documents may be simultaneously open 
on screen. An output window may be closed by clicking on .

Output for jobs that are executing may be viewed using the Monitor 
under the Options menu (Chapter 10).

Properties ( )

Spartan Student provides specialized dialogs for reporting (and in 
some cases changing) the properties of molecules, atoms, bonds, 
surfaces and constraints. For plots brought into the main Spartan 
Student window from the spectra and plot panes, Properties may 
be used to change default plot styles, limits and fitting functions. 
Only one Properties dialog may be open, and this refers either to 
the selected molecule (Molecule Properties), or to the selected 
component (atom, bond, etc.) or attribute (spectra, graphical surface, 
constraint, etc.) of the selected molecule (Atom Properties, Bond 
Properties, Surface Properties, etc.), or to a plot (Plot Properties, 
Curve Properties, etc.), or fitting function (Regression Properties). 
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Selection of a different molecule leads to the Molecule Properties 
dialog for that molecule. Dialogs that refer to components/attributes 
of the (newly selected) molecule follow by clicking on the component/
attribute.

With the Molecule Properties dialog on screen, clicking on a 
component/attribute brings up the appropriate Properties dialog. For 
example, clicking on an atom brings up the Atom Properties dialog. 
Clicking on a different component/attribute brings up the appropriate 
Properties dialog. Clicking a second time on the same component 
reverts back to the Molecule Properties dialog.*

Most Properties dialogs have an associated Utilities or Style toggle. 
For example, associated with the Molecule Properties dialog is a 
Molecule Utilities dialog. These access additional information about 
the molecule and its components/attributes, or provide style and color 
controls. This is useful for highlighting (or de-emphasize) a particular 
molecule, component or attribute. Utilities/Style dialogs are reached 
by clicking on  at the bottom right of the appropriate Properties 
dialog. Return to the Properties dialog follows from clicking on  
at the bottom right of the associated Utilities/Style dialog. 

The Properties (or Utilities/Style) dialog may be removed from the 
screen by clicking on .

	 Molecule Properties

	 The Molecular Properties dialog comprises four parts: Molecule, 
QSAR, Thermodynamics and 2D Drawing, controlled by tabs 
at the top. Entries under the Molecule tab relate to common 
molecular properties, only some of which depend on the selected 
level of calculation. 

	

*	 The only exception involves clicking on a graphical surface or property map, for example, 
clicking on a property map to obtain the value of the property at a particular surface location. 
Clicking a second time on the surface or map will report a new value of the property. Clicking 
on the background leads to the Molecule Properties dialog.
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	 Molecule

	
	 Molecule properties include the name and molecular formula, 

the energy (the specifics of the type of energy and the units it 
is reported in depend on the theoretical model), the HOMO 
and LUMO energies (in eV), the dipole moment (in Debye), 
the molecular weight (in amu), the point group, the predicted 
number of (non-carbon) tautomers and the predicted number of 
conformers, and (if available) the experimental heat of formation 
(in kJ/mol), the heat of formation from the T1 thermochemical 
recipe (in kJ/mol) and the CAS number. These may be posted to the 
spreadsheet using the  buttons, or dragged into the spreadsheet. 
The dipole moment vector may be added to the model by checking 
the box to the left of Display Dipole Vector. Buttons at the bottom 
right of the dialog access appropriate Wikipedia and ChemSpider 
pages based on InChi string. Label identifies the molecule in a 
document and appears in the first column of the spreadsheet (see 
Spreadsheet, later in this chapter).

	 QSAR

	 Entries under the QSAR tab provide additional properties, some 
of which may be particularly valuable in qualitative structure-
activity relationship type analyses.
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	 These include: the area, volume, polar surface area (PSA)* and 

ovality obtained from a space-filling model, and other structure-
dependent indicators: LogP, polarizability and the number of 
hydrogen-bond donor (HBD) and acceptor sites (HBA).** All 
of these are independent of the level of calculation. Additional 
quantities which depend on the level of calculation and are 
based on the electron density surfaces as well as on electrostatic 
potential maps are also available: the accessible area, the polar 
area and accessible polar area corresponding to absolute values 
of the electrostatic potential greater than 75, 100 and 125 kJ/mol 
(selection is made by repeated clicking on ), the minimum and 
maximum values of the electrostatic potential (as mapped onto 
an electron density surface) and the minimum value of the local 
ionization potential (as mapped onto an electron density surface). 
These quantities are not calculated unless explicitly requested by 
checking QSAR inside the Calculations dialog (Calculations... 
under the Setup menu; Chapter 8).

	

*	 Polar surface area is defined as the area due to nitrogen and oxygen and any attached 
hydrogens. Polar surface areas corresponding to arbitrary alternative definitions are available 
for posting into the spreadsheet using the PAREA function. See Table 22-3.

**	 Counts of hydrogen-bond donors and acceptors.
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	 Thermodynamics
	 Entries under the Thermodynamics tab provide the zero-point 

energy, the enthalpy, the constant volume heat capacity, the entropy 
and the Gibbs energy. Except for the zero-point energy, all depend 
on temperature. The default setting (298.15 K) may be changed. 
All require vibrational frequencies. Density functional frequency 
calculations scaled by a number that is slightly smaller than 1 to 
account for systematic errors.

	
	 As discussed under Properties and Spectra in Appendix A, the 

entropy and Gibbs energy are subject to considerable uncertainty 
due to the underlying harmonic approximation.
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	 2D Drawing

	 Displays a 2D drawing for molecules up to 250 atoms.

	

	 Molecule Utilities

	 Clicking on  at the bottom right of the Molecule Properties 
dialog brings up the Molecule Utilities dialog (clicking on  
returns to the Molecule Properties dialog).

	
	 Notes is a user-supplied text string that is reproduced in the output. 

Controls reset model color and style, add missing hydrogens and 
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bonds, provide information about amino acids in polypeptides and 
replace coordinates by standards based only on atomic connectivity, 
change enantiomers, reset default conformer selections, relabel 
atoms, and attempt to find local symmetry.

Atom Properties

Selection of an atom with a Properties dialog on screen, or 
selection of Properties following selection of an atom, leads to 
the Atom Properties dialog.

This displays the element name (and allows changing the element), 
R/S chirality, electrostatic-fit charges (in electrons), calculated 
NMR chemical shift (in ppm relative to the appropriate standard; 
tetramethylsilane for both proton and 13C) and exposed surface area 
of a space-filling model (in Å2). It also allows freezing the atom 
(see Freeze Center in Chapter 6), changing its mass number and 
the default label, setting an atom’s charge or number of unpaired 
electrons, and posting atomic charges, chemical shifts and exposed 
areas to the spreadsheet.
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Bond Properties

Selection of a bond with a Properties dialog on screen, or selection 
of Properties following selection of a bond leads to the Bond 
Properties dialog (not shown). This displays the bond length 
(in Å), Löwdin or Mulliken bond order (in electrons) and bond 
type (and allows changing the bond type). Note that the results of 
quantum chemical calculations do not depend on bond types.

Constraint Properties

Selection of a constraint marker with a Properties dialog on 
screen, or selection of Properties following selection of a 
constraint marker, leads to the Constraint Properties dialog 
(expanded form shown).

This allows setting the value of a constraint, posting it to the 
spreadsheet and changing the default constraint label. This also 
allows specifying a sequence of constraints for an energy profile 
(see Calculations... under the Setup menu; Chapter 8). The value 
of the starting constraint is given in the box to the right of Value, 
and the value of the ending constraint is given in the box to the 
right of to. The number of steps in the profile is given in the box 
to the right of Steps. Initially, the numbers in both boxes to the 
right of Value will be the same, and Steps will be set to 10. These 
may be altered by typing the desired numbers into the appropriate 
boxes and then pressing the Enter key (return key on Mac). This 
functionality may also be accessed from Constrain Distance 
(Angle, Dihedral) under the Geometry menu (Chapter 6). 
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Point and Plane Properties

Selection of a user-defined point or plane with a Properties 
dialog on screen, or selection of Properties from the Display 
menu following selection of a point or plane, leads to the Point 
Properties or Plane Properties dialog (not shown). These allow 
changing point or plane labels and colors. 

Surface Properties

Selection of a graphical display with a Properties dialog on screen, 
or selection of Properties following selection of a graphical 
display, leads to the Surface Properties dialog.

This allows changing display style, isovalue (and in the case of 
electron density surfaces), percentage of the electrons contained 
inside the surface, turning on mapped properties, selecting 
between continuous and banded displays and setting the range of 
the property, displaying accessible area of surfaces and maps and 
changing the default labels. A clipping plane may be invoked to 
allow part of the underlying structural model to be exposed. The 
dialog also reports (and optionally posts to the spreadsheet) the area 
and volume of the graphic, the accessible area*, the polar area of an 

*	 A region on a density surface is designated as inaccessible if a sphere of radius 1.0 Å centered on a 
line normal to the surface and touching a point in the middle of the region, impinges on any other 
regions of the density surface. The default radius (Accessible Area Radius) may be changed 
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electrostatic potential map*, maximum and minimum value of the 
mapped property and its value at the cursor position**. If checked, 
Legend displays a scale. If checked, Global Surfaces designates 
that the settings apply to all molecules in the document.
If the selected graphical surface is a slice, the Slice Properties 
dialog replaces the Surface Properties dialog.

This contains similar controls to that found in the previous dialog. 
Specification of isovalue has been replaced by specification of the 
number of contours to be displayed. A sphere or a cylinder may 
be selected instead of a plane, and check boxes allow for a frame 
around the slice and for a grid.

	 Regression Properties

	 Following a linear regression analysis, a new row, labeled 
Fit1***, appears near the bottom of the spreadsheet. This contains 
information about the fit. Clicking on this line with a Properties 
dialog on screen, or selecting Properties from the Display menu 
( ) after clicking on the line, leads to the Regression Properties 
dialog.

in the Settings Preferences dialog (Preferences under the Options menu; Chapter 10).
*	 This is defined as that part of the surface area for which the absolute value of the electrostatic 

potential is > 100 kJ/mol. The cutoff (Polar Area Range) may be changed in the Settings 
Preferences dialog (Preferences under the Options menu; Chapter 10).

**	 To determine property value at another position click on it. To bring up the Molecule 
Properties dialog, click on the background.

***	More precisely, a row will be written for each fit, and labelled Fit1, Fit2, . . ..
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This reports RMSD and R2, as well as allows for changing what is 
to be fit (Fit) and what it is to be fit to (Using). The error statistics 
will immediately update.

	 Orbital Energies ( )

	 Selecting Orbital Energies leads to the display of an orbital 
energy diagram (accessible when the wave function is available). 
This comprises up to ten occupied molecular orbitals and two 
unoccupied molecular orbitals, the highest-occupied (HOMO) 
and lowest-unoccupied (LUMO) being explicitly designated. 

	
	 Clicking on an energy level in the diagram leads to display of the 

corresponding molecular orbital. This may be manipulated in the 
usual way; the energy can be posted to the spreadsheet and the 
display style altered (from the menu at the bottom right of the 
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screen). After one energy level has been selected and the associated 
orbital displayed, moving the mouse up or down over the diagram 
while holding down the left button (“swiping”) then releasing the 
button selects the next higher or lower energy level.

Moving a finger up or down over the diagram then lifting selects 
the next higher or lower energy level.

Surfaces ( )

This accesses the same dialog described in Chapter 8.

Spectra ( )

Spartan Student displays calculated IR and NMR spectra. Spectra 
need to have been previously requested from the Calculations dialog 
(Calculations... under the Setup menu; Chapter 8). In addition, it 
provides on-line access and display of experimental IR and NMR spectra 
from public databases, allowing comparison with calculated spectra. 

Selecting Spectra from the Display menu leads to an empty display 
pane at the bottom of the screen.

The only accessible control (in a bar at the top of the pane) is  
(add a spectrum). Clicking on this leads to a palette.
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The left hand column lists the types of spectra for which calculations 
are available: IR, proton NMR with and without three-bond HH 
coupling, and 13C NMR. The entry is “red” if a calculation has actually 
been performed and the corresponding spectrum is available. The 
right hand column lists the types of spectra for which experimental 
spectra may be available (from on-line public databases): IR, proton 
NMR, and 13C NMR. These are shown in blue.

The procedure for displaying either a calculated or experimental 
spectrum (or both) is independent of the type of spectrum. For the purpose 
of illustration, we use the IR spectrum of methyl trans-cinnamate. 
A calculated spectrum is displayed by clicking on the appropriated 
(red highlighted) entry, following which the palette is dismissed. 

Clicking on IR results in an IR spectrum. Moving the mouse while 
holding down the left button moves the cursor (unfilled markers at the 
top and bottom of the spectrum) over the spectrum. When positioned 
directly over a special line, the markers are darkened and connected 
by a vertical green line, and a numerical value for the line is provided 
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at the bottom of the spectrum. In the case of an IR spectrum, this is 
a frequency in cm-1 and corresponds to a particular vibration of the 
atoms in the molecule. The molecular model (above the spectrum) 
vibrates to show this motion. For methyl trans-cinnamate, the line at 
1645 cm-1 corresponds to the C=C stretch while the line at 1739 cm-1 
corresponds to the C=O stretch.

OMe

O

Moving the mouse while holding down the right button slides the 
viewable scale from 4000 cm-1 to 500 cm-1 but does not change the 
overall range (of 3500 cm-1). The range is changed by using the scroll 
wheel. The original settings may be restored by clicking on  in the 
bar at the top of the spectra pane.

Move one finger over the spectrum to position the cursor, move 
two fingers to slide the viewable scale and pinch two fingers to 

change the range.

In the case of IR (only) three buttons appear at the left of the spectrum, 
 (Tables),  (Make List), and  (Fit). Clicking on ( ) leads to 

a scrollable panel at the left of the spectrum.

This contains a listing of calculated infrared frequencies and 
intensities. Checking the box to the left of an individual frequency 
moves the cursor on the spectrum over this line and animates the 
vibrational motion.



224	 Chapter 9

With a frequency selected, clicking on  (Make List) leads to a new 
panel.

This is used to make a list of structures centering around the minimum 
(or maximum in the case of a transition state) with control over the 
amplitude of vibration (maximum displacement in Å) and number of 
steps. Clicking on Make List leads to a separate document.

If available, an experimental spectrum from one of the public on-line 
databases may be superimposed on top of the calculated spectrum. 
The IR spectrum of methyl trans-cinnamate is available. Click on 

 and select  from the palette.

You can if you wish only display the experimental spectrum. If a 
calculated is already displayed, click on  and re-select  
(the control operates in toggle mode).

Additional spectra may be requested by clicking on  in the bar 
above the spectra pane and then clicking on the appropriate entry in 
the resulting palette. Each new spectrum adds a tab to the bar, although 
calculated and experimental spectra share the tab. Switching between 
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tabs changes the display. A spectrum can be deleted by clicking on  
in the bar above the spectra pane. If both calculated and experimental 
spectra were displayed, both will be deleted.

Controls at the top right of the spectra pane allow saving the spectrum 
as a PNG, JPEG or Bitmap image file ( ), printing the file ( ), 
detaching the spectrum pane from the main window ( ) and closing 
the pane ( ).

Spreadsheet ( )

Associated with each Spartan Student document (including 
documents with only a single molecule) is a spreadsheet. This may 
be displayed by selecting Spreadsheet from the Display menu.

The spreadsheet comprises a series of rows (corresponding to 
different molecules in the document) and columns (corresponding 
to different properties). Together, a row and column define a “cell”. 
The spreadsheet may be expanded or contracted by positioning the 
cursor at one of the corners, pressing the left mouse button and 
dragging the mouse.

Only one molecule from one document may be selected (although 
several molecules may be simultaneously displayed). Molecule 
selection follows either by clicking on the spreadsheet cell containing 
the molecule label or identifier (leftmost column), or by using the 
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 and  buttons or the scroll bar at the bottom left of the screen. 
Molecules may be animated (stepped through in succession) using 
the  button at the bottom left of the screen. Animation speed may 
be adjusted from the Settings tab (Preferences under the Options 
menu; Chapter 10). Selection of a new molecule in the document 
results in deselection of the previously selected molecule. A molecule 
may be designated for permanent display by checking the box to 
the left of its identifier (Label) in the spreadsheet. The molecules 
in a document may either be translated and rotated in concert or 
manipulated independently. This is controlled by Coupled under the 
Model menu (Chapter 5). By default (Coupled checked) molecules 
move in concert. Uncheck Coupled to move them independently.

Upon initial entry, all columns of the spreadsheet except the leftmost 
column, are blank. The leftmost column contains a label that may be 
changed either by directly typing a new label into the spreadsheet 
or into the Label box in the Molecule Properties dialog (see 
discussion earlier in this chapter). Additionally, default identifiers 
(M0001, ...) can be replaced by chemical names if the molecule has 

been retrieved from the Spartan Spectra 
and Properties Database (SSPD).

Right-clicking on a column leads 
to contextual menu with addition 
spreadsheet controls including copy/
paste, selection, sorting, and formatting 
(to name a few).

Information may be added to the spreadsheet in several ways:

From the Add Dialog

A selection of molecular properties may be entered into the 
spreadsheet by first clicking on the header cell of an empty column, 
and then clicking on Add... at the bottom of the spreadsheet. 
Alternatively, right click inside the header cell and then to select 
Add... from the menu that results.

This leads to a multi-tab dialog with Molecule selected.
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Name	 molecule name as it appears in SSPD or SMD
Formula	 molecular formula
CAS	 Chemical Abstracts designator (if available)
Molecular Weight	 molecular weight (in amu)
E	 energy (heat of formation, strain energy)
Pt Group	 symmetry point group
Heat (kJ/mol)	 experimental heat of formation in kJ/mol (if available)
T1 Heat (kJ/mol)	 T1 heat of formation in kJ/mol
Tautomers	 number of tautomers (proton-transfer isomers)
Conformers	 number of conformers
E HOMO	 energy of highest-occupied molecular orbital
E LUMO	 energy of lowest-occupied molecular orbital
Dipole	 dipole moment (in debye)

One or more properties may be added to the spreadsheet by 
clicking on their entries.

Clicking on the QSAR tab leads to another panel.
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CPK Area (Å2)	 surface area of a space-filling (CPK) model (in 
Å2)

CPK Volume (Å3)	 volume of a space-filling (CPK) model (in Å3)
PSA (Å2)	 polar surface area of a space-filling (CPK) 

model (in Å2). Defined as the area due to 
electronegative atoms (N, O) and hydrogens 
attached to the atoms

CPK Ovality	 measure of deviation from a spherical shape, 
where 1.0 = a sphere and values > 1.0 indicate 
deviation

Acc. Area (Å2)	 accessible surface area of an electron density 
surface (in Å2). Surface is defined by electron 
density of 0.002 electrons/au3 and accessible 
corresponds to a probe with a 1Å radius. Probe 
radius may be changed in the Settings tab of 
the Preferences dialog (Options menu)

Max ElPot (kJ/mol)	 maximum value of the electrostatic potential 
on an electron density surface (in kJ/mol)

Min ElPot (kJ/mol)	 minimum value of the electrostatic potential 
on an electron density surface (in kJ/mol)

Min LocIonPot (kJ/mol)	 minimum value of the local ionization potential 
on an electron density surface (kJ/mol)

Polar Area(75) (Å2)	 area of the region on an electrostatic potential 
map where the absolute value of the electrostatic 
potential is > 75 kJ/mol (in Å2). The value of 
the potential may be changed to 100 and 125 
kJ/mol.

Acc. Polar Area(75) (Å2)	 accessible area of the region on an electrostatic 
potential map where the absolute value of the 
electrostatic potential is >75 kJ/mol (in Å2). 

	 The value of the potential may be changed to 100 
and 125 kJ/mol. Probe radius may be changed 
from the default of 1Å2 in the Settings tab of 
the Preferences dialog (Options menu).

Log P	 octanol water partition coefficient
HBD Count	 number of hydrogen-bond donor sites
HBA Count	 numner of hydrogen-bond acceptor sites
Polarizability	 polarizability
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Clicking on the Thermodynamics tab leads to another panel:

ZPE (kJ/mol)	 zero-point energy (in kJ/mol)
S° (J/mol•K)	 entropy (in J/mol•K)
H° (au)	 enthalpy (in au). Sum of electronic energy and zero-

point energy adjusted for finite temperature
G° (au)	 Gibbs energy (in au). Sum of enthalpy and entropy.
Cv (J/mol•K)	 heat capacity at constant volume (in J/mol•K)

Scale is used to scale calculated frequencies, where default 
applies to B3LYP/6-31G* and EDF2/6-31G*, and Temperature 
is used to set temperature. Note that vibrational frequencies need 
to be available.

Clicking on the Molecule List tab leads to another panel. This 
allows quantities for different molecules (or different conformers 
of the same molecule) in a list to be related:
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Δ Energy (kJ/mol)	 energy (heat of formation, strain energy) relative to 
selected molecule

Boltzmann Weights	 Boltzmann weight
Cumulative 	 Sum of the Boltzmann weights for the selected
Boltzmann Weights	 molecule and all molecules with lower energy than 

the selected molecule
Alignment Scores	 1-R2/N, where R2 is the root mean square distance 

and N is the number of alignment centers. 1 is a 
perfect score

Units for Δ Energy and Temperature for Boltzmann weights 
and cumulative Boltzmann weights may be selected from menus 
at the bottom.

Clicking on the Summaries tab leads to another panel:

Total	 sum of column values
Minimum	 minimum of column values
Stdev	 standard deviation of column values
Boltz Avgs	 Boltzmann weighted average of column values
Average	 average of column values
Maximum	 maximum of column values
RMS	 rms of column values

Linear regression analysis may be performed on data in the 
spreadsheet. Clicking on the Linear Regression tab leads to 
another panel:
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Select one entry from the Fit menu and one or more entries from 
the list under Using. Clicking on Apply performs the linear 
regression analysis and places the results in a row at the bottom 
of the spreadsheet identified by Fit. As many regression analyses 
as desired may be performed on the data in the spreadsheet. 
The individual results will be entered as separate rows in the 
spreadsheet, with names Fit1, Fit2, etc. Additional information 
about the regression analyses is available from the Regression 
Properties dialog (see discussion earlier in this chapter).

From Post ( ) Buttons

Post buttons ( ) found in a number of properties dialogs provide 
an alternative method to the Add dialog for entering calculated 
properties into the spreadsheet. Note that some properties 
may require user specification. These include individual 
bond distances, angles and dihedral angles (available from 
Measure Distance, Measure Angle and Measure Dihedral 
under the Geometry menu; Chapter 6), bond distance, angle 
and dihedral angle constraints (available from Constrain 
Distance, Constrain Angle and Constrain Dihedral under the 
Geometry menu; Chapter 6), atomic charges, chemical shifts 
(available from the Atom Properties dialog; this chapter), the 
accessible area of an electron density surface, the polar area and 
accessible polar area of an electrostatic potential map, the area 
of a selected region (band) of a banded property map, minimum 
and maximum property values on a map and the value of the 
property at a specific location on a property map (available from 
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the Surfaces Properties dialog; this chapter). With the exception 
of the property value on a map and the area of a selected band, 
post generates an entire column. Where atom labels are involved, 
for example, in defining a specific distance, post can be expected 
to yield consistent results for all molecules in a document only 
where the molecules are closely related, for example, molecules 
resulting from a conformational search, or where labels have been 
explicitly reassigned*. The property value and the area of a selected 
band on a map is posted only for the selected molecule. Post 
buttons are also available for CAS numbers, experimental heats 
of formation and for T1 heats of formation contained in SSPD.

Copy/Paste

Properties of one or more molecules in a document may be 
copied and then pasted into spreadsheet cells. These include 
(but are not restricted to) bond distances, angles and dihedral 
angles (Measure Distance, Measure Angle and Measure 
Dihedral under the Geometry menu), bond distance, angle 
and dihedral angle constraints (Constrain Distance, Constrain 
Angle and Constrain Dihedral under the Geometry menu), 
atomic charges and chemical shifts  (Atom Properties dialog), 
infrared frequencies and chemical shifts (IR, NMR, and UV/
vis data from the Output Summary dialog) and the value of 
a property on a property map (Surface Properties dialog). To 
copy the spreadsheet, first highlight the numerical value of the 
property in the appropriate screen location (distances, etc.) or 
dialog (charges, etc.), then select Copy from the Edit menu, 
then click on the appropriate (destination) cell in the spreadsheet, 
and finally select Paste from the Edit menu. Pasting to other 
programs is achieved in a similar manner.

Numerical Data

Numerical data may be entered by typing directly into the 
spreadsheet. A column header first needs to be specified. Double 

*	 Label reassignment is accomplished using the Atom Properties dialog (see discussion 
earlier in this chapter).
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click on an empty column header cell, type in a name and press 
the Enter key (return key on Mac). Then, type the data into 
individual cells of the new column (press the Enter or return 
key following each data entry).

User-Defined Expressions

An expression may be entered either into a header cell (in which 
case it refers to all entries in a column) or into an individual cell (in 
which case it refers only to a single entry). Expressions in the column 
header take the form name=formula, where formula may involve 
arithmetic operations, specialty functions, calculated quantities, 
conversion factors and constants in addition to numerical values. 
References to specialty functions, molecular mechanics and quantum 
chemical quantities and conversion factors and constants must be 
preceded by @. For example, mu = @DIPOLE typed into a header 
cell gives the dipole moment. Some functions have arguments, for 
example, c1 and c2 in the expression c12= @DISTANCE (c1,c2) refer 
to atoms c1 and c2, while 3 in the expression orbitalE=@HOMO 
(-3) designates the energy of the molecular orbital three orbitals below 
the HOMO. It is necessary to press the Enter key (return key on Mac) 
following entry of the expression into a cell. The leading name= is 
optional for entries in an individual (non-header) cell.

Arithmetic Operations Boolean Operations

+ addition > greater than
_ subtraction >= greater than or equal to
* multiplication < less than
/ division <= less than or equal to
^ raise to a power == equal to
  != not equal to
  | or
  & and

Mathematical Functions

ABS(x) absolute value LN(x) natural logarithm
ACOS(x) inverse cosine LOG(x) log (base 10)
ASIN(x) inverse sine SIN(x) sine
ATAN(x) inverse tangent SQRT(x) square root
COS(x) cosine TAN(x) tangent
EXP(x) exponential
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Specialty Functions

AVG (column name) average of values in column
FITVAL (fit name) column of fit values from regression analysis
MIN (column name) minimum of values in column
MAX (column name) maximum of values in column
NUM (column name) number of defined entries in column
ROW the number of the row in the spreadsheet
ROW(molecule name) the number of the row of molecule
REF(i, x) the value of the x referenced to row i
STDEV (column name) standard deviation of values in column
SUM (column name) sum of values in column

Calculated Quantities

ANGLE(i, j, k) angle involving atoms i, j, k (degrees)
AREA area of a user-defined plane (Å2)
DIHEDRAL(i, j, k, l) dihedral angle involving atoms i, j, k, l (degrees)
DISTANCE(i, j) distance involving atoms i, j (Å)
ELECTROSTATIC (i) electrostatic charge on atom i (electrons)
HOMOev(-n) energy of nth orbital below the HOMO (eV)
HOMOBETAev(-n) energy of the nth orbital below the β HOMO (eV)
INTERTIA(i) principle movements of inertia from largest (i=1) 

to smallest (i=3)	
ISOTOPE(i) mass number of atom i
LENGTH (i) length of bond i (Å)
LUMOev(+n) energy of the nth orbital above the LUMO (eV)
LUMOBETAev(+n) energy of the nth orbital above the β LUMO (eV)
ZPE zero point energy
HØ absolute enthalpy at 298K
CV constant volume heat capacity at 298K
SØ absolute entropy at 298K
GO Gibbs energy at 298K

Conversion Factors and Constants

ANGS2AU Ångstroms to atomic units
AU2ANGS atomic units to Ångstroms
EV2HART eV to atomic units (hartrees)
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EV2KCAL eV to kcal/mol
EV2KJ eV to kJ/mol
HART2KCAL atomic units (hartrees) to kcal/mol
HART2EV atomic units (hartrees) to eV
HART2KJ atomic units (hartrees) to kJ/mol
KCAL2EV kcal/mol to eV
KCAL2HART kcal/mol to atomic units (hartrees)
KCAL2KJ kcal/mol to kJ/mol
KJ2EV kJ/mol to eV
KJ2HART kJ/mol to atomic units (hartrees)
KJ2KCAL kJ/mol to kcal/mol
PI π

Table 9-5:	 Examples of User Defined Expressions

E/area = @ENERGY/@AREA	 energy divided by surface 
area

Δ Energy = @ENERGY-@REF	 energy relative to energy 
(6,@ENERGY)	 of molecule in row 6
Eq = @EXP (-@ENERGY/592.1)	 equilibrium constant at 

room temperature
EnergyFilter = @ENERGY<-99.43	 “true” (≠0) for all energies 

<-99.43
RowFilter = @ROW>10	 “true” (≠0) all entries past 

row 10

Each row in a spreadsheet corresponds to a molecule in a document, 
and new rows are automatically added in response to adding new 
molecules to the document. New molecules are added by building 
(New Molecule under the File menu; Chapter 3), by appending one 
or more existing documents each containing one or more molecules 
using either Append Molecule(s)... under the File menu (Chapter 
3), or by right clicking inside the header cell of the first available 
row and selecting Append from the menu that appears, by pasting 
from the clipboard, or by dragging  from the file system. To copy 
a molecule into the clipboard, first select (click on) it, and then 
select Copy from the Edit menu, or click on its identifier (left most 
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column) in its spreadsheet, and then select Copy from the Edit menu. 
Alternatively right click either on the molecule or on its identifier in 
the spreadsheet and select Copy from the menu that appears. Use of 
the clipboard permits several molecules to be selected (and copied) 
at once using the Shift and Ctrl keys in the usual manner. To copy 
the contents of the clipboard to its destination, click on an empty 
row header in the spreadsheet (for the destination document), and 
then select Paste from the Edit menu. An alternative to the two-step 
Copy-Paste procedure is to drag the molecule or set of molecules 
from one spreadsheet to another.

A row (molecule) may be deleted from a spreadsheet, either by first 
selecting the molecule and then selecting Delete Molecule from the 
File menu, or by first clicking on its identifier in the spreadsheet 
(leftmost column) and then either clicking on the Delete button at 
the bottom of the spreadsheet, or by right clicking on its identifier in 
the spreadsheet and then selecting Delete Selected from the menu 
that appears. In all cases, a warning is provided prior to deletion. 
An entire column in the spreadsheet may be deleted by first clicking 
inside its header cell and then clicking on the Delete button (or 
Delete Selected from the menu).

Rows in the spreadsheet may be sorted according to the numerical 
values in any column either by first clicking inside the header cell 
and then clicking on the Sort button at the bottom of the spreadsheet 
or by right clicking inside the header cell and selecting Sort from 
the menu that appears. The rows are placed in ascending order, the 
smallest (least positive) value of the selected property at the top, 
largest (most positive) value at the bottom. To sort in descending 
order, hold down the Shift key before clicking on the Sort button or 
selecting Sort from the menu.

Information in one or more columns of the spreadsheet may be 
formatted by right clicking inside the header cell(s) and selecting 
Format Selected from the menu that appears.

Format as desired and click on OK to remove the dialog. The full 
contents of the spreadsheet may be formatted by right clicking inside 
the header cell for the left most column and then selecting Format 



Chapter 9	 237

Selected from the menu.

A button at the bottom right of the spreadsheet toggles between 
numerical representation of data, f(x), and formula presentation, =?.

The spreadsheet may be printed by right clicking in the spreadsheet 
and selecting Print. 

As many spreadsheets as desired (corresponding to the same or 
to different documents) may be open on screen. A spreadsheet is 
removed when the associated document is closed and may also be 
removed by clicking on .

The contents of the spreadsheet may be brought into Excel™ using the 
clipboard. Select whatever cells are to be copied, select Copy from the 
Edit menu. Alternatively, right click with the proper cells selected and 
select Copy from the menu that appears. Paste into Excel.

The contents of an Excel spreadsheet may be brought into Spartan 
Student. Copy whatever information is to be transferred from Excel, 
move into Spartan Student, click on the appropriate cell and select 
Paste from the Edit menu (or right click on the appropriate cell and 
select Paste from the menu that appears). Note, that information on the 
clipboard that goes beyond the number of rows in Spartan Student’s 
spreadsheet will be ignored.

Plots ( )

Plots may be constructed from data in a spreadsheet and a variety 
of simple curves fit to these data. Selecting Plots from the Display 
menu leads to an empty display pane at the right of the screen.
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Clicking on  (add plot) in the bar at the top of the plots pane leads 
to a dialog.

You need to select an item from the X Axis menu and one or more 
items from the Y Axes list, and then click on the Create button at 
the bottom of the dialog. A plot appears in the plot pane and the Add 
Plot dialog is dismissed.
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By default, the scales for both horizontal and vertical axes are set 
to bound the data trying to provide limits and increments that are 
“rounded”. Moving the mouse left and right while holding down the 
right button slides the horizontal scale but does not change the range. 
Similarly, moving the mouse up and down while holding down the 
right button slides the vertical scale. The horizontal range may be 
changed by moving the mouse left and right while holding down both 
the right button and shift key, and the vertical range changed by moving 
the mouse up and down while holding down both the right button 
and the shift key. The scroll wheel may be used to simultaneously 
change both horizontal and vertical ranges. The original settings may 
be restored by clicking on  in the bar at the top of the plots pane.

Move two fingers left and right and up and down to slide the 
viewable horizontal and vertical scales, respectively. Pinch two 

fingers left and right and up and down to change the horizontal and vertical 
scales, respectively.

The plot ranges may also be changed by clicking on  in the bar at 
the top of the plots pane.

The resulting dialog also allows axis labels to be altered (from their 
initial values designated in the spreadsheet) the number of “tics” of 
horizontal and vertical axes to be changed and a plot title to be added. 
Finally, the “curve” can be changed, the default is set to display data 
points only (no curve selected).
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Additional plots may be added by clicking on  in the bar at the 
top of the plots pane. Each plot is given a tab. Only one plot may 
be displayed at a time as controlled by which tab is selected. The 
selected (and displayed) plot may be deleted by clicking on .

Reactions... ( )

Data in a Spartan Student document or in SSPD may be used to 
calculate reaction energies (including activation energies).

∆E  =  NP1 Eproduct1  +  NP2 Eproduct2  –  NR1 Ereactant1  +  NR2 Ereactant2

NP1 and NP2 are the numbers of product molecules 1 and 2 and NR1 
and NR2 are the numbers of reactant molecules 1 and 2. Selection of 
Reactions... from the Display menu leads to the Reactions... dialog.

Two sets of menus under Reactants: and two sets of menus under 
Products: specify the number of each reactant and product and 
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identify them. The latter correspond to the labels (identifiers) of the 
molecules in the document, plus a null entry <none>.  The overall 
reaction needs to be mass balanced.

The Source menu identifies the source of the energies to be used in 
the reaction energy calculation. Either the Current Document or 
SSPD may be chosen. If the SSPD is selected, ∆E will be based on 
a high quality energy calculation from the wB97X-V functional with 
a large (6-311+G(2df,2p)) basis set.

Under Source is the Calculate drop down menu. This allows for 
selection of ∆E, ∆H°, or ∆G°. Note that if the Source is set to 
Current Document, an IR calculation is required to obtain ∆H° 
and ∆G° values.

A reaction energy is computed for the selected value: ∆E, ∆H°, or 
∆G°.

The results of a reaction energy calculation may be printed by right 
clicking inside the display area of the Reactions dialog and selecting 
Print from the menu that results.

The Reactions dialog is closed by clicking on .
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Chapter 10
The Options Menu

Functions under the Options menu* access an assortment of 
preferences. They also allow for changing default colors and fonts, 
for monitoring executing jobs, access a calculator and turn icon 
display on or off.  

Preferences...( )

This sets up preferences relating to the graphical user interface 
(Settings), and to molecule displays (Molecule). It permits changes 
to default van der Waals radii used for space-filling models as well as 
for calculating molecular surface areas and volumes (VDW Radii). It 
also specifies miscellaneous features (Miscellaneous), specifies which 
icons are to be displayed (Icons) and specifies URLs (URLs) for on-
line connections. Selection results in one of seven tabs. Clicking on a 
tab brings up the associated preference options. To exit a Preferences 
dialog click on OK. Clicking on Cancel or  exits the dialog without 
instituting any changes.

*	 Preferences is also found under the Spartan Student menu in the Macintosh version.
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Settings Tab

Style

(i)	 View:  Orthogonal/Perspective
	 Controls the view of structural models and graphics.

(ii)	 Menus: Classic List/Button Pad
	 Controls presentation of menus either as lists (Classic List) 

or as icon palettes (Button Pad). The latter is likely to be 
better suited to touch screen computers and tablets.

(iii)	 Interface: Classic/Touch
	 Under the Touch setting, some menu/dialog items (including 

up/down arrows) are displayed in a larger size to better 
support touch screen computers and tablets.

(iv)	 Icons: Small/Medium/Large/Extra Large/Jumbo
	 Controls size of program icons in the tool bar.

(v)	 Sketch Pad: Small/Medium/Large
	 Controls the size of the sketch pad (palette of sketch tools) 

for Spartan’s 2D builder.

(vi)	 Stereo: Off/Red-Cyan
	 Turns stereographic display on and off. This can also be 

controlled by toggling the “3” key on the keyboard.
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(vii)	 Global Rotate: Screen Centered/Molecule Centered
	 Screen Centered rotates all molecules about a common 

center. Molecule Centered rotates each molecule about its 
own center.

(viii)	 Document Tabs
	 Hide will revert display style to that of versions of Spartan 

prior to Spartan’14, that is, all open documents will be 
visible when in View mode. If Show is checked, this displays 
a tab at the bottom of the screen for each open document.
This allows for displaying molecules from documents other 
than the currently selected document by checking the box 
to the left of the tab. Show closable is the same as Show 
but includes the ability to close the document by clicking 
on the  button at the right of the tab

(ix)	 New Document: Pin
	 If checked, defaults to display of any new documents (from 

building or brought in from the File menu) irrespective of 
whether or no they have been explicitly selected. Does not 
affect the status of existing open documents. Pin setting is 
only applicable if either Show or Show closable is selected 
(see Documents Tabs above).

(x)	 Animation Speed
	 Slider bar controls the speed for animations.

(xi)	 Calculations Dialog
	 Controls the default task that is displayed upon entering 

Calculations... ( ) from the Setup menu. The default is 
Equilibrium Geometry with the ωB97X-D/6-31G* model, 
this can be modified by clicking the Edit button, which 
leads to a sample Calculations dialog. Clicking on Reset 
restores the default task.

(xii)	 Conformer Rules: Normal/Skeletal/Thorough
	 Chooses between rule sets for conformational searching. 

Normal is the default and should be used for Equilibrium 
Conformer and Conformer Distribution calculations 
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where the Monte Carlo approach is involved. Skeletal 
(in prior versions this was called Trimmed) eliminates 
degrees of freedom and should be used for Similarity 
Library calculations where a systematic approach is 
carried out. Thorough considers twist-boat conformers 
of six-membered rings (in addition to chair conformers).

Miscellaneous

(xiii)	 Double-Click Start
	 If checked, double-click as opposed to single-click is 

required to place the initial atom, group, ring, ligand, etc. 
on screen when using the 3D builder (consistent with the 
2D Sketch builder behavior).

(xiv)	 Persistent Delete
	 If checked, delete function is persistent. If not checked, 

delete will revert to the previously selected function after 
a single delete operation.

(xv)	 Auto-Gen Graphics
	 If checked, graphics calculations will be performed by the 

graphical interface (without having to submit a calculation) 
as long as the information necessary to generate the surface 
is available (a previous calculation has been run, or the 
molecule has been retrieved from the SSPD). Note, however, 
that graphics calculations will not be auto-generated on 
documents containing more than 25 molecules. These will 
need to be submitted as a calculation.

(xvi)	 ChemDraw Interface (Windows only)
	 If checked, adds ChemDraw as a tab at the top of the model 

kit. This allows for use of the ChemDraw program (version 
10 or newer) as an alternative for sketching molecules

(xvii)	Gradient
	 If checked, this replaces the single color background by a 

color gradient background.	
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(xviii)	Tumble
	 If checked, allows automatic tumbling of molecules. To 

tumble a molecule, select it, press the left mouse button, 
move the mouse and release the button. To stop tumbling, 
left click.

To start tumbling, swipe one finger over the screen. To stop, 
tap anywhere on screen.

(xix)	 Keep Verbose
	 If checked, keeps extended Q-Chem output. Normally 

discarded upon successful completion of submitted 
calculations, this may be useful for identifying the source 
of problems for calculations that have not successfully 
completed or have led to suspicious results. (The last 
100 lines of the verbose output is automatically kept for 
a job that has abnormally terminated). Verbose output 
significantly increases the size of the Spartan document.

(xx)	 Sketch Pad Tooltips
	 If checked, hovering over icons in the sketch pad palette 

will also display a description of the icon.

NMR Spectrometer

(xxi)	 Frequency
	 The frequency of the spectrometer, used in coupling constant 

calculations.

Surface

(xxii)	Polar Area Range (kJ/mol)
	 Sets the potential (in kJ/mol) for calculating polar area 

from the electrostatic potential map. The range is given as 
a single number but represents the range between –value to 
+value, for example, the default range of 100 kJ/mol means 
a range from -100 to +100 kJ/mol. Values above and below 
the range are considered when determining polar area. 
Click inside the box and use the number pad that appears.
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(xxiii)	Accessible Area Radius (Å)
	 Sets sphere radius (in Å) for determining accessible area, 

the default is 1.0Å. Click inside the box and use the number 
pad that appears.

Molecule Tab

This specifies default settings for model appearance. These settings 
may be overridden for individual molecules in a document using 
entries under the Model menu and for specific portions of a 
molecule using Utilities/Style dialogs associated with Properties 
dialogs (Properties under the Display menu; Chapter 9).

(i)	 Energy Units
	 Auto Select, where units depend on the computational model 

and on whether they refer to absolute or relative quantities, 
au (atomic units), kJ/mol and kcal/mol

(ii)	 Δ Energy Units
	 au (atomic units), kJ/mol and kcal/mol

(iii)	 Reaction Energy Units
	 au (atomic units), kJ/mol and kcal/mol

(iv)	 Model: Wire/Ball and Wire/Tube/Ball/Spoke/Space 
Filling/Line

	 Controls default model style.
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(v)	 Surface Style
	 If Bands is checked, this specifies that graphical surfaces, for 

example electrostatic potential maps, are to be displayed in 
terms of a series of color bands, rather than as a continuous 
spectrum. The number of bands is selected from the menu to 
the right. This setting can be changed at the document level 
and individual surface level as well (Surface Properties 
under the Display menu; Chapter 9).

(vi)	 Show Objects: Constraints/Frozens/Points/Planes/
Reactions/CFD’s/Images/Annotations

	 If checked, constraints and frozen markers, points and planes, 
reaction arrows, and attached images and text will always be 
shown as part of the model. Otherwise, they will be shown 
only in the appropriate mode.

(vii)	 Atom Labeling: Label/Element/Mass Number/Mulliken 
Charge/Electrostatic Charge/Natural Charge/Strand: 
Residue/Label/R/S/Exposed Area/Cal Chem Shift/Exp 
Chem Shift/Cal-Exp Chem Shift

	 Controls default label type.

Other Labeling:

(viii)	Bonds
	 If checked, bond labels will be shown.

(ix)	 Hydrogens
	 If checked, displays labels on hydrogen atoms.

(x)	 Constraints
	 If checked, constraint labels will be shown.

(xi)	 Planes
	 If checked, plane labels will be shown.

(xii)	 Reactions
	 If checked, reaction arrow labels will be shown.

(xiii)	Residues
	 If checked, residue labels will be shown.
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(xiv)	Points
	 If checked, point labels will be shown.

vdW Radii Tab

This provides a list of van der Waals radii

To order the list by element name click on Element, and by atomic 
radius click on vdW Radius. Individual entries may be changed 
from default values by first clicking on the entry and then entering 
a new value. The currently selected entry may be returned to its 
default radius by clicking on Reset Selected at the bottom of the 
dialog, and the full set of radii may be returned to their default 
values by clicking on Reset All at the bottom of the dialog.
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Miscellaneous

A number of miscellaneous preferences are accessible from this tab.

(i) Document Style
 Toggles between File Based and Directory Based. The 

former is the default and the latter is for compatibility with 
older Spartan Linux and Macintosh versions.

(ii) Builder Selection Method
 Toggles among Buttons on top, Tabs on side and Menu 

to control selection of the model kits in the 3D builder. The 
second and third choices conserve vertical space on small 
screen laptops and tablets.

(iii) Show Toolbar
 Turns on/off the delete, make bond, break bond, and minimize 

icons at the bottom of the 3D model kit.

(iv) Use Kekulé Rings
 Displays aromatic rings with the alternating single and double 

bonds or an aromatic (1.5) bond style.

(v) Use Alternate Builders
 Provides a different presentation of the model kits in the 3D 

builder. Try both and see which one you like.
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(vi) Use HTTP Proxy
 Allows setting up of an alternative path for access to external 

websites, for example, experimental spectra databases. Rarely 
needed.

(vii) Open GL Binding
 Allows for use of the OpenGL (3D visualization) libraries 

associated with your video card (Use Desktop OpenGL) or 
the option of using software-based libraries (Use Software 
OpenGL), or the three-dimensional viewing libraries 
developed to support web-based visualization (Use OpenGL 
ES).

(viii)Pick System
 Toggles between OpenGL, Color and Color + Geometric 

picking models. OpenGL is the standard but causes  
problems for Intel HD4000 and HD5000 series graphics 
(very common), where either Color or Color + Geometric 
should be used. Graphics chip is automatically detected at 
installation and this control should be properly set.

(ix) Multisampling
 Improves visualization using anti-aliasing.
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Icons

Icons for all menu entries are listed (you will need to use the 
horizontal slider bar to see them all). If checked, the icon will 
appear above the menu bar at the top of the Spartan Student 
screen.

Icon display is limited to one “permanent” row. Approximately 
20 medium size icons will fit on screen. All icon choices may be 
accessed via menu, irrespective of their selection preferences for 
permanent display.
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URLs

Lists URLs for access to experimental structural and spectral 
databases and to Wikipedia.

Colors ( )

This alters default colors. Selection leads to the Colors dialog.

After selecting an object, its color may be set by choosing from 
the palette, moving the cursor inside the window of colors, or by 
selecting  either a set of hue, saturation and values, or red, green and 
blue settings. The default color may be reset by clicking on Restore 
Default Color. Color selection applies to all objects of the same type, 
for example, all carbon atoms, and not just to the selected carbon. 
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To change the default Label Color, hold the shift key down and click 
on the Colors entry in the Options menu. Further control of colors 
is available from Utilities/Style dialogs associated with Properties 
dialogs (Properties under the Display menu; Chapter 9). Clicking 
on  removes the dialog.

Fonts/Graphics Fonts ( / )

This selects fonts, style and size of Spartan’s menus and dialogs 
(Fonts) and of labels attached to molecules, plots, and other objects 
(Graphic Fonts). Selection leads to the Appropriate dialog.

Clicking on OK dismisses the dialog with selections kept. Clicking 
on Cancel or on  dismisses the dialog and does not apply new 
selections.
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Monitor ( )

This provides a listing of all executing/queued jobs and their status. 
To see accumulated output for an executing job, click on its name. A 
ball-and-spoke model of the selected (executing) job will be displayed 
in a window to the right of the dialog. It can be manipulated using 
the usual mouse commands (you need to position the cursor inside 
the window). Touch-screen commands are presently limited to 
rotation (move one finger). Model style cannot be changed. Note that 
(except for molecular mechanics and semi-empirical calculations) the 
structure is updated throughout an equilibrium geometry or transition 
state optimization. Bond lengths, angles and dihedral angles can be 
queried. 

To terminate a job, right click on its name, and then select Terminate. 
To start a queued job, right click on its name and select Start.

The Monitor may be removed by clicking on  at the top of the 
dialog.
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Calculator ( )

Selection brings up a Calculator.

This functions the same way as a normal pocket calculator. The 
Calculator is removed by clicking on .

Icons ( )

Toggles the display of icons above the menu bar on and off. 
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Chapter 11
The Activities Menu

The Activities menu permits on-screen display of the full set of Spartan 
Student tutorials and a series of topics of practical relevance to 
molecular modeling. A series of lab activities, organized by subject, 
is available for assignment or self-study. It also allows a Wikipedia 
page to be brought up (external to Spartan Student).

Tutorials, Topics, and Labs

Selection brings up an HTML page (Tutorials shown).

Clicking on an entry (link) brings up the computer’s PDF reader 
alongside of Spartan Student. This allows you to access the materials 
while working with the program.
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Note that the full Manual is available as a PDF under the Help menu 
(see next chapter).

Look Up in Wikipedia...

Selection results in a dialog.

Entering a query followed by clicking on OK leads to a Wikipedia 
page. This occupies a window that is external to Spartan Student.
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Chapter 12
The Help Menu

Spartan Student v9 Help

This provides information relating to application of computational 
methods available in Spartan Student, as well as technical details 
regarding the program’s operation, and also provides a link to 
Wavefunction’s website. Help files are HTML documents.

Spartan Student v9 Manual

Opens a PDF file providing documentation on Spartan Student 
Edition menus and features (this document).

License Utility . . .

Provides access to the License Utility dialog. From here you can 
access your license activation code or KeyID, Maintenance Status 
and academic licenses can request a Transfer.*

*	 Transfers are not available for student-purchased licenses that utilize an activation code.
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About Spartan Student v9. . .*

Provides information about the user’s release of Spartan Student, 
and their license type. It also contains information on the machines 
video format and a button to access the license utility dialog. 

*	 About is located under the Spartan Student menu in the Macintosh version.
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Section IV
Appendices and Glossary

This section is comprised of a set of six appendices. The first of these 
(Topics) is also available in PDF form (by topic) from the Activities 
menu. The included appendices provide further details on Spartan 
Student version 9’s Capabilities and Limitations, an abridged guide 
to all menu entries Menus), a Units and an energy conversion table, 
details on proper Citation (if citing in publication), and instructions 
for Accessing ChemDraw. Both the Windows and Macintosh version 
can open native ChemDraw files, additionally (Windows version 
only) includes the ability to open ChemDraw (must be installed and 
licensed) from within Spartan Student. This seamless access allows 
Windows users to build in 2D in ChemDraw, and auto-convert 
the ChemDraw structure into 3D. This can also be done without 
ChemDraw access via Spartan Student’s 2D Sketch builder.

The final section includes a glossary of terms used throughout the 
documentation, and more generally in the “molecular modeling” or 
“computational chemistry” community.
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Appendix A
Topics

Essays address topics that are important to molecular modeling 
in general and to modeling applications of Spartan in particular. 
Most of these essays are at an elementary level and provide only 
fundamentals.

The first two essays are foundational. Potential Energy Surfaces 
relates two of the quantities that directly result from a quantum 
chemical calculation, geometry and energy. Theoretical Models 
outlines the steps taken in moving from the Schrödinger equation 
to practical techniques and broadly outlines the  scope of these 
techniques. 

Finding and Verifying Equilibrium and Transition-State 
Geometries and Total Energies and Thermodynamic and Kinetic 
Data provide specifics about the relationship between geometry 
and energy in the context of practical quantum chemical models. 
Calculating Accurate Heats of Formation details procedures that 
are available in Spartan to reliably reproduce the experimental heats 
of formation.

Interpreting Conformational Preferences shows how information 
resulting from a calculated energy profile for single-bond rotation 
may be related to familiar chemical notions. 

Calculating Infrared Spectra shows how the raw data resulting 
from a quantum chemical calculation may be combined with 
two empirical parameters to produce accurate infrared spectra. 
Calculating NMR Spectra describes a multi-parameter scheme to 
obtain 13C chemical shifts into close agreement with experiment. 

Atomic and Molecular Orbitals describes how molecular 
orbitals arise from atomic orbitals in the context of the practical 
quantum chemical models introduced previously, and illustrates the 
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information that can be drawn from them.  Electron Densities: Sizes 
and Shapes of  Molecules describes molecular size and shape from 
the perspective of quantum mechanics and in so doing provides a 
“platform” from which to evaluate how a molecule interacts with its 
environment.  Electrostatic Potential Maps: Charge Distributions 
describes a model that uses color to “map” the electrostatic potential 
(the energy of a positive point charge with the nuclei and electrons 
of a molecule) in order to distinguish neutral, positive and negative 
regions on an accessible surface. Local Ionization Potential Maps 
and LUMO Maps: Electrophilic and Nucleophilic Reactivities 
show how maps colored using the energy of ionization and the absolute 
value of the lowest-unoccupied molecular orbital, respectively, may 
be used to account for electrophilic and nucleophilic reactivity. 

Potential Energy Surfaces

One Dimensional Energy Surfaces

Every chemist has encountered a plot depicting the change in energy 
of ethane as a function of the angle of torsion (dihedral angle) around 
the carbon-carbon bond.
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Full 360° rotation leads to three identical energy minima in which 
the hydrogens are staggered, and three identical energy maxima in 
which the hydrogens are eclipsed. The difference in energy between 
eclipsed and staggered structures of ethane, termed the barrier to 
rotation, is known experimentally to be approximately 12 kJ/mol. 
Note that any physical measurements on ethane pertain only to 
its staggered structure, or more precisely the set of three identical 
staggered structures. Eclipsed ethane does not exist in the sense that it 
cannot be isolated and characterized. Rather, it can only be imagined 
as a structure in between equivalent staggered forms.

Open ethane rotation in the topics directory*. The image which appears is 
one frame in a sequence depicting rotation about the carbon-carbon bond 
in ethane. Click on the  and  keys at the bottom left of the screen to 
look at other frames. Verify that the staggered structures correspond to 
minima on the energy plot and that the eclipsed structures correspond 
to maxima. Click on the  key to animate the sequence. Close ethane 
rotation when you are finished.

Somewhat more complicated but also familiar is a plot of energy 
vs. the dihedral angle involving the central carbon-carbon bond in  
n-butane.

* For Windows, the Topics directory is found in Program Files/Wavefunction/Spartan 
Student. It needs to be copied to another location available to the user prior to opening it in 
Spartan. For Macintosh, this is located at the top level of the Spartan Student disc image. 
Copy the Topics directory to a location that allows write permission, typically the user’s 
home directory.
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This plot also reveals three energy minima, corresponding to staggered 
structures, and three energy maxima, corresponding to eclipsed 
structures. In the case of n-butane, however, the three structures in 
each set are not identical. Rather, one of the minima, corresponding 
to a dihedral angle of 180° (the anti structure), is lower in energy and 
distinct from the other two gauche minima (dihedral angles around 60° 
and 300°), which are identical. Similarly, one of the energy maxima 
corresponding to a dihedral angle of 0°, is distinct from the other 
two maxima (with dihedral angles around 120° and 240°), which 
are identical. As with eclipsed ethane, eclipsed forms of n-butane do 
not exist, and correspond only to hypothetical structures in between 
anti and gauche minima. Unlike ethane, which is a single compound, 
any sample of n-butane is made up of two distinct compounds, anti 
n-butane and gauche n-butane. The relative abundance of the two 
compounds as a function of temperature is given by the Boltzmann 
equation (see the topic Total Energies and Thermodynamic and 
Kinetic Data).
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Open n-butane rotation in the topics directory. The image which appears 
is one frame of a sequence depicting rotation about the central carbon-
carbon bond in n-butane. Click on the  and  keys at the bottom left 
of the screen to look at other frames. Verify that the staggered structures 
correspond to minima on the energy plot and that the eclipsed structures 
correspond to maxima. Also, verify that the anti structure is lower in 
energy than the gauche structure. Click on  to animate the sequence. 
Close n-butane rotation when you are finished.

The important geometrical coordinate in n-butane may clearly be 
identified as a torsion about the central carbon-carbon bond. This is 
an oversimplification, as bond lengths and angles no doubt change 
during rotation around the carbon-carbon bond.

Quantum chemical models available in Spartan are able to account 
for the subtle changes in bond lengths and angles which result from 
changes in conformation. Open n-butane geometry changes in the topics 
directory. The two plots depict the variation in central CC bond distance 
and in CCC bond angle as a function of the CCCC torsional angle. The 
variation in energy is superimposed on each plot. Note how closely the 
bond distance and energy changes parallel each other. Note also that the 
bond angle is insensitive to conformation except in the region of the syn 
(0° torsional angle) structure where it has opened up by several degrees. 
Close n-butane geometry changes when you are finished.

Many Dimensional Energy Surfaces

It will usually not be possible to identify a simple geometrical 
coordinate to designate a chemical transformation. A good example 
of this is provided by the potential energy surface for ring inversion 
in cyclohexane.
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reaction coordinate

transition
state

transition
state

twist boat
chair chair

energy

In this case, the geometrical coordinate connecting stable forms is 
not specified in detail (as it was in the previous two examples), but is 
referred to simply as the reaction coordinate. The two energy maxima 
on the reaction coordinate diagram have been designated as transition 
states to indicate that their structures may not be simply described 
(as are the energy maxima for rotation in ethane and n-butane).

The energy surface for ring inversion in cyclohexane, like that for  
n-butane, contains three distinct energy minima, two of lower energy 
referred to as chair forms, and one of higher energy referred to as a 
twist boat form. In fact, the energy difference between the chair and 
twist boat structures is around 23 kJ/mol and, only the former can 
be observed at normal temperatures. For a discussion, see the topic 
Total Energies and Thermodynamic and Kinetic Data.

All six carbons are equivalent in the chair form of cyclohexane, 
but the hydrogens divide into two sets of six equivalent equatorial 
hydrogens and six equivalent axial hydrogens.

Haxial

Hequatorial

However, only one kind of hydrogen can normally be observed, 
meaning that equatorial and axial positions interconvert via some 
low-energy process. This is the ring inversion process just described, 
in which one side of the ring is bent upward while the other side is 
bent downward.
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H*
H
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As shown in the potential energy diagram on the previous page, the 
overall ring inversion process appears to occur in two steps, with a twist 
boat structure as a midway point (an intermediate). The two (equivalent) 
transition states leading to this intermediate adopt structures in which 
five of the ring carbons lie (approximately) in one plane.

The energy profile for ring inversion in cyclohexane may be 
rationalized given what we have already said about single-bond 
rotation in n-butane. Basically, the interconversion of the reactant 
into the twist-boat intermediate via the transition state can be viewed 
as a restricted rotation about one of the ring bonds.

Correspondingly, the interconversion of the twist boat intermediate 
into the product can be viewed as rotation about the opposite ring 
bond. Overall, two independent bond rotations, pausing at the high-
energy (but stable) twist-boat intermediate effect conversion of one 
chair structure into another equivalent chair, and at the same time 
switch axial and equatorial hydrogens.

Open cyclohexane ring inversion in the topics directory. The image 
which appears is one frame in a sequence depicting ring inversion in 
cyclohexane. Click on the  and  keys at the bottom left of the screen 
to look at other frames. Verify that the three minima on the energy plot 
correspond to staggered structures and that the two maxima correspond 
to eclipsed structures. Also, verify that the twist boat structure is higher 
in energy than the chair structures. Click on  to animate the sequence. 
Note that the overall ring inversion appears to occur in two steps, one 
step leading up to the twist boat and the other step leading away from it. 
Close cyclohexane ring inversion when you are finished.

Ethane, n-butane and cyclohexane are all examples of the types 
of motions which molecules may undergo. Their potential energy 
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surfaces are special cases of a general type of plot in which the 
variation in energy is given as a function of reaction coordinate.

energy

reaction coordinate

transition state

reactant

product

Diagrams like this provide essential connections between important 
chemical observables - structure, stability, reactivity and selectivity 
- and energy. 

The positions of the energy minima along the reaction coordinate give 
the equilibrium structures of the reactant and product. Similarly, the 
position of the energy maximum gives the structure of the transition 
state. Both energy minima (which correspond to stable molecules) and 
the energy maximum (which may correspond to a transition state) are 
well defined. However, the path connecting them (reaction coordinate) 
is not well defined, in the sense that there are many possible paths. 
Liken this to climbing a mountain. The starting and ending points are 
well defined as is the summit, but there can be many possible routes.

transition state

product

energy

reaction coordinate

equilibrium structures

transition state structure

reactant
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The reaction coordinate for some processes may be quite simple. For 
example, where the “reaction” is rotation about the carbon-carbon 
bond in ethane, the reaction coordinate may be thought of as the 
HCCH torsion angle, and the structure may be thought of in terms 
of this angle alone. Thus, staggered ethane (both the reactant and the 
product) is a molecule for which this angle is 60° and eclipsed ethane 
is a molecule for which this angle is 0°.

A similar description applies to “reaction” of gauche n-butane leading 
to the more stable anti conformer. Again, the reaction coordinate may 
be thought of as a torsion about the central carbon-carbon bond, and 
the individual reactant, transition state and product structures in terms 
of this coordinate.

Equilibrium structure (geometry) may be determined from experiment, 
given that the molecule can be prepared and is sufficiently long-lived 
to be subject to measurement. On the other hand, the geometry of 
a transition state may not be experimentally established. This is 
simply because a transition state is not an energy well which can 
trap molecules. Therefore, it is impossible to establish a population 
of molecules on which measurements may be performed. 

Both equilibrium and transition-state structures may be determined 
from quantum chemical calculations. The fact that a molecule may 
not be stable enough to be detected and characterized (or even exist) 
is not important. It would seem from our discussion that equilibrium 
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and transition-state structures can be distinguished from one another 
simply by inspecting the shape of the potential energy surface in the 
vicinity of the structure. Of course, such a surface cannot actually be 
visualized for a system with more than one or at most two degrees 
of freedom. However, the set of frequencies associated with the 
vibrational motions around the structure, the same quantities measured 
by infrared spectroscopy, will all be real numbers for stable molecules 
(energy minima), whereas there will be one (and only one) vibrational 
frequency which is an imaginary number for a transition state. This 
does not guarantee that this is the transition state “of interest”, but if it 
is, the coordinate (vibrational motion) associated with it is the reaction 
coordinate. Further discussion is provided in the topic Calculating 
Infrared Spectra. 

Theoretical Models

A variety of different procedures based on quantum mechanics (so-
called quantum chemical models) have been developed to calculate 
molecular structure and properties as well as infrared, NMR and 
UV/visible spectra. All follow from a deceptively simple looking 
Schrödinger equation first written down in 1927.

HΨ = εΨˆ

Ĥ (the Hamiltonian or more precisely Hamiltonian operator) is 
the only known. It describes the kinetic energies of the particles that 
make up a molecule and the Coulombic interactions between the 
individual particles. Positively-charged nuclei repel other nuclei, 
and negatively-charged electrons repel other electrons, but nuclei 
attract electrons. Ψ (the wave function) is a function of the Cartesian 
coordinates, and ε (the energy) is a number. The goal in solving the 
Schrödinger equation is to find a function that when operated on by 
the Hamiltonian yields the same function multiplied by a number. 
Note that there are many (actually an infinite number of) solutions 
to the Schrödinger equation. These correspond to the ground and 
numerous excited states of an atomic or molecular system.

The energy of a molecule can be measured. On the other hand, the wave 
function has no physical meaning, and is not subject to experimental 
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measurement, although the square of the wave function times a small 
volume element gives the probability of finding an electron inside 
that volume. This exactly corresponds to what is actually measured 
in an X-ray diffraction experiment.

The Schrödinger equation has been solved exactly for the hydrogen 
atom (a one-electron system), where the wave functions are familiar to 
chemists as the s, p, d, ... atomic orbitals. The lowest-energy s orbital 
corresponds to the ground state of the hydrogen atom, whereas the 
higher-energy solutions correspond to excited states.

s orbital p orbital d orbital

The Schrödinger equation may easily be written down for many-
electron atoms as well as for molecules, although it cannot be solved. 
Even something as seemingly simple as the helium atom with only 
two-electrons presents an insurmountable problem. Approximations 
must be made.

Hartree-Fock Molecular Orbital Models

Hartree-Fock molecular orbital models or molecular orbital 
models, as they are commonly referred to, were the first practical 
quantum chemical models to be formulated. They result from making 
three approximations to the Schrödinger equation: 

1.	 Separate nuclear and electron motions. The Born-Oppenheimer 
approximation says that “from the point of view of the electrons”, 
the nuclei are stationary. This eliminates nuclear motion and leads 
to an electronic Schrödinger equation which can be solved for 
the H2

+ molecule, but cannot be solved for molecules with more 
than one-electron. The Born-Oppenheimer approximation is of 
little consequence for the description of molecular properties, for 
example, equilibrium geometries and reaction energies, and may 
be used without concern.
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2.	 Separate electron motions. The Hartree-Fock approximation 
eliminates the need of having to simultaneously account for the 
motions of several electrons. It leads to a much simpler set of 
equations in which the motion of each electron in an environment 
made up of the nuclei and all the other electrons is sought. 

3.	 Represent each one-electron solution or molecular orbital 
by a linear combination of atom-centered functions or atomic 
orbitals. The LCAO (Linear Combinations of Atomic Orbitals) 
approximation reduces the problem of finding the best functional 
form for the molecular orbitals to the much simpler problem of 
finding the best set of linear coefficients. As the number and 
complexity of the atomic orbitals increases, the energy and other 
properties approach limiting values. However, computational 
cost also increases. The goal is to provide as few functions as 
possible to yield a value for the property of interest that adequately 
reflects its limit. Note, that the limiting values of properties are 
not expected to be the same as experimental values, but rather 
reflect the behavior of the Hartree-Fock model. Spartan Student 
includes Hartree-Fock for molecules with up to 30 atoms.

Basis Sets

Gaussian functions are polynomials in the Cartesian coordinates 
times an exponential in the square of the distance from the origin. 
They are distinct although very closely related to the exact solutions 
of the hydrogen atom (exponential functions in the distance), and 
are labeled 1s, 2s, 2p, ... , the same nomenclature used to describe 
hydrogen atom solutions. 

A minimal basis set includes only sufficient functions to hold all 
the electrons on an atom and to maintain its spherical shape. This 
involves a single 1s orbital for each hydrogen atom, and a set of five 
orbitals (1s, 2s, 2px, 2py and 2pz) for each carbon atom. Because a 
minimal basis set incorporates only one set valence p functions, the 
components of which are the same size, atoms in nearly spherical 
environments will be better described than atoms in aspherical 
environments. A split-valence basis set addresses this problem by 
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providing two different sets of valence p functions, one compact 
set and one loose set. This allows different linear combinations 
for different directions. For example, the compact p orbital can be 
emphasized to construct a σ bond while the loose p orbital can be 
emphasized to construct a π bond.

ps  =  inner                  +  outer

pp  =  inner                   +  outer

Because the functions in a minimal or split valence basis set are 
centered on the atoms, they may have difficulty describing electron 
distributions that fall in between atoms (that is, bonds).  Polarization 
basis sets address this problem by providing a set of d-type functions 
(polarization functions) on main-group elements, and (optionally) a 
set of p-type functions on hydrogen. The resulting combinations can 
be thought of as hybrid orbitals, for example, the pd and sp hybrids 
shown below.

+  λ

+  λ

The so-called 6-31G* basis set will be used for the infrared and NMR 
calculations described in future topics. The number “6” to the left of 
the “-” in the name  indicates that 6 functions are used to describe each 
inner-shell (core) atomic orbital. The numbers, “31” to the right of 
the “-” indicate that groups of 3 and 1 functions are used to describe 
each valence-shell atomic orbital. “*” designates that polarization 
functions are supplied for non-hydrogen atoms. Were two stars to be 
present (as in 6-31G**) this would indicate that p-type  polarization 
functions would also be placed on hydrogen atoms.
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The valence basis functions can be further split and additional 
polarization functions can be added including f-type functions. A 
commonly used basis set is designated 6-311+G(2df,2p). “311” 
indicates a triply-split valence, “2df” indicates that two sets of d-type 
functions and a set of f-type functions are added to the valence of 
heavy atoms, and “2p” indicates that two sets of p-type functions are 
added to the valence of hydrogen atoms. 

Taken together, these three approximations lead to a set of 
equations known as the Roothaan-Hall equations. They increase 
in computational cost as the cube of the size (number of basis 
functions), and can easily be applied to molecules incorporating up 
to 100 heavy (non- hydrogen) atoms.

Beyond Hartree-Fock Models

Of the three approximations we have made to reach Hartree-Fock 
models, the second is to be taken most seriously. According to the 
Hartree-Fock approximation, electrons “move independently”, 
which means that both the electron-electron repulsion energy and 
the total energy will be too large. The limiting Hartree-Fock energy 
is, therefore, necessarily higher (less negative) than the experimental 
energy. Electron correlation is the term give to describe the 
coupling or correlation of electron motions. The correlation energy 
is defined as the difference between the Hartree-Fock energy and the 
experimental energy and is necessarily a negative quantity.

There are two conceptually different approaches for calculating the 
correlation energy, and numerous specific models arising from each of 
these approaches. Wave function based models start from the Hartree-
Fock wave function combining it with wave functions resulting from 
electron excitations from filled to empty molecular orbitals. Density 
functional models supplement the Hartree-Fock Hamiltonian. 

Configuration Interaction Models

Configuration interaction models are archetypal of wave function 
based correlated models. In the unachievable limit, so-called full 
configuration interaction, all possible single and multiple electron 
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promotions from occupied to unoccupied Hartree-Fock molecular 
orbitals and assuming a complete basis set, the energy is same as 
would be achieved by solution of the electronic Schrödinger equation. 
More practical limited configuration interaction schemes have 
been formulated by limiting the number of electron simultaneously 
promoted (1-electron, 2-electron, ...) and the number of filled and 
unfilled molecular orbitals involved in the promotions. Cl models 
are not included in the Spartan Student edition. 

Møller Plesset Models

An alternative and more commonly used wave function based model 
is Møller-Plesset theory. This assumes that the Hartree-Fock energy 
E0 and wave function Ψ0 are solutions to an equation involving 
a Hamiltonian, Ĥ0, that is very close to the exact Schrödinger 
Hamiltonian, Ĥ. This being the case, Ĥ can be written as a sum of Ĥ0 
and a small correction, V. λ is a dimensionless parameter.

H = H0 + λVˆ ˆ ˆ

Expanding the exact energy in terms of a power series of the Hartree-
Fock energy yields:

E = E(0) + λE(1) + λ2E(2) + λ3E(3) + ...

Substituting this expansion into the Schrödinger equation and 
collecting terms in powers of λ leads to an explicit expression for the 
energy correction. The sum of E(0) and E(1) is the Hartree-Fock energy. 
Including the next term gives rise to the so-called MP2 (second-order 
Møller-Plesset) model.

Both the simplest configuration interaction (limited to single and 
double electron excitations only) and the MP2 models increase in 
computational cost as the power of the total number of basis 5th 
functions. Spartan Student includes the MP2 model for molecules 
with up to 20 atoms.

Density functional theory or simply DFT, is based on two theorems 
elaborated by Hohenberg and Kohn, which taken together, prove 
that the energy and other properties of a many-electron system in its 
ground state may be correctly and uniquely described in terms of a 
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function of the electron density. The term “functional” or a function 
of a function arises because the electron density is itself a function of 
the three spatial coordinates. What the two Hohenberg-Kohn theorems 
imply is that the Schrödinger equation can actually be solved; that is, 
the completely “intractable” problem involving the coupled motions 
of n electrons in a static field due to the nuclei (a “molecule”) may 
be replaced by an eminently “solvable” problem that treats the 
electrons as independent (that is, non-interacting) particles. Because 
the electron density is a function of only three coordinates, in effect 
a 3 dimensional problem is substituted for a 3n dimensional problem. 
Unfortunately, the Hohenberg-Kohn theorems do not tell us anything 
about the functional itself.

In the density functional formalism, the electronic energy, Eel, is 
written as a sum of the kinetic energy, ET, the electron-nuclear 
interaction energy, EV, the Coulomb energy, EJ, and a term combining 
the exchange and correlation energies, EXC.    

Eel = ET + EV + EJ + EXC

What is “the” exchange/correlation functional? The quest has gone 
on for several decades and hundreds of functionals have actually been 
proposed and divided into several distinct classes. Spartan Student 
includes 3 functionals: B3LYP, EDF2, and wB97X-D for molecules 
with up to 30 atoms.

Local Density Approximation (LDA)

The functional first proposed stems from a purely hypothetical problem 
in which a uniform gas of non-interacting electrons moves in a 
positively charged field.  An analytical solution for the exchange energy 
is available and takes the form of the density raised to the 4/3’s power. 
The correlation energy may be arrived at through numerical simulation, 
and is also only dependent on only the local density at each point.

EXC = E(ρ)

Functionals that depend only on the electron density (ρ) are referred 
to as LDA functionals. They are not very successful in describing the 
properties of molecules and have largely been replaced.
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Generalized Gradient Approximation (GGA)

GGA functionals depend on the gradient of the electron density, ∇ρ, 
in addition to the density itself. 

EXC = E (ρ, ∇ρ)

They have been around since the mid 1980’s and were the first 
to provide a reasonable account of molecular properties and in 
particular the energies of chemical reactions. In this sense, they 
were instrumental in drawing attention to density functional theory 
as a viable “low-cost” alternative to wave function based correlation 
techniques, something that LDA functionals had failed to do. The 
BLYP functional is representative. 

Global Hybrid Generalized Gradient Approximation  
(GH-GGA)

GH-GGA functionals often referred to as hybrid functionals) replace a 
fixed fraction of the exchange by the “exact” Hartree-Fock exchange, 
the fraction being an adjustable parameter. It is likely that it was 
the introduction of hybrid functionals that caused the community 
to recognize that density functional theory was “semi-empirical” 
in nature. Adding the Hartree-Fock exchange is “costly”, but led 
to significant improvements in the description of reaction energies. 
While GH-GGA functionals were introduced in the early 1990’s, they 
remain a mainstay in the application of density functional theory to 
chemistry. The B3LYP functional, in particular, is perhaps still more 
widely used than any other functional, even though there are now 
much better choices. B3LYP and EDF2 are representative GH-GGA 
functionals in Spartan Student.

Range Separated Hybrid Generalized Gradient Approximation 
(RSH-GGA)

The idea behind range separated GGA hybrid functionals is that the 
“optimum” amount of Hartree-Fock exchange varies with electron-
electron distance, from a small percentage in the long range limit 
to a large percentage in the short range limit, in the extreme from 
0% to100%. Both ωB97X-D and ωB97X-V functionals are range-
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separated GGA hybrids. Both incorporate so-called local corrections 
to account for dispersive interactions (see discussion following), the 
former is included in Spartan Student. 

meta Generalized Gradient Approximation (mGGA)

A meta GGA functional not only depends on the electron density and 
its gradient (as does a GGA functional) but also on the Laplacian of 
the electron density. As such, it can be construed as the next logical 
step beyond GGA in constructing a Taylor series expansion of the 
electron density.

E = E (ρ, ∇ρ,∇2ρ)

More commonly, meta GGA functionals are viewed as adding the 
so-called kinetic energy density to GGA.

E = E (ρ, ∇ρ,∇2ψ)

In either case, the addition can be construed as second-order term 
in a Taylor series expansion of the electron density. The B97M-V 
functional is an example of a “pure” meta functional.

Global Hybrid meta Generalized Gradient Approximation 
(GH-mGGA)

These are strictly akin to global hybrid GGA (GH-GGA) functionals 
in that a fixed percentage of the Hartree-Fock exchange is introduced. 
The “only” difference is that a meta GGA functional including 
a second-order term replaces a GGA functional. The M06-2X 
functional, widely accepted as an excellent choice for thermochemical 
comparisons, is an example of a GH-meta GGA functional.

Range Separated Hybrid meta Generalized Gradient 
Approximation (RSH-mGGA)

A range-separated meta GGA (RSH-mGGA) functional is identical 
to a range-separated GGA (RSH-GGA) functional except that a meta 
GGA functional has replaced the underlying GGA functional. M11 and 
ωB97M-V are examples of range-separated meta GGA functionals.
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Double Hybrid meta Generalized Gradient Approximation 
(DH-RSH-mGGA)

A double hybrid meta GGA (DH-RSH-mGGA) functional accounts 
for contributions of unoccupied molecular orbitals as well as occupied 
orbitals, by way of a MP2 like approach. The wB97M(2) functional 
is now supported for energy calculations only.

Non Local Corrections

The previous functional classes are all considered “local” in that 
they are described in terms of a single integral over the three spatial 
coordinates.  In order to capture dispersive van der Waals interactions, 
so-called non local correlation functionals are needed.  These involve a 
double integral over two sets of coordinates, these may add significant 
cost to the calculations. For example, the range-separated GGA hybrid 
ωB97X-V functional used throughout this text, incorporates theVV10 
non-local correlation functional and is 3-5 times more costly than 
the parent ωB97X functional. An alternative and less costly way to 
account for dispersive interactions is to add an empirical correction 
to the functional. So-called Grimme corrections are designated by 
appending “-D” as in ωB97X-D, or “D3” as in B3LYP-D3, to the 
end of the functional.

A graphical summary of a number of commonly-used functionals 
stemming from different classes is provided in the figure below. 
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Which classes of functionals are “best” and which functionals within 
each class are “best”? A broad base of experience allows some general 
remarks to be made.

Numerical Integration

Unlike both Hartree-Fock and wave function based correlated models, 
density functional models cannot be evaluated wholly analytically. 
Some components require numerical integration, which introduces 
another variable into the mix, specifically the form and size of the 
integration grid. An oversimplified description places the grid points 
along a set number of angular directions and at a set number of 
distances from the origin. This is referred to as a Lebedev grid.

“Cost” of Density Functional Models

The computation “cost” of density functional models depends on the 
class, the number of basis functions, η, and the number of points in the 
numerical integration grid, κ, where κ >> η. GGA and pure meta-GGA 
functionals such as B97M-V that do not require the Hartree-Fock 
exchange formally scale as O(η2κ). The other functionals combine 
this dependence with the cost of the Hartree-Fock exchange, which 
formally scales as O(η4) but in practice is O(η3) or lower. Finally, 



282	 Appendix A

functionals such as ωB97X-V that directly account for dispersion have 
a step that scales as O(η2κ2). This typically dominates the calculation. 
Times (in minutes) for calculation of the energy together with its 
gradient (“one step” in the optimization of molecular geometry) for 
morphine (C17H19NO3) with the B3LYP (GH-GGA), ωB97X-D 
(RSH-GGA), ωB97X-V (RSH-GGA+dispersion), B97M-V (mGGA), 
M06-2X (GH-mGGA) and M11 and ωB97M-V (RSH-mGGA) 
functionals,  as well as with RI-MP2, which formally scales as O(η5), 
with the 6-31G* basis set are provided in Table A-1. These have been 
obtained using a single core of a 3.3 GHz Intel i7 5820K processor. 
Table A-2provides times for 6-311+G(2df,2p) calculation, a dual 
basis set 6-311+G(2df,2p) calculation and a dual basis set cc-pVQZ-g 
(cc-pVQZ minus the set of g functions) energy calculation, relative to 
the  corresponding 6-31G* energy/gradient calculations. For example, 
the value of 26 for the dual basis set cc-pVQZ–g ωB97X-D energy 
calculation given in Table A-2, means that this calculation is 26 
times more costly than the ωB97X-D energy/gradient calculation. 
Put another way, a structure optimization requiring 26 cycles would 
cost the same as an energy obtained using the larger basis set.

The manner of reporting is deliberate. The 6-31G* basis set is usually 
deemed satisfactory for calculation of equilibrium geometry, whereas 
larger basis sets (for example, 6-311+G(2df,2p) and cc-pVQZ-g) are 
known to be required for accurate descriptions of the energies of most 
chemical reactions. Determination of geometry for molecules of the 
complexity of morphine typically requires upwards of 10-20 energy/
gradient cycles, that is, an order of magnitude or more greater than 
the time reported in the first column of the table. Both parts must be 
considered in order to correctly access cost and practicality.  
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Table A-1:	Times for energy and gradient calculations on morphine with 
B3LYP, ωB97X-D, ωB97X-V, B97M-V, M06-2X, M11 and 
ωB97M-V density functional models and RI-MP2 model with 
the 6-31G* basis set (need ωB97M-V times)

 6-31G* + gradient

 B3LYP 7
 ωB97X-D 15
 ωB97X-V 41
 B97M-V 50
 M06-2X 19
 M11 22	
 RI-MP2 10

Table A-2: Times for B3LYP, ωB97X-D, ωB97X-V, B97M-V, M06-2X, 
M11 and ωB97M-V density functional and RI-MP2 energy 
calculations with 6-311+G(2df,2p), dual 6-311+G(2df,2p) and 
dual cc-pVQZ-g basis sets relative to the corresponding times 
for energy and gradient calculations with the 6-31G* basis 
set give in Table A-1  (need ωB97M-V times)

 	 6-311+G(2df,2p)	 cc-pVQZ-g
 6-311G(2df,2p)	 [6-311G*]	 [rcc-pVQZ]

 B3LYP	 26	 5	 48
 ωB97X-D	 14	 3	 26
 ωB97X-V	 6	 2	 10
 B97M-V	 5	 2	 6
 M06-2X	 13	 3	 21
 M11	 11	 3	 20	
 RI-MP2	 18	 3	 33

Several conclusions may be drawn:

Times for calculation of the energy together with its gradient 1.	
vary by close to an order of magnitude among the seven models. 
The B3LYP model is the least costly and the ωB97X-V, B97M-V 
and ωB97M-V models most costly. The latter result suggests that 
calculation of the gradient of dispersion functional common to 
both models is to blame.  In terms of cost, the ωB97X-D model 
is closest to B3LYP. The surprising result is perhaps the good 
performance of the RI-MP2 model, surpassed only by B3LYP.
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6-311+G(2df,2p) energy calculations are roughly an order of 2.	
magnitude more costly than the corresponding energy/gradient 
calculations. At the high end and low ends is the factor of 26 
for the B3LYP model and a factor of 5 for the B97M-V model. 
Structure optimization typically requires upwards of 20 steps 
(energy/gradient), and will likely dominate the overall task.

The dual basis set approximation applied to 6-311+G(2df,2p) basis 3.	
set leads to significant cost savings. If this is the chosen energy 
method, the costly step will most certainly be determination of 
geometry.

Except for the ωB97X-V and B97M-V functionals, dual basis set 4.	
cc-pVQZ-g calculations are roughly an order of magnitude more 
costly than the corresponding 6-311+G(2df,2p) calculations. This 
means that geometry and energy steps are likely to contribute 
equally to overall cost. The much smaller increase in cost for 
B97M-V is presumably due to its lack of the Hartree-Fock 
exchange.

The RI-MP2 model is clearly competitive, greater in overall cost 5.	
only to the B3LYP models. Because of its inherent O(η5) scaling, 
RI-MP2 will eventually fall significantly behind density functional 
models in performance as molecular size is increased.

Disadvantages of Density Functional Models

Low computation cost relative to wave function based electron 
correlation models is the principal attraction of density functional 
models. Aside from the RI-MP2 model, density functional models 
are the only procedures that are both reliable and routinely applicable 
to molecules of moderate size. However, density functional models 
come with some disadvantages not shared by wave function based 
procedures. By far the most serious of these is that they do not offer 
a clear pathway to improvement. Whereas wave function based 
procedures return a higher and higher percentage of the correlation 
energy with increasing degree of complexity, for example, in 
successively adding orders in the Møller-Plesset models,



Appendix A	 285

there is no guarantee that increasing the flexibility (and complexity) 
of a particular functional will actually lead to improvement. It is clear 
that present generation functionals are “better” than those of previous 
generations, for example, ωB97X-D and M06-2X are significantly 
better than B3LYP, in particular for calculation of reaction energies. 
What is less clear is whether the improvement is to large extent due 
to careful parameterization to high quality reference data (and to an 
increased number of parameters) rather than from insight into the 
“proper” functional form. Functional selection, even while guided 
by clear physical models, certainly has an uncertain component, and 
at least at present it is not possible to say from first principles which 
of several functionals is likely to provide the “best” results. This can 
only be done by way of thorough comparisons with “known” data. 

In practice, density functional models increase in computational cost 
as the cube of the total number of basis functions (the same dependence 
seen for Hartree-Fock models). Because most functionals require 
calculation of the Hartree-Fock exchange energy, they are necessarily 
more costly than Hartree-Fock models, but can easily be applied to 
molecules incorporating up to 100 heavy (non-hydrogen) atoms.

Models for Open-Shell Molecules

Thus far, discussion has been limited to molecules with closed-
shell electron configurations, that is, with all electrons being paired. 
This covers the vast majority of organic molecules as well as most 
organometallic molecules. There are two ways to think about 
molecules with unpaired electrons. The obvious way is to insist that 
electrons are either paired or are unpaired.
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This is referred to as restricted and the individual models as restricted 
models, for example, the restricted Hartree-Fock (or RHF) model.

The restricted procedure does not necessarily yield the lowest possible 
energy, simply because it forces the “paired” electron into the same 
spatial orbitals. Removing this constrains provides greater flexibility 
and generally lead to a lower energy. This is termed unrestricted and 
the resulting models are termed unrestricted models, for example, the 
unrestricted Hartree-Fock (or UHF) model.

Aside from yielding lower energy, unrestricted models are generally 
less costly than restricted models, and are much more widely used 
and is the default procedure in Spartan.

Semi-Empirical Molecular Orbital Models

The principal disadvantage of Hartree-Fock, density functional and 
MP2 models is their computational cost. It is possible to introduce 
further approximations together with empirical parameters in order to 
significantly reduce cost while still retaining the underlying quantum 
mechanical formalism. So-called semi-empirical molecular orbital 
models follow in a straightforward way from Hartree-Fock models: 

1.	 Insist that basis functions on different atoms do not overlap (“see 
each other”). The so-called NDDO approximation is rather 
drastic but reduces the computation effort by more than an order 
of magnitude over Hartree-Fock models.

2.	 Restrict to a minimal valence basis set of atomic functions. This 
means that there are no inner-shell (core) functions in the basis 
set. As a consequence, the cost of doing a calculation involving a 
second-row element such as silicon, is no more than that incurred 
for the corresponding first-row element such as carbon.



Appendix A	 287

3.	 Introduce adjustable parameters to reproduce specific experimental 
data. This is what distinguishes the various semi-empirical models 
currently available. Choice of parameters, more than anything else, 
appears to be the key to formulating successful semi-empirical 
models.

Spartan Student includes the PM3 semi-empirical model for systems 
with up to 75 atoms. 

Molecular Mechanics Models

The alternative to quantum chemical models are molecular mechanics 
models. These do not start from the Schrödinger equation, but 
rather from a simple but chemically reasonable picture of molecular 
structure, a so-called force field. In this picture, just as with a Lewis 
structure, molecules are made up of atoms (as opposed to nuclei and 
electrons), some of which are connected (bonded). Both crowding 
(van der Waals) and charge-charge (Coulombic) interactions between 
atoms are then considered, and atom positions are adjusted to best 
match known structural data (bond lengths and angles). 

Molecular mechanics is much simpler than attempts at solving 
an “approximate” Schrödinger equation, but requires an explicit 
description of chemical bonding, as well as a large amount of 
information about the structures of molecules. This biases results and 
seriously limits the predictive value of molecular mechanics models. 
Nevertheless, molecular mechanics has found an important role in 
molecular modeling as a tool to establish equilibrium geometries 
of proteins and other large molecules. It has also been widely used 
to establish the preferred conformation of molecules with multiple 
degrees of conformational freedom and hundreds or even thousands 
of accessible conformers. With regard to the latter, comparisons with 
results of high-level quantum chemical calculations have, however, 
clearly shown that present-generation molecular mechanics models 
are often not satisfactory in identifying the “best” (lowest-energy) 
conformer and are not to be trusted for obtaining Boltzmann weighed 
averages. However, they have proven to be useful for identifying 
highly unfavorable conformers allowing some shortening of the initial 
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list of possible structures. Spartan Student includes the MMFF94 
model with no restrictions on atom counts.

Choosing a Theoretical Model

No single method of calculation is likely to be ideal for all applications. 
A great deal of effort has been expended to define the limits of 
different molecular mechanics and quantum chemical models, 
and to judge the degree of success of different models. The latter 
follows from the ability of a model to consistently reproduce known 
(experimental) data. Molecular mechanics models are restricted to 
determination of geometries and conformations of stable molecules. 
Quantum chemical models also provide energy data, which may 
in turn be directly compared with experimental thermochemical 
data, as well as infrared, Raman, UV/visible and NMR spectra and 
properties such as dipole moments, which may be compared directly 
with the corresponding experimental quantities. Quantum chemical 
models may also be applied to transition states. While there are no 
experimental structures with which to compare (see the topic Potential 
Energy Surfaces), experimental kinetic data may be interpreted to 
provide information about activation energies (see the topic Total 
Energies and Thermodynamic and Kinetic Data).

Success is not an absolute. Different properties, and certainly different 
problems may require different levels of confidence to be placed in 
the calculation to actually be of value. Neither is success sufficient. A 
model also needs to be practical for the task at hand. Were this not the 
case, there would be no reason to look further than the Schrödinger 
equation itself. Models that may be practical for small to medium 
size organic molecules cannot be expected to be applied to proteins. 
Models that are successful and practical for organic molecules may 
not necessarily meet either criterion for inorganic molecules or 
transition-metal organometallics. Not only does the nature and size 
of the system needs to be taken into account, with due attention to the 
available computational resources and the experience (and patience) 
of the practitioner. Specifics aside, practical models usually share 
one common feature in that they are not likely to be the best possible 
treatments which have been formulated. Compromise is almost always 
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an essential component of model selection. Continued advances in 
both digital computers and computer software will continue to raise 
the bar, but it will be some time before fully reliable models will be 
routinely applicable to all chemical systems of interest.

The MMFF model generally provides a satisfactory description of 
equilibrium geometry for organic molecules. It has also proven to 
be suitable for removing high-energy conformers for molecules 
with multiple degrees of freedom in preface to quantum chemical 
calculations of conformer energy differences.

Semi-empirical model are appropriate for: 

i)	 Equilibrium geometry determinations for large molecules. 

ii)	 Transition-state geometry determinations. 

iii)	Equilibrium and transition-state geometry determinations 
involving transition metals. 

Semi-empirical models are unsuitable for: 

i)	 Calculation of reaction energies.

ii)	 Calculation of conformer energy differences.

Small basis set Hartree-Fock models such as HF/3-21G and  
HF/6-31G* are appropriate for: 

i)	 Equilibrium and transition-state structure determinations of 
organic molecules.

ii)	 Calculation of energies of isodesmic reactions, including 
comparisons of regio and stereoisomers.

They are unsuitable for: 

i)	 Calculation of reaction energies that involve bond making or 
breaking and calculation of absolute activation energies. 

ii) Comparison of isomer energies of molecules with different 
bond types.	

iii)	Equilibrium and transition-state structure determinations for 
transition-metal organometallic molecules.
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iv)	Calculation of conformer energy differences.

Small basis set density functional models such as B3LYP/6-31G* 
and wB97X-D/6-31G* are appropriate for: 

i)	 Equilibrium and transition-state structure determinations for  
organic molecules as well as molecules incorporating transition 
metals. 

ii)	 Calculation of all types of reaction energies, although some 
caution is needed.

iii)	Calculation of conformer energy differences, although caution 
is needed.

The RI-MP2/6-31G* model is appropriate for: 

i)	 Equilibrium and transition-state structure determinations except 
for molecules including transition metals. 

ii)	 Calculation of all types of reaction energies, although some 
caution is needed.

It is unsuitable for: 

i)	 Equilibrium and transition-state structure determinations for 
transition-metal organometallic molecules.

ii)	 Calculation of reaction and activation energies where transition-
metals are involved. 

The wB97X-V/6-311+G(2df,2p) model is appropriate for calculating 
all types of reaction energies. Implemented together with a dual basis 
set, it provides a practical and reliable means to establish conformer 
energy differences.
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Finding and Verifying Equilibrium and 
Transition-State Geometries

The energy of a molecule depends on its geometry. Even small changes 
in structure can lead to quite large changes in total energy. What 
is the “best” choice of geometry for use in a molecular modeling 
study? While experimental structures, where available, would at 
first glance seem to be ideal, there are multiple problems with this. 
First, while upwards of one million structures have been established 
experimentally, many, many more have not been. Second, the vast 
majority of experimental structures follow from X-ray crystallography 
on solid samples and may differ significantly from those of isolated 
molecules to which the calculations pertain. An additional problem 
with X-ray structures is that bonds to hydrogen are too short (by 
as much as 0.1 - 0.2Å). Finally, experimental data for reactive or 
otherwise short-lived molecules are scarce, and data for transition states 
are completely lacking. In the final analysis, there is no alternative 
to obtaining geometries from calculation. Fortunately, this is not 
difficult, although it may be demanding in terms of computer time.

Determination of geometry (geometry optimization) is an iterative 
process. The energy and energy gradient (first derivative of the energy 
with respect to all geometrical coordinates) are calculated for the 
initial geometry, and this information is then used to project a new 
geometry. This process continues until three criteria are satisfied. 
First, the gradient must closely approach zero. This ensures that the 
optimization is terminating in a flat region of the potential surface (either 
the bottom of an energy well in the case of equilibrium geometry or the 
top of an energy hill in the case of transition-state geometry). Second, 
successive iterations must not change any geometrical parameter by 
more than specified (small) value. Third, successive iterations must 
not change the total energy by more than a specified (small) value.

Equilibrium Geometries
In order for a geometry to correspond to an energy minimum, the 
curvature of the energy surface must be positive, that is, the structure 
must lie at the bottom of an energy well. The surface’s curvature is 
defined by the Hessian (the matrix of second derivatives of the energy 
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with respect to geometrical coordinates).

What is actually done is to transform from the original coordinates to 
a new set of geometrical coordinates (normal coordinates) for which 
the Hessian will be diagonal, that is, all off-diagonal elements will be 
zero. In this representation, all (diagonal) elements must be positive for 
the geometry to correspond to an energy minimum. Normal coordinate 
analysis, as it is termed, is required for the calculation of vibrational 
frequencies, which relate directly to the square root of the elements of 
the (diagonal) Hessian. Positive Hessian elements yield real frequencies; 
negative Hessian elements yield imaginary frequencies.

Geometry optimization does not guarantee that the final structure 
has a lower energy than any other structure of the same molecular 
formula. All that it guarantees is a local minimum, that is, a geometry 
with a lower energy than that of any similar geometry, although not 
necessarily the lowest energy geometry possible for the molecule. 
The number and types of chemical bonds are maintained in the 
optimization process as are single bond and flexible-ring conformers. 
Altering bond types would lead to isomers (stable molecules of the 
same molecular formula) which under normal conditions could not 
be reached, whereas altering conformation would lead to different 
“shapes” of the same molecule, which would be in equilibrium 
under the same conditions. Finding the best conformer or global 
minimum requires repeated optimization starting with different initial 
geometries corresponding to different initial conformers. Only when 
all local minima have been located is it possible to say with certainty 
that the lowest energy geometry has been identified. This process is 
termed conformational analysis.

In principle, geometry optimization carried out in the absence of 
symmetry, that is, with C1 symmetry, must result in a local minimum. 
On the other hand, imposition of symmetry may result in a geometry 
that is not a local minimum. For example, optimization of ammonia 
constrained to a planar trigonal geometry (D3h symmetry) will result 
in a structure that corresponds to an energy maximum in the direction 
of motion toward a puckered trigonal geometry (C3v symmetry). 
This is the transition state for inversion at nitrogen in ammonia. 
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The most conservative tactic is always to optimize geometry in the 
absence of symmetry. If this is not done, it is always possible to verify 
that the structure located indeed corresponds to a local minimum 
by calculating the vibrational frequencies on the final (optimized) 
structure. If one or more frequencies are imaginary, then the geometry 
does not correspond to an energy minimum.

Transition-State Geometries

Chemists recognize a transition state as the structure that lies at the 
top of a potential energy surface connecting reactant and product (see 
the topic Potential Energy Surfaces).

transition state

reactant

product

Energy

reaction coordinate

More precisely, a transition state is a point on the potential energy 
surface for which the gradient is zero (just as it is for an equilibrium 
geometry), but for which the diagonal representation of the Hessian 
has one and only one negative element, corresponding to the reaction 
coordinate (see diagram above). All the other elements are positive. In 
other words, a transition state is a structure that is an energy minimum 
in all dimensions except one, for which it is an energy maximum. 
Mathematically, such a structure is referred to as a first-order saddle 
point.

The geometries of transition states on the pathway between reactants 
and products are not as easily anticipated as the equilibrium 
geometries of the reactants and products themselves. This is not to 
say that transition-state geometries do not exhibit the same systematic 
behavior as equilibrium geometries, but rather that there is not 
sufficient experience to identify what systematics do exist, and more 
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importantly how to capitalize on structural similarities. It needs to 
be recognized that transition states cannot even be detected let alone 
characterized experimentally, at least not directly. While measured 
activation energies relate to the energies of transition states above 
reactants, and while activation entropies and activation volumes as 
well as kinetic isotope effects may be interpreted in terms of transition-
state structure, no experiment can actually provide direct information 
about the detailed geometries and/or other physical properties of 
transition states. Quite simply, transition states do not exist in terms of 
a stable population of molecules on which experimental measurements 
may be made. Experimental activation parameters may act as a guide, 
although here too it needs to be pointed out that their interpretation is 
in terms of transition state theory. This assumes that all molecules 
proceed over a single transition state (the high point along the reaction 
coordinate) on their way to products. Even then, experiments tell little 
about what actually transpires in going from reactants to products. 

Lack of experience about “what transition states look like” is one 
reason why their detailed geometries are more difficult to obtain than 
equilibrium geometries. Other reasons include:

i)	 Algorithms for locating transition states are less well developed 
than procedures for finding equilibrium structures. After all, 
minimization is an important task in many diverse fields of 
science and technology, whereas saddle point location has few 
if any important applications outside of chemistry.

ii)	 It is likely that the potential energy surface in the vicinity of a 
transition state is more “flat” than the surface in the vicinity of 
a local minimum. After all, transition states represent a delicate 
balance of bond breaking and bond making, whereas overall 
bonding is maximized in equilibrium structures. As a consequence, 
the potential energy surface in the vicinity of a transition state 
is likely to be less well described in terms of a simple quadratic 
function (assumed in all common optimization procedures) than 
the surface in the vicinity of a local minimum.

iii)	 To the extent that transition states incorporate partially (or 
completely) broken bonds, it might be anticipated that very 
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simple theoretical models lacking adequate treatment of electron 
correlation will not be able to provide entirely satisfactory 
descriptions.

In time, all of these problems will be overcome, and finding transition 
states will be as routine as finding equilibrium geometries is today. 
Chemists can look forward to the day when reliable tools become 
available for the elucidation of reaction mechanisms.

While the same iterative procedure previously described for 
optimization of equilibrium geometry applies as well to transition 
states, the number of steps required for satisfactory completion is 
likely to be somewhat larger. This is due to the factors discussed 
earlier. Note, however, that the task of transition state determination 
may be completely automated and needs no more human intervention 
than that involved in locating equilibrium geometries.

Having found a transition-state geometry, two tests need to be 
performed in order to verify that it actually corresponds to a proper 
transition state, and further that it actually corresponds to the transition 
state for the process of interest, that is, it smoothly connects energy 
minima corresponding to reactant and product:

i)	 Verify that the Hessian (matrix of second energy derivatives)
yields one and only one imaginary frequency. This requires 
that a normal mode analysis be carried out on the proposed 
transition-state geometry. The imaginary frequency will 
typically be in the range of 400-2000 cm-1, quite similar to 
real vibrational frequencies. In the case of flexible rotors, for 
example, methyl groups or floppy rings, the analysis may yield 
one or more additional imaginary frequencies  with very small 
(<100 cm-1) values. These can be difficult to “get rid of” simply 
because energy changes are likely to be very small and inside 
the precision settings of the optimization procedure. Small 
imaginary frequencies can almost always be ignored, but make 
certain to verify what motions these small imaginary frequencies 
actually correspond to (see discussion following) before doing 
so. Most important, be wary of structures that yield only very 
small imaginary frequencies. This suggests a very low energy 
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transition state, which quite likely will not correspond to the 
particular reaction of interest.

ii)	 Verify that the normal coordinate corresponding to the imaginary 
frequency smoothly connects reactants and products. A simple 
way to do this which requires no additional calculations, is to 
animate the normal coordinate corresponding to the imaginary 
frequency, that is, to walk along this coordinate without any 
additional optimization. This does not necessarily require any 
additional calculations beyond the normal mode analysis already 
performed. “Incorrect” transition states located by calculation, 
that is, transition states that do not link the reactant to the expected 
product, may indicate new chemistry, so don’t discard them too 
quickly! There are more costly procedures that actually involve 
“walking” the geometry down from the transition state to both 
reactants and products. In our view these are rarely worth the effort.

Reactions Without Transition States

Not all chemical reactions have transition states, and that the rates of 
some reactions depend only on the speed with which reactants diffuse 
into one another (so-called, diffusion controlled reactions). In fact, 
reactions without energy barriers are quite common. Two radicals will 
typically (but not always*) combine without activation, for example, 
two methyl radicals to form ethane.

H3C•  +  •CH3 H3C CH3

Radicals will often add to paired-electron species with no (or very 
small) activation, for example, methyl radical and ethylene forming 
1-propyl radical.

H3C–CH2–CH2
•H3C•  +  H2C CH2

Exothermic ion-molecule reactions that have activation energies in 
solution, do not necessarily have activation energies in the gas phase. 
Any complex of an ion and a neutral molecule is likely to be lower in 
energy than the separated species and the entire reaction coordinate for 

* Exceptions may occur where both radicals are delocalized, for example, combing two 
benzyl radicals.
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an ion-molecule reaction might lie below the energy of the separated 
reactants for example, nucleophilic attack by OH– on CH3Cl to give 
CH3OH and Cl–.

Failure to find a transition state, and location instead of what appears to 
be a stable intermediate or even the final product, does not necessarily 
mean failure of the theoretical model (nor does it rule this out). It 
may simply mean that there is no transition state!

Calculations Using Approximate Geometries

Given that small-basis set Hartree-Fock models, semi-empirical 
models and even molecular mechanics models generally provide 
geometries for organic molecules that are quite close to those 
obtained from Hartree-Fock, density functional and MP2 models, it 
is legitimate to ask whether or not structures from these techniques 
may be used as the basis for energy and property calculations.* It 
would be of great help were this the case as geometry optimization 
is a major cost in any modeling investigation. 

“Exact” geometries must be used for frequency (infrared and Raman 
spectra) calculations. The reason for this is that frequencies are related 
to the first finite term in a Taylor series expansion of the energy (as a 
function of geometry). This is (assumed to be) the second-derivative 
term, which will not be true if the first-derivative term (the gradient) 
is not precisely zero. (Cubic and higher order terms are assumed to 
be small and are ignored.) Frequencies evaluated at non-equilibrium 
(or non-transition-state) geometries are meaningless.

* Molecular mechanics models are not applicable to transition states as they have been 
parameterized to account for the structures of stable molecules. This is not to say that 
molecular mechanics parameterizations could not be developed for transition states, simply 
that they have not been.
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Total Energies and Thermodynamic and 
Kinetic Data

In addition to molecular geometry, energy is certainly the most 
important quantity to come out of molecular modeling. Energy can be 
used to reveal which of several isomers is most stable, to determine 
whether a particular chemical reaction will have a thermodynamic 
driving force (an exothermic reaction) or be thermodynamically uphill 
(an endothermic reaction), and to ascertain how fast a reaction is likely 
to proceed. Other molecular properties, such as dipole moment, and 
infrared, Raman, UV/visible and most importantly NMR spectra are 
also of great interest, but energy plays a special role.

There is more than one way to express the energy of a molecule. 
Most common to chemists is the heat of formation, ∆Hf. This is the 
heat of a hypothetical chemical reaction that creates a molecule from 
well defined (but arbitrary) standard states of each of its constituent 
elements. Note that the heat of formation, which most commonly 
assumes a value between -1,000 and +500 kJ/mol, cannot be directly 
measured, but must be obtained indirectly. 

An alternative, total energy, is the heat of a hypothetical reaction that 
creates a molecule from a collection of separated nuclei and electrons. 
Like the heat of formation, total energy cannot be measured directly, 
and is used solely to provide a standard method for expressing and 
comparing energies. Total energies are always negative numbers and 
are much larger than the sum of the bond energies By convention, they 
are expressed in so-called atomic units* or au, but may be converted 
to other units as desired:

1 au = 2625 kJ/mol

It makes no difference which reference reaction (heat of formation or 
total energy) is used to calculate the thermochemistry of a balanced 
chemical reaction (reactant 1 + reactant 2 + . . . → product 1 + product 
2 + . . .):

E(reaction) = Eproduct 1 + Eproduct 2 + … – Ereactant 1 - Ereactant 2 – …

* The exact energy of hydrogen atom is -0.5 atomic units.
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Total energies will be used in the discussion that follows. A negative 
∆E indicates an exothermic (thermodynamically favorable) reaction, 
while a positive ∆E an endothermic (thermodynamically unfavorable) 
reaction.

A special case involves energy differences among isomers. Each 
comparison may be viewed as a chemical reaction involving only 
two molecules:

E(isomer) = Eisomer 2 – Eisomer 1

A negative ∆E means that isomer 2 is more stable than isomer 1.

Total energies may also be used to calculate activation energies, 
∆E‡:

E‡  =  Etransition state  – Ereactant 1  –  Ereactant 2  –  …

Here, Etransition state is the total energy of the transition state, and Ereactant1, 
Ereactant2, ... are the total energies of the reactants. Activation energies 
are expected to be positive numbers*, meaning that the transition 
state is less stable that reactants.

Reaction and activation energies are sufficient to know whether a 
reaction is exothermic or endothermic and whether it proceeds with 
small or large activation barrier. There are, however, situations where 
energies need to be replaced by Gibbs energies in order to take proper 
account contributions due to entropy.** For example, a proper account 
of the equilibrium concentrations of reactants and products requires 
calculation of the equilibrium constant, Keq, which according to the 
Boltzmann equation, is related to the Gibbs energy of reaction, ∆Grxn:

Keq = exp(–  Grxn/RT)

Here R is the gas constant and T is the temperature (in K). At room 
temperature (298K) and for ∆Grxn in au, this is given by:

* Referred to separated reactants, "negative activation energies" are possible. This is due 
to the formation of a complex, the total energy of which is lower than the sum of the 
total energies of the reactants. Also note that some reactions proceed with zero activation 
energy, meaning that there is no transition state.

** Entropy contributions will be largest where the numbers of reactants and products differ. On 
the other hand, entropy might be expected to largely cancel where reactants and products 
are very similar.
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Keq = exp(–1060   Grxn)

∆Grxn has two components, the enthalpy of reaction, ∆Hrxn, and the 
entropy of reaction, ∆Srxn. These are defined as follows:

  Grxn  =    Hrxn  – T  Srxn

  Hrxn ≈   Erxn = Eproduct 1 + Eproduct 2 + … – Ereactant 1 – Ereactant 2 – …

  Srxn  =  Sproduct 1 + Sproduct 2 + … – Sreactant 1 – Sreactant 2 – …

Although ∆Grxn depends on both enthalpy and entropy, it is often 
assumed that the entropy contribution will be small, and can be 
neglected. Further assuming that ∆Hrxn ≈ ∆Erxn, equilibrium constants 
can then be estimated according to the “Boltzmann” equation:

Keq ≈ exp(–  Erxn/RT) ≈ exp(-1060   Erxn)  .

This equation may also be used to establish the equilibrium 
composition of a mixture of isomers:

Isomer 1 Isomer 2 Isomer 3 . . .

% Isomer i  =
100 exp (-1060 EIsomer i)

k
Σ exp (-1060 EIsomer k)

Isomer energies, Eisomer, are given in atomic units relative to the energy 
of the lowest-energy isomer. An important special case involves an 
equilibrium between two isomers:

Isomer 1 Isomer 2

=  exp [-1060 (Eisomer1 – Eisomer2)][ Isomer 1 ]
[ Isomer 2 ]

Reaction rate constants, krxn, are also related to Gibbs energies. As 
before, if entropy contributions can be neglected, the rate constant 
can be obtained directly from the activation energy, ∆E‡, according 
to the Arrhenius equation:

krxn ≈ (kBT/h)[exp(-  E‡/RT)]

Here kB and h are the Boltzmann and Planck constants, respectively. 
At room temperature and for ∆E‡ in au, krxn is given by:
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krxn  =  6.2x1012 exp(-1060   E‡)

Another way to describe reaction rates is by half-life, t1/2, the amount 
of time it takes for the reactant concentration to drop to one half of 
its original value. When the reaction follows a first-order rate law, 
rate = -krxn[reactant], t1/2 is given by:

t1/2  =  ln2/krxn  =  0.69/krxn

It is useful to associate reaction energies and reaction rates with 
potential energy diagrams introduced earlier. The thermodynamics 
of reaction is given by the Δ Energy of the reactant and product on 
the potential surface.

energy

reaction coordinate

"thermodynamics"

transition state

reactant

product

For situations such as bond rotation in ethane and ring inversion in 
cyclohexane, the reactant and product are the same and the reaction 
is said to be thermoneutral. The most common case, as depicted in 
the above diagram, is where the energy of the products is lower than 
that of the reactants. The reaction is said to be exothermic, and the 
difference in stabilities of reactant and product is simply the difference 
in their energies. For example, the “reaction” of gauche n-butane to 
anti n-butane is exothermic, and the difference in stabilities of the two 
conformers is simply the difference in the energies (~3.8 kJ/mol).

Chemical reactions can also be endothermic, which give rise to a 
reaction profile.
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transition state

reactant

product
energy

reaction coordinate

Where two or more different products may form in a reaction, 
thermodynamics tells us that if we wait long enough, the product 
formed in greatest abundance will be that with the lowest energy 
irrespective of pathway.

reaction coordinate

energy

thermodynamic product

In this case, the product is referred to as the thermodynamic product 
and the reaction is said to be thermodynamically controlled.

The energy of the transition state above the reactants (the activation 
energy) provides the connection with reaction rate (kinetics). Of 
course, such an interpretation is based on the notion that all reactions 
actually pass through a single transition state.
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energy

reaction coordinate

"kinetics"

transition state

reactant

product

Aside from the obvious dependence on the concentration of reactants, 
absolute reaction rates also depend on the percentage that encounters 
between molecules will actually lead to reaction (the so-called pre-
exponential or A factor). The hope is that pre-exponential factors 
for closely-related reactions will be very similar and therefore can 
be ignored. Thus, it is not at all evident that activation energies for 
disparate reactions will parallel measured reaction rates.

The product formed in greatest amount in a kinetically controlled 
reaction (the kinetic product) is that proceeding via the lowest energy 
transition state, irrespective of whether or not this is lowest energy 
product (the thermodynamic product).

reaction coordinate

energy

kinetic product

Kinetic product ratios show dependence with activation energy 
differences which are identical to thermodynamic product ratios with 
difference in reactant and product energies.
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THERMOCHEMICAL RECIPES AND Calculating 
Accurate Heats of Formation

The “energy” of a molecule is most commonly reported as a heat 
of formation. As noted in the previous topic, this is defined as the 
enthalpy at 298.15K of a hypothetical chemical reaction in which the 
molecule is transformed into a set of products that correspond to the 
most stable forms of its constituent pure elements at room temperature. 
For example, the heat of formation of ethylene corresponds to the 
enthalpy of a reaction to yield graphite and molecular hydrogen.

C2H4 → 2C (graphite) + 2H2

Differences in heats of formation between the products and reactants 
(reaction enthalpies) indicate the extent to which the reaction will 
be favorable (exothermic) or unfavorable (endothermic), and allow 
thermodynamic product distributions to be established.* 

In almost all cases, the heat of formation is obtained from a heat of 
combustion. For example, the heat of formation of ethylene would 
likely have been established from its reaction with oxygen to produce 
carbon dioxide and water.

C2H4 + 3O2 → 2CO2 + 2H2O

Experimental heats of formation are available for ~2000 compounds. 
While much of the data is accurate to within 4-8 kJ/mol, a significant 
portion is subject to greater uncertainty. The most egregious source 
of error is that the reported heat actually does not correspond to the 
reported structure. More common sources of error include impure 
samples, incomplete combustion and most importantly, poorly 
characterized combustion products. Hydrocarbons and oxycarbons 
present fewest problems as combustion leads only to carbon 
dioxide and water. However, combustion of molecules with other 
elements may give rise to a complex mixture of products and greater 
uncertainty, with nitrogen compounds being particularly problematic. 

* Of course, other references are equally suitable for examining mass balanced reactions. For 
example, total energies from quantum chemical calculations are referenced to separated 
nuclei and electrons, in the case of ethylene.

 C2H4 → 2C6+ + 4H+ + 16C– 
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Despite their fundamental importance, heats of formation are not 
routinely determined for new compounds. While the combustion 
experiment is straightforward and does not require particularly 
expensive instrumentation, accurate measurements may require 
(and will likely destroy) significant quantities of compound. Very 
few chemists are willing to part with hundreds of mg of a compound 
that they have just spent days, weeks or months preparing.

Because of the lack of experimental data and serious concerns over 
the accuracy of part of the data that do exist, considerable attention has 
been directed at the use of quantum chemical calculations to obtain 
heats of formation. One avenue that has been pursued relies on the 
knowledge that CCSD (T) calculations (coupled cluster singles and 
doubles with triples corrections introduced perturbatively) reliably 
reproduce the energetics of a wide variety of organic reactions. The 
problem is that the singles and doubles contribution scale as O(h6), 
where h is the number of basis functions, and the triples correction 
scales as O(h7). This limits practical applications of the method to 
very small molecules (<15 non-hydrogen atoms).

A simplified account of the “solution” first proposed by John Pople 
is depicted in the next page. The essential idea is that the energy 
obtained using a “good” electron correlation method and a large basis 
set may be closely approximated by combining the energy calculated 
using the good correlation method with a small basis set with 
difference in calculated energies for a “simple” correlation method 
with small and large basis sets. In principle, only three calculations 
are required: small and large basis set calculations with the simple 
correlation method and a small basis set calculation with the good 
correlation method. In practice, some of the schemes that have been 
formulated do exactly this while others employ a combination of 
simple correlation methods.
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The original Pople implementation and subsequent developments 
primarily by Larry Curtiss are now collectively known as Gx 
methods. G1 relied on MP4 as the “good” correlation method with 
a gradual shift to the more costly and more accurate CCSD(T) 
method. To some extent, the overall objective has also broadened, 
from a means to approximate correlation energy to a stand-alone 
source of thermochemical data (298° heats of formation). Our focus 
is on the former, as possible low-cost replacements of the CCSD(T) 
correlation method.

The two most widely-used methods are G3(MP2) and G3, and the two 
most recent additions to the series are G4(MP2) and G4. A summary 
of the procedures involved in calculating electronic energy using 
these four methods is provided on the next page. The full recipes 
lead to heat of formation in addition to electronic energy, and require 
specifying an equilibrium geometry and a procedure for obtaining 
vibrational frequencies in addition to “empirical” corrections to 
account for the standard states of each of the elements. While each 
the four procedures involves several steps, these can be carried out 
in proper sequence without user intervention.

simple correlation method good correlation method limiting steps

G3(MP2) MP2 QCISD(T)/6-31G* T in QCISD(T)

G3 MP2 & MP4 QCISD(T)/6-31G* MP4 and T in QCISD(T)

G4(MP2) MP2 CCSD(T)/6-31G* T in CCSD(T)

G4 MP2 & MP4 CCSD(T)/6-31G* MP4 and T in CCSD(T)
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The T1 Thermochemical Recipe

The simplest of the GX recipes, termed G3(MP2), involves several 
costly steps, most significantly an MP2/6-31G* geometry calculation, 
a HF/6-31G* frequency calculation and a QCISD(T)/6-31G* energy 
calculation. In practice, G3(MP2) scales as the 7th power of size and 
is applicable only to molecules with molecular weights less than 
150 amu. Clearly, even simpler procedures are required for routine 
application to larger molecules.

The goal behind the T1 recipe was to maintain the accuracy of  
G3(MP2) but at significantly reduced computation cost. It is  limited 
to uncharged, closed-shell molecules comprising H, C, N, O, F, Si, 
P, S, Cl and Br. T1 substitutes the MP2/6-31G* geometry used in 
G3(MP2) by a HF/6-31G* geometry, eliminates both the HF/6-31G* 
frequency and the QCISD(T)/6-31G* energy calculations and 
approximates the MP2 energy calculation with the G3MP2 large 
basis set by an analogous calculation using a dual basis set RI-MP2 
model. Taken together, these changes reduce computation time by 
2-3 orders of magnitude, and  T1 calculations on molecules in the 
molecular weight range of 400-500 amu are  practical. 

The T1 recipe, unlike G3(MP2), involves parameters, specifically 
atom counts, Mulliken bond orders and HF/6-31G* and RI-MP2 
energies. These have been determined using linear regression as a 
best fit to G3(MP2) (not experimental) heats of formation for >1100 
small molecules. It reproduces these values with mean absolute and 
RMS errors of 1.8 and 2.5 kJ/mol, respectively. More important, the 
T1 recipe reproduces experimental heats of formation for a set of 
>1800 diverse organic molecules from the NIST thermochemical 
database with mean absolute and RMS errors of 8.5 and 11.5 kJ/
mol, respectively. The plot provided below covers the data from 
-1000 to +500 kJ/mol.
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Heats of formation from the T1 recipe are included as a property in 
the Spartan Spectra and Properties Database (SSPD), a database that 
presently comprises more than a 300,000 entries.
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Interpreting Conformational Preferences

Rotation about single bonds is periodic, retracing itself every 360°, 
and any function that seeks to describe the energy of internal rotation 
must also repeat itself every 360°. In practice, the energy function, 
Etorsion, is written as a combination of simpler functions, Vn, in the 
torsion angle w, each of which repeats n times in a 360° interval.

Etorsion (w) = V1 (w) + V2 (w) + V3 (w)...

The first three terms, V1, V2, and V3 repeat every 360°, 180°, and 
120°, respectively, and are referred to as one-fold, two-fold, and 
three-fold potentials.*

Separation into distinct n-fold potentials is a useful concept because 
each can be associated with a particular chemical phenomenon. For 
example, a one-fold potential describes the different energies of anti 
(COOC=180°) and syn (COOC=0°) conformers of dimethylperoxide, 
while a two-fold potential describes the different energies of planar 
and perpendicular conformers of benzyl cation. Three-fold potentials, 
which are more familiar to chemists, describe the difference between 
staggered and eclipsed conformers in molecules like ethane.

O O
CH3

O O

CH3vs.

C
HH +

vs.

C

HH

+

one-fold two-fold

C C

H

H
vs.

H H

H
H C C

H

H

H

H
H H

three-fold

CH3
CH3

While rotation in some molecules might be adequately described using 
only one of the components or a combination of two components, 
other molecules require more complex combination. This is illustrated 
by fluoromethylamine.

C N
F

HH
H H FCN: = 0°

* The torsional potential in most organic molecules will be adequately described in terms of 
one, two and three-fold components, and only rarely will higher-order terms be needed.
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The heavy solid line describes Etorsion for rotation about the CN bond, 
while the light solid line, the dashed line and the dotted line correspond 
to the one-fold, two-fold and three-fold components, respectively. 
There are two distinct minima.

C N
F

H
H

FCN: = 180°

HH

C N
F

H
H

FCN: ≈ 45°
H

H

The lower (global) minimum arises when the CF bond and the nitrogen 
lone pair are anti, while the higher and much more shallow minimum 
is close to a gauche structure, FCN: dihedral angle of ~45°. Also, note 
that one of the two energy maxima is close to an eclipsed structure, 
with the FCCN: dihedral angle of ~115°.

The behavior of Etorsion becomes clear when it is resolved into its 
components. The one-fold term reflects a clear and very strong 
preference for the CF bond and the nitrogen lone pair to be anti and 
not syn. This preference might be electrostatic since the anti structure 
arranges the dipoles associated with the CF bond and nitrogen lone 
pair in opposite directions.

FCN: = 180°
dipoles subtract

FCN: = 0°
dipoles add

C N

F

HH
H HC N

F H

H
H

H
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The three-fold term reflects the preference for staggered over eclipsed 
structures, and contributes less to the variation in Etorsion than either 
of the one-fold or two-fold terms.

What is most interesting, and perhaps not have been easily anticipated 
without this type of analysis, is the large contribution made by the 
two-fold potential, which reflects a strong preference for a planar 
arrangement of FCN:. This can be attributed to stabilization resulting 
from donation of the lone pair orbital on nitrogen into low-energy 
unfilled molecular orbital associated with the CF bond, requiring that 
the molecule adopts either a syn planar or anti planar conformation 
and not a perpendicular conformation.

C N

F

syn planar

C N

F

anti planar

C N

F

perpendicular

X

Note that the terms that contribute to Etorsion are completely independent 
of each other, and each may be treated as one part of a larger picture. 
Thus, the observation that electron donation from the nitrogen lone 
pair into the empty orbital associated with the CF bond is optimal 
when the two groups are planar is independent of the observation that 
cis coplanar structure is destabilized, relative to the anti structure, by 
dipole-dipole interactions.
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Calculating Infrared Spectra

The infrared spectrum of a molecule arises because of transitions 
between vibrational energy levels. Each line in an infrared spectrum 
is characterized by a frequency (energy) and an intensity. In one 
dimension (a diatomic molecule), it is common practice to assume 
that the frequency is proportional to the square root of the ratio of 
the second-derivative of the energy with respect to the internuclear 
distance, r, and the reduced mass (the product of the masses of the 
two atoms divided by their sum).

vibrational frequency a √ [(d2E(r)/dr2/)reduced mass]

This is referred to as the harmonic approximation, the origin of which 
can be seen by expanding the energy in a Taylor series.

E(r) = E(r0) + (dE(r)/dr) r + (d2E(r)/dr2) r2 + higher-order terms

E(r0) is a constant and dE(r)/dr (the gradient) is assumed to be zero. 
The latter implies that the underlying structure corresponds precisely 
to a minimum (or a maximum) on the potential energy curve. Were 
this not the case, the first derivative would be non zero and the 
calculated frequency would be meaningless. Nearly all practical 
calculations ignore cubic and higher-order terms (anharmonic 
terms), leaving only the  second derivative term (the force constant). 
This said, the frequency may be interpreted as the relative ease or 
difficulty of stretching the bond away from its equilibrium position, 
that is, the curvature of the energy surface at the minimum. Where 
distortion away from the equilibrium position is easy, the result is 
a low frequency; where it is difficult the result is a high frequency. 
High (reduced) mass leads to a low frequency while low mass leads 
to high frequency.

The expression for vibrational frequency qualitatively accounts for mass 
effects on reaction energies (equilibrium isotope effects). Even at 0K 
molecules vibrate, giving rise to the so-called zero-point vibrational 
energy (or simply zero-point energy). Zero-point energy is directly 
proportional to the sum of the vibrational frequencies and decreases with 
increasing mass. For example, the zero-point energy of HCl is lowered 
upon  replacement of hydrogen by deuterium. Thus, the measured energy 
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(enthalpy) decreases with increasing mass and the energy of DCl is smaller 
(more negative) than that for HCl.

Because the  potential energy has been approximated by a quadratic 
function, calculated frequencies will almost always be larger than 
measured frequencies. This is because a quadratic function goes to 
infinity with increase in distance rather than going asymptotically to 
a constant (separated atoms), meaning that the potential curve will 
be too steep.

It is possible to extract the harmonic frequency from an experimental 
spectrum by measuring the spacing of the energy levels associated 
with the ground and excited states of a particular vibration. (The 
lines would be evenly spaced were the potential quadratic.) However, 
such an analysis is impractical for any but diatomic and very simple 
polyatomic molecules.

Generalization from a diatomic to a polyatomic molecule is 
straightforward. The energy of displacement away from the 
equilibrium position is expanded in the same way as before, the only 
difference being that a vector quantity, x, replaces a scalar quantity, x.
E(x) = E(x0) + Σi(∂E(x)/∂xi)xi + ½Σij(∂2E(x)/∂xi∂xj)xixj + higher-order terms

As with the expression for a diatomic molecule, the leading term is a 
constant, the first derivative term is zero and cubic and higher-order 
terms are ignored. For a molecule with N atoms, the dimension of 
x is 3N (x,y,z Cartesian coordinates for each atom), although there 
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are only 3N-6 (3N-5 for a linear molecule) vibrational frequencies. 
Six dimensions (five for a linear molecule) correspond to translation 
away from and rotation around the center of mass. 

The first (and only computationally expensive) step involved in 
calculating the vibrational spectrum of a polyatomic molecule is 
evaluation of the full set of second energy derivatives in Cartesian 
coordinates. These then need to be mass weighted. Diagonal terms 
(∂2E(x)/∂xi

2) are divided by the mass of the atom associated with xi, 
and off-diagonal terms (∂2E(x)/∂xi∂xj) are divided by the product 
of the square root of the masses of the atoms associated with xi and 
xj. These expressions reduce to that already provided for the one-
dimensional case. 

The second step involves replacing the Cartesian coordinates by 
a new set of coordinates ζ, such that the matrix of mass-weighted 
second derivatives is diagonal. δij is the so-called Kronecker delta 
function which is 1 if i=j and 0 otherwise.

[∂2E(ζ)/∂ ζi∂ ζj]/(√Mi√Mj) = δij [∂2E(ζ)/∂ ζi
2]/Mi

These new coordinates are referred to as normal coordinates. While 
the normal coordinates for some vibrations may be described in terms 
of stretching of one bond or bending of one angle, more commonly 
they will be made up of mixtures of several bond stretches, angle 
bends and other motions. 

The third step involves removing the six coordinates corresponding 
to the three translations and three rotations, leaving 3N-6 vibrational 
coordinates. 

The intensity of a line in the infrared spectrum is proportional to 
the change in the dipole moment along the vibrational coordinate. It 
follows that where there is no change in dipole moment, for example, 
in a homonuclear diatomic molecule, the infrared intensity is zero. 

The two major components of the earth’s atmosphere, N2 and O2, are 
homonuclear diatomics and do not absorb in the infrared, that is, the 
intensity is zero. However, two of the four vibrational motions of 
CO2, the third most common but very minor molecular component in 
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the atmosphere, have non-zero infrared intensities. As a result, carbon 
dioxide absorbs radiation reflected from the earth’s surface thereby 
trapping heat and leading to an increase in temperature (the so-called 
greenhouse effect).

Lack of a line in the infrared spectrum does not mean that the 
molecule does not vibrate or that the vibrational energy for this 
line does not contribute to the zero-point energy. Rather, it means 
that absorption of radiation does not occur leading to a change in 
vibrational energy state. It should also be noted that a particular line 
that is infrared inactive might be visible in the Raman spectrum (an 
alternative form of vibrational spectroscopy based on reflectance 
rather than absorption). Here the intensity is related to the change in 
the polarizability rather than the change in dipole moment. 

The application of quantum chemical models to infrared spectroscopy 
requires calculation of the second energy derivatives and first dipole 
moment derivatives with regard to changes in geometrical coordinate. 
The former completely dominates and scales as the fifth power of the 
size (number of basis functions). Infrared spectra may be calculated 
using semi-empirical molecular orbital models, for example, the 
PM3 models available in Spartan, Hartree-Fock molecular orbital 
models, density functional models and MP2 models. Of the theoretical 
models available in Spartan, semi-empirical models provide a poor 
account, Hartree-Fock models provide a reasonable account but 
density functional and MP2 models with polarization or larger basis 
sets perform best. Density functional models are the obvious choice 
for infrared spectra calculations, offering better results than Hartree-
Fock models at comparable cost, and comparable results at much 
lower cost than MP2 models. 

For two reasons, we recommend EDF2/6-31G* over the wB97X-D/ 
6-31G* model for infrared spectra calculations. First, EDF2/ 
6-31G* was specifically formulated to reproduce measured infrared 
frequencies. Second, it is significantly (factor of two) less costly than 
wB97X-D for frequency calculation and is easily applicable to the 
calculation of infrared spectra of organic molecules of moderate size 
(up to 400-500 amu). There are two major deficiencies with infrared 



316	 Appendix A

spectra obtained directly from the EDF2/6-31G* model. The first 
is that calculated frequencies are almost always too large, typically 
by 3-5%. This can be directly traced to the harmonic approximation 
and to a potential energy curve that is too steep.

Other density functional models and the MP2 model show similar 
behavior. Vibrational frequencies obtained from Hartree-Fock models 
show an even larger systematic error in the same direction (frequencies 
too large), typically by 12-14%. Here two factors contribute. The first 
is the insistence on a quadratic potential, the same problem associated 
with density functional and MP2 models. The second is due to the fact 
that bond dissociation is improperly described by Hartree-Fock models, 
as evidenced by the fact that Hartree-Fock bond lengths are uniformly 
shorter than experimental distances. This suggests that the potential 
energy surface will be too steep and the frequency will be too large.

The second and more conspicuous deficiency is due to the fact that 
the lines in an infrared spectrum measured at finite temperature are  
broadened due primarily to rotational structure, whereas the lines 
in a calculated spectrum correspond to an isolated molecule at 0K 
and are sharp. There may be other differences, such as the absence 
of overtones, that is, vibrational transitions originating from excited 
vibrational states and, more importantly, lack of solvent. Although 
these are more difficult to quantify.

It is straightforward to correct the calculated spectrum to account 
for both deficiencies. First the spectrum may be uniformly scaled 
(multiplied by a parameter in the range of 0.95-0.97 for density 
functional models). Second, the calculated frequencies and intensities 
may be fit to a Lorentzian function with peak width and half peak 
height being treated as a second parameter. 

Quality of Calculated Infrared Spectra 

An infrared spectrometer records frequencies in the range 500-
4500 cm-1. Frequencies below this range (which may require special 
instrumentation to measure) typically correspond to torsional 
motions and may depend strongly on conformation. It should be 
noted that the spectral region beyond ~2800 cm-1 is dominated by 
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CH stretching vibrations and may be too crowded to be of value.

Calculated infrared spectra from the EDF2/6-31G* model that have  
been scaled to account for the systematic error in frequency and 
broadened to account for finite temperature are visually quite similar to 
the corresponding experimental spectra (taken from the NIST database). 
The four examples that follow, benzamide, (dimethylmethylidene)
cyclopentadiene, 1,2-epoxy-cis-4-vinylcyclohexane and camphor 
are typical of the ~1000 comparisons that have been made.

benzamide

(dimethylmethylidene)cyclopentadiene

1,2-epoxy-cis-4-vinylcyclohexane

camphor
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Even though scale and line-broadening parameters have been 
individually adjusted for these four examples, the values of the 
parameters are quite similar. Default  parameters could have been 
substituted with little change.

Calculating NMR Spectra

There are several reasons why NMR spectroscopy, in particular 
proton and 13C NMR, is the most important analytical technique for 
characterizing organic molecules. The experiment is straightforward 
and can be carried out rapidly. It requires relatively small samples 
and is non destructive. The so-called proton-decoupled 13C NMR is 
particularly simple, comprising a single line (resonance) for each and 
every unique carbon. Despite its simplicity (or perhaps because of 
it), associating an 13C spectra to a particular molecular structure can 
be problematic and prone to error, in particular, where alternative 
structures might be very similar. 2D spectra, in particular, COSY 
and HMBC spectra that combine chemical shifts and HH and CH 
coupling constants are more and more commonly employed to assist 
in assignment.

A routine and reliable method to predict 13C chemical shifts as a 
function of three-dimensional structure would clearly be of value in 
helping to assign experimental NMR spectra of complex molecules, 
at the very least, either providing supporting evidence or casting 
doubt on a proposed assignment. One might argue that such a method 
already exists in the form of extensive NMR spectral databases. An 
exact match to an existing spectrum provides a definitive structure, 
while one or more close matches to entries in a database suggest what 
types of structures are reasonable. Of course, entirely new compounds 
will never give exact matches, simply because the spectrum is not 
in the database. Closely related are empirical relationships based 
primarily on connectivity and obtained from fitting previously 
assigned (and presumed correctly assigned) spectra. While these 
can achieve some degree of success, the fact that NMR chemical 
shifts (and of course three-bond HH and CH coupling constants) 
are sensitive to conformation means that molecules that appear to 
be very similar may give rise to entirely different spectra. Closely 
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related to this is the fact that most organic molecules are not rigid 
and described by a single 3D structure. Rather, they comprise a 
connection of different 3D structures (conformers) and the resulting 
spectrum is a weighted average of energy weighted spectra of the 
individual conformer.

One alternative to databases and purely empirical schemes would be 
to calculate chemical shifts a priori using quantum mechanics.* In so 
doing, differences in structure and conformation are directly taken 
into account. The underlying methodology has been available for 
several decades for both Hartree-Fock and density functional models. 
However, calculations have only rarely been used to actually assist 
in the interpretation of spectra, and few practicing chemists seem to 
be aware that quantum chemical calculations are now possible (and 
practical) for real molecules, and how well calculations perform in 
accounting for chemical shifts. Those who are aware, are confronted 
and all too often stymied, with what must seem to be an endless list 
of calculation methods. We believe that the full potential of quantum 
chemical calculations as assists to assigning NMR spectra will only 
be realized after a small number of alternatives or standard models 
are elaborated and their limits and reliability clearly defined. Stated 
differently, chemists need to approach quantum chemical calculations 
much in the same way that they now approach a spectrometer. 

Underlying Theory

Application of an external magnetic field causes the nuclear spins 
to align either parallel or antiparallel to the field. The difference in 
energy (ΔE) between nuclear spin states is given by.

ΔE = γħB0

γ is the gyromagnetic ratio, a constant that depends on the magnetic 
moment of the nucleus, ħ is Planck’s constant/2π and B0 is the 
strength of the magnetic field at the nucleus. What makes nuclear 
magnetic resonance (NMR) spectroscopy useful to chemists is that 

* Neural nets offer another alternative, the downside being that their construction requires 
very large datasets. We are in the process of exploring this replacing experimental chemical 
shifts as reference data by values calculated from quantum chemical models.
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the magnetic field felt at the nucleus is different for each chemically 
distinct nucleus in a molecule. This is because the applied magnetic 
field is slightly weakened by electrons around the nucleus and 
the extent of this weakening depends on the detailed chemical 
environment. Nuclei that are well shielded by the electron cloud 
experience a lesser field than those that are poorly shielded and, as 
a result, show a smaller energy splitting. The splitting, relative to a 
standard, is termed a chemical shift.

Two additional comments need to be made. First, not all nuclei possess 
non-zero magnetic moments and, therefore, give rise to an NMR 
signal. The magnetic moment for the proton is non-zero, although that 
of the dominant isotope of carbon (12C) is not. Fortunately, the minor 
(1%) isotope 13C possesses a finite magnetic moment. The fact that 
the dominant isotope of carbon has a zero magnetic moment is both 
a "curse" and a "blessing". A curse because it certainly slowed the 
application of carbon NMR to organic chemistry by several decades 
(waiting for  magnet and spectrometer  technology to catch up). A 
blessing because it results in a 13C spectrum being much simpler 
(and easier to interpret) than a proton NMR spectrum. 

The second comment is that proximate nuclei with finite magnetic 
moments will contribute to the magnetic field felt by the nuclei under 
investigation. Whereas nearby protons interact (couple) leading to 
splitting of the individual lines in the proton NMR spectrum, the 
very low probability (1% x 1%) that two 13C nuclei will be adjacent 
all but eliminates carbon-carbon coupling. Proton-13C coupling does 
occur but can be (and nearly almost always is) removed. The result is 
that the 13C NMR spectrum contains only one line per unique carbon. 

From the perspective of the experiment, the fact that the difference 
in energy between nuclear spin states (and ultimately the ability of 
an NMR spectrometer to distinguish chemically-different nuclei) is 
directly proportional to the magnetic field strength is disheartening. 
Magnets used in NMR spectrometers are now approaching practical 
and perhaps theoretical limits, and a mere 10-20%  increase in field 
strength (translating to an equivalent increase in resolution) can 
mean more than doubling the cost of the spectrometer. Without a 
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major breakthrough in magnet technology, the prognosis for greatly 
improved resolution over what is now possible (practical) is bleak. 
On the other hand, computer performance continues to double 
every few years (anticipated by Moore’s law), and NMR spectra 
calculations on larger and ever more complex molecules continue to 
become more routine.

Correcting 13C Chemical Shifts from B3LYP/6-31G*, wB97X-D/ 
6-31G* and wB97X-V/6-31G* Density Functional Models

Spartan can calculate NMR chemical shifts using Hartree-Fock 
models as well as a range of density functional models. We have 
focused on and carefully examined three density functional models, 
specifically B3LYP, wB97X-D and wB97X-V models with the 
6-31G* basis set. Used directly, all three models lead to rms errors 
in 13C chemical shifts on the order of 5-6 ppm (over a range from 
0-250 ppm), and are not reduced by replacing 6-31G* by a larger 
more complete basis set. Errors of this magnitude are likely to be too 
large for reliably assigning the lines in an experimental 13C spectrum, 
for supporting a proposed structure assignment or perhaps most 
important for casting doubt on one. 

Empirically Corrected 13C Chemical Shifts

Empirical schemes have been developed to dramatically reduce errors 
in 13C chemical shifts, specifically for B3LYP/6-31G*, wB97X-D/6-
31G* and wB97X-V/6-31G* models. These utilize the same dataset 
for the linear regression comprising ~8000 sp3 carbons, ~6200 sp2 
carbons (including aromatic carbons) and ~450 sp carbons.* The 
functional form is as follows:

13Ci = 13Ci•Scale + Σk [X(0)
k  + X(1)

k(Ri,k - 1) + X(2)
k(Ri,k - 1)2]

13C is the corrected chemical shift and13C is the uncorrected chemical 
shift and Scale is a scaling factor. Summation is carried out over all 
bonds (1 or 2 for sp carbons, 3 for sp2 carbons and 4 for sp3 carbons). 
X(0)

k , X(1)
k and X(2)

k are parameters that depend on the atom bonded 

* Care has been taken to select either rigid molecules or molecules where a single conformer 
dominates the equilibrium (Boltzmann) distribution.
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to carbon (H, C, N, O, F, Si, P, S, Cl or Br) and Ri,k are bond lengths 
to carbon. Different expressions apply to sp, sp2 and sp3 carbons. 
The equation for sp carbon involves four X(0)parameters, four X(1) 
parameters and one X(2) parameter (11 parameters in total), that for 
sp2 carbon involves all ten X(0) parameters, six X(1) parameters and 
four X(2) parameters (21 parameters in total), and that for sp3 carbon 
involves all ten X(0) parameters but no X(0)or X(1) parameters (11 
parameters in total).* 

Resulting rms errors are 2.4, 2.1 and 2.1 ppm for B3LYP, wB97X-D, 
and wB97X-V models, all significantly (factor of 2-3) smaller than 
the uncorrected shifts. In our view, these are close to experimental 
deviations in 13C shifts commonly noted due to changes in solvent.

Atomic and Molecular Orbitals

Chemists have developed a variety of methods for describing electrons 
in molecules. Lewis structures are the most familiar. These drawings 
assign pairs of electrons either to single atoms (lone pairs) or pairs 
of atoms (bonds)**. The quantum mechanical equivalents are atomic 
and molecular orbitals which arise from solution of (approximate) 
Schrödinger equations for atoms and molecules, respectively. 
Molecular orbitals are spread throughout the entire molecule, that 
is, they are delocalized.*** Because of this, they are typically more 
difficult to interpret than Lewis structures.

Orbital Surfaces 

Molecular orbitals may be able to provide important clues about 
chemical reactivity, but before we can use this information we first 
need to understand the fundamentals for very simple molecules. The 
following figure shows two representations, a hand drawing and 

* Parameter files are available for review from: https://downloads.wavefun.com/NMR_
Correction_Parameters.zip.

** The present discussion is limited to molecules in which all electrons are paired. Molecules 
with one or more unpaired electrons (radicals, triplet states, etc.) may also be treated.

*** Is it possible to localize molecular orbitals such that they correspond more closely to 
conventional Lewis structures. Because this is costly in terms of computation and to some 
extent "ill defined" (the need to specify what conditions are to be met) localization is only 
rarely performed.
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a Spartan-generated image of an unoccupied molecular orbital of 
hydrogen molecule, H2.

H H

unoccupied molecular orbital in hydrogen

Open hydrogen empty in the topics directory. Note that except for the 
colors (sign of the orbital) the two sides of the graphic are identical. The 
junction between red and blue regions is where the value of the orbital 
is zero. Close hydrogen empty when you are finished.

The familiar hand drawing shows the orbital as two circles and a 
dashed line. The circles identify regions where the orbital takes on a 
significant value, either positive (shaded) or negative (unshaded). The 
dashed line identifies locations where the orbital’s value is exactly 
zero (a node). The drawing is useful, but it is also limited. We only 
obtain information about the orbital in two dimensions, and we only 
learn the location of significant regions and not how the orbital builds 
and decays inside and outside of these regions.

The Spartan-generated image depicts the same orbital as a surface 
of constant value. The surface is accurate in that it is derived from 
an authentic (but approximate) calculated solution to the quantum 
mechanical equations of electron motion (the Schrödinger equation). 
Equally important, the image is three-dimensional, and can be 
manipulated and looked at from a variety of different perspectives. 
It is not unexpected that the orbital consists of two distinct surfaces 
represented by different colors. The two surfaces have the same 
meaning as the two circles in the orbital drawing. They identify 
regions where the orbital takes on a significant value, either positive 
(blue) or negative (red). The orbital node is not shown, but we can 
guess that it lies midway between the two surfaces (this follows 
from the fact that the orbital’s value can only change from positive 
to negative by passing through zero).
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Atomic Orbitals

Atomic orbitals (descriptions of atoms) are the fundamental building 
blocks from which molecular orbitals (descriptions of molecules) are 
assembled. The familiar atomic orbitals for the hydrogen atom are in 
fact exact solutions of the Schrödinger equation which can actually 
be solved exactly for this one electron system. They form an infinite 
collection (a complete set), the lowest-energy member representing 
the best location for the electron, and higher-energy members 
representing alternative locations. Orbitals for real many-electron 
atoms are normally (and necessarily) assumed to be similar in form 
to those of hydrogen atom, the only difference being that, unlike 
hydrogen, more than the lowest-energy atomic orbital is utilized. 
In practical quantum chemical calculations, atomic orbitals for 
many-electron atoms are made up of sums and differences of a finite 
collection of hydrogen-like orbitals (see the topic Theoretical Models).

It is common practice to divide the full set of atomic orbitals into core 
and valence orbitals, and further to ignore the former. Valence orbitals 
for an element in the first long row of the Periodic Table are 2s, 2px, 
2py and 2pz, and for the second long row are 3s, 3px, 3py and 3pz. In 
the case of first-row elements, a single orbital, 1s, lies underneath (is 
a core orbital) while in the case of second-row elements, a set of five 
orbitals, 1s, 2s, 2px, 2py and 2pz, lie underneath.

Open fluoride and chloride in the topics directory. On the top row are 
the four valence orbitals of fluoride anion and on the bottom row the four 
valence orbitals of chloride anion. You can select among them by clicking 
(left mouse button) on each in turn. First note that the three 2p orbitals 
in fluoride are identical except for the direction in which they point. The 
same is true for the three 3p orbitals in chloride. Next, note that the valence 
orbitals in chloride are larger than those in fluoride. Atoms further down 
in the Periodic Table are generally larger than analogous atoms further 
up. Close fluoride and chloride when you are finished.

Orbitals and Chemical Bonds

Although molecular orbitals and Lewis structures are both used 
to describe electron distributions in molecules, they are used for 



Appendix A	 325

different purposes. Lewis structures are used to count the number 
of bonding and non-bonding electrons around each atom. Molecular 
orbitals are not useful as counting tools, but orbitals and associated 
orbital energies are useful tools for describing chemical bonding and 
reactivity. This section describes a few common orbital shapes and 
illustrates their use.

Molecular orbital surfaces can extend over varying numbers of atoms. 
If the orbital surface (or surfaces) is confined to a single atom or to 
atoms which are not close together, the orbital is regarded as non-
bonding. If the orbital contains a surface that extends continuously 
over two neighboring atoms, the orbital is regarded as bonding with 
respect to these atoms. Adding electrons to such an orbital will 
strengthen the bond between these atoms and cause them to draw 
closer together, while removing electrons will have the opposite 
effect. Two different kinds of bonding orbitals are depicted below. 
The drawing and surface on the left correspond to a σ bond while the 
drawing and surface on the right correspond to a π bond.

A B

     

A B

	 s bonding 	 p bonding

Open nitrogen bonding in the topics directory. The image on the left 
corresponds to the σ bonding orbital of N2, while that on the right 
corresponds to one of two equivalent π bonding orbitals. Switch to a 
transparent or mesh model to see the underlying molecular skeleton. 
Note that the σ orbitals is drawn in a single color (insofar as NN bonding 
is concerned) while the π orbital is made up of red and blue parts. This 
indicates a node or a break in the latter, although not involving the NN 
bond. Close nitrogen bonding when you are finished.

It is also possible for an orbital to contain a node that divides the 
region between two neighboring atoms into separate atomic regions. 
Such an orbital is regarded as antibonding with respect to these 
atoms. Adding electrons to an antibonding orbital weakens the bond 
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and pushes the atoms apart, while removing electrons from such an 
orbital has the opposite effect. The following pictures show drawings 
and orbital surfaces for two different kinds of antibonding orbitals. 
As above, the left and right-hand sides correspond to σ and π type 
arrangements, respectively.

node

A B

     

node

A B

	 s antibonding 	 p antibonding

Open nitrogen antibonding in the topics directory. The image on the 
left corresponds to the σ antibonding (so-called σ*) orbital of N2 while 
that on the right corresponds to one of the two equivalent π antibonding 
(so-called π*) orbitals. Switch to a mesh or transparent surface to see 
the underlying molecular skeleton. Note that the σ* orbital has a single 
node (change in color from red to blue) in the middle of the NN bond, 
while the π* orbital has two nodes (one in the middle of the NN bond 
and to the other along the bond). Close nitrogen antibonding when you 
are finished.

To summarize, bonds can be strengthened in two different ways, 
by adding electrons to bonding orbitals, or by removing electrons 
from antibonding orbitals. The converse also holds. Bonds can be 
weakened either by removing electrons from bonding orbitals or by 
adding electrons to antibonding orbitals. 

Singlet Methylene

Molecular orbitals in molecules which contain many atoms are 
typically spread throughout the molecule (they are delocalized). 
Delocalized orbitals have complicated shapes and contain multiple 
interactions that may be bonding, non-bonding, antibonding, or any 
mixture of all three. Nevertheless, these shapes can usually be broken 
down into two-atom interactions and analyzed using the principles 
outlined earlier. This process is illustrated for a triatomic molecule, 
singlet methylene, CH2. (Singlet refers to the fact that the eight 
electrons in this highly reactive molecule are organized into four 
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pairs, and that each pair of electrons occupies a different molecular 
orbital. The lowest-energy state of methylene is actually a triplet with 
three electron pairs and two unpaired electrons.)

The lowest energy molecular orbital of singlet methylene is not very 
interesting in that it looks like a 1s atomic orbital on carbon. The 
electrons occupying this orbital restrict their motion to the immediate 
region of the carbon nucleus and do not significantly affect bonding. 
Because of this restriction, and because the orbital’s energy is very 
low, this orbital is referred to as a core orbital and its electrons are 
referred to as core electrons.

core orbital for methylene

The next orbital is much higher in energy. It consists of a single 
surface that is delocalized over all three atoms. This means that it is 
simultaneously (σ) bonding with respect to each CH atom pair.

core orbital for methylene

The next higher energy orbital is described by two surfaces, a positive 
(blue) surface that encloses one CH bonding region and a negative 
(red) surface that encloses the other CH bonding region*. Since each 
surface encloses a bonding region, this orbital is also (σ) bonding with 
respect to each CH atom pair. This reinforces the bonding character of 
the previous orbital. The node that separates the two surfaces passes 
through the carbon nucleus, but not through either of the CH bonding 
regions, so it does not affect bonding.

* While the absolute signs (colors) of a molecular orbital are arbitrary, the relative signs 
(colors) indicate bonding and antibonding character.
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core orbital for methylene

Thus, the two CH bonds in the Lewis structure for singlet methylene 
are replaced by two bonding molecular orbitals.*

The highest-occupied molecular orbital (the HOMO) is also described 
by two orbital surfaces. One surface extends into carbon’s non-bonding 
region opposite the two hydrogens. The other surface encompasses the 
two CH bonding regions. Although it is hard to track the exact path 
of the orbital node in this picture, it happens to pass almost exactly 
through the carbon. This means that this particular orbital possesses 
only weak CH bonding character (it is H---H bonding). It turns out that 
the non-bonding character of the orbital is much more important than 
the bonding character, in that it leads to the fact that singlet methylene 
is able to behave as an electron-pair donor (a nucleophile).

core orbital for methylene

In addition to two CH bonds, the Lewis structure for singlet methylene 
shows a lone pair on carbon.

The above analysis shows that while the occupied orbitals of singlet 
methylene are spread over all three atoms, they are comprehensible. 

* Unlike the two Lewis structures, the two CH bonding molecular orbitals reflect the fact 
that the two CH bonds in methylene are identical. Specifically, the square of each of the 
orbitals, corresponding to the electron distribution or electron density, has the same 2-fold 
symmetry as the molecule. The square of either the molecular orbitals themselves or a 
combination of so-called degenerate (same energy) molecular orbitals must have the same 
symmetry as the underlying nuclear skeleton.
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The orbitals divide into two groups, a single low-energy core orbital 
and three higher-energy valence orbitals. The latter consist of two CH 
bonding orbitals and a non-bonding orbital on carbon. There is no one-
to-one correspondence between these orbitals and the Lewis structure. 
The bonding orbitals are not associated with particular bonds, and the 
non-bonding orbital contains bonding interactions as well.

Open methylene bonding in the topics directory. Four images appear 
corresponding to the core and three valence orbitals of singlet methylene. 
Switch to a mesh or transparent surface to see the underlying molecular 
skeleton. Close methylene bonding when you are finished.

Singlet methylene also possesses unoccupied molecular orbitals. The 
unoccupied orbitals have higher (more positive) energies than the 
occupied orbitals, and these orbitals, because they are unoccupied, 
do not describe the electron distribution in singlet methylene.* 
Nevertheless, the shapes of unoccupied orbitals, in particular, the 
lowest-unoccupied orbital (LUMO), is worth considering because it 
provides valuable insight into the methylene’s chemical reactivity.

The LUMO in methylene has non-bonding character, and looks like 
a 2p atomic orbital on carbon. This suggests that singlet methylene 
should be able to behave as an electron-pair acceptor (an electrophile). 
Note, however, that were the molecule to accept electrons, these would 
go into non-bonding orbital; carbon would become more electron-
rich, but the CH bonds would not be much affected.

LUMO of methylene

* Because Lewis structures describe electron pair bonds and non-bonding electron pairs, 
they may not be related to unoccupied molecular orbitals.
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Open methylene LUMO in the topics directory and switch to a mesh 
or transparent surface to see the underlying skeleton. Close methylene 
LUMO when you are finished.

Frontier Molecular Orbitals and Chemical Reactivity

Chemical reactions often involve movement of electrons from an 
electron donor (base, nucleophile, reducing agent) to an electron 
acceptor (acid, electrophile, oxidizing agent). This electron movement 
between molecules can also be thought of as electron movement 
between molecular orbitals, and the shapes and energies of orbitals 
that act as electron donors or electron acceptors may provide 
considerable insight into chemical reactivity.

The first step in constructing a molecular orbital picture of a chemical 
reaction is to decide which orbitals are most likely to act as electron 
donors and acceptors. It is obvious that an electron-donor orbital must 
be drawn from the set of occupied orbitals, and an electron-acceptor 
orbital must be an unoccupied orbital, but there are many orbitals in 
each set to choose from.

Orbital energy is usually the deciding factor. The highest-energy 
occupied orbital (the HOMO) is most commonly assumed to be the 
relevant electron-donor orbital and the lowest-energy unoccupied 
orbital (the LUMO) is most commonly assumed to be the relevant 
electron-acceptor orbital. For example, the HOMO and LUMO of 
singlet methylene (σ and π non-bonding orbitals, respectively) would 
serve as the donor and acceptor orbitals. The HOMO and LUMO 
are collectively referred to as the frontier molecular orbitals, and 
most chemical reactions involve electron movement between them. 
In this way, the energy input required for electron movement is kept 
to a minimum.
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Closely related to chemical reactivity (reaction rate) is chemical 
selectivity. The relevant question is, where more than one combination 
of reagents can react, which combination will react more quickly? 
The answer can often be found by examining the energies of the 
frontier orbitals. Consider ranking the rates of a series of reagents, 
where chemical reaction requires electron donation from the donor’s 
HOMO. It is reasonable to expect that the donor with the highest 
energy HOMO will give up its electrons most easily and be the most 
reactive. Electron-acceptor reagents should follow the opposite 
pattern. The reagent with the lowest energy LUMO should be able to 
accept electrons most easily and be the most reactive. For a mixture 
of several donor and acceptor reagents, the fastest chemical reaction 
would be expected to involve the reagent combination that yields the 
smallest HOMO-LUMO energy gap. 

The Fukui-Woodward-Hoffmann Rules

In certain cases, multiple frontier orbital interactions must be 
considered. A good example is provided by so-called cycloaddition 
reactions, such as the Diels-Alder reaction between 1,3-butadiene 
and ethylene.

+

The key feature of this reaction is that the reactants combine in a 
way that allows two bonds to form simultaneously. This implies two 
different sites of satisfactory frontier orbital interaction (the two new 
bonds that form are sufficiently far apart that they do not interact 
with each other during the reaction). If we focus exclusively on the 
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interactions of the terminal carbons in each molecule, then three 
different frontier orbital combinations made up of upper and lower 
components can be imagined. 

individual interactions 
reinforce

individual interactions 
cancel

The upper orbital components are the same sign in all three 
combinations, meaning that their overlap is positive. In the two cases 
on the left, the lower orbital components also lead to positive overlap. 
Thus, the two interactions reinforce, and the total frontier orbital 
interaction is non zero. Electron movement (leading to chemical 
reaction) can occur. The right-most case is different. Here the lower 
orbital components lead to negative overlap (the orbitals have opposite 
signs at the interacting sites), and the total overlap is zero. No electron 
movement and no chemical reaction can occur in this case.

As it happens, the frontier orbital interactions in the Diels-Alder 
cycloaddition shown above correspond to those found in the middle 
drawing, that is, the upper and lower interactions reinforce and the 
reaction proceeds. 

Open 1,3-butadiene+ethylene in the topics directory. The image on top 
is the LUMO of ethylene while that on the bottom is the HOMO of 1,3-
butadiene. They are properly poised to interact, but you can manipulate 
them independently. Close 1,3-butadiene+ethylene when you are 
finished.

The same arguments suggest that cycloaddition of two ethylene 
molecules is unlikely to occur. This is because it involves a frontier 
orbital interaction like that found in the right drawing.

+ X

Open ethylene+ethylene in the topics directory. The image on top 
corresponds to the LUMO of one ethylene while that on the bottom 
corresponds to the HOMO of the other ethylene. You can manipulate them 
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independently or in concert (hold down on the Ctrl key while you carry 
out rotation and translation). Note, that in this case, the two individual 
atom-atom interactions cancel. Close ethylene+ethylene when you are 
finished.

The importance of orbital overlap in determining why certain chemical  
reactions proceed easily while other seemingly similar reactions are 
sluggish or do not go at all was first advanced by Fukui and then 
beautifully elaborated by Woodward and Hoffmann, and collectively 
their ideas are now known as the Fukui-Woodward-Hoffmann rules.

Electron Densities: Sizes and Shapes of 
Molecules

How big is an atom or a molecule? Atoms and molecules require a 
certain amount of space, but how much? We know that gases can be 
compressed into a smaller volume but only so far, and that liquids and 
solids are very difficult is not nearly impossible to compress. While 
the individual atoms or molecules in a gas are widely separated and 
can be pushed into a much smaller volume, the atoms or molecules in 
a liquid or a solid are already close together and cannot be squeezed 
much further. Atoms can be talked about as having well-defined size. 
What is it?

Space-Filling Models

Chemists have long tried to answer the size question by using a special 
set of molecular models known as space-filling or CPK models. The 
space-filling model for an atom is simply a sphere of fixed radius. 
A different radius is chosen for each element in order to reproduce 
certain experimental observations, such as the compressibility of a 
gas, or the spacing between atoms in a crystal. Space-filling models 
for molecules consist of a set of interpenetrating atomic spheres. 
This reflects the idea that the chemical bonds that hold the molecule 
together cause the atoms to move closer together than the sum of the 
radii for the individual space-filling models. Interpenetration can be 
used as a criterion for chemical bonding. If two atomic spheres in a 
space-filling model strongly interpenetrate then the atoms must be 
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bonded. Space-filling models not only show how big molecules are, 
but also show which parts of the molecule are shielded and which 
are exposed.

space-filling models for ammonia (left), trimethylamine (center) and 
1-azaadamantane (right)

Open amines space filling in the topics directory. Space-filling models 
for ammonia, trimethylamine and 1-azaadamantane all appear on screen. 
Carbon atoms are colored dark grey, hydrogen atoms white and nitrogen 
blue. Note that the models clearly reveal the extent to which the nitrogen 
is exposed. Close amines space filling when you are finished.

Electron Density Surfaces

An alternative technique for portraying molecular size and shape 
relies on the molecule’s own electron cloud. Atoms and molecules 
are made up of positively-charged nuclei surrounded by a negatively-
charged electron cloud, and it is the size and shape of the electron 
cloud and not that of the nuclear skeleton that defines the size and 
shape of an atom or molecule. The size and shape of an electron cloud 
is described by the electron density (the number of electrons per unit 
volume). Consider a graph of electron density in the hydrogen atom 
as a function of distance from the nucleus.

distance from nucleus

electron
density



Appendix A	 335

The graph brings up a problem for chemists seeking to define atomic 
and molecular size, in that the electron cloud lacks a clear boundary. 
While electron density decays rapidly with distance from the nucleus, 
nowhere does it fall to zero. Therefore, when atoms and molecules 
rub up against each other, their electron clouds overlap and merge 
to a small extent.

electron density
for second molecule

molecular 
"boundary"

electron density
for first molecule

This suggests that molecular size and shape is ill defined and that the 
best that can be done is to pick a value of the electron density, and to 
connect together all the points that have this value. The criteria for 
selecting this value is exactly the same as that for selecting atomic radii 
in space-filling models, the only difference being that only a single 
parameter (the value of the electron density) is involved (rather than 
a different radius for each element). The result is an electron density 
surface which, just like a space-filling model, is intended to depict 
overall molecular size and shape.

electron density surfaces for ammonia (left), trimethylamine (center)  
and 1-azaadamantane (right)

Open amines electron density in the topics directory. Electron density 
surfaces for ammonia, trimethylamine and 1-azaadamantane all appear 
on screen. Switch to a mesh or transparent surface in order to see the 
underlying skeletal model. Click on one of the surfaces, and select 
Mesh or Transparent from the menu which appears at the bottom right 
of the screen. With mesh selected, change the model to Space Filling 
(Model menu). This allows you to see how similar the electron density 
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representation is to that offered by a simple space-filling model. Close 
amines electron density when you are finished.

Both space-filling models (atomic radii) and electron density models 
can be chosen to yield similar molecular volumes, and both show 
differences in overall size among molecules. Because the electron 
density surfaces provide no discernible boundaries between atoms, the 
surfaces may appear to be less informative than space-filling models in 
helping to decide to what extent a particular atom is exposed. This raises 
an important point. Electrons are associated with a molecule as a whole 
and not with individual atoms. The space-filling representation of a 
molecule with its discernible atomic boundaries does not reflect reality.

Bond Density Surfaces

More closely representing a conventional Lewis structure is a so-
called bond density surface, where the boundary corresponds to a 
much higher value of the electron density*. As such a surface is located 
much closer to the atomic nuclei, it encloses a relatively small volume, 
and does not give a correct impression of molecular size.

The bond density surface for hex-5-ene-1-yne clearly shows which  
atoms are connected, although it does not clearly distinguish single, 
double and triple carbon-carbon bonds.

C CH C

C

H
H

CH
H

H

C H

H
bond density surface for hex-5-ene-1-yne

Open hex-5-ene-1-yne bond density in the topics directory, and switch to 
a mesh or transparent surface to see the connection between the chemical 
bonds in a conventional model and the electron density. Close hex-5-
ene-1-yne bond density when you are finished. 

* An even higher value of the electron density leads to a surface in which only nearly spherical 
regions of electron density around the non-hydrogen atoms are portrayed. This serves to 
locate the positions of these atoms and is the basis of the X-ray diffraction experiment.
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The usefulness of the bond density surface is more apparent in the 
following model of diborane. The surface clearly shows that there is 
relatively little electron density between the two borons, suggesting 
the absence of a boron-boron bond. This is information extracted 
from the bond density surface model, and has been obtained without 
reference to any preconceived ideas about the bonding in diborane.

H
B

H
B

H

H

H

H

bond density surface for diborane

Open diborane bond density in the topics directory, and switch to a mesh 
or transparent surface to see how few electrons actually accumulate in 
the region between the two borons. Close diborane bond density when 
you are finished. 

Bond density surfaces can also be informative in describing changes 
in bonding in moving from reactants to products through a transition 
state in a chemical reaction. For example, heating ethyl formate causes 
the molecule to fragment into two new molecules, formic acid and 
ethylene. A line drawing can show which bonds are affected by the 
overall reaction, but it cannot tell us if these changes occur all at once, 
sequentially, or in some other fashion.

O OH
+

O

H
O O

H

O

On the other hand, the bond density surface is able to provide 
quantitative information.
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bond density surfaces for the reactant, ethyl formate (left), pyrolysis transition 
state (center) and for the products, formic acid and ethylene (right)

Comparison of the bond density surface in the pyrolysis transition 
state with those of the reactant and the products suggests that the CO 
single bond of the reactant is clearly broken in the transition state and 
that the migrating hydrogen seems more tightly bound to oxygen (as 
in the product) than to carbon (as in the reactant). It can be concluded 
that the transition state more closely resembles the products than the 
reactants, and this provides an example of what chemists refer to as 
a late (product-like) transition state.

To see the smooth change in electron density throughout the course of 
the ethyl formate pyrolysis reaction, open pyrolysis bond density in the 
topics directory. Click on  at the bottom left of the screen to animate 
the graphic (click on  to stop the animation). Switch to a mesh or 
transparent surface to follow the change in bonding. Close pyrolysis bond 
density when you are finished.

Electrostatic Potential Maps: Charge 
Distributions

The charge distribution in a molecule can provide critical insight into 
its physical and chemical properties. For example, molecules that are 
charged, or highly polar, tend to be water-soluble, and polar molecules 
may stick together in specific geometries, such as the double helix 
in DNA. Chemical reactions are also associated with charged sites, 
and the most highly-charged molecule, or the most highly-charged 
site in a molecule, is often the most reactive. The sign of the charge 
is also important. Positively-charged sites in a molecule invite attack 
by bases and nucleophiles, while negatively-charged sites are usually 
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targeted by acids and electrophiles.

One way to describe a molecule’s charge distribution is to give a 
numerical atomic charge for each atom. A particularly simple and 
familiar recipe yields so-called formal charges directly from Lewis 
structures. Unfortunately, formal charges are arbitrary. In fact, all 
methods for assigning charge are arbitrary and necessarily bias the 
calculated charges in one way or another. This includes methods based 
on quantum mechanics. The reason may be traced back to the notion 
that atomic boundaries are themselves ill-defined and it is impossible 
to decide which electrons are associated with which nuclei.

An attractive alternative for describing molecular charge distributions 
makes use of a quantity termed the electrostatic potential. This is 
the energy of interaction of a point positive charge with the nuclei 
and electrons of a molecule. The value of the electrostatic potential 
depends on the location of the point positive charge. If the point 
charge is placed in a region of excess positive charge (an electron-
poor region), the point charge-molecule interaction is repulsive and 
the electrostatic potential will be positive. Conversely, if the point 
charge is placed in a region of excess negative charge (an electron-rich 
region), the interaction is attractive and the electrostatic potential will 
be negative. Thus, by moving the point charge around the molecule, 
the molecular charge distribution can be surveyed.

Electrostatic potentials can be depicted in various ways. For example, 
it is possible to make an electrostatic potential surface by finding all 
of the points in space where the electrostatic potential matches some 
particular value. This is precisely what was previously done for both 
molecular orbitals and electron densities. A much more useful way 
to show molecular charge distribution is to construct a so-called 
electrostatic potential map. This is done first by constructing an 
electron density surface corresponding to a space-filling model (see 
the topic Electron Densities: Sizes and Shapes of Molecules). The 
electrostatic potential is then mapped onto this surface using different 
colors to represent the different values of the electrostatic potential. 
Mapping requires an arbitrary choice for a color scale. Spartan 
uses the rainbow. Red, the low energy end of the spectrum, depicts 
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regions of most negative (least positive) electrostatic potential, and 
blue depicts the regions of most positive (least negative) electrostatic 
potential. Intermediate colors represent intermediate values of the 
electrostatic potential, so that potential increases in the order: red < 
orange < yellow < green < blue.

The connection between a molecule’s electron density surface, 
its electrostatic potential surface, and an electrostatic potential 
map is illustrated below for benzene. The electron density surface 
defines molecular shape and size, and performs the same function 
as a conventional space-filling model by indicating how close two 
benzenes can get in a liquid or in a crystal.

 
	 space-filling model  	 electron density surface
	 for benzene	 for benzene

Open benzene electron density in the topics directory. Two different 
images, a space-filling model and an electron density surface, appear side 
by side. You can switch between the two models (in order to manipulate 
them) by clicking on each in turn. Notice how similar they are. To get an 
even clearer impression, switch to a mesh surface. Click on the graphic 
and select Mesh from the menu which appears at the bottom right of the 
screen. Switch to a space-filling model (Space Filling from the Model 
menu). The two are now superimposed. Close benzene electron density 
when you are finished.

The electrostatic potential corresponding to points where the potential 
is negative shows two different surfaces, one above the face of the 
ring and the other below. Since the molecule’s π electrons lie closest 
to these surfaces, we conclude that these electrons are responsible 
for the attraction of a point positive charge (or an electrophile) to the 
molecule. An electrostatic potential surface corresponding to points 
where the potential is positive has a completely different shape. It is 
disk-shaped and wrapped fairly tightly around the nuclei. The shape 
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and location of this surface indicates that a point positive charge is 
repelled by this region, or that a point negative charge (a nucleophile) 
would be attracted here.

	negative (left) and positive (right) electrostatic potential surfaces for benzene

Open benzene electrostatic potential in the topics directory. Two different 
images appear side by side. The one on the left depicts a surface of 
constant negative potential, while the one on the right depicts a surface 
of equal positive potential. You can switch between the two models (in 
order to manipulate them) by clicking on each in turn. Close benzene 
electrostatic potential when you are finished.

Next, combine the electron density and electrostatic potential surfaces 
to produce an electrostatic potential map. This simultaneously conveys 
both the molecule’s size and shape as well as its charge distribution 
in a compact and easily interpretable manner. The size and shape of 
the map are, of course, identical to that of the electron density surface, 
and indicates what parts of the molecule are easily accessible to other 
molecules (the outside world). The colors reveal the overall charge 
distribution. The faces of the ring, the π system, are red (electron rich), 
while the plane of the molecule and especially the hydrogens are blue 
(electron poor).

	 electrostatic potential map for benzene
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Open benzene electrostatic potential map in the topics directory. 
Manipulate the image to convince yourself that the red regions are on 
the π faces and the blue regions are around the edges. Close benzene 
electrostatic potential map when you are finished.

Electrostatic potential maps have made their way into mainstream 
general and (especially) organic chemistry textbooks as a means 
of displaying charge distributions in molecules. In addition, they 
have found application as a natural step beyond steric models for 
interpreting and predicting the way in which molecules fit together. A 
good example of this follows from the electrostatic potential map for 
benzene, which recall is negative on the π faces and positive around 
the periphery. The benzene dimer would, therefore, be expected to 
exhibit a perpendicular geometry, to best accommodate Coulombic 
interactions, instead of a parallel arrangement.

	 electrostatic potential maps for parallel (left) and perpendicular (right) 
benzene dimers

Open benzene dimer electrostatic potential map in the topics directory. 
Note that the parallel arrangement forces the negative region of one 
benzene onto the negative region of the other, while the perpendicular 
structure associates the negative region of one benzene with a positive 
region of the other. Close benzene dimer electrostatic potential map 
when you are finished.
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Of greater interest is the structure of benzene in solid state. Intuition 
suggests a parallel stack. After all, benzene is flat and flat things 
(plates, pancakes, hamburgers) make stacks. However, Coulombs 
law clearly favors a perpendicular arrangement.

perpendicularparallel

The experimental X-ray crystal structure indeed shows a perpendicular 
arrangement, albeit in three dimensions. There are two lessons 
here. Intermolecular interactions go beyond steric interactions and 
sometimes our simple one and two-dimensional views of the world 
will lead us astray.

	 X-ray crystal structure of benzene

Open benzene crystal in the topics directory. Manipulate in order to see 
the packing of benzene molecules. Close benzene crystal when you are 
finished.
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Electrostatic potential maps may also be used to describe in great 
detail the workings of chemical reactions. For example, a map may be 
used to show the transfer of negative charge during the Sn2 reaction 
of cyanide with methyl iodide.

N C N C CH3  +  ICH3 I– –

Open Sn2 cyanide+methyl iodide in the topics directory. One frame of a 
sequence of electrostatic potential maps for the Sn2 reaction will appear. 
Animate by clicking on  at the bottom left of the screen (stop the 
animation by clicking on ). Note that the negative charge (red color) 
flows smoothly from cyanide to iodide during the reaction. Note also, that 
cyanide (as the reactant) is more red than iodide (as the product). Iodide is 
better able to carry negative charge, that is, it is the better leaving group. 
Switch to mesh or transparent map to see the making and breaking of 
bonds. Close Sn2 cyanide+methyl iodide when you are finished.

Local Ionization Potential Maps and LUMO 
Maps: Electrophilic and  
Nucleophilic Reactivities

The Hammond Postulate states that the transition state in a (one-step) 
reaction will more closely resemble the side of the reaction that is 
higher in energy. Thus, the transition state of an endothermic reaction 
will more closely resemble the products, and the transition state of an 
exothermic reaction will resemble the reactants. One way  to rationalize 
the Hammond postulate is to suggest that similarity in energy implies 
similarity in structure. That is, the transition state will resemble 
whichever reactants or products to which it is closer in energy. As 
seen in the reaction coordinate diagrams below this is the product in 
an endothermic reaction and the reactants in an exothermic reaction.



Appendix A	 345

Energy

reaction coordinate reaction coordinate

reactant

product reactant

product

transition state transition state

Energyendothermic reaction exothermic  reaction

The Hammond Postulate provides a conceptual basis both for the Fukui-
Woodward-Hoffmann rules (see the topic Atomic and Molecular 
Orbitals) and for the use of graphical models. Both consider the 
properties of reactants as an alternative to direct calculations of 
transition states and reaction pathways as a way to assess chemical 
reactivity and selectivity. In this context, two models stand out as 
being particularly useful: the local ionization potential map for 
electrophilic reactions and (with some caveats) the LUMO map for 
nucleophilic reactions.

Local Ionization Potential Maps and Electrophilic Reactivity

The local ionization potential provides a measure of the relative ease 
of electron removal (ionization) at any location around a molecule. 
For example, a surface of low local ionization potential for sulfur 
tetrafluoride demarks the areas which are most easily ionized, and is 
clearly recognizable as a lone pair on sulfur.

	 local ionization potential for sulfur tetrafluoride

While the local ionization potential by itself is not a particularly useful 
model, a map of the local ionization potential onto an electron density 
surface (a local ionization potential map) has proven to be of value in 
revealing regions from which electrons are most easily ionized and 
susceptible to electrophilic attack. 
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"electron density"

For example, they show both the positional selectivity in electrophilic 
aromatic substitution (NH2 directs ortho/para, and NO2 directs 
meta), and the fact that π-donor groups (NH2) activate benzene while 
electron-withdrawing groups (NO2) deactivate benzene.

NH2 NO2

	 local ionization potential maps for benzene (left), aniline (center) 
and nitrobenzene (right)

Open benzene, aniline, nitrobenzene local ionization potential maps 
in the topics directory. Here, the color red corresponds to regions of 
lowest ionization potential (most accessible to electrophiles). Note, that 
the π system in aniline is more accessible than the π system in benzene 
(the standard) and that the ortho and para positions are more accessible 
than meta positions. Note also, that the π system in nitrobenzene is less 
accessible than the π system in benzene and that here the meta positions 
are more accessible than the ortho and para positions, in accord with 
observation. Close benzene, aniline, nitrobenzene local ionization 
potential maps when you are finished.
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LUMO Maps and Nucleophilic Reactivity

As elaborated in the topic Atomic and Molecular Orbitals, the 
energies and shapes of the frontier molecular orbitals may anticipate 
chemistry of a molecule. Molecular orbital maps may also lead to 
informative models. The most common of these is the so-called 
LUMO map, in which the (absolute value) of the LUMO is mapped 
onto an electron density surface. This anticipates where an electron 
pair (a nucleophile) might attack.

"electron density"

LUMO
electron pair

A good example is provided by the LUMO map for cyclohexenone.

O

a

β

LUMO map for cyclohexenone showing positions  
for nucleophilic attack in blue

The LUMO shows which regions of a molecule are most electron 
deficient, and hence most subject to nucleophilic attack. In this case, 
one such region is over the carbonyl carbon, consistent with the 
observation that carbonyl compounds undergo nucleophilic addition 
at the carbonyl carbon. Another region is over the β carbon, again 
consistent with the known chemistry of α,β-unsaturated carbonyl 
compounds, in this case conjugate or Michael addition.

OCH3HO

CH3

carbonyl addition Michael addition

O

CH3Li (CH3)2CuLi
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The buildup of positive charge on the β carbon leading to possibility 
of Michael addition could have been anticipated from resonance 
arguments, although the LUMO map, like an experiment, has the 
advantage of showing the result (“you don’t have to ask”).

Open cyclohexenone LUMO map in the topics directory and click on 
the resulting surface. Switch to a mesh or transparent surface in order to 
see the underlying skeletal model. On Windows, click on the graphic and 
select Mesh or Transparent from the menu which appears at the bottom 
right of the screen. On the Mac, position the cursor over the graphic, hold 
down on either the left or right button and select from the menu which 
appears alongside. Orient the molecule such that the two “blue regions” 
are positioned over the appropriate carbons and then switch back to a solid 
surface. Close cyclohexenone LUMO map when you are finished.

Some caution needs to be exercised. Specifically the LUMO may 
not be the important molecular orbital for the chemical reaction of 
interest, and it may be necessary to base the map on a higher-energy 
unoccupied molecular orbital (LUMO+1, LUMO+2, ...).
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Appendix B
Capabilities and Limitations

Molecular Mechanics Models1

The MMFF molecular mechanics model is available for the calculation 
of energy (a combination of strain energy and intramolecular 
interaction energy), equilibrium geometries, equilibrium conformers, 
conformer energy distributions and vibrational frequencies. There are 
no atom limits for molecular mechanics calculations.

Semi-Empirical Models1

The PM3 semi-empirical model is available for calculation of heats 
of formation, wave functions, equilibrium and transition-state 
geometries and vibrational frequencies. The elements H, Li-F, Mg-Cl, 
Ca, Ti-Br, Zr, Mo-Pd, Cd-I, Hf-Pt and Hg-Bi and Gd are supported. 
PM3 calculations are limited to 75 atoms.

Hartree-Fock Models1-3

Hartree-Fock models are available for calculation of energies and 
wave functions, equilibrium and transition-state geometries and 
vibrational frequencies with STO-3G, 3-21G, 6-31G* and 6-311+G** 
basis sets. Hartree-Fock calculations are limited to 30 atoms.

Density Functional Models1,

B3LYP, EDF2, and wB97X-D density functional models are available 
for calculation of energies and wave functions, equilibrium and 
transition-state geometries and vibrational frequencies with both 
6-31G* and 6-311+G** basis sets. Density functional calculations 
are limited to 30 atoms.
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MP2 Møller-Plesset Models1

The MP2 Møller-Plesset model is available for calculation of energies 
and wave functions and equilibrium and transition-state geometries 
with 6-31G* and 6-311+G** basis sets. Vibrational frequencies are 
also available, but are very costly in terms of computation time. MP2 
calculations are limited to 20 atoms.

T14 Thermochemical Recipe

The T1 recipe has been developed to closely reproduce G3(MP2) heats 
of formation. It makes use of an HF/6-31G* geometry, instead of the 
MP2/6-31G* geometry, replaces the large basis set MP2 calculation 
in G3(MP2) by a dual-basis set RI-MP2 calculation, eliminates both 
the QCISD(T) calculation and the vibrational frequency calculation 
(needed to obtain zero-point energy and to correct the energy for finite 
temperature) and introduces an empirical correction based on the atom 
counts and Mulliken bond orders. The result is that T1 requires 2-3 
orders of magnitude less computation time than G3(MP2).

T1 is limited to closed-shell, uncharged molecules comprising H, C, 
N, O, F, Si, P, S, Cl and Br only and, because it incorporates parameters 
which depend explicitly on molecular geometry, is in practice limited 
to molecules that can be properly described in terms of a conventional 
valence structure. T1 is likely to be unsatisfactory for transition states. 
T1 calculations are limited to 20 atoms.

Solvent Models

Spartan Student supports SM5.0R5 for molecular mechanics 
calculations this estimates the aqueous solvation energy. For systems 
with H, C–F, S–Cl, Br and I. Hartree-Fock and density functional 
models support the C-PCM6,7 solvent model, allowing for calculations 
in water and both polar and non-polar solvents. 

Properties and Spectra

The properties module (that is automatically called from the molecular 
mechanics module or one of the quantum chemical modules) 
provides for text output printing, population analyses based on fits 
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to electrostatic potentials), evaluation of thermodynamic quantities 
(enthalpy, entropy, free energy and heat capacity), and calculation of 
the dipole moment. 

IR spectra calculations may be carried out with molecular mechanics 
models, semi-empirical models, Hartree-Fock models, B3LYP, EDF2, 
wB97X-D and MP2 models. NMR spectra calculations may be 
carried out with Hartree-Fock, B3LYP, EDF2, and wB97X-D models.  
UV/vis spectra calculations are only available from B3LYP/6-31+G* 
as a property following a density functional energy or optimization.

Graphical Models

The graphics module provides for data preparation associated with the 
display as surfaces, property maps and slices of molecular orbitals, 
electron densities, spin densities, electrostatic potentials and local 
ionization potentials. The sizes of electron density surfaces (and of 
property maps based on electron density surfaces) may be chosen 
either using a specific value of the density or a value that encloses a 
specific percentage of the total number of electrons. Accessible and 
inaccessible regions may be distinguished for electron density surfaces 
and all property maps based on electron density surfaces.

Database

The database supported with Spartan Student is a subset of the Spartan 
Spectra and Properties Database (SSPD). It contains structures, 
energies, T1 heats of formation, IR and NMR spectra and diverse 
molecular properties for ≈6,000 molecules obtained from EDF2/ 
6-31G* and wB97X-D/6-31G* calculations. In addition, it contains 
the wave function, allowing for function on-the-fly calculation and 
display of the full variety of graphical surfaces and property maps. 
The full version of SSPD (currently >300,000 molecules) may be 
licensed separately with the Spartan Parallel Suite (the research 
version of Spartan). 
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1. For a general discussion and assessment of the techniques and methods available in Spartan 
Student, see: W.J. Hehre, A Guide to Molecular Mechanics and Quantum Chemical 
Calculations, Wavefunction, Inc., Irvine, CA 2003. This is available from Wavefunction’s 
website (www.wavefun.com).

2. For a review of the quantum chemical methods utilized in Spartan Student (except for 
the PM3 semi-empirical method) with emphasis on recent developments, see: Yihan Shao,  
Zhengting Gan,  Evgeny Epifanovsky,  Andrew T.B. Gilbert,  Michael Wormit,  Joerg 
Kussmann,  Adrian W. Lange,  Andrew Behn,  Jia Deng,  Xintian Feng,  Debashree Ghosh,  
Matthew Goldey,  Paul R. Horn,  Leif D. Jacobson,  Ilya Kaliman,  Rustam Z. Khaliullin,  
Tomasz Kuś,  Arie Landau,  Jie Liu,  Emil I. Proynov,  Young Min Rhee,  Ryan M. Richard,  
Mary A. Rohrdanz,  Ryan P. Steele,  Eric J. Sundstrom,  H. Lee Woodcock III,  Paul M. 
Zimmerman,  Dmitry Zuev,  Ben Albrecht,  Ethan Alguire,  Brian Austin,  Gregory J. O. 
Beran,  Yves A. Bernard,  Eric Berquist,  Kai Brandhorst,  Ksenia B. Bravaya,  Shawn T. 
Brown,  David Casanova,  Chun-Min Chang,  Yunqing Chen,  Siu Hung Chien,  Kristina D. 
Closser,  Deborah L. Crittenden,  Michael Diedenhofen,  Robert A. DiStasio Jr.,  Hainam Do,  
Anthony D. Dutoi,  Richard G. Edgar,  Shervin Fatehi,  Laszlo Fusti-Molnar,  An Ghysels,  
Anna Golubeva-Zadorozhnaya,  Joseph Gomes,  Magnus W.D. Hanson-Heine,  Philipp H.P. 
Harbach,  Andreas W. Hauser,  Edward G. Hohenstein,  Zachary C. Holden,  Thomas-C. 
Jagau,  Hyunjun Ji,  Benjamin Kaduk,  Kirill Khistyaev,  Jaehoon Kim,  Jihan Kim,  Rollin 
A. King,  Phil Klunzinger,  Dmytro Kosenkov,  Tim Kowalczyk,  Caroline M. Krauter,  Ka 
Un Lao,  Adèle D. Laurent,  Keith V. Lawler,  Sergey V. Levchenko,  Ching Yeh Lin,  Fenglai 
Liu,  Ester Livshits,  Rohini C. Lochan,  Arne Luenser,  Prashant Manohar,  Samuel F. Manzer,  
Shan-Ping Mao,  Narbe Mardirossian,  Aleksandr V. Marenich,  Simon A. Maurer,  Nicholas 
J. Mayhall,  Eric Neuscamman,  C. Melania Oana,  Roberto Olivares-Amaya,  Darragh P. 
O’Neill,  John A. Parkhill,  Trilisa M. Perrine,  Roberto Peverati,  Alexander Prociuk,  Dirk 
R. Rehn,  Edina Rosta,  Nicholas J. Russ,  Shaama M. Sharada,  Sandeep Sharma,  David 
W. Small,  Alexander Sodt,  Tamar Stein,  David Stück,  Yu-Chuan Su,  Alex J.W. Thom,  
Takashi Tsuchimochi,  Vitalii Vanovschi,  Leslie Vogt,  Oleg Vydrov,  Tao Wang,  Mark A. 
Watson,  Jan Wenzel,  Alec White,  Christopher F. Williams,  Jun Yang,  Sina Yeganeh,  Shane 
R. Yost,  Zhi-Qiang You,  Igor Ying Zhang,  Xing Zhang,  Yan Zhao,  Bernard R. Brooks,  
Garnet K.L. Chan,  Daniel M. Chipman,  Christopher J. Cramer,  William A. Goddard III,  
Mark S. Gordon,  Warren J. Hehre,  Andreas Klamt,  Henry F. Schaefer III,  Michael W. 
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Appendix C
Menus

Spartan Student Screen

File

New Build 	 Brings up a model kit for 3D molecule 
building or substitution

New Sketch 	 Brings up the sketch pad for molecule 
sketching in 2D

Build New Molecule 	 Adds a molecule to an existing document; 
brings up a model kit for molecule 
building

Sketch New Molecule 	 Adds a molecule to an existing document; 
brings up the sketch pad for molecule 
sketching in 2D

Delete Molecule 	 Deletes a molecule (or molecules) from 
a document

Append Molecule(s)... 	 Appends molecules to an existing 
document

Open... 	 Opens (imports) a molecule or multi-
molecule document

Close 	 Closes a molecule or multi-molecule 
document

Open Recent  	 Brings up a list of recent documents,
Documents 	 allowing one of which to be opened
Save 	 Saves (exports) a molecule or multi- 

molecule document		
Save As... 	 Saves a document as one of a number of 

file formats under a user-specified name
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Save Image As 	 Saves molecule or graphical model as a 
high-resolution PNG file

Print... 	 Prints on-screen display; also prints 
contents of output window and the 
Spreadsheet 

Access PDB Online... 	 Accesses the online Protein Data Bank 
(PDB)

Access Database by	 Searches the Spartan Student database 
Name 	 by name or partial name

Start/Stop QuickTime	 Starts and stops QuickTime recording of
Recording 	 contents of main Spartan Student screen 

(Macintosh only)
Exit 	 Exits Spartan Student

Edit

Undo 	 Undoes previous operations
Cut 	 Moves the current molecule or contents 

of the selection box to the clipboard
Copy 	 Copies the current molecule or contents 

of the selection box to the clipboard
Paste 	 Pastes contents of the clipboard to the screen
Select All 	 Selects all atoms in the selected 

molecule
Find... 	 Locates a text string in the output dialog 

or an on-screen molecular fragment
Find Next 	 Locates next occurrence of a text string 

or molecular fragment
Center 	 Centers the molecule on screen; applies 

to all molecules in a document
Clear 	 Clears the selected molecule
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Model 	

Wire 	 Displays structure as wire-frame model
Ball and Wire 	 Displays structure as ball-and-wire 

model
Tube 	 Displays structure as tube model
Ball and Spoke 	 Displays structure as ball-and-spoke 

model
Space Filling 	 Displays structure as space-filling 

model
Hide 	 Hides structure model from view
Global Model 	 Applies model type and labels of 

current molecule to all molecules in the 
document

Coupled 	 Couples motions of all molecules in the 
document

Labels 	 Toggles labels on and off
Hydrogens 	 Toggles hydrogens on and off
Ribbons 	 Toggles ribbons on and off
R/S Chirality 	 Toggles R/S chirality labels on and off 
Hydrogen Bonds 	 Toggles hydrogen bonds on and off
Ramachandran Plot 	 Display a Ramachandran plot for a protein 

that has been brought in from the Protein 
Data Bank (PDB)

Configure... 	 Labels atoms, bonds, etc., provides 
information about  polypeptides/
polynucleotides residues and designates 
ribbon displays

Geometry

Measure Distance 	 Displays and/or sets bond distance
Measure Angle  	 Displays and/or sets bond angle
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Measure Dihedral 	 Displays and/or sets dihedral angle
Constrain Distance 	 Constrains bond distance
Constrain Angle 	 Constrains bond angle
Constrain Dihedral 	 Constrains dihedral angle
Define Point 	 Defines a point as a geometric mean of a 

set of atoms
Define Ligand Point 	 Defines a ligand point as a position that 

is perpendicular to the centroid of a plane 
made by three or more atoms

Define Plane 	 Defines a plane made by three or more atoms
Freeze Center 	 Freezes selected atomic positions
Generate Isomer 	 Generates a list of stereo and/or regioisomers 

based on user specification.
Align 	 Aligns molecules in a document

Build

View 	 Removes the model kit
Edit Build 	 Brings up a 3D model kit (organic, 

inorganic, peptide, nucleotide, or 
ChemDraw) with the presently selected 
molecule

Edit Sketch 	 Brings up the sketch pad with the presently 
selected molecule. This function is only 
available if the sketch has not been altered 
using any of the 3D model kits or has not 
been replaced by an entry in SSPD.

Delete 	 Deletes atoms, bonds, points, planes, etc. 
Also available at the bottom of the 3D 
model kits

Make Bond 	 Makes bonds between free valences or 
atoms. Also available at the bottom of the 
3D model kits
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Break Bond 	 Breaks a bond. Also available at the 
bottom of the 3D model kits

Minimize 	 Performs energy minimization using 
MMFF molecular mechanics. Also 
available at the bottom of the 3D model 
kits

Guess Transition State 	 Provides transition-state guess based on 
reaction database or, lacking a database 
entry, based on a linear synchronous 
transit procedure

Setup

Calculations... 	 Sets up molecular mechanics and 
quantum chemical calculations; specifies 
calculation of IR and NMR spectra and 
QSAR properties

Surfaces 	 Sets up generation of and displays 
graphical surfaces

Submit 	 Submits job to the execution queue

Display

Output 	 Displays text output
Properties 	 Displays molecule, bond and atom 

properties as well as information about 
geometrical constraints, graphical 
surfaces and statistical analyses

Orbital Energies 	 Displays an orbital energy diagram and 
allows on-the-fly generation and display 
of molecular orbitals	

Surfaces 	 Sets up generation of and displays  
graphical surfaces (same as entry in 
Setup menu)
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Spectra 	 Displays IR and NMR spectra, animates 
vibrational modes (IR), and accesses on-
line experimental spectral databases

Spreadsheet 	 Displays spreadsheet
Plots... 	 Creates 2D plots from the data in the 

spreadsheet
Reactions 	 Calculates reaction (and activation) 

energies using data either from current 
document or from the Spartan Spectra 
and Properties Database (SSPD)

Options

Preferences... 	 Sets various run-time and labeling 
preferences, icon displays, establishes 
URL’s for on-line access

Colors 	 Sets screen and model colors
Fonts... 	 Sets fonts for menus and dialogs
Graphics Fonts... 	 Sets fonts for graphical displays and 

labels
Monitor 	 Monitors and allows for killing jobs
Calculator 	 Pocket calculator
Icons 	 Toggles display of icons on and off

Activities

Tutorials 	 Brings up Spartan Student tutorials as 
PDF documents

Topics 	 Brings up selection of topics relevant 
to calculations performed in Spartan 
Student as PDF documents

Labs 	 Brings up a sample set of student lab 
activities 

Look up in Wikipedia 	 Brings up a Wikipedia page
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Help

Spartan Student v9 	 Provides  informat ion about  the
Help 	 performance and timing of computational 

methods in Spartan Student; provides 
information about using graphical models 
in Spartan Student; bulletin board for 
FAQs about Spartan Student

Spartan Student v9	 Opens a PDF file providing a guided tour
Manual 	 through Spartan Student Edition menus

License Utility . . . 	 Accesses information about your Spartan 
Student license

Check for Updates . . . 	Provides information on availability of 
newer versions.

About Spartan Student	 Provides program version information for
v9. . . 	 citation and support

Contextual

Main Screen

Copy	 Copies selected molecule to the clipboard
Paste 	 Pastes the contents of the clipboard into 

the selected document
Delete Selected	 Deletes selected molecule from document
Properties	 Brings up the Molecular Properties dialog

Spreadsheet

Copy	 Copies text of selected cell or cells to 
the clipboard. If leftmost cell (or cells) 
selected, copies molecule(s) to the 
clipboard
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Paste 	 Pastes the contents of the clipboard into 
selected cells. If leftmost cell (or cells) 
selected, either pastes text or molecule(s) 
depending on menu choice

Add	 Brings up a wide selection of calculated 
quantities for adding to the spreadsheet 

Sort	 Sorts the column from low to high. 
Pressing the Shift key prior to menu 
selection sorts from high to low

Format Selected	 Formats selected cell(s), selected 
column(s) if selection is in a header cell, 
or entire spreadsheet if selection is header 
cell of leftmost column

Delete Selected	 Deletes selected molecule or group of 
molecules

Append	 Appends the contents of Spartan 
Student document(s) to the spreadsheet 
(corresponding to the selected document)

Rename Selected	 Renames selected molecule(s) with names
Using SSPD	 in the Spartan Spectra and Properties 

Database (SSPD)
Properties	 Brings up the Molecular Properties dialog

Reactions

Copy	 Copies selected text to the clipboard
Print 	 Prints selected text

Output Window

Copy	 Copies selected text to the clipboard
Find/Find Next	 Performs text search of Output
Print 	 Prints selected text
Save As PDF	 Saves output as .pdf file		
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Appendix D
Units

Geometries

Cartesian coordinates are given in Ångstroms (Å), and in atomic 
units (au).

Bond distances are given in Å and in au. Bond angles and dihedral 
angles are given in degrees (°).

Surface areas, accessible surface areas and polar surface areas are 
available in Å2 and volumes in Å3, and in au2 (au3).

1 Å = 0.1 nm=1.889762 au

Energies, Heats of Formation and Strain Energies, Zero-Point 
Energies, Enthalpies and Gibbs Energies and Entropies

Total energies from Hartree-Fock calculations are available in au, 
kcal/mol, kJ/mol and electron volts (eV).

Experimental heats of formation as well as those from semi-empirical 
calculations and from thermochemical recipes are available in kJ/
mol, au, kcal/mol and eV.

Strain energies from molecular mechanics calculations are available 
in kJ/mol, au, kcal/mol and eV.

Zero-point energies, enthalpies and Gibbs energies available in kJ/
mol, kcal/mol and au/mol. Entropies are available in kJ/mol•degree, 
kcal/mol•degree and au/mol•degree. 

Orbital Energies

Orbital energies are available in eV, kcal/mol, kJ/mol and au.
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Energy Conversions

 au kcal/mol kJ/mol eV

1 au - 627.5 2625 27.21
1 kcal/mol 1.593 (-3) - 4.184 4.337 (-2)
1 kJ/mol 3.809 (-4) 2.390 (-1) - 1.036 (-2)
1 eV 3.675 (-2) 23.06 96.49 -
a) exponent follows in parenthesis, e.g., 1.593 (-3) = 1.593 x 10-3

Electron Densities, Spin Densities, Dipole Moments, Charges, 
Electrostatic Potentials and Local Ionization Potentials

Electron densities and spin densities are given in electrons/au3.

Dipole moments are given in debye.

Atomic charges are given in electrons.

Electrostatic potentials are given in kJ/mol.

Local ionization potentials are given in eV.

Vibrational Frequencies

Vibrational frequencies are given in wavenumbers (cm-1).

Chemical Shifts, Coupling Constants

Chemical shifts are given in parts-per-million (ppm) relative 
to the following standards: hydrogen, tetramethylsilane; 
carbon, tetramethylsilane; nitrogen, nitromethane; fluorine, 
fluorotrichloromethane; silicon, tetramethylsilane, phosphorous, 
phosphoric acid.

Coupling constants are in ppm.
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Appendix E
Citation

The proper citation for Spartan Student is as follows:

Spartan Student
Wavefunction, Inc.

Irvine, CA

Except for molecular mechanics, semi-empirical models and the T1 
thermochemical recipe, the calculation methods used in Spartan 
Student have been documented in: Yihan Shao,  Zhengting Gan,  
Evgeny Epifanovsky,  Andrew T.B. Gilbert,  Michael Wormit,  Joerg 
Kussmann,  Adrian W. Lange,  Andrew Behn,  Jia Deng,  Xintian 
Feng,  Debashree Ghosh,  Matthew Goldey,  Paul R. Horn,  Leif D. 
Jacobson,  Ilya Kaliman,  Rustam Z. Khaliullin,  Tomasz Kuś,  Arie 
Landau,  Jie Liu,  Emil I. Proynov,  Young Min Rhee,  Ryan M. 
Richard,  Mary A. Rohrdanz,  Ryan P. Steele,  Eric J. Sundstrom,  
H. Lee Woodcock III,  Paul M. Zimmerman,  Dmitry Zuev,  Ben 
Albrecht,  Ethan Alguire,  Brian Austin,  Gregory J. O. Beran,  Yves 
A. Bernard,  Eric Berquist,  Kai Brandhorst,  Ksenia B. Bravaya,  
Shawn T. Brown,  David Casanova,  Chun-Min Chang,  Yunqing 
Chen,  Siu Hung Chien,  Kristina D. Closser,  Deborah L. Crittenden,  
Michael Diedenhofen,  Robert A. DiStasio Jr.,  Hainam Do,  Anthony 
D. Dutoi,  Richard G. Edgar,  Shervin Fatehi,  Laszlo Fusti-Molnar,  
An Ghysels,  Anna Golubeva-Zadorozhnaya,  Joseph Gomes,  Magnus 
W.D. Hanson-Heine,  Philipp H.P. Harbach,  Andreas W. Hauser,  
Edward G. Hohenstein,  Zachary C. Holden,  Thomas-C. Jagau,  
Hyunjun Ji,  Benjamin Kaduk,  Kirill Khistyaev,  Jaehoon Kim,  Jihan 
Kim,  Rollin A. King,  Phil Klunzinger,  Dmytro Kosenkov,  Tim 
Kowalczyk,  Caroline M. Krauter,  Ka Un Lao,  Adèle D. Laurent,  
Keith V. Lawler,  Sergey V. Levchenko,  Ching Yeh Lin,  Fenglai 
Liu,  Ester Livshits,  Rohini C. Lochan,  Arne Luenser,  Prashant 
Manohar,  Samuel F. Manzer,  Shan-Ping Mao,  Narbe Mardirossian,  
Aleksandr V. Marenich,  Simon A. Maurer,  Nicholas J. Mayhall,  
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Eric Neuscamman,  C. Melania Oana,  Roberto Olivares-Amaya,  
Darragh P. O’Neill,  John A. Parkhill,  Trilisa M. Perrine,  Roberto 
Peverati,  Alexander Prociuk,  Dirk R. Rehn,  Edina Rosta,  Nicholas 
J. Russ,  Shaama M. Sharada,  Sandeep Sharma,  David W. Small,  
Alexander Sodt,  Tamar Stein,  David Stück,  Yu-Chuan Su,  Alex 
J.W. Thom,  Takashi Tsuchimochi,  Vitalii Vanovschi,  Leslie Vogt,  
Oleg Vydrov,  Tao Wang,  Mark A. Watson,  Jan Wenzel,  Alec White,  
Christopher F. Williams,  Jun Yang,  Sina Yeganeh,  Shane R. Yost,  
Zhi-Qiang You,  Igor Ying Zhang,  Xing Zhang,  Yan Zhao,  Bernard 
R. Brooks,  Garnet K.L. Chan,  Daniel M. Chipman,  Christopher J. 
Cramer,  William A. Goddard III,  Mark S. Gordon,  Warren J. Hehre,  
Andreas Klamt,  Henry F. Schaefer III,  Michael W. Schmidt,  C. 
David Sherrill,  Donald G. Truhlar,  Arieh Warshel,  Xin Xu,  Alán 
Aspuru-Guzik,  Roi Baer,  Alexis T. Bell,  Nicholas A. Besley,  Jeng-
Da Chai,  Andreas Dreuw,  Barry D. Dunietz,  Thomas R. Furlani,  
Steven R. Gwaltney,  Chao-Ping Hsu,  Yousung Jung,  Jing Kong,  
Daniel S. Lambrecht,  WanZhen Liang,  Christian Ochsenfeld,  Vitaly 
A. Rassolov,  Lyudmila V. Slipchenko,  Joseph E. Subotnik,  Troy 
Van Voorhis,  John M. Herbert,  Anna I. Krylov,  Peter M.W. Gill and 
Martin Head-Gordon. Mol.Phys. 113, 184-215 (2015).
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Appendix F
Accessing ChemDraw 

(Windows Only)*

The ChemDraw program may be seamlessly accessed inside of 
Spartan Student** allowing chemical drawings to be produced in a 
familiar environment and then brought over as 3D structures***. The 
conversion is unambiguous as long as all stereochemical cues are in 
place in the 2D drawing. Note that the conformation implied by the 
2D drawing may be ambiguous and need to be altered.

You need to check the box next to ChemDraw Interface in the 
Settings Preferences dialog under the Options menu (Chapter 10). 
This will add a ChemDraw button, tab or menu entry to the 3D 
builder.

To access ChemDraw, select ChemDraw from the buttons or menu at 
the top of the model kit, and click on Edit at the bottom of the panel 
that results. ChemDraw will appear. To return to Spartan Student, 
close ChemDraw. The 2D drawing will appear at the center of the 
panel and manipulable 3D structure will appear at the top of the 
panel. Clicking on screen will move the 3D structure into Spartan 
Student’s main window.

*	 ChemDraw files (.cdx) may be read with all versions of Spartan.
**	 ChemDraw is not provided with Spartan but must be obtained from Perkin Elmer.
***	Transfer is one directional only. 3D structures that have been altered may not be transferred 

back to ChemDraw, however, Spartan’s sketch builder and molecule properties dialog will 
provide a modified 2D structure for molecules with up to 100 atoms.
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Glossary
This glossary addresses nomenclature (“jargon”) used throughout the 
manual, and more generally, in applications of molecular modeling. 
Some of the terms, such as Basis Set, will be familiar to the modeling 
community but foreign to the broader community, while other terms, 
such as Kinetic Product, may be foreign to the modeling community 
and familiar to the broader community. Terms such as Entropy should 
be familiar to all and are generally avoided. A number of terms from 
both categories have been defined “in the context” of their use in 
molecular modeling rather than more generally.

3-21G. A Split-Valence Basis Set in which each Core Basis 
Function is written in terms of three Gaussians, and each Valence 
Basis Function is split into two parts, written in terms of two and 
one Gaussians, respectively. 3-21G basis sets have been determined 
to yield the lowest total Hartree-Fock Energies for atoms. The 
nomenclature 3-21G implies use of the 3-21G(*) basis set on 
molecules incorporating second-row (and heavier) main-group 
elements.

3-21G(*). The 3-21G Basis Set supplemented by d-type Gaussians 
for each second-row and heavier main-group elements only. This is 
required in order to get good equilibrium geometries. Without the 
added functions, the 3-21G basis set is not recommended for use 
for molecules incorporating second-row (and heavier) main-group 
elements.

6-31G. A Split-Valence Basis Set in which each Core Basis 
Function is written in terms of six Gaussians, and each Valence 
Basis Function is split into two parts, written in terms of three and 
one Gaussians, respectively. 6-31G basis sets have been determined 
to yield the lowest total Hartree-Fock Energies for atoms. The 
6-31G basis set is rarely used alone but rather is supplemented by one 
or more sets of Polarization Functions and/or Diffuse Functions.
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6-31G*, 6-31G**. The 6-31G Basis Set in which non-hydrogen 
atoms are supplemented by d-type Gaussians and (for 6-31G**) 
hydrogen atoms are supplemented by p-type Gaussians (Polarization 
Functions). 6-31G* and 6-31G** are Polarization Basis Sets.

6-31+G*, 6-31+G**. Basis Sets that are identical to 6-31G* and  
6-31G** except that all non-hydrogen atoms are supplemented by 
diffuse s and p-type Gaussians (Diffuse Functions). 6-31+G* and 
6-31+G** are supplemented Polarization Basis Sets.

6-311G. A Split-Valence Basis Set in which each Core Basis 
Function is written in terms of six Gaussians, and each Valence 
Basis Function is split into three parts, written in terms of three, 
one and one Gaussians, respectively. 6-311G basis sets have been 
determined to yield the lowest total MP2 Energies for atoms. The 
6-311G basis set is rarely used alone but rather is supplemented 
by one or more sets of Polarization Functions and/or Diffuse 
Functions.

6-311G*, 6-311G**. The 6-311G Basis Set in which non-hydrogen 
atoms are supplemented by d-type Gaussians and (for 6-311G**) 
hydrogen atoms are supplemented by p-type Gaussians (Polarization 
Functions). 6-311G* and 6-311G** are Polarization Basis Sets.

6-311+G*, 6-311+G**. Basis Sets that are identical to 6-311G* 
and 6-311G** except that non-hydrogen atoms are supplemented 
by diffuse s and p-type Gaussians (Diffuse Functions). 6-311+G* 
and 6-311+G** are supplemented Polarization Basis Sets.

Ab Initio Models. The general term used to describe methods 
seeking approximate solutions to the many-electron Schrödinger 
Equation, but which do not involve empirical parameters. Ab initio 
models include Hartree-Fock Models, Møller-Plesset Models and 
Density Functional Models.

Acidity. The energy required to break an XH bond into X- and H+, 
that is, to undergo Heterolytic Bond Dissociation. Acidities in the 
gas phase are very large positive numbers (producing isolated ions 
is highly unfavorable); they are much smaller (and of either sign) in 
solution.
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Activation Energy. The energy of a Transition State above that of 
reactants. Activation energy is related to reaction rate by way of the 
Arrhenius Equation.

Anharmonic Frequency Correction. Non-quadratic contributions 
to a Vibrational Frequency. Because calculated frequencies 
are harmonic, that is, assume that the potential is quadratic, they 
are typically ~5% larger than measured frequencies, which 
include anharmonic corrections. Frequencies can be corrected for 
anharmonicity but, due to high computational cost, this is seldom 
done for any but very small molecules.

Anion. An atom or molecule with a Total Charge of -1.

Antibonding Molecular Orbital. A Molecular Orbital which is 
antibonding between particular atomic centers. The opposite is a 
Bonding Molecular Orbital.

Arrhenius Equation. An equation governing the rate of a chemical 
reaction as a function of the Activation Energy and the temperature.

Atomic Orbital. A Basis Function centered on an atom. Atomic 
orbitals typically take on the form of the solutions to the hydrogen 
atom (s, p, d, f... type orbitals).

Atomic Units. The set of units which remove all of the constants 
from inside the Schrödinger Equation. The Bohr is the atomic unit 
of length and the Hartree is the atomic unit of energy.

Atomization Energy. The energy of dissociation of an atom or 
molecule into separated nuclei and electrons. This is another term 
for Total Energy.

B3LYP Model. A Global Hybrid Generalized Gradient 
Approximation (GH-GGA) functional which improves on the 
Local Density Model by accounting explicitly for non-uniformity 
in electron distributions. It incorporates the Exchange Energy from 
the Hartree-Fock Model and involves three adjustable parameters. 
The B3LYP model is perhaps the most widely used density functional 
model and provides a solid account of equilibrium geometries 
(including the geometries of molecules incorporating transition 
metals), vibrational frequencies and reaction energies.
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Basicity. The energy gained from adding a proton to an atom 
or molecule. Basiscities in the gas phase are very large negative 
numbers; they are much smaller (and of either sign) in solution.

Basis Functions. Functions usually centered on atoms which are 
linearly combined to make up the set of Molecular Orbitals. Except 
for Semi-Empirical Models where basis functions are Slater type, 
basis functions are Gaussian type.

Basis Set. The entire collection of Basis Functions.

Bohr. The Atomic Unit of length. 1 bohr = 0.529167Å.

Boltzmann Distribution. The equilibrium distribution of products 
in a Thermodynamically-Controlled Reaction. A special (and very 
important) case involves the equilibrium distribution of Conformers 
of a flexible molecule.

Boltzmann Equation. The equation governing the distribution of 
products in Thermodynamically-Controlled Reaction.

Bonding Molecular Orbital. A Molecular Orbital which is bonding 
between particular atom centers. The opposite is an Antibonding 
Molecular Orbital.

Bond Order. A measure of the number of electrons shared between 
“bonded” atoms.

Bond Separation Reaction. An Isodesmic Reaction in which a 
molecule described in terms of a conventional valence structure 
is broken down into the simplest (two-heavy-atom) molecules 
containing the same component bonds.

Bond Density Surface. A Density Surface used to elucidate the 
bonding in molecules. The value of the density is typically taken as 
0.1 electrons/bohr.3

Born-Oppenheimer Approximation. An approximation based on 
the assumption that nuclei are stationary. Applied to the Schrödinger 
Equation, it leads to the Electronic Schrödinger Equation.

C-PCM. The Conductor like Polarizable Continuum Model is a 
solvent model that depends on the shape and charge distribution of 
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the molecule (solute) and the dielectric constant of the solvent. This 
is the solvent model used in the Spartan Student version. 

Cambridge Structural Database (CSD). A collection of >1,000,000 
experimental structures for organic and organometallic compounds 
almost entirely from X-ray crystallography. Structures lacking 
carbon are excluded as are biopolymers (the latter are available from 
the Protein Data Bank).

Cartesian Coordinates. x, y, z spatial coordinates.

CAS Number. Chemical Abstract Service registry number; a unique 
substance identifier used to a large degree in the chemistry literature, 
see www.cas.org for more information.

Cation. An atom or molecule with a Total Charge of +1.

Chemical Shift. The difference in the energies of nuclear spin states 
for a nucleus in a molecule caused by an external magnetic field. 
This is the fundamental quantity measured in NMR spectroscopy.

Chiral Molecule. A molecule with a non-superimposible mirror 
image. Most commonly (but not necessarily) a chiral molecule will 
incorporate one or more R/S centers.

Closed Shell. An atom or molecule in which all electrons are paired.

Conformation. The arrangement about single bonds and of flexible 
rings.

Conformational Analysis. One of several different procedures to 
deal with molecules that are not properly described in terms of a 
single Conformer. Determination of Equilibrium Conformer or 
establishing a Conformer Distribution or a Similarity Library are 
examples of conformational analysis.

Conformer. One of a number of possible shapes a flexible molecule 
can assume.

Core. Electrons which are primarily associated with individual 
atoms and do not participate significantly in chemical bonding (1s 
electrons for first-row elements, 1s, 2s, 2px, 2py, 2pz electrons for 
second-row elements, etc.).
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Core Orbital. A Molecular Orbital that is primarily involved with 
the Core rather than with the Valence.

Correlated Models. Models which take implicit or explicit account 
of the Correlation of electron motions. Møller-Plesset Models, 
Configuration Interaction Models and Density Functional 
Models are correlated models.

Correlation. The coupling of electron motions not explicitly taken 
into account in Hartree-Fock Models.

Correlation Energy. The difference in energy between the Hartree-
Fock Energy and the experimental energy.

Correlation Functional. A function of the Electron Density and 
perhaps as well the gradient of the Electron Density. The functional 
form derives from “exact” solution of the Schrödinger Equation for 
an idealized many-electron problem. Used in Density Functional 
Models.

Coulomb Energy. The electron-electron repulsion energy according 
to Coulomb’s law.

Coulombic Interactions. Charge-charge interactions which follow 
Coulomb’s law. Stabilizing when charges are of opposite sign and 
destabilizing when they are of the same sign.

Coupling Constant. A measure of the extent to which nuclear spins 
on neighboring atoms interact (couple) with each other, causing 
splitting of the lines in an NMR spectrum.

CPK Model.  A molecular model in which atoms are represented 
by spheres, the radii of which correspond to van der Waals Radii. 
Intended to portray molecular size and shape. Also known as a 
space-filling model.

CSD; See Cambridge Structural Database.

Curtin-Hammett Principle. The idea that the reactive conformer 
in a Kinetically-Controlled Reaction is not necessarily the lowest-
energy conformer. The rationale is that the energy barriers separating 
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conformers are typically much smaller than barriers to chemical 
reaction, and that any reactive conformers will be replenished.

Density; See Electron Density.

Density Functional Models. Methods in which the energy 
is evaluated as a function of the Electron Density. Electron 
Correlation is taken into account explicitly by incorporating into the 
Hamiltonian terms which derive from exact solutions of idealized 
many-electron systems.

Diffuse Functions. Functions added to a Basis Set to allow 
description of electron distributions far away from atomic positions. 
Important for descriptions of anions.

Diffusion-Controlled Reactions. Chemical reactions without 
Transition States (or energy barriers), the rates of which are 
determined by the speed in which molecules encounter each other 
and how likely these encounters are to lead to reaction.

Dipole Moment. A vector indicating the magnitude, sign and 
direction of the overall distribution of charge in a molecule based on 
the combination of nuclear and electron charges. Most commonly 
only the magnitude of the dipole moment is known experimentally.

Double Hybrid Functional. A class of functionals that take account 
of unoccupied molecular orbitals in addition to occupied molecular 
orbitals (the density) usually by way of an MP2-like procedure.

Doublet. A molecule with one unpaired electron, also known as a 
radical.

Dual Basis Set. A technique whereby the converged wavefunction 
resulting from a calculation using a small basis set is passed on for a 
single SCF cycle using a large basis set. This closely approximates 
the energy and wavefunction that would have resulted from a 
full calculation using the large basis set but with 5-10 times less 
computation.

EDF2 Model. A Global Hybrid Generalized Gradient 
Approximation (GH-GGA) functional which improves on the 
Local Density Model by accounting explicitly for non-uniformity in 
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electron distributions. EDF2 was explicitly formulated to reproduce 
experimental vibrational frequencies (infrared spectra), and it was for 
this reason (together with practical concerns) that the EDF2/6-31G* 
model was chosen for use in the Spartan Spectra and Properties 
Database (SSPD).

Electron Affinity. The energy gained as a result of adding an 
electron to an atom or molecule. May be calculated as the (negative 
of) the difference in energies between the atom/molecule and it 
corresponding radical anion. Note that not all atoms/molecules have 
positive electron affinities, that is, bind an electron.

Electron Correlation. See Correlation.

Electron Density. The number of electrons per unit volume at a 
point in space. This is the quantity which is measured in an X-ray 
diffraction experiment.

Electron Density Surface. A surface of constant Electron Density. 
May be used to elucidate bonding (Bond Density Surface) or to 
characterize overall moelcular size and shape.

Electronic Schrödinger Equation. The equation which results 
from incorporation of the Born-Oppenheimer Approximation to 
the Schrödinger Equation.

Electrostatic Charges. Atomic charges chosen to best match the 
Electrostatic Potential at points surrounding a molecule, subject to 
overall charge balance.

Electrostatic Potential. A function describing the energy of 
interaction of a positive point charge with the nuclei and fixed 
electron distribution of a molecule.

Electrostatic Potential Map. A graph that shows the value of 
Electrostatic Potential on an Electron Density Isosurface 
corresponding to a van der Waals Surface.

Electrostatic Potential Surface. It may be used to elucidate regions 
in a molecule which are particularly electron rich and subject to 
electrophilic attack and those which are particularly electron poor, 
subject to nucleophilic attack.
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Energy Profile. A plot of energy vs. change in geometrical coordinate, 
for example, change in bond length or in dihedral angle.

Enthalpy. The heat of a chemical reaction. Related to energy by a 
pressure-volume that is insignificant at normal pressures.

Equilibrium Conformer. The lowest-energy Conformer. 

Equilibrium Geometry. A Local Minimum on a Potential Energy 
Surface.

Equilibrium Isotope Effect. The effect on the heat of reaction due 
to a change in nuclear mass of one or more atoms. The most common 
(and largest) isotope effects arise from substitution of deuterium for 
hydrogen. 

Exchange Functional. A function of the Electron Density and 
perhaps as well the gradient of the Electron Density. The functional 
form derives from “exact” solution of the Schrödinger Equation for 
an idealized many-electron problem. Used in Density Functional 
Models.

Exchange Energy. An “attractive” (negative) component of the 
electron-electron interaction energy. Arises due to an overestimation 
of the “repulsive” (positive) component or Coulomb energy.

Excited State. An electronic state for an atom or molecule which is 
not the lowest-energy or Ground State.

Force Constant. For a diatomic molecule, the second derivative of 
the energy with respect to change in bond length. For a polyatomic 
molecule, the second derivative of the energy with regard to a change 
in Normal Coordinate.

Force Field. The set of rules underlying Molecular Mechanics 
Models. Comprises terms which account for distortions from ideal 
bond distances and angles and for Non-Bonded van der Waals and 
Coulombic Interactions.

Fourier Series. An expansion of a periodic (in 360o rotation) in 
terms of powers of the cosine of the torsion angle.

Frontier Molecular Orbitals. The HOMO and LUMO.
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Gx Models. “Recipes” which combine a series of Hartree-Fock 
and Correlated Models to properly account for Atomization 
Energies of atoms and molecules. Useful for providing accurate 
thermochemical data.

G3(MP2). A “simplified” version of the G3 Model. Reproduces 
experimental Heats of Formation with an RMS errors of ~8 kJ/
mol, practical for molecules comprising less than 20 atoms.

Gaussian. A function of the form xlymzn exp (αr2) where l, m, n are 
integers (0, 1, 2 . . .) and α is a constant. Used in the construction of 
Basis Sets for Hartree-Fock, Density Functional, MP2 and other 
Correlated Models.

Gaussian Basis Set. A Basis Set made up of Gaussian Basis 
Functions.

Global Minimum. The lowest energy Local Minimum on a 
Potential Energy Surface.

Ground State. The lowest energy electronic state for an atom or 
molecule.

Hamiltonian. An operator which accounts for the kinetic and 
potential energy of an atom or a molecule.

Hammond Postulate. The idea that the Transition State for an 
exothermic reaction will more closely resemble reactants than 
products. This provides the basis for “modeling” properties of 
Transition States in terms of the properties of reactants.

Harmonic Frequency. A Vibrational Frequency which has been 
corrected to remove all non-quadratic (anharmonic) components. 
Calculated Vibrational Frequencies correspond to harmonic 
frequencies. The corrections require data on isotopically-substituted 
systems and are typically available only for small molecules.

Hartree. The Atomic Unit of energy. 1 hartree = 627.47 kcal/mol.

Hartree-Fock Approximation. Separation of electron motions in 
many-electron systems into a product form of the motions of the 
individual electrons.
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Hartree-Fock Energy. The energy resulting from Hartree-Fock 
Models.

Hartree-Fock Equations. The set of differential equations resulting 
from application of the Born-Oppenheimer and Hartree-Fock 
Approximations to the many-electron Schrödinger Equation.

Hartree-Fock Models. Methods in which the many-electron 
wavefunction in written terms of a product of one-electron 
wavefunctions. Electrons are assigned in pairs to functions called 
Molecular Orbitals.

Hartree-Fock Wavefunction. The simplest quantum-mechanically 
correct representation of the many-electron wavefunction. Electrons 
are treated as independent particles and are assigned in pairs to 
functions termed Molecular Orbitals. Also known as Single-
Determinant Wavefunction.

Heat of Formation. The Enthalpy at 298 K of a balanced chemical 
reaction in which a molecule is converted into the most stable form 
of the each element, for example, hydrogen molecule for hydrogen 
and graphite for carbon.

Hessian. The matrix of second energy derivatives with respect 
to geometrical coordinates. The Hessian together with the atomic 
masses lead to the Vibrational Frequencies of molecular systems.

Heterolytic Bond Dissociation. A process in which a bond is 
broken and a cation and anion result. The number of electron pairs 
is conserved, but a non-bonding electron pair has been substituted 
for a bond.

HOMO. Highest Occupied Molecular Orbital.

Homolytic Bond Dissociation. A process in which a bond is 
broken and two radicals result. The number of electron pairs is not 
conserved.  

HOMO-LUMO Gap. The difference in energies between the 
HOMO and LUMO.
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HOMO Map. A graph of the absolute value of the HOMO on an 
Isodensity Surface corresponding to a van der Waals Surface.

Hydrogen-Bond Acceptor. An electronegative element (typically, 
nitrogen, oxygen or halogen) with one or more lone pairs able to 
“accept” a hydrogen from a Hydrogen-Bond Donor.

Hydrogen-Bond Donor. A hydrogen bonded to an electronegative 
element (typically nitrogen or oxygen) that can be donated to a 
Hydrogen-Bond Acceptor.

Hydrophobe. A non polar region of a molecule.

Hypervalent Molecule. A molecule containing one or more main-
group elements in which the normal valence of eight electrons has 
been exceeded. Hypervalent molecules are common for second-row 
and heavier main-group elements but are uncommon for first-row 
elements.

Imaginary Frequency. A frequency which results from a negative 
element in the diagonal form of the Hessian. Equilibrium Geometries 
are characterized by all real frequencies while Transition States are 
characterized by one imaginary frequency.

Infrared Spectrum. Spectrum resulting from transitions between 
vibrational energy levels. Infrared intensities depend on the change 
in dipole moment associated with the vibration.

Internal Coordinates. A set of bond lengths, bond angles and 
dihedral angles (among other possible variables) describing 
molecular geometry. The Z Matrix is a set of internal coordinates.

Ionization Potential. The energy required to completely eject an 
electron from an atom or molecule. May be calculated as the difference 
in energies between the atom/molecule and its corresponding radical 
cation. May be approximated from Koopman’s Theorem as the 
negative of the HOMO Energy.

Isodesmic Reaction. A chemical reaction in which the number of 
formal chemical bonds of each type is conserved.
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Isosurface. A three-dimensional surface defined by the set of points 
in space where the value (isovalue) of the function is constant.

Kinetically-Controlled Reaction. Refers to a chemical reaction 
which has not gone all the way to completion, and the ratio of 
products is not related to their thermochemical stabilities, but rather 
inversely to the heights of the energy barriers separating reactants 
to products.

Kinetic Isotope Effect. The effect on the rate of reaction due to a 
change in nuclear mass of one or more atoms. The most common 
(and largest) isotope effects arise from substitution of deuterium for 
hydrogen. 

Kinetic Product. The product of a Kinetically-Controlled 
Reaction.

kJ/mol. The unit commonly used to express chemical energy 
differences, replacing kcal/mol. 1 kJ/mol = 0.239 kcal/mol = 
0.000381 au.

LCAO Approximation. Linear Combination of Atomic Orbitals 
approximation. Approximates the unknown Hartree-Fock 
Wavefunctions (Molecular Orbitals) by linear combinations 
of atom-centered functions (Atomic Orbitals) and leads to the 
Roothaan-Hall Equations.

Ligand. This term has two meanings in the context of molecular 
modeling. It denotes a molecular fragment that is (viewed as) 
non-covalently bonded to a transition metal in an inorganic or 
organometallic compound. For example, both carbon monoxide and 
benzene are said to be ligands in benzene chromium tricarbonyl. It 
also denotes a molecule that is “associated” (non-covalently bonded) 
to a protein.

Linear Synchronous Transit. The name given to procedures which 
estimate the geometries of transition states based on “averages” of 
the geometries of reactants and products, sometimes weighted by 
the overall thermodynamics of reaction.
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Local Ionization Potential. A function of the relative ease of 
electron removal (ionization) from a molecule.

Local Ionization Potential Map. A graph of the Local Ionization 
Potential on an Isodensity Surface corresponding to a van der 
Waals Surface.

Local Minimum. Any Stationary Point on a Potential Energy 
Surface for which all elements in the diagonal representation of the 
Hessian are positive.

LogP. An empirical measure of the extent to which a molecule 
partitions between water and octanol.

Lone Pair. A Non-Bonded Molecular Orbital which is typically 
associated with a single atom.

LUMO. Lowest Unoccupied Molecular Orbital.

LUMO Map. A graph of the absolute value of the LUMO on an 
Isodensity Surface corresponding to a van der Waals Surface.

Mechanism. The sequence of steps connecting reactants and products 
in an overall chemical reaction. Each step starts from an equilibrium 
form (reactant or intermediate) and ends in an equilibrium form 
(intermediate or product).

Minimal Basis Set. A Basis Set which contains the fewest functions 
needed to hold all the electrons on an atom and still maintain spherical 
symmetry. STO-3G is a minimal basis set.

Minimal Valence Basis Set. A  Minimal Basis Set from which 
Core Orbitals have been removed. Semi-Empirical Models make 
use of a minimal valence basis set.

MMFF94. Merck Molecular Force Field. A Molecular Mechanics 
Force Field for organic molecules and biopolymers developed by 
Merck Pharmaceuticals.

Molecular Mechanics Models. Methods for structure, conformation 
and strain energy calculation based on bond stretching, angle bending 
and torsional distortions, together with Non-Bonded Interactions, 
and parameterized to fit experimental data.
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Molecular Orbital. A one-electron function made of contributions 
of Basis Functions on individual atoms (Atomic Orbitals) and 
delocalized throughout the entire molecule.

Molecular Orbital Models. Methods based on writing the many-
electron solution of the Electronic Schrödinger Equation in terms 
of a product of one-electron solutions (Molecular Orbitals).

Møller-Plesset Energy. The energy resulting from Møller-Plesset 
Models terminated to a given order, e.g., the MP2 energy is the 
energy of the second-order Møller-Plesset Model (or MP2).

Møller-Plesset Models. Methods which partially account for 
Electron Correlation by way of the perturbation theory of Møller 
and Plesset.

Monte-Carlo Conformation Search. A limited search of 
Conformers resulting from a random sampling of all torsional angles 
(including constrained torsions associated with flexible rings) while 
satisfying the requirements imposed by the Boltzmann Equation.

MP2 Energy. The energy resulting from MP2 Models.

MP2 Model. A Møller-Plesset Model terminated to be second order 
in the energy.

Multiplicity. The number of unpaired electrons (number of electrons 
with “down” spin) +1. 1=singlet; 2=doublet; 3=triplet, etc.

NIST Chemistry Web Book (National Institutes of Standards 
and Technology). On-line source of experimental Infrared and 
UV/visible spectra.

NMR Spectrum. Spectrum resulting from transitions between 
nuclear spin states under the influence of an external magnetic field. 
Both 1D spectra (most important, proton and 13C) and 2D spectra 
(most important COSY, HMBC and  HSQC) are available.

Non-Bonded Interactions. Interactions between atoms which are 
not directly bonded. van der Waals Interactions and Coulombic 
Interactions are non-bonded interactions.
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Non-Bonded Molecular Orbital. A molecular orbital which does 
not show any significant Bonding or Antibonding characteristics. 
A Lone Pair is a non-bonded molecular orbital.

Normal Coordinates. Coordinates that lead to a diagonal Hessian, 
and which correspond to vibrational motions in molecules.

Normal Mode Analysis. The process for calculating Normal 
Coordinates leading to Vibrational Frequencies. This involves 
diagonalizing the Hessian and accounting for atomic masses.

Octet Rule. The notion that main-group elements prefer to be 
“surrounded” by eight electrons (going into s, px, py, pz orbitals).

Orbital Energy. The energy of a Molecular Orbital.

Orbital Energy Diagram. A diagram listing Orbital Energies from 
most negative at the bottom. Usually restricted to occupied Valence 
Orbitals and the few lowest unoccupied orbitals.

Orbital Symmetry Rules; See Woodward-Hoffmann Rules.

Open Shell. An atom or molecule in which one or more electrons 
are unpaired.

PM3. Parameterization Method 3. A Semi-Empirical Model.

Polar Area. The area of an Electrostatic Potential Map that is either 
more positive or more negative than some preset value (typically 
between 80-120 kJ/mol).

Polarization Basis Set. A Basis Set which contains functions of 
higher angular quantum number (Polarization Functions) than 
required for the Ground State of the atom, e.g., d-type functions for 
main-group elements and p-type functions for hydrogen. 6-31G*, 
6-31G**, 6-311G*, 6-311G**, cc-pVDZ, cc-pVTZ and cc-pVQZ 
are polarization basis sets.

Polarization Functions. Functions of higher angular quantum than 
required for the Ground State atomic description. Added to a Basis 
Set to allow displacement of Valence Basis Functions away from 
atomic positions.
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Polar Surface Area. The area of a space-filling (CPK) model due 
to electronegative elements (typically, nitrogen and oxygen) and any 
hydrogens that are bonded to these elements.

Pople-Nesbet Equations. The set of equations describing the best 
Unrestricted Single Determinant Wavefunction within the LCAO 
Approximation. These reduce the Roothaan-Hall Equations for 
Closed Shell (paired electron) systems.

Potential Energy Surface. A function of the energy of a molecule 
in terms of the geometrical coordinates of the atoms.

Property Map. A representation or “map” of a “property” on top 
of an Isosurface, typically an Isodensity Surface. Electrostatic 
Potential Maps, and HOMO and LUMO Maps and Spin Density 
Maps are useful property maps.

Proton Affinity; See Basicity.

Pseudopotential. A Basis Set which treats only Valence electrons 
in an explicit manner, all other electrons being considered as a part 
of a “Core”. LAVCP (and extensions including Polarization and/
or Diffuse Functions) are pseudopotentials.

Pseudorotation. A mechanism for interconversion of equatorial 
and axial sites around trigonal bipyramidal centers, e.g., fluorines in 
phosphorous pentafluoride.

QSAR. Quantitative Structure Activity Relationships. The name 
given to attempts to relate measured or calculated properties to 
molecular structure.

Quantum Mechanics. Methods based on approximate solution of 
the Schrödinger Equation.

Ramachandran Plot. A plot for each α carbon in a polypeptide of the 
two dihedral angles that define the conformation of the backbone. The 
points will typically cluster in two regions denoting helices and sheets.

Rate Limiting Step. The step in an overall chemical reaction 
(Mechanism) which proceeds via the highest-energy Transition 
State.
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Reaction Coordinate. The coordinate that connects the Local 
Minima corresponding to the reactant and product, and which passes 
through a Transition State.

Reaction Coordinate Diagram. A plot of energy vs. Reaction 
Coordinate.

Restricted SCF. An SCF procedure which restricts electrons to be 
paired in orbitals or permits orbitals to be singly occupied.

Roothaan-Hall Equations. The set of equations describing the best 
Hartree-Fock or Single-Determinant Wavefunction within the 
LCAO Approximation.

R/S. Atomic chirality markers.

SCF. Self Consistent Field. An iterative procedure whereby a one-
electron orbital is determined under the influence of a potential made 
up of all the other electrons. Iteration continues until self consistency. 
Hartree-Fock, Density Functional and MP2 Models all employ 
SCF procedures.  

Schrödinger Equation. The quantum mechanical equation which 
accounts for the motions of nuclei and electrons in atomic and 
molecular systems.

Self Consistent Field; See SCF.

Semi-Empirical Models. Quantum Mechanics methods that seek 
approximate solutions to the many electron Schrödinger Equation, 
but which involve empirical parameters.

Size Consistent. Methods for which the total error in the calculated 
energy is more or less proportional to the (molecular) size. Hartree-
Fock and Møller-Plesset models are size consistent, while Density 
Functional Models, (limited) Configuration Interaction Models 
and Semi-Empirical Models are not size consistent. 

Size Surface. A Density Surface used to establish overall molecular 
size and shape. The value of the density is typically taken as 0.002 
electrons/bohr3. 
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Slater. A function of the form xlymzn exp (-ζr) where l, m, n are 
integers (0, 1, 2 . . .) and ζ is a constant. Related to the exact solutions 
to the Schrödinger Equation for the hydrogen atom. Used as Basis 
Functions in Semi-Empirical Models. 

Space-Filling Model; See CPK Model.

Spartan Reaction Database (SRD). A collection of ~2,500 
transition-state structures for a wide variety of simple organic and 
organometallic reactions obtained from up to five different quantum 
chemical models. Searchable by structure.

Spartan Spectra and Properties Database (SSPD). A collection 
of molecular structures, infrared and NMR spectra, molecular and 
atomic properties and QSAR descriptors for >300,000 organic 
molecules obtained from the wB97X-D/6-31G* and EDF2/6-31G* 
density functional models based on the lowest-energy conformer 
assigned from the T1 model. The wavefunction is available, as 
such, surfaces and property maps may be generated “on-the-fly”. 
Searchable by structure, name, formula, molecular weight and 
isomer.

Spin Density. The difference in the number of electrons per unit 
volume of “up” spin and “down” spin at a point in space.

Spin Density Map. A graph that shows the value of the Spin 
Density on an Isodensity Surface corresponding to a van der 
Waals Surface.

Spin Orbital. The form of Wavefunction resulting from application 
of the Hartree-Fock Approximation to the Electronic Schrödinger 
Equation. Comprises a space part (Molecular Orbital) and one of 
two possible spin parts (“spin-up” and “spin-down”).

Split-Valence Basis Set. A Basis Set in which the Core is represented 
by a single set of Basis Functions (a Minimal Basis Set) and the 
Valence is represented by two or more sets of Basis Functions. 
This allows for description of aspherical atomic environments in 
molecules. 3-21G, 6-31G and 6-311G are split-valence basis sets.

SSPD; see Spartan Spectra and Properties Database.
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Stationary Point. A point on a Potential Energy Surface for which 
all energy first derivatives with respect to the coordinates are zero. 
Local Minima and Transition States are stationary points. 

STO-3G. A Minimal Basis Set. Each atomic orbital is written in 
terms of a sum of three Gaussian functions taken as best fits to 
Slater-type (exponential) functions.

Systematic Conformation Search. An exhaustive search of 
Conformers resulting from stepping through all torsional angles 
(including constrained torsions associated with flexible rings). This 
is the only procedure that guarantees identification of the Global 
Minimum.

T1. A combination of quantum chemical models and empirical 
parameters formulated to reproduce Heats of Formation obtained 
from the G3(MP2) Model using 2-3 orders of magnitude less 
computation. T1 reproduces experimental heats with an RMS error of 
~8 kJ/mol (the same error as obtained from the G3(MP2) Model).

Tautomer. An isomer related by rearrangement of hydrogen atoms, 
for example vinyl alcohol is a tautomer of acetaldehyde. All tautomers 
are isomers but not all isomers are tautomers.

TDDFT (Time Dependent Density Functional Theory).

Theoretical Model. A “recipe” leading from the Schrödinger 
Equation to a general computational scheme. A theoretical models 
needs to be unique and well defined and, to the maximum extent 
possible, be unbiased by preconceived ideas. It should lead to 
Potential Energy Surfaces which are continuous. It is also desirable 
(but not required) that a theoretical model be Size Consistent and 
Variational. Finally, a theoretical model will be applicable for the 
problems of interest.

Theoretical Model Chemistry. The set of results following from 
application of a particular Theoretical Model.

Thermochemical Recipes. Combinations of quantum chemical 
models and (in the case of T1) empirical parameters to reproduce 
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experimental (or in the case of T1) G3(MP2) Heats of Formation. 
G3(MP2) and T1 are thermochemical recipes.

Thermodynamically-Controlled Reaction. A chemical reaction 
which has gone all the way to completion, and the ratio of different 
possible products is related to their thermochemical stabilities 
according to the Boltzmann Equation.

Thermodynamic Product. The product of a reaction which is under 
Thermodynamic Control.

Total Charge. The sum of the nuclear charges minus the total 
number of electrons.

Total Energy. The energy of a balanced chemical reaction in which 
a molecule is split into single particle fragments, that is, nuclei and 
electrons. Total energy is the standard way to report energy data 
derived from quantum chemical models (except Semi-Empirical 
Models and Thermochemical Recipes).

Transition State. A Stationary Point on a Potential Energy Surface 
in which all but one of the elements in the diagonal representation of 
the Hessian are positive, and one element is negative. Corresponds 
to the highest-energy point on the Reaction Coordinate.

Transition-State Geometry. The geometry (bond lengths and 
angles) of a Transition State.

Transition State Theory. The notion that all molecules react through 
a single well-defined Transition State.

Triplet. A molecule with two unpaired electrons.

Unrestricted SCF. An SCF procedure which does not restrict 
electrons to be paired on orbitals.

UV/visible Spectrum. The spectrum resulting between ground and 
excited electronic states.

Valence. Electrons which are delocalized throughout the molecule 
and participate in chemical bonding (2s, 2px, 2py, 2pz for first-row 
elements, 3s, 3px, 3py, 3pz for second-row elements, etc.).
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Valence Orbital. A Molecular Orbital that is primarily involved 
with the Valence rather than the Core.

van der Waals Interactions. Interactions which account for short-
range repulsion of non-bonded atoms as well as for weak long-range 
attraction.

van der Waals Radius. The radius of an atom (in a molecule), which 
is intended to reflect its overall size. van der Waals radii are used to 
define space-filling models.

van der Waals Surface. A surface formed by a set of interpreting 
spheres (atoms) with specific van der Waals radii, and which is 
intended to represent overall molecular size and shape.

Variational. Methods for which the calculated energy represents an 
upper bound to the exact (experimental) energy. Hartree-Fock and 
Configuration Interaction Models are variational while Møller-
Plesset Models, Density Functional Models and Semi-Empirical 
Models are not variational.

Vibrational Frequencies. The energies at which molecules vibrate. 
Vibrational frequencies correspond to the peaks in an infrared and 
Raman spectrum. 

Wave function. The solution of the Schrödinger Equation. In 
the case of the hydrogen atom, a function of the coordinates which 
describes the motion of the electron as fully as possible. In the case 
of a many-electron system a function which describes the motion of 
the individual electrons.

Zero-Point Energy. The energy of molecular vibration at 0K, given 
as half the sum of the Vibrational Frequencies times Planck’s 
constant.

Z Matrix. A set of internal coordinates (bond lengths, bond angles 
and dihedral angles only) describing molecular geometry. Of 
historical interest only. Not supported in Spartan.

Zwitterion. A neutral valence structure which incorporates both a 
formal positive charge and a formal negative charge.


